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Notice
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Copyrights
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instruction manual may not be copied, reproduced, distributed, merged or modified in any manner without the express
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directly or by implication, estoppel, or otherwise, any license under the copyrights, patents or patent applications of
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Copyrighted Materials
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FCC Requirements

Content

This section presents Federal Communications Commission (FCC)
Rules Parts 15 and 68 requirements and compliance information for the
SC�4812T/ET/ET Lite series Radio Frequency Base Transceiver
Stations.

FCC Part 15 Requirements

Part 15.19a(3) - INFORMATION TO USER

NOTE This device complies with Part 15 of the FCC Rules. Operation
is subject to the following two conditions:
1. This device may not cause harmful interference, and

2. This device must accept any interference received, including
interference that may cause undesired operation.

Part 15.21 - INFORMATION TO USER

CAUTION Changes or modifications not expressly approved by Motorola
could void your authority to operate the equipment.

15.105(b) - INFORMATION TO USER

NOTE This equipment has been tested and found to comply with the
limits for a Class B digital device, pursuant to Part 15 of the
FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that
interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment
OFF and ON, the user is encouraged to try to correct the
interference by one or more of the following measures:

� Reorient or relocate the receiving antenna.

� Increase the separation between the equipment and receiver.

� Connect the equipment into an outlet on a circuit different
from that to which the receiver is connected.

� Consult the dealer or an experienced radio/TV technician for
help.
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FCC Part 68 Requirements

This equipment complies with Part 68 of the Federal Communications
Commission (FCC) Rules. A label on the GLI3 board, easily visible
with the board removed, contains the FCC Registration Number for this
equipment. If requested, this information must be provided to the
telephone company.

FCC Part 68 Registered Devices

Device FCC Part 68 ID

Group Line Interface (GLI3) See Note US: IHEXDNANGLI3-1X

Cisco Model 1900-27 Router US: 5B1DDNDN0006

ADC KENTROX Model 537 US: F81USA-31217-DE-N

NOTE
 The BTS equipment is always equipped with the GLI3, 
< US: IHEXDNANGLI3-1X>, and may be used in conjunction with
one or both of the listed registered CSU devices, or another registered
CSU device not listed above.

The telephone company may make changes in its facilities, equipment,
operations, or procedures that could affect the operation of your T1. If
this happens, the telephone company will provide advance notice so that
you can modify your equipment as required to maintain uninterrupted
service.

If this equipment causes harm to the telephone network, the telephone
company will notify you in advance that temporary discontinuance of
service may be required. If advance notice is not practical, the telephone
company will notify you as soon as possible. Also, you will be advised
of your right to file a complaint with the FCC if you believe it is
necessary.

If you experience trouble operating this equipment with the T1, please
contact:

Global Customer Network Resolution Center (CNRC)
1501 W. Shure Drive, 3436N
Arlington Heights, Illinois 60004
Phone Number: (847) 632-5390

for repair and/or warranty information. You should not attempt to repair
this equipment yourself. This equipment contains no customer or
user-serviceable parts.

Changes or modifications not expressly approved by Motorola could
void your authority to operate this equipment.
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Foreword

Scope of manual

This manual is intended for use by cellular telephone system
craftspersons in the day-to-day operation of Motorola cellular system
equipment and ancillary devices.

This manual is not intended to replace the system and equipment
training offered by Motorola, although it can be used to supplement or
enhance the knowledge gained through such training.

Obtaining Manuals

To view, download, order manuals (original or revised), visit the
Motorola Lifecycles Customer web page at http://services.motorola.com,
or contact your Motorola account representative.

If Motorola changes the content of a manual after the original printing
date, Motorola publishes a new version with the same part number but a
different revision character.

Text conventions

The following special paragraphs are used in this manual to point out
information that must be read. This information may be set-off from the
surrounding text, but is always preceded by a bold title in capital letters.
The three categories of these special paragraphs are:

NOTE Presents additional, helpful, non-critical information that you can
use. Bold-text notes indicate information to help you avoid
an undesirable situation or provides additional information
to help you understand a topic or concept.

CAUTION Presents information to identify a situation in which equipment
damage could occur, thus avoiding damage to equipment.

WARNING Presents information to warn you of a potentially hazardous
situation in which there is a possibility of personal injury.

The following typographical conventions are used for the presentation of
software information:

� In text, sans serif BOLDFACE CAPITAL characters (a type style
without angular strokes: i.e., SERIF versus SANS SERIF) are used to
name a command.

� In text, typewriter  style characters represent prompts and the
system output as displayed on an operator terminal or printer.

� In command definitions, sans serif boldface characters represent those
parts of the command string that must be entered exactly as shown and
typewriter  style characters represent command output responses
as displayed on an operator terminal or printer.

� In the command format of the command definition, typewriter
style characters represent the command parameters.
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Reporting manual errors

To report a documentation error, call the CNRC (Customer Network
Resolution Center) and provide the following information to enable
CNRC to open an MR (Modification Request):
- the document type 
- the manual title, part number, and revision character
- the page number(s) with the error
- a detailed description of the error and if possible the proposed solution
Motorola appreciates feedback from the users of our manuals.

Contact us

Send questions and comments regarding user documentation to the email
address below:
cdma.documentation@motorola.com

Motorola appreciates feedback from the users of our information.

Manual banner definitions

A banner (oversized text on the bottom of the page, for example,
PRELIMINARY) indicates that some information contained in the
manual is not yet approved for general customer use.

24-hour support service

If you have problems regarding the operation of your equipment, please
contact the Customer Network Resolution Center for immediate
assistance. The 24 hour telephone numbers are:

NA CNRC +1-800-433-5202
EMEA CNRC +44- (0) 1793-565444
ASPAC CNRC +86-10-88417733
Japan & Korea CNRC +81-3-5463-3550
LAC CNRC +51-1-212-4020

For further CNRC contact information, contact your Motorola account
representative.
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General Safety

Remember! . . . Safety
depends on you!!

The following general safety precautions must be observed during all
phases of operation, service, and repair of the equipment described in
this manual. Failure to comply with these precautions or with specific
warnings elsewhere in this manual violates safety standards of design,
manufacture, and intended use of the equipment. Motorola, Inc. assumes
no liability for the customer’s failure to comply with these requirements.
The safety precautions listed below represent warnings of certain dangers
of which we are aware. You, as the user of this product, should follow
these warnings and all other safety precautions necessary for the safe
operation of the equipment in your operating environment.

Ground the instrument

To minimize shock hazard, the equipment chassis and enclosure must be
connected to an electrical ground. If the equipment is supplied with a
three-conductor ac power cable, the power cable must be either plugged
into an approved three-contact electrical outlet or used with a
three-contact to two-contact adapter. The three-contact to two-contact
adapter must have the grounding wire (green) firmly connected to an
electrical ground (safety ground) at the power outlet. The power jack and
mating plug of the power cable must meet International Electrotechnical
Commission (IEC) safety standards.

NOTE Refer to Grounding Guideline for Cellular Radio Installations -
68P81150E62.

Do not operate in an explosive
atmosphere

Do not operate the equipment in the presence of flammable gases or
fumes. Operation of any electrical equipment in such an environment
constitutes a definite safety hazard.

Keep away from live circuits

Operating personnel must:

� not remove equipment covers. Only Factory Authorized Service
Personnel or other qualified maintenance personnel may remove
equipment covers for internal subassembly, or component
replacement, or any internal adjustment.

� not replace components with power cable connected. Under certain
conditions, dangerous voltages may exist even with the power cable
removed.

� always disconnect power and discharge circuits before touching them.

Do not service or adjust alone

Do not attempt internal service or adjustment, unless another person,
capable of rendering first aid and resuscitation, is present.
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Use caution when exposing or
handling the CRT

Breakage of the Cathode-Ray Tube (CRT) causes a high-velocity
scattering of glass fragments (implosion). To prevent CRT implosion,
avoid rough handling or jarring of the equipment. The CRT should be
handled only by qualified maintenance personnel, using approved safety
mask and gloves.

Do not substitute parts or
modify equipment

Because of the danger of introducing additional hazards, do not install
substitute parts or perform any unauthorized modification of equipment.
Contact Motorola Warranty and Repair for service and repair to ensure
that safety features are maintained.

Dangerous procedure
warnings

Warnings, such as the example below, precede potentially dangerous
procedures throughout this manual. Instructions contained in the
warnings must be followed. You should also employ all other safety
precautions that you deem necessary for the operation of the equipment
in your operating environment.

WARNING Dangerous voltages, capable of causing death, are present in this
equipment. Use extreme caution when handling, testing, and
adjusting.
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Revision History

Manual Number

68P09255A57- 2

Manual Title

SC�4812ET Optimization/ATP Manual Software Release R16.1.x.x

Version Information

The following table lists the manual version, date of version, and
remarks on the version. Revision bars printed in page margins (as shown
to the side) identify material which has changed from the previous
release of this publication.

Version
Level

Date of Issue Remarks

1 Mar 2002 Preliminary manual submitted for engineering markup

2 Jul 2002 LMF software updates. Preliminary manual submitted for DV&V
evaluation
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Introduction

Scope of This Document

This document provides information pertaining to the optimization and
audit tests of Motorola SC 4812ET Base Transceiver Subsystem (BTS)
equipment frames equipped with trunked high-power Linear Power
Amplifiers (LPAs) and their associated internal and external interfaces.

Also covered is software release 2.16.1.X and can support the following
versions of SC 4812ET BTS sites:

-  1X Packet Backhaul BTS
-  1X Circuit BTS
-  1X Packet backhaul BTS

The 1X packet BTS has a packet backhaul network interface which
provided via a pair of external routers together with a GLI upgrade
(GLI3) that can handle voice (IS-95A/B, 1X) and data (IS-95B, 1X).

This BTS equipment is configured with all 1X cards (BBX-1X
andMCC1X) or a mix of 1X cards and non-1X cards (BBX2 and
MCC8E/24E). This configuration is compliant with all applicable
cdma2000 1X specifications. It provides the forward link and reverse
link RF functions to support 2G features and 3G-1X features (i.e., high
capacity voice & high bit rate data).

The 1X circuit BTS has a split backhaul (circuit/packet pipe) network
interface that can handle circuit based voice (IS-95A/B, 1X) and data
(IS-95B) as well as packet based data (1X).

This document assumes the following prerequisites: The BTS frames
and cabling have been installed per the BTS Hardware Installation
Manual which covers the physical “bolt down” of all SC series
equipment frames, and the specific cabling configurations.

Document Composition
This document covers the following major areas:

� Introduction, consisting of preliminary background information (such
as component and subassembly locations and frame layouts) to be
considered by the Cell Site Field Engineer (CFE) before optimization
or tests are performed.

� Preliminary Operations, consisting of cabinet power up and power
down procedures.

� Optimization/calibration, covering topics of Local Maintenance
Facility (LMF) connection to the BTS equipment, Global Positioning
System (GPS) Verification, test equipment setup, downloading all
BTS processor boards, RF path verification, Bay Level Offset (BLO)
calibration and calibration audit, and Radio Frequency Diagnostic
System (RFDS) calibration.

� Acceptance Test Procedures (ATPs), consisting of ATP tests executed
by the LMF and used to verify all major transmit (TX) and
receive (RX) performance characteristics on all BTS equipment.

� Preparing to leave the site, presents instructions on how to properly
exit customer site, ensure that all equipment is operating properly, and
all work is complete according to Motorola guidelines.

1



Introduction68P09255A57-2

Aug 2002 SC�4812ET Optimization/ATP Manual Software Release R16.1.x.x

PRELIMINARY
1-3

� Basic troubleshooting, consisting of procedures for installation,
calibration, transmit and receive tests, backplane problems, GPS
failures, and module connectors.

� Appendices contain pertinent Pseudorandom Noise (PN) Offset,
frequency programming, output power data tables, data sheets that are
filled out manually by the CFE at the site, an optimization/ATP test
matrix, BBX gain set point information, CDMA operating frequency
information, PN Offset programminginformation, information on test
equipment preparation, manual cable calibration procedures, power
Delta calibration procedures, RF cabinet interconnect cable
information, procedures for checking changing GPIB addresses, and
proceduress for downloading ROM Code from the LMF.

CDMA LMF Product Description
The Code Division Multiple Access (CDMA) LMF is a graphical user
interface (GUI) based LMF. This product is specifically designed to
provide cellular communications field personnel the vehicle to support
the following CDMA BTS operations:

� Installation

� Maintenance

� Calibration

� Optimization

The LMF also provides Command Line Interface (CLI) capability.
Activate the CLI by clicking on a shortcut icon on the desktop. The CLI
cannot be launched from the GUI, only from the desktop icon.

Online Help
Task oriented online help is available in the LMF by clicking on Help
from the menu bar.

Why Optimize?
Proper optimization and calibration assures:

� Accurate downlink RF power levels are transmitted from the site.

� Accurate uplink signal strength determinations are made by the site.

What Is Optimization?
Optimization compensates for the site-specific cabling and normal
equipment variations. Cables that interconnect the BTS and Duplexer
assemblies (if used), for example, are cut and installed at the time of the
BTS frame installation at the site. Site optimization guarantees that the
combined losses of the new cables and the gain/loss characteristics and
built-in tolerances of each BTS frame do not accumulate, causing
improper site operation.

Optimization identifies the accumulated loss (or gain) for all receive and
transmit paths at the BTS site, and stores that value in a database.

� The RX path starts at the ancillary equipment frame RFDS RX
directional coupler antenna feedline port, through the RX input port

1
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on the rear of the frame, through the DDRCs, Multicoupler Preselector
Card (MPC), and additional splitter circuitry, ending at a CDMA
Channel Processor (C-CCP) backplane Broad Band Transceiver
(BBX) slot in the C-CCP shelf.

� A transmit path starts at the BBX, through the C-CCP backplane slot,
travels through the LPA/Combiner TX Filter and ends at the rear of
the input/output (I/O) Panel.  If the RFDS option is added, then the
TX path continues and ends at the top of the RFDS TX directional
coupler antenna feedline port installed in the ancillary equipment
frame. 

1
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These values are factored in by the BTS equipment internally, leaving
only site specific antenna feed line loss and antenna gain characteristics
to be factored in by the CFE when determining site Effective Radiated
Power (ERP) output power requirements.

Each C-CCP shelf BBX board is optimized to a specific RX and TX
antenna port. (One BBX board acts in a redundant capacity for BBXs
1-12, and is optimized to all antenna ports). A single value is generated
for each path, thereby eliminating the accumulation of error that would
occur from individually measuring and summing the gain and loss of
each element in the path.

When to Optimize

New Installations

After the initial site installation, the BTS must be prepared for operation.
This preparation includes verifying hardware installation, initial power
up, and GPS verification. Basic alarm tests are also addressed.

A calibration audit of all RF transmit paths is performed to verify factory
calibration.

A series of ATP CDMA verification tests are covered using the actual
equipment set up. An ATP is also required before the site can be placed
in service.

Site Expansion

Optimization is also required after expansion of a site.

Periodic Optimization

Periodic optimization of a site may also be required, depending on the
requirements of the overall system.

Repaired Sites

Verify repair(s) made to the BTS by consulting an Optimization/ATP
Test Matrix table. This table outlines the specific tests that must be
performed anytime a BTS subassembly or RF cable associated with it is
replaced.

NOTE Refer to Appendix B for detailed basic guideline tables and
detailed Optimization/ATP Test Matrix.

1
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Documentation
Site Documents

The following documents are required to perform optimization of the
cell site equipment:

� Site document (generated by Motorola systems engineering), which
includes:

- General site information

- Floor plans

- Power levels

- Site PN

- Site paging and traffic channel allocation

- Board placement

- Site wiring lists

- Cell-site Data Files (CDF)

� Demarcation Document (Scope of Work Agreement)

� Equipment manuals for non-Motorola test equipment.

Product Documentation

For other information, refer to the following manuals:

� CDMA LMF Operator’s Guide; 68P64114A78

� CDMA RFDS Hardware Installation manual; 68P64113A93

� CDMA RFDS User’s Guide

� Equipment Manuals for non-Motorola test equipment

� SC4812ET Field Replacable Units Guide Motorola part number
68P09253A48

� SC 4812ET RF & Power Cabinet Hardware Installation Manual
Motorola part number 68P09253A94

� LMF CLI Commands R16.X Motorola part number 68P09253A56

1
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Test Equipment

Overview

The LMF is used in conjunction with Motorola recommended test
equipment, and it is a part of a “calibrated test set.” To ensure consistent,
reliable, and repeatable optimization test results, only recommended test
equipment supported by the LMF must be used to optimize the BTS
equipment. Table 1-1 outlines the supported test equipment that meets the
technical criteria required for BTS optimization.

Table 1-1: CDMA LMF Test Equipment Support Table

Item Description

Hewlett Packard, model

HP 8921A

Cellular communications analyzer (includes
83203B CDMA interface option)

Agilent E4406A Analyzer
with Agilent E4432B
Generator

Used for both IS-95A/B and CDMA 2000
testings

Advantest R3267 Analyzer
with Advantest R3562
Generator

Used for both IS-95A/B and CDMA 2000
testings

Hewlett Packard, model

HP 83236A

PCS interface for PCS band

Hewlett Packard, model HP
8935

Cellular communications analyzer

Motorola CyberTest Cellular communications analyzer

Advantest R3465 with 3561
CDMA option

Cellular communications analyzer

Gigatronix 8541C Power meter

HP437B Power meter

 

To ensure consistent, reliable, and repeatable optimization test results,
test equipment meeting the following technical criteria should be used to
optimize the BTS equipment. You can, of course, substitute test
equipment with other test equipment models supported by the LMF
meeting the same technical specifications.

1
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LMF Hardware Requirements

An LMF computer platform that meets the following requirements (or
better) is recommended:

� Notebook computer

� 266 MHz (32-bit CPU) Pentium processor

� 4 GB internal hard disk drive

� Color display with 1024 x 768 pixel resolution and capability to
display more than 256 colors

� Memory requirements:

- Minimum required RAM: 96 MB

- Recommended RAM:

- 128 MB for Windows 98 SE

- 256 MB for Windows 2000

� CD ROM drive and 3 1/2 inch floppy drive

� 56 kbps V.90Modem

� Serial port (COM 1)

� Parallel port (LPT 1)

� PCMCIA Ethernet interface card (for example, 3COM Etherlink III)
with a 10Base-T-to-coax adapter

� Windows 98SE operating system or Windows 2000 operating system

NOTE If 800 x 600 pixel resolution is used, the LMF window must be
maximized after it is displayed.

Test Equipment Guidelines

To ensure consistent, reliable, and repeatable optimization test results,
test equipment meeting the following technical criteria should be used to
optimize the BTS equipment. You can, of course, substitute test
equipment with other test equipment models supported by the LMF
meeting the same technical specifications.

NOTE During manual testing, you can substitute test equipment with
other test equipment models not supported by the LMF, but
those models must meet the same technical specifications.

The customer has the responsibility of accounting for any measurement
variances and/or additional losses/inaccuracies that can be introduced
as a result of these substitutions. Before beginning optimization or
troubleshooting, make sure that the test equipment needed is on hand
and operating properly.

Test Equipment Calibration

Optimum system performance and capacity depend on regular equipment
service, calibration, and characterization prior to BTS optimization.
Follow the original equipment manufacturer (OEM) recommended
maintenance and calibration schedules closely.

1
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Test Cable Calibration

Equipment test cables are very important in optimization. Motorola
recommends that the cable calibration be run at every BTS with the test
cables attached. This method compensates for test cable insertion loss
within the test equipment itself. No other allowance for test cable
insertion loss needs to be made during the performance of tests.

Another method is to account for the loss by entering it into the LMF
during the optimization procedure. This method requires accurate test
cable characterization in a shop. The cable should be tagged with the
characterization information prior to field optimization.

Equipment Warm-up

After arriving at the a site, the test equipment should be plugged in and
turned on to allow warm up and stabilization to occur for as long as
possible. The following pieces of test equipment must be warmed-up for
a minimum of 60 minutes prior to using for BTS optimization or RFDS
calibration procedures.

� Communications test set

� Rubidium time base

� Power meter

Test Equipment List

The following pieces of test equipment are required during the
optimization procedure. Common assorted tools like screwdrivers and
frame keys are not listed but are still required. Read the owner’s manual
on all of the following major pieces of test equipment to understand their
individual operation prior to use in optimization.

NOTE Always refer to specific OEM test equipment documentation for
detailed operating instructions.

10BaseT/10Base2 Converter

Ethernet LAN transceiver (part of CGDSLMFCPQ1700)

� PCMCIA Ethernet Adpater + Ethernet UTP adapter: 3COM model -
Etherlink III 3C589B

Transition Engineering model E-CX-TBT-03  10BaseT/10Base2
converter

NOTE Xircom model PE3-10B2 or equivalent can also be used to
interface the LMF Ethernet connection to the frame.

RS-232  to GPIB Interface
� National Instruments GPIB-232-CT with Motorola CGDSEDN04X

RS232 serial null modem cable (see Figure 1-1) or equivalent; used to
interface the LMF to the test equipment.

� Standard RS-232 cable can be used with the following modifications:

1
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- This solution passes only the three minimum electrical connections
between the LMF and the GPIB interface. The control signals are
jumpered as enabled on both ends of the RS-232 cable (9-pin D).
TX and RX signals are crossed as null modem effect. Pin 5 is the
ground reference.

- Short pins 7 and 8 together, and short pins 1, 4, and 6 together on
each connector.

Figure 1-1: Null Modem Cable Detail

5
3
2
7
8
1
4
6

GND
RX
TX

RTS
CTS

RSD/DCD
DTR

GND
TX
RX
RTS
CTS
RSD/DCD
DTR

ON BOTH CONNECTORS
SHORT PINS 7, 8;
SHORT PINS 1, 4, & 6

9-PIN D-FEMALE 9-PIN D-FEMALE

5
2
3
7
8
1
4
6 DSR DSR FW00362

Model SLN2006A MMI Interface Kit
� Motorola Model TRN9666A null modem board. Connectors on

opposite sides of the board must be used as this performs a null
modem transformation between cables. This board can used for
10-pin to 8-pin, 25-pin to 25-pin and 10-pin to 10-pin conversions.

� Motorola 30-09786R01 MMI cable or equivalent ; used to interface
the LMF serial port connection to GLI3, CSM and LPA debug serial
ports.

� 25 pin D to 25 pin D serial cable from PC to null modem board.

Communications System Analyzer

The communication system analyzer is used during optimization and
testing of the RF communications portion of BTS equipment and
provides the following functions:

(1) Frequency counter
(2) RF power meter (average and code domain)
(3) RF Signal generator (capable of CDMA modulation)
(4) Spectrum analyzer
(5) CDMA code domain analyzer

The following types of communication system analyzers are currently
supported by the LMF:

� HP8921A/600 Analyzer - Including 83203B CDMA Interface,
manual control system card, and 83236A/B PCS Interface for 1900
MHz BTSs.

� Advantest R3465 Analyzer - Including R3561L test source unit

� Advantest R3267 Analyzer - Including R3562 test source unit

� Agilent E4406A Analyzer -  including E4432 test source unit

� HP8935 Analyzer

� CyberTest Communication Analyzer

GPIB Cables
� Hewlett Packard 10833A or equivalent; 1 to 2 meters (3 to 6 feet) long

used to interconnect test equipment and LMF terminal.

1
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Power Meter
One of the following power meters is required for TX calibration and
audit if an HP8921A or Advantest R3465 analyzer is used:

� Hewlett Packard Model HP HP437B with HP8481A power sensor

� Gigatronix model 8541C with model 80601A power sensor

Timing Reference Cables
� Two BNC-male to BNC-male RG316 cables; 3 meters (10 ft.) long,

used to interconnect the HP8921A/600 or Advantest R3465
communications analyzer to the CSM front panel timing references in
the BTS.

NOTE Two Huber & Suhner 16MCX/11BNC/K02252D or equivalent;
right angle MCX-male to standard BNC-male RG316 cables;
3m long are required to interconnect the HP8921A/600
communications analyzer to SGLN4132A and SGLN1145A
CSM board timing references.

� BNC “T” adapter with 50 ohm termination.

NOTE This BNC “T” adapter (with 50 ohm termination) is required to
connect between the HP 8921A/600 (or Advantest R3465)
EVEN SECOND/SYNC IN and the BNC cable. The BNC cable
leads to the 2-second clock connection on the TIB. Erroneous
test results may occur if the “T” adapter with the 50 ohm
termination is not connected.

Digital Multimeter
� Fluke model 8062A with Y8134 test lead kit or equivalent; used for

precision DC and AC measurements, requiring 4-1/2 digits.

Directional Coupler
� Narda model 30661 30 dB (Motorola part no. 58D09732W01) coupler

terminated with two Narda Model 375BN-M loads, or equivalent.

RF Attenuators
� 20 dB fixed attenuators, 20 W (Narda 768-20); used with  test cable

calibrations or during general troubleshooting procedures.
� Narda Model 30445 30 dB (Motorola Part No. 58D09643T01) coupler

terminated with two Narda Model 375BN-M loads, or equivalent.

Miscellaneous RF Adapters, Loads, etc
� As required to interface test cables and BTS equipment and for

various test set ups. Should include at least two 50 Ohm loads (type
N) for calibration and one RF short, two N-type female-to-female
adapters.

High-impedance  Conductive Wrist Strap
� Motorola model 42-80385A59; used to prevent damage from

Electrostatic Discharge (ESD) when handling or working with
modules.

RF Load (at least three for trunked cabinets)
� 100 W non-radiating RF load; used (as required) to provide dummy

RF loading during BTS transmit tests.
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RF Network Box (and calibrated cables)
� Motorola model SGLN5531A 18:3 Passive Antenna Interface used to

interface test equipment to the BTS receive and transmit antenna
inputs during optimization/ATP or general troubleshooting
procedures.

Optional Equipment

Frequency Counter
� Stanford Research Systems SR620 or equivalent. If direct

measurement of the 3 MHz or 19.6608 MHz references is required.

Spectrum Analyzer
� Spectrum Analyzer (HP8594E with CDMA personality card) or

equivalent; required for tests other than standard Receive band spectral
purity and TX LPA IM reduction verification tests performed by the
LMF.

Local Area Network (LAN) Tester
� Model NETcat 800 LAN troubleshooter (or equivalent); used to

supplement LAN tests using the ohm meter.

Span Line (T1/E1) Verification Equipment
� As required for local application

RF Test Cable (if not Provided with Test Equipment)
� Motorola model TKN8231A; used to connect test equipment to the

BTS transmitter output during optimization or during general
troubleshooting procedures.

Oscilloscope
� Tektronics model 2445 or equivalent; for waveform viewing, timing,

and measurements or during general troubleshooting procedure.

2-way  Splitter
� Mini-Circuits  model ZFSC-2-2500 or equivalent; provide the

diversity receive input to the BTS

High Stability 10 MHz Rubidium Standard
� Stanford Research Systems SR625 or equivalent. Required for CSM

and Low Frequency Receiver/High Stability Oscillator (LFR/HSO)
frequency verification.
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Abbreviations and Acronyms

Table 1-2: Abbreviations and Acronyms

Acronym Definition

ACLC AC Load Center

ASU Antenna Selection Unit

AMR Alarm Monitor Reporting

ATP Acceptance Test Plan

BBX Broadband Transceiver

BLO Bay Level Offset

BTS Base Transceiver Subsystem

CBSC Centralized Base Station Controller

C-CCP Combined CDMA Channel Processor

CCD CDMA Clock Distribution

cdf command data file

CDMA Code Division Multiple Access

CE Channel Element

CHI Concentration Highway Interface

CLI Command Line Interface

CIO Combiner Input/Output

CMR Cellular Manual Revision

CSM Clock Synchronization Manager

CSU Clock Synchronization Unit

DBPF Dual Bandpass Filter

DBM Debug Monitor

DLM Download Manager

DMAC Digital Metering and Alarm Control (also see MAP)

DRDC Duplexer/RX Filter/Directional Coupler

DSP Digital Signal Processor

EMPC Expansion Multicoupler Preselector Card

FRU Field Replaceable Unit

FSI Frame Status Indicator

FWTIC Fixed Wireless Terminal Interface Card

GFCI Ground Fault Connection Interrupt

GLI 2 Group Line Interface II

GPS Global Positioning System

GUI Graphical User Interface

HSO High Stability Oscillator

IFM Integrated Frame Modem

I&Q Interphase and Quadrature

ISB InterShelf Bus
. . . continued on next page
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Table 1-2: Abbreviations and Acronyms

Acronym Definition

LAPD Link Access Protocol “D”

LFR LORAN-C Frequency Receiver

LMF Local Maintenance Facility

LORAN LOng RAnge Navigational

LPA Linear Power Amplifier

MAP Meter Alarm Panel (also refered to as DMAC)

MCC Multi-Channel CDMA

MGLI Master Group Line Interface

MM Mobility Manager

MMI Man Machine Interface

MPC Multicoupler Preselector Card

oos Out-of-Service

OMCR Operations Maintenance Center - Radio

PC Personal Communication System

PDA Personal Communication System Controller

PN Pseudo-random Noise

QPSK Quadrature Phase Shift Keyed

RFDS Radio Frequency Diagnostic Subsystem

RGPS Remote Global Positioning System

RSSI Received Signal Strength Indicator

SCAP Super Cell Application Protocol

TCH Traffic Channel

TCP Traffic Channel

TMPC Traffic Channel

TSIC Traffic Channel

TSI Time Slot Interchanger
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BTS Overview
The SC 4812ET BTS consists of an RF Cabinet that is an outdoor,
weatherized version of the SC 4812T. The RF cabinet is powered by
27 Vdc and each cabinet has the capability to support up to 4 carriers (at
3 sector) or 2 carriers (at 6 sector).

The RF Cabinet houses the fan modules, C-CCP, LPA modules, LPA
trunking backplane, Bandpass 2:1 & 4:1 Combiners, Duplexer/Receive
Filter/Directional Couplers (DRDC) and a DC Power distribution
assembly. The Power Cabinet (PC) provides +27 Vdc distribution and
battery backup for the SC 4812ET. The Power Cabinet houses batteries,
battery heaters, rectifiers, an AC Load Center (ACLC), a power
distribution assembly, and two duplexed GFCI convenience outlets.

C-CCP  Shelf Card/Module Device ID Numbers

All cards/modules/boards in the frames at a single site, assigned to a
single BTS number, are also identified with unique Device ID numbers
dependent upon the Frame ID number in which they are located. Refer to
Table 1-3 and Table 1-4 for specific C-CCP Shelf Device ID numbers.

Table 1-3: C-CCP Shelf/Cage Card/Module Device ID Numbers (Top Shelf)

Frame Card/Module ID Number (Left to Right)
#

Power
(PS-1)

Power
(PS-2)

Power
(PS-3)

AMR
- 1

GLI3
-1

MCC BBX BBX
-R

MPC/
EMPC

- 1

1 - - - 1 1 1 2 3 4 5 6 1 2 3 4 5 6 R1 -

101 - - - 101 101 101 102 103 104 105 106 101 102 103 104 105 106 R101 -

201 - - - 201 201 201 202 203 204 205 206 201 202 203 204 205 206 R201 -

301 - - - 301 301 301 302 303 304 305 306 301 302 303 304 305 306 R301 -

Table 1-4: C-CCP Shelf/Cage Card/Module Device ID Numbers (Bottom Shelf)

Frame Card/Module ID Number (Left to Right)
#

HSO/
LFR

CSM
-1

CSM
-2

CCD
A

CCD
B

AMR
- 2

GLI3-
2

MCC BBX SW MPC/
EMPC

- 2

1 - 1 2 - - - 2 2 7 8 9 10 11 12 7 8 9 10 11 12 - -

101 - 101 102 - - - 102 102 107 108 109 110 111 112 107 108 109 110 111 112 - -

201 - 201 202 - - - 202 102 207 208 209 210 211 212 207 208 209 210 211 212 - -

301 - 301 302 - - - 302 102 307 308 309 310 311 312 307 308 309 310 311 312 - -
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Major Components

The major components that make up the Motorola SC 4812ET are
illustrated in this section: the RF Cabinet (see Figure 1-2) and the Power
Cabinet (see Figure 1-9).

Figure 1-2: SC 4812ET RF Cabinet

Main Door

LPA Door
(Can only be opened after Main Door is open)

RF I/O
Area Cover Plate

Rear I/O DoorRear DC  Conduit Panel

Rear Conduit Panel

FW00189
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RF Cabinet Internal FRUs

Figure 1-3 shows the location of the Internal Field Replaceable
Units (FRUs). A brief description of each Internal FRU is found in the
following paragraphs.

Figure 1-3: RF Cabinet Internal FRUs

DRDC LPAs

CCP Fans

LPA Trunking
Backplane

5 RU Rack Space

RFDS

DC
Power
Dist.

Punch
Block
(back)

EBA

C-CCP  Shelf

Combiner
Cage

Circuit
Breaker Panel

ETIB

FW00163

OPTIONAL AREA

Duplexer/RX Filter Directional Coupler
The DRDC combines, in a single module, the functions of antenna
duplexing, receive band pass filtering, and surge protection (see
Figure 1-7).

Combiner Cage (2:1, 4:1, or Band pass Filter)
The Combiner Cage holds the transmit band pass filters, 2:1 combiners,
or 4:1 combiners, depending on system configuration.
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Combined CDMA Channel Processor Shelf

The C-CCP shelf contains the following (see Figure 1-4):

� High Stability Oscillator (HSO) or Low Frequency Receiver (LFR)
card (1)

� Clock Synchronization Manager (CSM) cards (2)
� CDMA Clock Distribution (CCD) cards (2)
� Power Supply cards (2 minimum, 3 maximum)
� Multicoupler Preselector Cards (MPC) or Expansion Multicoupler

Preselector Cards (EMPC) (2)
� Alarm Monitoring and Reporting (AMR) cards (2)
� Multi Channel CDMA (MCC8E, MCC24E or MCC-1X) cards (up to

12)
� Broadband Transceiver (BBX2 or BBX-1X) cards (up to 13)
� Combined Input/Output (CIO) card (1)
� Group Line Interface (GLI3) cards (2)
� BBX Switch card (1)
� Modem (optional)
� Filler Panels (as required)
� Fan Module (3)

Figure 1-4: SC 4812ET C-CCP Shelf

5 RU RACK
SPACE

RFDS

EBAETIB

NOTE: MCCs may be
MCC8Es, MCC24Es
or MCC-1Xs. BBXs
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Punch Block

The Punch Block is the interface point of the RF Cabinet between the
T1/E1 span lines, the Customer I/O, alarms, multi-cabinet timing
(RGPS and HSO), and Pilot Beacon control (optional). (see Figure 1-6).
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Span I/O Board

The Span I/O Board provides the interface for the span lines from the
CSU to the C-CCP backplane (see Figure 1-6).

RF Diagnostic Subsystem

The RFDS provides the capability for remotely monitoring the status of
the SC 4812ET RF Transmit and Receive paths (Figure 1-7).

Heat Exchanger

The Heat Exchanger provides cooling to the internal compartment of the
RF Cabinet.  The fan speed of the heat exchangers adjusts automatically
with temperature.  The Heat Exchanger is located in the primary front
door of the RF Cabinet.

SC 4812ET Interface Board (ETIB) & LPA Control Brd
(LPAC)

The ETIB is an interconnect board showing status LEDs for the RF
Cabinet, as well as providing secondary surge protection. The LPAC
board provides the interface for the LPA connection.

SC 4812ET Trunking Backplane

The Trunking Backplane contains a complex passive RF network that
allows RF signals to share the resources of a bank of four LPAs. It also
provides DC Power and digital interconnect.

Figure 1-5:  SC 4812ET Intercabinet I/O Detail (Rear View)
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Figure 1-6: SC 4812ET  I/O Plate Diagram
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Figure 1-7: RFDS Location in an SC 4812ET RF Cabinet
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Sector Configuration
There are a number of ways to configure the BTS frame. Table 1-5
outlines the basic requirements. When carrier capacity is greater than
two, a 2:1 or 4:1 cavity combiner must be used. For one or two carriers,
bandpass filters or cavity combiners may be used, depending on
sectorization and channel sequencing.

Table 1-5: BTS Sector Configuration

Number of
carriers

Number of
sectors

Channel spacing Filter requirements

1 3 or 6 N/A Bandpass Filter, Cavity Combiner (2:1 or 4:1)

2 6 Non-adjacent Cavity Combiner (2:1 Only)

2 6 Adjacent Dual Band Pass Filter

2 3 Non-adjacent Cavity Combiner (2:1 or 4:1)

2 3 Adjacent Bandpass Filter

3,4 3 Non-adjacent Cavity Combiner (2:1 or 4:1)

3,4 3 Adjacent Cavity Combiner (2:1 Only)

The matrix in Table 1-6 shows a correlation between the various sector
configurations and BBX cards.

NOTE In Table 1-6, BBXs may be BBX2s or BBX-1Xs.
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Table 1-6: Sector Configurations

Config Ref. No. Description

3-Sector/2-ADJACENT  Carriers - The configuration below maps TX with optional 2:1 cavity
combiners for 3 sectors/2 carriers for adjacent channels. Note that 2:1 cavity combiners are used (6
total).

1 TX1 TX2 TX3 TX4 TX5 TX6 Carrier#

BBX-1 BBX-2 BBX-3 N/A N/A N/A 1

N/A N/A N/A BBX-4 BBX-5 BBX-6 2

6-Sector/2-NON-ADJACENT Carriers - The configuration below maps TX with 2:1 cavity
combiners for 6 sectors/2 carriers for non-adjacent  channels.

2 TX1 TX2 TX3 TX4 TX5 TX6 Carrier#

BBX-1 BBX-2 BBX-3 BBX-4 BBX-5 BBX-6 1

BBX-7 BBX-8 BBX-9 BBX-10 BBX-1 1 BBX-12 2

3-Sector/2-NON-ADJACENT Carriers - The configuration below maps TX with 2:1 cavity
combiners for 3 sectors/2 carriers for non-adjacent  channels.

3 TX1 TX2 TX3 TX4 TX5 TX6 Carrier#

BBX-1 BBX-2 BBX-3 N/A N/A N/A 1

BBX-7 BBX-8 BBX-9 N/A N/A N/A 2

3-Sector/4-ADJACENT Carriers - The configuration below maps TX with 2:1 cavity combiners
for 3 sector/4 carriers for adjacent channels.

TX1 TX2 TX3 TX4 TX5 TX6 Carrier#

4 BBX-1 BBX-2 BBX-3 N/A N/A N/A 1

BBX-7 BBX-8 BBX-9 N/A N/A N/A 2

N/A N/A N/A BBX-4 BBX-5 BBX-6 3

N/A N/A N/A BBX-10 BBX-1 1 BBX-12 4

3-Sector / 2-ADJACENT Carriers - The configuration below maps TX with bandpass filters for
3 sectors/2 carriers for adjacent channels.

5 TX1 TX2 TX3 TX4 TX5 TX6 Carrier#

BBX-1 BBX-2 BBX-3 N/A N/A N/A 1

N/A N/A N/A BBX-7 BBX-8 BBX-9 2

3-Sector/3 or 4-NON-ADJACENT Carriers - The configuration below maps TX with 4:1
cavity combiners for 3 sectors/3 or 4 carriers for non-adjacent  channels.

TX1 TX2 TX3 TX4 TX5 TX6 Carrier#

6 BBX-1 BBX-2 BBX-3 N/A N/A N/A 1

BBX-7 BBX-8 BBX-9 N/A N/A N/A 2

BBX-4 BBX-5 BBX-6 N/A N/A N/A 3

BBX-10 BBX-1 1 BBX-12 N/A N/A N/A 4

6-Sector/1-Carrier - The configuration below maps TX with either bandpass filters or 2:1 cavity
combiners for 6 sector/1 carrier.

7 TX1 TX2 TX3 TX4 TX5 TX6 Carrier#

BBX-1 BBX-2 BBX-3 BBX-4 BBX-5 BBX-6 1

1
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Figure 1-8: SC4812ET LPA Configuration with Combiners/Filters
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Power Cabinet

Figure 1-9 illustrates the Power Cabinet design.

Figure 1-9: Power Cabinet
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Internal FRUs
Figure 1-10 shows the location of the Internal Field Replaceable
Units (FRUs). A brief description of each Internal FRU is found in the
following paragraphs.

Figure 1-10: Power Cabinet with Batteries Installed (Doors Removed for Clarity)
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Batteries

The batteries provide a +27 Vdc backup to the RF Cabinet should AC
Power be lost.  The Power Cabinet can accommodate a total of 24 12-V
batteries, configured in 12 strings of 2 batteries each.  The time duration
of backup provided depends on system configuration.

Battery Heater

The battery heaters provide heating to the batteries in the Power Cabinet.
A separate heater is required for each string of batteries.  The heater is a
pad the batteries sit on located top of each battery shelf.  The number of
heaters is dependent on system configuration.

1
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Battery Compartment Fan

The battery compartment fan provides air circulation for the two battery
compartments. It is located on the inside of the battery compartment
door.

Heat Exchanger

The Heat Exchanger provides cooling to the rectifier compartment of the
Power Cabinet.  The Heat Exchanger is located in the primary front door
of the Power Cabinet.

Rectifiers

The +27 Vdc rectifiers convert the AC power supplied to the Power
Cabinet to +27 Vdc to power the RF Cabinet and maintain the charge of
the batteries.

AC Load Center

The ACLC is the point of entry for AC Power to the Power Cabinet.  It
incorporates AC power distribution and surge protection.

Punch Block

The Punch Block is the interface for the alarm signalling between the
Power Cabinet and the RF Cabinet.

1
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Notes
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Power Up Procedures
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Prepower-up
This section first verifies proper frame equipage. This includes verifying
module placement,  jumper, and dual in-line package (DIP) switch
settings against the site-specific documentation supplied for each BTS
application.  Next,  pre-power up and initial power-up procedures are
presented.

Cellsite Types

Sites are configured as with a maximum of 4 carriers, 3-sectored with a
maximum of 4 carriers, and 6-sectored with a maximum of 2 carriers.
Each type has unique characteristics and must be optimized accordingly.

CDF

The Cell-site Data File (CDF) contains site type and equipage data
information and passes it directly to the LMF during optimization.  The
number of modem frames, C-CCP shelves, BBX and MCC boards (per
cage), and linear power amplifier assignments are some of the equipage
data included in the CDF.

Site Equipage Verification

Review the site documentation. Match the site engineering equipage data
to the actual boards and modules shipped to the site. Physically inspect
and verify the equipment provided for the BTS or Modem frame and
ancillary equipment frame.

CAUTION Always wear a conductive, high impedance wrist strap while
handling any circuit card/module to prevent damage by ESD.
After removal, the card/module should be placed on a conductive
surface or back into the anti-static bag it was shipped in.

Initial Installation of Boards/Modules

Table 2-1: Initial Installation of Boards/Modules

Step Action

1 Refer to the site documentation and install all boards and modules into the appropriate shelves as
required. Verify they are NOT SEATED at this time.

2 As the actual site hardware is installed, record the serial number of each module on a “Serial Number
Checklist” in the site logbook.
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Setting Frame C-CCP Shelf Configuration Switch
If the frame is a Starter BTS, the backplane switch settings behind the
fan module should be set to the ON position (see Figure 2-1).

The switch setting must be verified and set before power is applied to the
BTS equipment.

Figure 2-1: Backplane DIP Switch Settings
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Checking for shorts
The following information is used to check for any electrical short
circuits and to verify the operation and tolerances of the cellsite and BTS
power supply units before applying power for the first time. It contains
instructional information on the initial proper power up procedures for
the SC 4812ET power cabinet and RF cabinet. Also presented are tests
to be performed on the power cabinet. Please pay attention to all
cautions and warning statements in order to prevent accidental injury to
personnel.
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Required Tools
The following tools are used in the procedures.

� DC current clamp (600 Amp capability with jaw size to accommodate
2/0 cable).

� Hot Air Gun - (optional for part of the Alarm Verification)

� Digital Multimeter (DMM)

Cabling Inspection
Using the site-specific documentation generated by Motorola Systems
Engineering, verify that the following cable systems are properly
connected:

� Receive RF cabling - up to 12 RX cables

� Transmit RF cabling - up to six TX cables

NOTE For positive power applications (+27 V):

� The positive power cable is red.

� The negative power cable is black. (The black power cable is
at ground potential.)

Initial Inspection and Setup
CAUTION Ensure all battery breakers for unused battery positions are open

(pulled out) during any part of the power up process, and remain
in the off position when leaving the site.

Table 2-2: Initial Inspection and Setup

Step Action

1 Verify that ALL AC and DC breakers are turned OFF in both the Power and RF cabinets. Verify that
the DC power cables between the Power and RF cabinets are connected with the correct polarity

2 The RED cables  connect to the uppermost three (3) terminals (marked +) in both cabinets. Confirm
that the split phase 240/120 AC supply is correctly connected to the AC load center input.

CAUTION Failure to connect the proper AC feed will damage the surge
protection module inside the AC load center.

AC Power Check
The first task in the power up sequence is to apply AC power to the
Power cabinet. Once power is applied a series of AC Voltage
measurements is required.

Table 2-3: AC Voltage Measurements

Step Action

1 Measure the AC voltages connected to the AC load center (access the terminals from the rear of the
cabinet after removing the AC load center rear panel). See Figure 2-2.

2 Measure the AC voltage from terminal L1 to neutral. This voltage should be in the range of nominally
115 to 120 Vac.

. . . continued on next page
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Table 2-3: AC Voltage Measurements

Step Action

3 Measure the AC voltage from terminal L1 to ground. This voltage should be in the range of nominally
115 to 120 Vac.

4 Measure the AC voltage from terminal L2 to neutral. This voltage should be in the range of nominally
115 to 120 Vac.

5 Measure the AC voltage from terminal L2 to ground. This voltage should be in the range of nominally
115 to 120 Vac.

6 Measure L1 - L2 - should be from  208 to 240 Vac.

 

CAUTION If the AC voltages are in excess of 120 V (or exceed 200 V)
when measuring between terminals L1 or L2 to neutral or
ground, STOP and Do Not proceed until the cause of the higher
voltages are determined. The power cabinet WILL be damaged
if the Main breaker is turned on with excessive voltage on the
inputs.

Figure 2-2: AC Load Center Wiring
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AC Power Up Sequence

Applying AC Power

Once AC Voltage Measurements are complete, apply AC power to the
Power Cabinet. Table 2-4 provides the procedure for applying AC
power.

Table 2-4: Applying AC Power

Step Action

1 When the input voltages are verified as correct, turn the Main AC breaker (located on the front of the
ACLC) ON. Observe that all eight (8) green LEDs on the front of the ACLC are illuminated (see
Figure 2-7).

2 Turn Rectifier 1 and Rectifier 2 AC branch breakers (on the AC Load Center) ON. All the installed
rectifier modules (see Figure 2-7) will start up and should each have two green LEDs (DC and Power)
illuminated.

3 Turn the Meter Alarm Panel  module, ON (see Figure 2-3), while observing the K2 contact in the
PDA assembly (see Figure 2-9). The contact should close. The Meter Alarm Panel voltage meter
should read approximately 27.4 + 0.2 Vdc.

4 Turn the Temperature Compensation Panel (TCP)  ON, (see Figure 2-4). Verify that the Meter Alarm
Control Panel does not have any alarm LEDs illuminated.

5 Check the rectifier current bargraph displays (green LED display on the rectifier module). None
should be illuminated at this point.

NOTE If batteries are fitted, turn on the two battery heater AC breakers
on the AC Load Center.

Figure 2-3: Meter Alarm Panel
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Power Cabinet Power Tests

Table 2-5 lists the step-by-step instructions for Power Up Tests.

Table 2-5: Power Cabinet Power Up Tests

Step Action

1 Probe the output voltage test point on the Meter Alarm Panel while pressing the 25° C set button on
the TCP (see Figure 2-4). The voltage should read 27.4 + 0.2 Vdc. Adjust Master Voltage on Meter
Alarm Panel if necessary. Release the TCP 25° C set button.

2 Depending on the ambient temperature, the voltage reading may now change by up to + 1.5 V
compared to the reading just measured. If it is cooler than 25�C, the voltage will be higher, and if it is
warmer than 25�C, the voltage will be lower.

3 Ensure the RF cabinet 400A main DC breaker is OFF.

4 Close the three (3) Main DC breakers on the Power Cabinet ONLY. Close by holding in the reset
button on the front of the PDA, and engaging one breaker at a time.

5 Measure the voltage between the + and - terminals at the rear of the Power Cabinet and the RF
Cabinet, observing that the polarity is correct. The voltage should be the same as the measurement in
step 2.

6 Place the probes across the black and red battery buss bars in each battery compartment. Place the
probe at the bottom of the buss bars where the cables are connected. The DC voltage should measure
the same as the previous step.
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DC Power Pre-test

DC Power Checks
Before applying any power to the BTS cabinet, verify there are no shorts
in the RF or power DC distribution system (see Figure 2-5).

Table 2-6: DC Power Pre-test (BTS Frame)

Step Action

1 Physically verify that all AC rectifiers supplying power to the RF cabinets are OFF or disabled (see
Figure 2-5). There should be no 27 Vdc on DC feed terminals.

2 On each RF cabinet:

� Unseat all circuit boards/ modules in the distribution shelf, transceiver shelf, and Single Carrier
Linear Power Amplifier (SCLPA) shelves, but leave them in their associated slots.

� Unseat all circuit boards (except CCD and CIO cards) in the C-CCP shelf and LPA shelves, but
leave them in their associated slots.

� Set C-CCP shelf breakers to the OFF position by pulling out power distribution breakers (labeled
C-CCP 1, 2, 3 - located on the power distribution panel).

� Set LPA breakers to the OFF position by pulling out power distribution breakers (8 breakers,
labeled 1A-1B through 4C-4D  - located on the power distribution panel).

3 Verify that the resistance from the power (+) feed terminals with respect to the ground terminal on the
cabinet measures > 500 Ω (see Figure 2-5).

� If reading is < 500 Ω, a short may exist somewhere in the DC distribution path supplied by the
breaker. Isolate the problem before proceeding. A reading > 3 MΩ could indicate an open (or
missing) bleeder resistor (installed across the filter capacitors behind the breaker panel).

4 Set the 400 Amp Main Breaker and the C-CCP breakers (C-CCP 1, 2, 3) to the ON position by
pushing them IN one at a time. Repeat step 3 after turning on each breaker.

* IMPORTANT
If, after inserting any board/module, the ohmmeter stays at 0 Ω, a short probably exists in that
board/module. Replace the suspect board/module and repeat the test. If test still fails, isolate the
problem before proceeding.

5 Insert and lock the DC/DC converter modules into their associated slots one at a time. Repeat step3
after inserting each module.

� A typical response is that the ohmmeter will steadily climb in resistance as capacitors charge, finally
indicating approximately 500 Ω.

! CAUTION
Verify the correct power/converter modules by observing the locking/retracting tabs appear as follows:

-  

6 Insert and lock all remaining circuit boards and modules into their associated slots in the C-CCP shelf.
Repeat step 3 after inserting and locking each board or module.

� A typical response is that the ohmmeter will steadily climb in resistance as capacitors charge,
stopping at approximately 500 Ω..

. . . continued on next page
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Table 2-6: DC Power Pre-test (BTS Frame)

Step Action

7 Set the 8 LPA breakers ON by pushing them IN one at a time. Repeat step 3 after turning on each
breaker.

� A typical response is that the ohmmeter will steadily climb in resistance as capacitors charge,
stopping at approximately 500 Ω..

8 Seat all LPA and associated LPA fan modules into their associated slots in the shelves one at a time.
Repeat step 3 after seating each LPA  and associated LPA fan module.

� A typical response is that the ohmmeter will steadily climb in resistance as capacitors charge,
stopping at approximately 500 Ω..

9 Seat the Heat Exchanger, ETIB, and Options breakers one at a time. Repeat step 3.

 

RF Cabinet Power Up
Table 2-7 covers the procedures for properly powering up the RF
Cabinet.

Table 2-7: RF Cabinet Power Up

Step Action

1 Ensure the 400 Amp Main DC breaker and all other breakers in the RF Cabinet are OFF.

2 Proceed to the DC Power Pre-test (BTS Frame) sequence (see Table 2-6) (for initial power-up as
required).

3 Ensure the power cabinet is turned on  (see Table 2-5). Verify that 27 volts is applied to the terminals
on the back of the RF cabinet.

4 Engage the main DC circuit breaker on the RF cabinet (see Figure 2-5).

5 On each RF cabinet:

� Set C-CCP shelf breakers to the ON position by pushing them in one at a time (labeled
C-CCP 1, 2, 3 - located on the power distribution panel).

� Set LPA breakers to the ON position by pushing them in one at a time  (8 breakers, labeled 1A-1B
through 4C-4D  - located on the power distribution panel).

� Set the two heat exchanger breakers to the ON position by pushing them in one at a time.

� Set the ETIB breaker to the ON position by pushing it in.

� Set the OPTION breaker  to the ON position by pushing it in.

6 Measure the voltage drop between the Power Cabinet meter test point and the 27 V buss bar inside the
RF Cabinet PDA while the RF Cabinet is transmitting.

NOTE
For a 3-sector carrier system, the voltage drop should be less than 0.2 V.

For a 12-sector carrier system, the voltage drop should be less than 0.3 V.

7 Using a DC current probe, measure the current in each of the six (6) DC cables that are connected
between the RF and Power Cabinet. The DC current measured should be approximately the same. If
there is a wide variation between one cable and the others (>20 A), check the tightness of the
connections (torque settings) at each end of the cable.
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Figure 2-5: RF Cabinet Circuit Breaker Panel and 27Vdc Terminal Locations
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Battery Test

Charge Test (Connected Batteries)

Table 2-8 lists the step-by-step instructions for testing the batteries.

Table 2-8: Battery Charge Test (Connected Batteries)

Step Action

1 Close the battery compartment breakers for connected batteries ONLY. This process should be
completed quickly to avoid individual battery strings with excess charge current

NOTE
If the batteries are sufficiently discharged, the battery circuit breakers may not engage individually
due to the surge current. If this condition is observed, turn off the Meter Alarm Panel power switch,
and then engage all the connected battery circuit breakers, the Meter Alarm Panel  power switch
should then be turned ON.

2 Using the DC current probe, measure the current in each of the battery string connections to the buss
bars in each battery cabinet. The charge current may initially be high but should quickly reduce in a
few minutes if the batteries have a typical new battery charge level.

3 The current in each string should be approximately equal  (+ 5 A).

4 The bargraph meters on the rectifier modules can be used as a rough estimate of  the total battery
charge current. Each rectifier module has eight LEDs to represent the output current. Each illuminated
LED indicates that approximately 12.5% (1/8 or 8.75 A) of the rectifier’s maximum (70 A) current is
flowing.

EXAMPLE:

Question: A system fitted with three rectifier modules each have three bargraph LEDs illuminated.
What is the total output current into the batteries?

Answer: Each bargraph is approximately indicating 12.5% of 70 A, therefore, 3 X 8.75A equals
26.25A. As there are three rectifiers, the total charge current is equal to (3 X 26.25 A) 78.75 A.

This charge current calculation only applies at this part of the start up procedure when the RF Cabinet
is not powered on, and the power cabinet heat exchanger is turned off.

5 Allow a few minutes to ensure that the battery charge current stabilizes before taking any further
action. Recheck the battery current in each string. If the batteries had a reasonable charge, the current
in each string should reduce to less than 5 A.

6 Recheck the DC output voltage. It should remain the same as measured in step 4 of the Power Up
Test.

NOTE
If discharged batteries are installed, all bargraphs may be illuminated on the rectifiers during the
charge test. This indicates that the rectifiers are at full capacity and are rapidly charging the batteries.
It is recommended in this case that the batteries are allowed to charge and stabilize as in the above
step before commissioning the site. This could take several hours.
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Discharge Test

Perform the test procedure in Table 2-9 only when the battery current is
less than 5 A per string. Refer to Table 2-8 for the procedures to check
current levels.

Table 2-9: Battery Discharge Test

Step Action

1 Turn the battery test switch on the Meter Alarm Panel, ON (see Figure 2-3). The rectifier output
voltage and current should decrease by approximately 10% as the batteries assume the load. Alarms
for the Meter Alarm Panel may occur.

2 Measure the individual battery string current using the DC current probe. The battery discharge
current in each string should be approximately the same (within± 5 A).

3 Turn Battery Test Switch OFF.

CAUTION Failure to turn OFF the Battery Test Switch before leaving the
site, will result in low battery capacity and reduce battery life.
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Heat Exchanger Power Up

Table 2-10: Heat Exchanger Power Up

Step Action

1 Turn the Power Cabinet Heat Exchanger breakers ON (seeFigure 2-6 for breaker location).

2 The Heat Exchanger will now go into a five (5) minute test sequence. Ensure that the internal and
external fans are operating. Place a hand on the internal and external Heat Exchanger grills to feel for
air draft.

Figure 2-6: Heat Exchanger Blower Assembly
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Figure 2-7: Power Cabinet Circuit Breaker Assemblies
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Figure 2-8: Power Cabinet AC Circuit Breakers
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Figure 2-9: Power Cabinet DC Circuit Breakers
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Basic Optimization

Introduction
This chapter provides procedures for downloading system operating
software, set up of the supported test equipment, CSM reference
verification/optimization, and transmit/receive path verification.

NOTE Before using the LMF, use an editor to view the ”CAVEATS”
section in the ”readme.txt” file in the c:\wlmf folder for any
applicable information.

Optimization Process
After a BTS is physically installed and the preliminary operations
(power up) have been completed, the CDMA LMF is used to calibrate
and optimize the BTS. The basic optimization process can be
accomplished as follows:

� Download MGLI with code and data and then enable MGLI.

NOTE The GLIs may be GLI2s or GLI3s

� Use the status function and verify that all of the installed devices of
the following types respond with status information: CSM, BBX,
GLI3, and MCC (and TSU if RFDS is installed). If a device is
installed and powered up but is not responding and is colored gray in
the BTS display, the device is not listed in the CDF file. The CDF file
will have to be corrected before the device can be accessed by CDMA
LMF.

� Download code and data to all devices of the following types:

- CSM

- BBX (may be BBX2 or BBX-1X)

- GLI3 (other than GLI3-1)

- MCC (may be MCC-8E, MCC24, or MCC-1X)

� Download the RFDS TSIC (if installed).

� Verify the operation of the GPS and HSO or LFR signals.

� Enable the following devices (in the order listed):

- Secondary CSM (slot 2)

- Primary CSM (slot 1)

- All MCCs

� Connect the required test equipment for a full optimization.

� Select the test equipment.

� Calibrate the TX and RX test cables if they have not previously been
calibrated using the CDMA LMF that is going to be used for the
optimization/calibration. The cable calibration values can also be
entered manually.

� Select all of the BBXs and all of the MCCs and use the full
optimization function. The full optimization function performs TX
calibration, BLO download, TX audit, all TX tests, and all RX tests
for all selected devices.
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� If the TX calibration fails, repeat the full optimization for any failed
paths.

� If the TX calibration fails again, correct the problem that caused the
failure and repeat the full optimization for the failed path.

� If the TX calibration and audit portion of the full optimization passes
for a path but some of the TX or RX tests fail, correct the problem that
caused the failure and run the individual tests as required until all TX
and RX tests have passed for all paths.

Cell-site  Types
Sites are configured as Omni/Omni or Sector/Sector (TX/RX). Each type
has unique characteristics and must be optimized accordingly.

NOTE For more information  on the different in site types, please refer
to the applicable BTS/Modem Frame Hardware Installation and
Functional Hardware Description manuals.

Cell-site  Data File
The Cell-Site Data File (CDF) contains information that defines the
BTS and data used to download files to the devices. A CDF file must be
placed in the applicable BTS folder before the LMF can be used to log
into that BTS. CDF files are normally obtained from the CBSC using a
floppy disk. A file transfer protocol (ftp) method can be used if the LMF
computer has the cabability.

The CDF includes the following information:

� Download instructions and protocol

� Site specific equipage information

� C-CCP shelf allocation plan

- BBX equipage (based on cell-site type) including redundancy

- CSM equipage including redundancy

- MCC (MCC24E, MCC8E or MCC-1X) channel element allocation
plan. This plan indicates how the C-CCP shelf is configured, and
how the paging, synchronization, traffic, and access channel
elements (and associated gain values) are assigned among the (up to
12) MCCs in the shelf.

� CSM equipage including redundancy

� Effective Rated Power (ERP) table for all TX channels to antennas
respectively.  Motorola System Engineering specifies the ERP of a
transmit antenna based on site geography, antenna placement, and
government regulations. Working from this ERP requirement, the
antenna gain, (dependent on the units of measurement specified) and
antenna feed line loss can be combined to determine the required
power at the top of the BTS frame.  The corresponding BBX output
level required to achieve that power level on any channel/sector can
also be determined.

NOTE Refer to the CDMA LMF Operator’s Guide for additional
information on the layout of the LMF directory structure
(including CDF file locations and formats).
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BTS System Software Download
BTS system software must be successfully downloaded to the BTS
processor boards before optimization can be performed. BTS operating
code is loaded from the LMF computer terminal.

Circuit Backhaul BTS

The information below is for Circuit-Backhaul BTS. GLI-3’s
configured for Circuit-backhaul use bts.cdf files.

NOTE Before using the LMF for optimization/ATP, the correct
bts-#.cdf  and cbsc-#.cdf  files for the BTS must be obtained
from the CBSC and put in a bts-#  folder in the LMF. Failure to
use the correct CDF files can cause wrong results.

CAUTION Failure to use the correct CDF files to log into a live (traffic
carrying) site can shut down the site.

Packet-Backhaul  BTS
GLI-3’s are configured for Packet-backhaul BTS’s the file that is needed
to login to the BTS is the NECF file (bts-xxx.xml) located on the
OMC/R.

The CDF is normally obtained from the CBSC on a DOS formatted
diskette, or through a file transfer protocol (ftp) if the LMF computer has
ftp capability. Refer to the CDMA LMF Operator’s Guide, or the LMF
Help screen, for more information.

Site Equipage Verification
If you have not already done so, use an editor to view the CDF, and
review the site documentation. Verify the site engineering equipage data
in the CDF to the actual site hardware.

CAUTION Always wear a conductive, high impedance wrist strap while
handling any circuit card/module to prevent damage by ESD.
Extreme care should be taken during the removal and installation
of any card/module. After removal, the card/module should be
placed on a conductive surface or back into the anti-static bag in
which it was shipped.

Isolate BTS from T1/E1 Spans
NOTE At active sites, the OMC/CBSC must disable the BTS and place

it out of service (OOS). DO NOT remove the span surge
protectors until the OMC/CBSC has disabled the BTS.

Each frame is equipped with one 50-pair punch block for spans,
customer alarms, remote GPS, and power cabinet alarms. See Figure 3-2
and refer to Table 3-1 for the physical location and pin call-out
information. To disable the span, pull the surge protectors for the
respective span.

Before connecting the LMF to the frame LAN, the OMC/CBSC must
disable the BTS and place it OOS to allow the LMF to control the
CDMA BTS. This prevents the CBSC from inadvertently sending
control information to the CDMA BTS during LMF based tests.
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Configure Channel Service Unit
The M-PATH 537 Channel Service Unit (CSU) provides in-band
SNMP-managed digital service access to T1 and fractional T1 lines.
M-PATH units plug into the Kentrox 2-slot frame (see Figure 3-1).

Remote M-PATH management is available via SNMP over an in-band
data link on the T1 line (using a facility data link or 8-64 kbps of a DS0
channel). The unit at the near end of the management path can be an
SNMP manager or another M-PATH CSU.

Each 19 inch rack can support two CSU M-PATH 537 modules. Each
M-PATH 537 module supports one and only one span connection.

Programming of the M-PATH is accomplished through the DCE 9-pin
connector on the front panel of the CSU shelf. Manuals and a Microsoft
Windows programming disk is supplied with each unit.

Setting the Control Port

Whichever control port is chosen, it must first be set up so the control
port switches match the communication parameters being used by the
control device. If using the rear-panel DTE control port, set the
shelf-address switch SA5 to “up” (leave the switch down for the
rear-panel DCE control port).

For more information, refer to the vendor user manual (part number
1174139) and installation manual (part number 1174462) provided with
each CSU.

Plug one of the cables listed below into the Control Port connectors:

Part Number Description of Cable

01-95006-022 (six feet) DB-9S to DB-9P

01-95010-022 (ten feet)

The control port cables can be used to connect the shelf to:

� A PC using the AT 9-pin interface

� A modem using the 9-pin connector

� Other shelves in a daisy chain
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Figure 3-1: Back and Front View of the CSU

REF. FW00212Front View

SLOT 1 SLOT 2

DCE Connector
(Craft Port)

SLOT 1SLOT 2
T1 TERMINAL T1 TERMINAL

CONTROL
PORT

GROUP
ADDRESS

SHELF
ADDRESS

T1 DDS T1 DDS

DTE DCEDATA PORT DATA PORT

Back View

NETWORK NETWORK

To/From
Network

To/From
GLI

To/From
Network

To/From
GLI

CAUTION SC4812ET Span Line Labeling for Span B and Span C is
swapped

-On the SC4812ET’s, the span cable internal to the base station
that connects the 50 pin header on the I/O plate to the CSU has
Span B and Span C (RJ-45) connectors mis-labeled.

-CFE will punch down the span on the 50 pair bunchblock as per
Motorola documentation and punchdown chart. When conecting
the span input to the CSU re-label “Span B” cable to”Span C”
cable to “Span B”. Connect to CSU as per documentation
Note: The labeling issue on the cable from the I/O plate to the
CSU Part Number 3086601H01 Rev C shall be corrected on
revision “D” to address this issue. The cut over date to Rev. D
will be approximately January 30, 2001.
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Alarm and Span Line Cable Pin/Signal Information
See Figure 3-2 and refer toTable 3-1for the physical location and pin
call-out information for the 50-pin punch block.

Figure 3-2: 50 Pair Punch Block

TOP VIEW OF PUNCH BLOCK
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CABLE TO BRACKET WITH

TIE WRAPS

2T

1T 1R 2T 2R

1 2

1R

2R

LEGEND

1T = PAIR 1 - TIP
1R = PAIR 1 -RING
          ”                ”
          ”                ”
          ”                ”

RF Cabinet I/O Area

50R
50T

49R

49T

1T

FW00162

TO LAN
CONNECTOR

TO ALARMS
CONNECTOR

TO MODEM
CONNECTOR

TO RGD/RGPS
CONNECTOR
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Alarm and Span Line Cable Pin/Signal Information

Table 3-1 lists the complete pin/signal identification for the 50-pin
punch block.

Table 3-1: Pin-Out for 50-Pair Punchblock

Punchblock
Cable

Connector
Function

Signal Name Punch Pin Ext. Cable Wire
Color

Power Cab Control - NC 1T Blue

Power Cab Control - NO 1R Blk/Blue

Power Cab Control-Com 2T Yellow

Reserved 2R N/C

Rectifier Fail 3T Blk/Yellow

AC Fail 3R Green

Power Cabinet Power Cab Exchanger Fail 4T Blk/Grn

Power Cab Door Alarm 4R White

Power Cab Major Alarm 5T Blk/White

Battery Over Temp 5R Red

Power Cab Minor Alarm 6T Blk/Red

Reticifier Over Temp 6R Brown

Power Cab Alarm Rtn 7T Blk/Brn
ALARM

LFR_HSO_GND 7R
HSO/LFR EXT_1PPS_POS 8T
Extension

EXT_1PPS_NEG 8R

CAL_+ 9T

CAB_- 9R
LFR Antenna

LORAN_+ 10T

LORAN_- 10R

Pilot Beacon Alarm - Minor 11T

Pilot Beacon Alarm - Rtn 11R

Pilot Beacon Alarm - Major 12T
Pilot Beacon

Pilot Beacon Control-NO 12R

Pilot Beacon Control - COM 13T

Pilot Beacon Control - NC 13R

. . . continued on next page
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Table 3-1: Pin-Out for 50-Pair Punchblock

Punchblock
Cable

Connector

Ext. Cable Wire
Color

Punch PinSignal Name
Function

Customer Outputs 1 - NO 14T

Customer Outputs 1 - COM 14R

Customer Outputs 1 - NO 14T

Customer Outputs 1 - COM 14R

Customer Outputs 1 - NC 15T

Customer Outputs 2 - NO 15R

Customer Outputs 2 - COM 16T
ALARM Customer Outputs

Customer Outputs 2 - NC 16R

Customer Outputs 3 - NO 17T

Customer Outputs 3 - COM 17R

Customer Outputs 3 - NC 18T

Customer Outputs 4 - NO 18R

Customer Outputs 4-COM 19T

Customer Outputs 4 - NC 19R

Customer Inputs 1 20T

Cust_Rtn_A_1 20R

Customer Inputs 2 21T

Cust_Rtn_A_2 21R

Customer Inputs 3 22T

Cust_Rtn_A_3 22R

Customer Inputs 4 23T

Cust_Rtn_A_4 23R

Customer Inputs 5 24T

Cust_Rtn_A_5 24R
ALARM Customer Inputs

Customer Inputs 6 25T

Cust_Rtn_A_6 25R

Customer Inputs 7 26T

Cust_Rtn_A_7 26R

Customer Inputs 8 27T

Cust_Rtn_A_8 27R

Customer Inputs 9 28T

Cust_Rtn_A_9 28R

Customer Inputs 10 29T

Cust_Rtn_A_10 29R

. . . continued on next page
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Table 3-1: Pin-Out for 50-Pair Punchblock

Punchblock
Cable

Connector

Ext. Cable Wire
Color

Punch PinSignal Name
Function

RCV_TIP_A 30T

RCV_RING_A 30R
Span 1

XMIT_TIP_A 31T

XMIT_RING_A 31R

RCV_TIP_B 32T

RCV_RING_B 32R
Span 2

XMIT_TIP_B 33T

XMIT_RING_B 33R

RCV_TIP_C (Note) 34T

RCV_RING_C (Note) 34R
Span 3

XMIT_TIP_C (Note) 35T

XMIT_RING_C(Note) 35R

RCV_TIP_D (Note) 36T
SPAN I/O

RCV_RING_D (Note) 36R
Span 4

XMIT_TIP_D (Note) 37T

XMIT_RING_D(Note) 37R

RCV_TIP_E (Note) 38T

RCV_RING_E (Note) 38R
Span 5

XMIT_TIP_E (Note) 39T

XMIT_RING_E(Note) 39R

RCV_TIP_F (Note) 40T

RCV_RING_F (Note) 40R
Span 6

XMIT_TIP_F (Note) 41T

XMIT_RING_F(Note) 41R

NOTE
Span 3 through 6 are spares for expansion purposes

. . . continued on next page
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Table 3-1: Pin-Out for 50-Pair Punchblock

Punchblock
Cable

Connector

Ext. Cable Wire
Color

Punch PinSignal Name
Function

GPS_Power_A 42T Yellow

For frame GPS_Power_A_Return 42R Yellow/Black
without RGD GPS_Power_B 43T Blue
Expansion
Punchblock GPS_Power_B_Return 43R Blue/Black

Single Frame GPS_TXD+ 44T White
RGD/RGPS BTS;RGPS Head GPS_TXD- 44R White/Black

Connection
GPS_RXD+ 45T Green

OR

Multiple Frame GPS_RXD- 45R Green/BlackMultiple Frame
BTS; RGD Signal Ground (TDR+) 46T Red
Connection at Signal Ground (TDR-) 46R Red/Black
RGPS Secondary
Frame GPS_1PPS+ 47T Brown

GPS_1PPS- 47R Brown/Black

GPS_Power_A 42T Yellow

GPS_Power_A_Return 42R Yellow/Black

GPS_Power_B 43T Blue

For frame with GPS_Power_B_Return 43R Blue/Black
RGD Expansion
Punchblock GPS_TXD+ 44T White

OR GPS_TXD- 44R White/Black
RGD/RGPS Multiple Frame

BTS; RGPS Head
GPS_RXD+ 45T Green

BTS; RGPS Head
Connection at GPS_RXD- 45R Green/Black
RGPS Primary
Frame Signal Ground (TDR+) 46T Red

Master Frame (TDR-) 46R Red/Black

GPS_1PPS+ 47T Brown

GPS_1PPS- 47R Brown/Black

Reserved 48T

MODEM Reserved 48R

RGD/RGPS Chassis Ground 49T N/A

None No Connection 49R None

Reserved 50T None

ALARM Reserved 50R None
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T1/E1 Span Isolation

Table 3-2 describes the action required for span isolation.

Isolate BTS from T1/E1 Spans

NOTE At active sites, the OMC/CBSC must disable the BTS and place
it out of service (OOS). DO NOT remove the span surge
protectors until the OMC/CBSC has disabled the BTS.

Table 3-2: T1/E1 Span Isolation

Step Action

1 The OMC/CBSC must disable the BTS and place it OOS.

The Span Lines can be disabled by removing the surge protectors on the 50-pin punch block. Using
Table 3-1 locate the span or spans which need to be disabled and remove the respective surge
protector.

NOTE
If a third party is used for span connectivity, the third party must be informed before disabling the span
line.
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LMF Operation

Preparing the LMF

Before optimization can be performed, the LMF application software
must be installed and configured on a computer platform meeting
Motorola-specified requirements (see Recommended Test Equipment
and Software in Chapter 1).

NOTE For the LMF graphics to display properly, the computer platform
must be configured to display more than 256 colors. See the
operating system software instructions for verifying and
configuring the display settings.

Software and files for installing and updating the LMF are provided on
CD ROM disks. The following items must be available:

� LMF Program on CD ROM

� CDF for each supported BTS (on diskette or available from the
CBSC)

� CBSC File for each supported BTS (on diskette or available from the
CBSC)

The following section provides information and instructions for
installing and updating the LMF software and files.

LMF Operating System Installation

Follow the procedure in Table 3-3 to install the LMF operating system.

Table 3-3: LMF Operating System Installation

Step Action

1 Insert the LMF Program CD ROM into the LMF CD ROM drive.

- If the Setup screen is displayed, go to step 5.

- If the Setup screen is not displayed, proceed to step 2.

2 Click on the Start button.

3 Select Run.

4 In the Open box, enter d:\autorun and click on the OK button.

NOTE
If applicable, replace the letter d with the correct CD ROM drive letter.

5 Follow the instructions displayed on the Setup screen.

. . . continued on next page
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Table 3-3: LMF Operating System Installation

Step Action

* IMPORTANT
First Time Installations:

- Install U/WIN (First)

- Install Java Runtime Environment (Second)

- Install LMF Software (Third)

- Install BTS Binaries (Fourth)

- Install/Create BTS Folders (Fifth)

Any time you install U/WIN, you must install the LMF software because the installation of the LMF
modifies some of the files that are installed during the U/Win installation. Installing U/Win
over-writes these modifications.

NOTE
There are multiple binary image packages for installation on the CD-ROM. When prompted, choose
the load that corresponds to the switch release that you currently have installed. Perform the Device
Images install after the WinLMF installation.

If applicable, a separate CD ROM of BTS Binaries may be available for binary updates.

 

CDMA LMF Home Directory

The CDMA LMF installation program creates the default home directory
c:\wlmf,  and installs the application files and subdirectories (folders)
in it. Because this can be changed at installation, the CDMA LMF home
directory will be referred to with the generic convention of:

<x>:\<lmf home directory>

Where:

<x> = the LMF computer drive letter where the CDMA LMF home
directory is located.

<lmf home directory> = the directory path or name where the CDMA
LMF is installed

NOTE The CDMA LMF installation program creates the default home
directory c:\wlmf when the CDMA LMF is installed.

Copy CBSC CDF Files to the LMF Computer

Before logging on to a BTS with the LMF to execute optimization/ATP
procedures, the correct bts-#.cdf and cbsc-#.cdf  files must be obtained
from the CBSC and put in a bts-#  folder in the LMF computer. This
requires creating versions of the CBSC CDF files on a DOS-formatted
floppy diskette and using the diskette to install the CDF files on the
LMF computer.
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NOTE When copying CDF files, comply with the following to prevent
BTS login problems with the LMF.

- The numbers used in the bts-#.cdf and cbsc-#.cdf filenames
must correspond to the locally assigned numbers for each BTS
and its controlling CBSC.

- The generic cbsc-1.cdf file supplied with the LMF will work
with locally numbered BTS CDF files. Using this file will not
provide a valid optimization unless the generic file is edited to
replace default parameters (e.g., channel numbers) with the
operational parameters used locally.

The procedure in Table 3-4 lists the steps required to transfer the CDF
files from the CBSC to the LMF computer. For any further information,
refer to the CDMA LMF Operator’s Guide (Motorola part number
68P64114A21) or the LMF Help screen..

Table 3-4: Copying CBSC CDF Files to the LMF

Step Action

1 Login to the CBSC workstation.

2 Insert a DOS-formatted floppy diskette in the workstation drive.

3 Type eject -q and press <Enter>.

4 Type mount and press <Enter>.

NOTE
� Look for the “floppy/no_name” message on the last line displayed.

� If the eject command was previously entered, floppy/no_name will be appended with a number. Use
the explicit floppy/no_name reference displayed when performing step 7.

5 Change to the directory, where the files to be copied reside, by typing cd <directoryname> 
(e.g., cd bts-248) and pressing <Enter>.

6 Type ls and press the Enter key to display the list of files in the directory.

7 With Solaris versions of Unix, create DOS-formatted versions of the bts-#.cdf and cbsc-#.cdf files
on the diskette by entering the following command:

unix2dos  <source filename>   /floppy/no_name/<target   filename>
(e.g., unix2dos   bts-248.cdf   /floppy/no_name/bts-248.cdf).

NOTE
� Other versions of Unix do not support the unix2dos and dos2unix commands. In these cases, use the

Unix cp (copy) command. The copied files will be difficult to read with a DOS or Windows text
editor because Unix files do not contain line feed characters. Editing copied CDF files on the LMF
computer is, therefore, not recommended.

� Using cp, multiple files can be copied in one operation by separating each filename to be copied
with a space and ensuring the destination directory (floppy/no_name) is listed at the end of the
command string following a space (e.g., cp  bts-248.cdf   cbsc-6.cdf   /floppy/na_name)

8 Repeat steps 5 through 7 for each bts-# that must be supported by the LMF.

. . . continued on next page
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Table 3-4: Copying CBSC CDF Files to the LMF

Step Action

9 When all required files have been copied to the diskette, type eject and press <Enter>.

10 Remove the diskette from the CBSC drive.

11 If it is not running, start the Windows operating system on the LMF computer.

12 Insert the diskette containing the bts-#.cdf and cbsc-#.cdf files into the LMF computer.

13 Using Windows Explorer (or equivalent program), create a corresponding bts-# folder in the <lmf
home directory> directory for each bts-#.cdf/cbsc-#.cdf file pair copied from the CBSC.

14 Use Windows Explorer (or equivalent program) to transfer the cbsc-#.cdf  and bts-#.cdf  files from the
diskette to the corresponding <lmf home directory>\cdma\bts-#  folders created in step 13.

 

Creating a Named HyperTerminal Connection for MMI Connection

Confirming or changing the configuration data of certain BTS FRUs
requires establishing an MMI communication session between the LMF
and the FRU. Using features of the Windows operating system, the
connection properties for an MMI session can be saved on the LMF
computer as a named Windows HyperTerminal connection. This
eliminates the need for setting up connection parameters each time an
MMI session is required to support optimization.

Once the named connection is saved, a shortcut for it can be created on
the Windows desktop. Double clicking the shortcut icon will start the
connection without the need to negotiate multiple menu levels.

Follow the procedures in Table 3-5 to establish a named HyperTerminal
connection and create a Windows desktop shortcut for it.

NOTE There are differences between Windows NT and Windows 98 in
the menus and screens for creating a HyperTerminal connection.
In the following procedure, items applicable to:

- Windows NT will be identified with Win NT
- Windows 98 will be identified with Win 98
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Table 3-5: Creating a Named Hyperlink Connection for MMI Connection

Step Action

1 From the Windows Start menu, select:

Programs>Accessories

2 Perform one of the following:

� For Win NT, select Hyperterminal and then click on HyperTerminal or

� For Win 98, select Communications, double click the Hyperterminal folder, and then double click
on the Hyperterm.exe icon in the window that opens.

NOTE
� If a Location Information Window appears, enter the required information, then click  Close.

(This is required the first time, even if a modem is not to be used.)

� If a You need to install a modem..... message appears, click NO.

3 When the Connection Description box opens:

- Type a name for the connection being defined (e.g., MMI Session) in the Name: window.

- Highlight any icon preferred for the named connection in the Icon: chooser window, and

- Click OK.

4

NOTE
For LMF configurations where COM1 is used by another interface such as test equipment and a
physical port is available for COM2, select COM2 to prevent conflicts.

From the Connect using: pick list in the Connect To box displayed, select the RS-232 port to be used
for the connection (e.g., COM1 or COM2 - Win NT - or Direct to Com 1 or Direct to Com 2 - Win
98), and click OK.

5 In the Port Settings tab of the COM# Properties window displayed, configure the RS-232 port
settings as follows:

� Bits per second: 9600

� Data bits: 8

� Parity: None

� Stop bits: 1

� Flow control: None

6 Click OK.

7 Save the defined connection by selecting:

File>Save

8 Close the HyperTerminal window by selecting:

File>Exit

9 Click Yes to disconnect when prompted.

10 Perform one of the following:

� If the Hyperterminal folder window is still open (Win 98) proceed to step 12 or

� From the Windows Start menu, select Programs > Accessories

. . . continued on next page
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Table 3-5: Creating a Named Hyperlink Connection for MMI Connection

Step Action

11 Perform one of the following:

� For Win NT, select Hyperterminal and release any pressed mouse buttons.

� For Win 98, select Communications and double click the Hyperterminal folder.

12 Highlight the newly created connection icon by moving the cursor over it (Win NT) or clicking on it
(Win 98).

13 Right click and drag the highlighted connection icon to the Windows desktop and release the right
mouse button.

14 From the popup menu displayed, select Create Shortcut(s) Here.

15 If desired, reposition the shortcut icon for the new connection by dragging it to another location on the
Windows desktop.

 

Folder Structure Overview

The CDMA LMF installation program creates the default home directory
c:\wlmf, and installs the application files and subdirectories (folders) in
it. Because this can be changed at installation, the CDMA LMF home
directory will be referred to with the generic convention of:

<x>:\<lmf home directory>

Where:

<x> = the LMF computer drive letter where the CDMA LMF home
directory is located

<lmf home directory> = the directory path or name where the CDMA
LMF is installed.

Figure 3-3: LMF Folder Structure

version folder (A separate folder is
required for each different version; for
example, a folder name 2.8.1.1.1.5)

loads folder

<x>:\  (drive letter)

<lmf home directory> folder

cdma folder

code folder

data folder

BTS-nnn folders (A separate folder is
required for each BTS where bts-nnn is the
unique BTS number; for example, bts-163)
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LMF to BTS Connection

The LMF is connected to the LAN A or B connector located on the left
side of the frame’s lower air intake grill, behind the LAN Cable Access
door (see Figure 3-4).

Table 3-6: LMF to BTS Connection

Step Action

1 To gain access to the connectors, open the LAN Cable Access door, then pull apart the Velcro  tape
covering the BNC “T” connector and slide out the computer service tray, if desired (see Figure 3-4).

2 Connect the LMF to the LAN A BNC connector via PCMCIA Ethernet Adapter with an unshielded
twisted-pair (UTP) Adapter and 10BaseT/10Base2 converter (powered by an external AC/DC
transformer). If there is no login response, connect the LMF to the LAN B BNC connector. If there is
still no login response, see Table 6-1, Login Failure Troubleshooting Procedure.

NOTE
- Xircom Model PE3-10B2 or equivalent can also be used to interface the LMF Ethernet

connection to the frame connected to the PC parallel port, powered by an external AC/DC
transformer. In this case, the BNC cable must not exceed 91 cm (3 ft) in length.

* IMPORTANT
The LAN shield is isolated from chassis ground. The LAN shield (exposed portion of BNC connector)
must not touch the chassis during optimization.

Figure 3-4: LMF Connection Detail
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B LMF BNC connector.
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Pinging the Processors
For proper operation, the integrity of the Ethernet LAN A and B links
must be be verified. Figure 3-5 represents a typical BTS Ethernet
configuration. The drawing depicts one (of two identical) links, A and B.

Ping is a program that sends request packets to the LAN network
modules to get a response from the specified “target” module.

NOTE WinLMF (unreleased version 2.16.1.0.15 for example) has an
option in the LOGIN menu to ping the GLI prior to login.

Follow the steps in Table 3-7 to ping each processor (on both LAN A
and LAN B) and verify LAN redundancy is working properly.

CAUTION Always wear a conductive, high impedance wrist strap while
handling any circuit card/module to prevent damage by ESD.

Figure 3-5: BTS Ethernet LAN Interconnect Diagram
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Table 3-7: Pinging the Processors

Step Action

1 From the Windows desktop, click the Start button and select Run.

2 In the Open box, type ping and the GLI IP address (for example, ping 128.0.0.2).

NOTE
128.0.0.2 is the default IP address for the GLI3 in field BTS units.

3 Click on the OK button.

4 If the targeted module responds, text similar to the following is displayed:

Reply from 128 128.0.0.2: bytes=32 time=3ms TTL=255

If there is no response the following is displayed:

Request timed out

If the GLI3 fails to respond, it should be reset and re-pinged. If it still fails to respond, typical
problems are shorted BNC to inter-frame cabling, open cables, crossed A and B link cables, or the
GLI3 itself.

 

Log into and out of the BTS

Table 3-8: Logging into the BTS

Step Action

NOTE
The LMF Mouse/Tracball must be attached if Windows and/or the GUI applications will be used.

1 Connect the LMF to the BTS as shown in .

2 Power-up the LMF. Allow the Windows operating system to come up.

3 Click the CDMA LMF desktop icon.

4 Click CDMA icon. Ths list of available BTS cell sites appears.

5 Click on the desired BTS (for example, BTS-6). If the IP Address and Port number are correct, press
Login to BTS.

6 To keep the current IP Address for the next log in, click the Remember Modified Address box (a
check appears in the box).

7 To use the default IP Address setting, click on Use Defaults.
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Download Files to the LMF - Site Specific BTS Files
These procedures must be followed prior to an initial BTS optimization,
or anytime a new release of the BTS operating system software is to be
loaded from the LMF to the BTS.

Follow the steps outlined in Table 3-9 to create a bts directory and
download files to that bts-specific directory. Perform this procedure only
if the CDF files have not been previously loaded.

Table 3-9: Downloading Site Specific BTS Files

Step Action

NOTE
The types of files that can be downloaded include calibration files (.cal extension) and CDF files
(.cdf extension).  Files may be compressed (indicated by a .Z extension).

1 Obtain the 3.5-in. diskette(s) containing the configuration data file and calibration data.

2 Enter the following UNIX command from the /usr/lmf directory,  to create a BTS specific
directory (if it does not already exist).

mkdir bts-<bts#>

3 Enter the following UNIX command to change to the newly created directory:

cd bts-<bts#>

4 Insert the first 3.5 inch floppy diskette. Verify disk is loaded with the proper BTS files/ versions by
typing the following at the  (lmf): prompt:

    seedisk <cr>

5 To load the BTS files from the disk into the appropriate directory, enter the following at the (lmf):
prompt:

  fromdisk <cr>

NOTE
� Copy bts-#.cdf and (if they exist) bts-#.cal files to the /usr/lmf/bts-# directory. (# equates

to the actual BTS site number).

� Unless sites use different device loads, create links to device files (as described in Table 3-10)
rather than placing individual copies into each bts directory.

6 If files are compressed, use the uncompress *.Z command to unpack files.

 

Download Files to the LMF - Master-bts-cdma Files

These procedures must be followed prior to an initial BTS optimization,
or anytime a new release of the BTS operating system software is to be
loaded from the LMF to the BTS.

Follow the steps outlined in Table 3-10 to create a bts-master-cdma
directory, to download files, and to create softlinks to the device load
files into the appropriate bts- <bts#> subdirectory.  (Always consult
latest software release notes as this is an interim procedure and is subject
to change).
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Table 3-10: Downloading and linking master-bts-cdma directory files for device loads

Step Action

NOTE
� If the current LMF code needs to be installed on the LMF PC, or if more information on file

management, creating bts directories, or viewing CDF files is needed, refer to the.LMF Users
Guide.

� The types of files that can be downloaded include code (.hex or .bin extension) and data (.dds
extension) files. Files may be compressed (indicated by a .Z extension).

1 Enter the following UNIX command, from the /usr/lmf directory, to create a device load master
directory (if it does not already exist).

mkdir bts-master-cdma

2 Enter the following UNIX command to change to the newly created directory:

cd bts-master-cdma

3 Obtain the 3.5-in. diskette(s) containing the current release of the BTS operating code and/or data
files.

NOTE
File naming conventions for all processor boards and applicable files for each are listed below.
Rename files using the mv UNIX command as required:
Device File Name(s) 

� GLI <version>-gliboot.hex &  gli.dds 

� BBX <version>-bbxboot.hex  &  bbx.dds

� BDC <version>-bdcboot.hex  & bdc.dds

� MCC <version>-mccboot.hex.0501  & mcc.dds.0501

� CSM <version>-csmboot.hex  & csm.dds

� TSU tsuboot.hex

4 Insert the first 3.5 inch floppy diskette. Verify disk is loaded with the proper BTS files/versions by
typing the following at the  (lmf): prompt:

    seedisk <cr>

5 To load the BTS files from the disk into the appropriate directory, enter the following at the (lmf):
prompt:

  fromdisk <cr>

6 If files are compressed, use the uncompress *.Z command to unpack files.  Rename files to match
the naming conventions listed above if required.

7 Repeat Steps 4 and 5 for each diskette that is a part of this load.

NOTE
All older versions of files (and links to files) in the  bts-master-  bts-<bts#> subdirectories must
be removed before beginning this procedure.

. . . continued on next page
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Table 3-10: Downloading and linking master-bts-cdma directory files for device loads

Step Action

8 Create softlinks to the device load and data load files in the bts-master-cdma directory using the
following UNIX commands:

ln  -s  /usr/lmf/bts-master-cdma/*.hex   /usr/lmf/bts-<bts#>/

ln  -s  /usr/lmf/bts-master-cdma/*.hex.*   /usr/lmf/bts-<bts#>/

ln  -s  /usr/lmf/bts-master-cdma/*.dds   /usr/lmf/bts-<bts#>/

ln  -s  /usr/lmf/bts-master-cdma/*.dds.*   /usr/lmf/bts-<bts#>/

NOTE
You may need to specify specific file names in the command instead of using the * ”wildcard”
character in order to link multiple versions of files in the same subdirectory. Using *.* will link ALL
files in the directory.
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Create BTS Specific CDF File

Follow the steps outlined in Table 3-11 to create a BTS specific CDF
file, if one cannot be obtained from the OMCR/CBSC. (This is an
interim procedure and is subject to change).

Table 3-11: Create BTS Specific CDF File

Step Action

! CAUTION
If you are not familiar with the UNIX vi editor, create a “dummy” CDF file, and practice making
changes to it, prior to altering the “real” one.

NOTE
For more information on file management, creating bts directories, viewing/editing CDF files, refer
to LMF Users Guide.

1 Determine the CDF file, currently loaded on the LMF, is closest to the configuration at the site. Use a
generic CDF file that equips all devices, if possible. If this is an OMNI site, use an OMNI CDF file,
if SECTOR, use SECTOR CDF file.

2 List the contents of the bts-<bts#> directory by entering the ls command at the (lmf) prompt
followed by a <cr>, to verify the CDF file for the site does not already exist.

3 Enter the following command to copy an existing CDF file on the LMF hard drive to the new BTS
directory.

cp  /usr/lmf/bts-src_<bts#>.cdf /usr/lmf/bts- dest_<bts#>.cdf 

NOTE
The following step is for LMF software releases version 5 and 6 only.

4 Globally change the BTS ID in the new CDF file using the following UNIX commands:

vi bts-new_<bts#>.cdf

:1,$  s/Id1 = old_<bts#>/Id1 = new_<bts#>

:1,$ s/old_<bts#>_/new_<bts#>_

Include the underscore after the old and new bts # in the above command

:1,$ s/BTS\[old_<bts#>/BTS\[new_<bts#>

:wq

NOTE
You should now be able to log into the bts using the new CDF file. If you search for the old BTS #, it
should be gone. You will have to edit the CDF file (using the vi editor) as far as BBX, MCC, etc.
equipage is concerned.

Update BTS Specific CDF File Device Load Version and Site Type
Follow the steps outlined in Table 3-12 to update the existing BTS
specific CDF file NextLoad parameter, to reflect the current device load
version to be downloaded and verify the correct Site Type. (This is an
interim procedure and is subject to change).

CAUTION Device load version in the CDF file must match the current
version loaded at the OMCR/CBSC.
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Table 3-12: Update BTS Specific CDF File Device Load Version

Step Action

! CAUTION
If you are not familiar with the UNIX vi editor, create a “dummy” CDF file, and practice making
changes to it, prior to altering the “real” one.

* IMPORTANT
CDF files obtained from the OMCR/CBSC are modified by DELTA information being appended to
the end of the CDF file. The information in the DELTA fields take precedence over information in the
“core CDF file” For example: If NextLoad=‘‘1.2.3.4.5” for BBX 1 was specified in the CDF file, and
there was a DELTA entry specifying NextLoad=‘‘2.3.4.5.6” appended to the CDF file for the same
BBX, 2.3.4.5.6 would be the version used.

There are two ways resolve this. Edit both the DELTA and “core” areas of the file to reflect the same
version, or make sure the delta information is transferred to the main CDF file and delete all DELTA
CDF file entries.

1 Globally change the device load version number in the new CDF file using the following UNIX
commands:

vi bts-new_<bts#>.cdf
:1,$   s/x.x.x.x.x/y.y.y.y.y

Where: x.x.x.x.x and y.y.y.y.y represent the old and new version number, respectively.

:wq

NOTE
You should now be able to download all devices at the BTS with the current device load version.

2 Verify the SiteType and SSType entries in the CDF file (under the BTS subheading) reflect the
following information. See example of applicable fields of CDF file below.
(CDMA only; 1900 MHz example shown):

BTS[#] = {
....,
SiteType=3,
SSType=16
...
},

Valid SiteTypes (SC9600=1, SC9600(Mixed)=2, SC2400=3, SC2400(Mixed)=4, SC600=5)
Valid SSTypes (CDMA800MHz=8,   CDMA1900MHz=16,  CDMA900MHz=32)

Update Antenna Mapping Files

Earlier release versions may require the antenna.map  file to be
updated. There are two antenna mapping files. These are
antenna.map  and antenna.asu .

Follow the steps outlined in Table 3-13 to check the antenna mapping
file and update as needed.
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Table 3-13: Update Antenna Mapping Files

Step Action

! CAUTION
If you are not familiar with the UNIX vi editor, create a “dummy” CDF file, and practice making
changes to it, prior to altering the “real” one.

NOTE
For more information on file management, creating bts directories, viewing/editing CDF files, refer to
the LMF Users Guide.

1 View the antenna.map   file (see below) and verify the Xcvrs listed in the CDF file (and that are
equipped in the BTS) are also listed in the antenna.map  file (for both RX and TX tables). Make
sure the antenna.map  file has enough RX and TX antennas listed to cover the number of sectors
indicated by CDF’s SiteConf parameter.

Example of Antenna Map File
R --- Rx --- -- Sec -- ----- Xcvrs -----

R 1:M :RX1: 1 :1,4,5,8
R 2:D :RX2: 1 :1,4,5,8
R 3:M :RX3: 2 :2,4,6,8
R 4:D :RX4: 2 :2,4,6,8
R 5:M :RX5: 3 :3,4,7,8
R 6:D :RX6: 3 :3,4,7,8

T --- Tx --- -- Sec -- ----- Xcvrs -----

T 1:0 :TX1: 1 :1,4
T 2:0 :TX2: 2 :2,4
T 3:0 :TX3: 3 :3,4
T 4:0 :TX4: 1 :5,8
T 5:0 :TX5: 2 :6,8
T 6:0 :TX6: 3 :7,8

2 Verify all RX and TX antennas listed in the file antenna.map  are also listed in the antenna.asu
file.

NOTE
The antenna.asu file is required only if the BTS is equipped with RFDS. Be sure that the information
in antenna files matches  your actual configuration.
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Operating the LMF

Basic Operation

NOTE The terms “CDMA LMF” and “WinLMF” are interchangeable

The CDMA LMF allows the user to work in the two following operating
environments which are accessed using the specified desktop icon:

� Graphical User Interface (GUI) using the WinLMF icon

� Command Line Interface (CLI) using the WinLMF CLI icon

The GUI is the primary optimization and acceptance testing operating
environment. The CLI environment provides additional capability to the
user to perform manually controlled acceptance tests and audit the
results of optimization and calibration actions.

Basic operation of the LMF GUI  includes the following:

� Selecting and deselecting BTS devices

� Enabling devices

� Disabling devices

� Resetting devices

� Obtaining device status

� Sorting a status report window

For detailed information on performing these and other LMF operations,
refer to the CDMA LMF Operator’s Guide, 68P64114A78.

Both the GUI and the CLI use a program known as the handler. Only one
handler can be running at one time. The architectural  design is such that
the GUI must be started before the CLI if you want the GUI and CLI to
use the same handler.

When the CLI is launched after the GUI, the CLI automatically finds and
uses an in-progress login session with a BTS initiated under the GUI.
This allows the use of the GUI and the CLI in the same BTS login
session.

If a CLI handler is already running when the GUI is launched (this
happens if the CLI window is already running when the user starts the
GUI, or if another copy of the GUI is already running when the user
starts the GUI), a dialog window displays the following warning
message:

The CLI handler is already running.
This may cause conflicts with the LMF.
Are you sure that you want to start the application?

This window also contains yes and no buttons. Selecting yes starts the
application. Selecting no terminates the application.
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CLI Format Conventions

The CLI command can be broken down in the following way:

� Verb

� Device including device identifier parameters

� Switch

� Option parameters consisting of:

- Keywords

- Equals sign (=) between the keyword and the parameter value

- Parameter values

Spaces are required between the verb, device, switch, and option
parameters. A hyphen is required between the device and its identifiers.
Following is an example of a CLI command.

measure bbx-<bts_id>- <bbx_id> rssi channel=6 sector=5

Refer to the LMF CLI Commands (68P09251A59) for a complete
explanation of the CLI commands and their usage.

Logging into a BTS

NOTE Be sure that the correct bts-#.cdf and cbsc-#.cdf file is used for
the BTS. These should be the CDF files that are provided for the
BTS by the CBSC. Failure to use the correct CDF files can
result in wrong results. Failure to use the correct CDF files to
log into a live (traffic carrying) site can shut down the site.

Logging into a BTS establishes a communications link between the BTS
and the CDMA LMF. You may be logged into one or more BTS’s at a
time, but only one LMF may be logged into each BTS.

Before attempting to log into the BTS, confirm the CDMA LMF is
properly connected to the BTS (see Figure 3-4). Follow the procedure in
Table 3-14 to log into a BTS.

Prerequisites

Before attempting to login to a BTS, ensure the following have been
completed:

� The LMF is correctly installed and prepared.

� A bts-nnn folder with the correct CDF and CBSC file exists.

� The LMF is correctly installed and prepared, and the LMF computer
was connected to the BTS before starting the Windows operating
system and LMF software. If necessary, restart the computer after
connecting it to the BTS (see Table 3-6 and Figure 3-4).

BTS Login from the GUI Environment

Follow the procedures in Table 3-14 to log into a BTS when using the
GUI environment
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Table 3-14: BTS GUI Login Procedure

Step Action

1 Start the LMF GUI environment by double clicking on the WinLMF desktop icon (if the LMF’s not
running).

NOTE
If a warning similar to the following is displayed, select No, shut down other LMF sessions which
may be running, and start the LMF GUI environment again:

The CLI handler is already running.

This may cause conflicts with the LMF

Are you sure you want to start the application?

Yes No

2 Click on Login tab (if not displayed).

3 If no base stations are displayed in the Available Base Stations pick list, double click on the CDMA
icon.

4 Click on the desired BTS number.

5 Click on the Network Login tab (if not already in the forefront).

6 Enter correct IP address (normally 128.0.0.2 for a field BTS)  if not correctly displayed in the IP
Address box.

NOTE
128.0.0.2 is the default IP address for MGLI-1 in field BTS units. 128.0.0.1 is the default IP address
for MGLI-2.

7 Type in the correct IP Port number (normally 9216) if not correctly displayed in the IP Port box.

8 Select the Multi-channel Preselector type from the Multi-channel Preselector drop-down list  (default
is MPC) to a device corresponding to your BTS configuration if  required.

NOTE
When performing RX tests on expansion frames, do not choose EMPC if the test equipment is
connected to the starter frame.

9 Click on the Use a Tower Top Amplifier, if applicable.

10 Click on Login. (A BTS tab with the BTS is displayed.)

NOTE
� If you attempt to log in to a BTS that is already logged on, all devices will be gray.

� There may be instances where the BTS initiates a log out due to a system error (i.e., a device
failure).

� If the MGLI is OOS_ROM (blue), it will have to be downloaded with code before other devices can
be seen.

� If the MGLI is OOS-RAM (yellow), it must be enabled before other installed devices can be seen.

 

BTS Login from the CLI Environment
Follow the procedures in Table 3-15 to log into a BTS when using the
GUI environment
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Table 3-15: BTS CLI Login Procedure

Step Action

1 Double click the WinLMF CLI desktop icon (if the LMF CLI environment is not already running).

NOTE
If a BTS was logged into under a GUI session when the CLI environment was started, the CLI session
will be logged into the same BTS, and step 2 is not required.

2 At the /wlmf prompt, enter the following command:

login bts-<bts#>   host=<host>   port=<port>
where:

host = MGLI card IP address (defaults to address last logged into for this BTS or 128.0.0.2 if this is
first login to this BTS).

port = IP port of the TS (defaults to port last logged into for this BTS or 9216 if this is first login to
this BTS)

Logging Out
Logging out of a BTS is accomplished differently for the GUI and the
CLI operating environments.

NOTE The GUI and CLI environments use the same connection to a
BTS. If a BTS is logged into in both the GUI and the CLI
environments at the same time, logging out of the BTS in either
environment will log out of it for both.  When either a login or
logout is performed in the CLI window, there is no GUI
indication that the login or logout has occurred.

Logging Out of a BTS from the GUI Environment

Follow the procedure in Table 3-16 to logout of a BTS when using the
GUI environment.

Table 3-16: BTS GUI Logout Procedure

Step Action

1 Click on the BTS tab menu bar.

2 Click the Logout item in the pulldown menu (a Confirm Logout pop-up message will appear).

3 Click on Yes or press the Enter key to confirm  logout.  You are returned to the Login tab.

NOTE
If a logout was previously performed on the BTS from a CLI window running at the same time as the
GUI, a Logout Error popup message will appear stating the system should not log out of the BTS.
When this occurs, the GUI must be exited and restarted before it can be used for further operations.

4 If a Logout Error popup message appears stating that the system could not log out of the Base Station
because the given BTS is not logged in, click OK and proceed to step 5.

5 Select File > Exit in the window menu bar, click Yes in the Confirm Logout popup, and click OK in
the Logout Error popup which appears again.

6 If further work is to be done in the GUI, restart it.
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Logging Out of a BTS from the CLI Environment

Follow the procedure in Table 3-16 to logout of a BTS when using the
CLI environment.

Table 3-17: BTS CLI Logout Procedure

Step Action

1

* IMPORTANT
If the BTS is also logged into from a GUI running at the same time and further work must be done
with it in the GUI, proceed to step 2.

Logout of a BTS by entering the following command:

logout bts- <bts#>
A response similar to the following will be displayed:

LMF>

12:22:58.028 Command Received and Accepted
            Command=logout bts-33

12:22:58.028 Command Received and Accepted

12:22:58.028 Command Successfully Completed
            REASON_CODE=”No Reason”

2 If desired, close the CLI interface by entering the following command:

exit
A response similar to the following will be displayed before the window closes:

Killing background processes....

 

Establishing an MMI Communication Session

For those procedures that require MMI communications between the
LMF and BTS FRUs, follow the procedure in Table 3-18 to initiate the
communication session.

Table 3-18: Establishing MMI Communications

Step Action

1 Connect the LMF computer to the equipment as detailed in the applicable procedure that requires
MMI communication session.

2 Start the named HyperTerminal connection for MMI sessions by double clicking on its Windows
desktop shortcut.

NOTE
If a Windows desktop shortcut was not created for the MMI connection, access the connection from
the Windows Start menu by selecting:

Programs>Accessories>Hyperterminal>HyperTerminal><Named HyperTerminal Connection
(e.g., MMI Session).

3 Once the connection window opens, establish MMI communication with the BTS FRU by pressing
the LMF computer Enter key until the prompt identified in the applicable procedure is obtained.
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Figure 3-6: CDMA LMF Computer Common MMI Connections
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BTS Download Overview

Before a BTS can operate, each equipped device must contain device
initialization (ROM) code. ROM code is loaded in all devices during
manufacture, factory repair, or, for software upgrades, from the CBSC
using the DownLoad Manager (DLM). Device application (RAM) code
and data must be downloaded to each equipped device by the user before
the BTS can be made fully functional for the site where it is installed.

ROM Code

Downloading ROM code to BTS devices from the LMF is NOT routine
maintenance or a normal part of the optimization process. It is only
done in unusual situations where the resident ROM code release level in
the device is not compatible with the required release level of the site
operating software and the CBSC can not communicate with the BTS to
perform the download. An example would be a BTS loaded with R16.0
software where a GLI which is factory-loaded with R9.2.x or earlier
ROM code must be installed to replace a malfunctioning GLI.

Before ROM code can be downloaded from the LMF, the correct ROM
code file for each device to be loaded must exist on the LMF computer.
ROM code must be manually selected for download.

NOTE The ROM code file is not available for GLI3s are ROM code
loaded at the factory.
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ROM code can be downloaded to a device that is in any state. After the
download is started, the device being downloaded will change to
OOS_ROM (blue). The device will remain OOS_ROM (blue) when the
download is completed. A compatible revision-level  RAM code must
then be downloaded to the device. Compatible code loads for ROM and
RAM must be used for the device type to ensure proper performance.
The compatible device code release levels for the BSS software release
being used are listed in the Version Matrix section of the SC� CDMA
Release Notes (supplied on the tape or CD-ROM containing the BSS
software).

Procedures to load ROM code are located in Appendix J.

RAM Code

Before RAM code can be downloaded from the LMF, the correct RAM
code file for each device must exist on the LMF computer. RAM code
can be automatically or manually selected depending on the Device
menu item chosen and where the RAM code file for the device is stored
in the LMF file structure. The RAM code file will be selected
automatically if the file is in the <x>:\<lmf home
directory>\cdma\loads\n.n.n.n\code folder (where n.n.n.n is the
download code version number that matches the “NextLoad” parameter
of the CDF file). The RAM code file in the code folder must have the
correct hardware bin number for the device to be loaded.

RAM code can be downloaded to a device that is in any state. After the
download is started, the device being loaded will change to OOS_ROM
(blue). When the download is completed successfully, the device will
change to OOS_RAM (yellow).

When code is downloaded to an MGLI or GLI, the LMF automatically
also downloads data and then enables the MGLI. When enabled, the
MGLI will change to INS_ACT (bright green). A redundant GLI will
not be automatically enabled and will remain OOS_RAM (yellow).
When the redundant GLI is manually commanded to enable through the
LMF, it will change state to INS_SBY (olive green).

For non-GLI devices, data must be downloaded after RAM code is
downloaded. To download data, the device state must be OOS_RAM
(yellow).

The devices to be loaded with RAM code and data are:

� Master Group Line Interface (MGLI)

� Redundant GLI

� Clock Synchronization Module (CSM) (Only if new revision code
must be loaded)

� Multi Channel CDMA (MCC24E, MCC8E, or MCC-1X) cards

� Broadband Transceiver (BBX2 or BBX-1X) cards

� RFDS Test Subscriber Interface Card (TSIC) or RFDS-1X RFDS
PROCessor (RPROC) card, if RFDS is installed
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NOTE IMPORTANT: The MGLI must be successfully downloaded
with RAM code and data, and in INS_ACT (bright green) status
before downloading any other device. The RAM code download
process for an MGLI automatically downloads data and then
enables the MGLI.

Verify GLI ROM Code Loads
Devices should not be loaded with a RAM code version which is not
compatible with the ROM code with which they are loaded. Before
downloading RAM code and data to the processor cards, follow the
procedure in Table 3-19 to verify the GLI devices are loaded with the
correct ROM code for the software release used by the BSS.

Prerequisite
Identify the correct GLI ROM code load for the software release being
used on the BSS by referring to the Version Matrix section of the
SC� CDMA Release Notes (supplied on the tape or CD-ROM
containing the BSS software).

Table 3-19: Verify GLI ROM Code Loads

Step Action

1 If it has not already been done, start a GUI LMF session and log into the BTS ( refer to Table 3-14).

2 Select all GLI devices by clicking on them, and select Device > Status from the BTS menu bar.

3 In the status report window which opens, note the number in the ROM Ver column for each GLI3.

4 If the ROM code loaded in the GLIs is not the correct one for the software release being used on the
BSS, log out of the BTS, disconnect the LMF computer, reconnect the span lines as described in
Table 5-6, and have the CBSC download the correct ROM code version to the BTS devices.

5 When the GLIs have the correct ROM load for the software release being used, be sure the span lines
are disabled as outlined in Table 3-2 and proceed to downloading RAM code and data.

 

Download RAM Code and Data to MGLI and GLI
Follow the steps outlined in Table 3-20 to download the RAM code and
data to the MGLI and other installed GLI devices.

Prerequisites
� Prior to performing these procedures, ensure a code file exists for each

of the devices to be loaded (refer to Table 3-3).

� The LMF computer is connected to the BTS (refer toTable 3-6), and is
logged in using the GUI environment (refer to Table 3-14).

Table 3-20: Download and Enable MGLI and GLI Devices

Step Action

1 Be sure the LMF will use the correct software release for code and data downloads by performing the
following steps:

1a - Click on Util in the BTS menu bar, and select Tools > Update NextLoad > CDMA from the
pull-down menus.

. . . continued on next page
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Table 3-20: Download and Enable MGLI and GLI Devices

Step Action

1b - Click on the BTS to be loaded.
-- The BTS will be highlighted.

1c - Click the button next to the correct code version for the software release being used.
-- A black dot will appear in the button circle.

1d - Click Save.

1e - Click OK to close each of the advisory boxes which appear.

2 Prepare to download code to the MGLI by clicking on the device.

3 Click Device in the BTS menu bar, and select Download > Code/Data in the pull-down menus.

- A status report is displayed confirming change in the device(s) status.

4 Click OK to close the status window.

- The MGLI will automatically be downloaded with data and enabled.

5 Once the MGLI is enabled, load and enable additional installed GLIs by clicking on the devices and
repeating steps 3 and 4.

6 Click OK to close the status window for the additional GLI devices.

 

Download RAM Code and Data to Non-GLI Devices
Downloads to non-GLI devices can be performed individually for each
device or all installed devices can be downloaded with one action. RAM
code and data are downloaded to non-GLI devices in separate steps.

NOTE CSM devices are RAM code-loaded at the factory. RAM code is
downloaded to CSMs only if a newer software version needs to
be loaded.

NOTE When downloading to multiple devices, the download may fail
for some of the devices (a time-out occurs). These devices can
be loaded individually after completing the multiple download.

Follow the steps in Table 3-21 to download RAM code and data to
non-GLI devices.

Table 3-21: Download RAM Code and Data to Non-GLI Devices

Step Action

1 Select the target CSM, MCC, and/or BBX device(s) by clicking on them.

2 Click Device in the BTS menu bar, and select Download > Code/Data in the pull-down menus.

- A status report is displayed that shows the results of the download for each selected device.

3 Click OK to close the status report window when downloading is completed.

NOTE
After a BBX, CSM, or MCC device is successfully loaded with RAM code and has changed to the
OOS_RAM state (yellow), the status LED should be rapidly flashing GREEN.

. . . continued on next page
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Table 3-21: Download RAM Code and Data to Non-GLI Devices

Step Action

4 To download data, select the target CSM, MCC and/or BBX device(s).

5 Click Device in the BTS menu bar, and select select Download > Data in the pull-down menus.

- A status report is displayed showing the results of the download for each selected device.

6 Click OK to close the status report window when downloading is completed.
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System Tests

Select CSM Clock Source
A CSM can one of have three different clock sources. The Select CSM
Source function can be used to select the clock source for each of the
three inputs. This function is only used if the clock source for a CSM
needs to be changed. The Clock Source function provides the following
clock source options.

� Local GPS

� Remote GPS

� HSO (only for source 2 & 3)

� HSOX (only for source 2 & 3)

� LFR (only for source 2 & 3)

� 10 MHz (only for source 2 & 3)

� NONE (only for source 2 & 3)

Prerequisites

MGLI=INS_ACT, CSM= OOS_RAM or INS_ACT

Table 3-22: Select CSM Clock Source

Step Action

1 Select the applicable CSM(s).

2 Click on the Device menu.

3 Click on the CSM/MAWI menu item.

4 Click on the Select Clock Source menu item. A clock source selection window is displayed.

5 Select the applicable clock source in the Clock Reference Source pick lists. Uncheck the related
check box if you do not want the displayed pick list item to be used.

6 Click on the OK button. A status report window is displayed showing the results of the selection
action.

7 Click on the OK button to close the status report window.
 

Enable CSMs
Each BTS CSM system features two CSM boards per site. In a typical
operation, the primary CSM locks its Digital Phase Locked Loop
(DPLL) circuits to GPS signals. These signals are generated by either an
on-board GPS module (RF-GPS) or a remote GPS receiver (R-GPS).
The CSM2 card is required when using the R-GPS. The GPS receiver
(mounted on CSM 1) is used as the primary timing reference and
synchronizes the entire cellular system. CSM 2 provides redundancy (but
does not have a GPS receiver).

The BTS may be equipped with a LORAN-C LFR, HSO, or external 10
MHz Rubidium source which the CSM can use as a secondary timing
reference. The HSOX is used for expansion frames. In all cases, the
CSM monitors and determines what reference to use at a given time.
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NOTE For RF-GPS, verify the CSM configured with the GPS receiver
“daughter board” is installed in the frame’s CSM 1 slot before
continuing.

Follow the steps outlined in Table 3-23 to enable the CSMs installed in
the C-CCP shelves.

Table 3-23: Enable CSMs

Step Action

1 Click on the target CSM.

From the Device pull down, select Enable.

NOTE
If equipped with two CSMs, enable CSM-2 first

A status report is displayed confirming change in the device(s) status.

Click OK to close the status report window.

NOTE
FAIL may be shown in the status table for enable action. If Waiting For Phase Lock is shown in the
Description field, the CSM changes to the Enabled state after phase lock is achieved.

CSM 1 houses the GPS receiver. The enable sequence can take up to one hour (see below).

* IMPORTANT
The GPS satellite system satellites are not in a geosynchronous orbit and are maintained and operated
by the United States Department of Defense (D.O.D.). The D.O.D. periodically alters satellite orbits;
therefore, satellite trajectories are subject to change. A GPS receiver that is INS contains an “almanac”
that is updated periodically to take these changes into account.

If a GPS receiver has not been updated for a number of weeks, it may take up to an hour for the GPS
receiver “almanac” to be updated.

Once updated, the GPS receiver must track at least four satellites and obtain (hold) a 3-D position fix
for a minimum of 45 seconds before the CSM will come in service. (In some cases, the GPS receiver
needs to track only one satellite, depending on accuracy mode set during the data load).

2

NOTE
If equipped with two CSMs, CSM-1 should be bright green (INS-ACT) and CSM-2 should be dark
green (INS-STY)

If more than an hour has passed, refer to CSM Verification, see Figure 3-7 and Table 3-26 to determine
the cause.

NOTE
After the CSMs have been successfully enabled, observe the PWR/ALM LEDs are steady green
(alternating green/red indicates the card is in an alarm state).

 

Enable MCCs

This procedure configures the MCC and sets the “TX fine adjust”
parameter. The “TX fine adjust” parameter is not a transmit gain setting,
but a timing adjustment that compensates for the processing delay in the
BTS (approximately 3 �S).

Follow the steps outlined in Table 3-24 to enable the MCCs installed in
the C-CCP shelves.
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NOTE The MGLI and CSM must be downloaded and enabled, before
downloading and enabling the MCC.

Table 3-24: Enable MCCs

Step Action

1 Click on the target MCC(s) or from the Select pull down menu choose MCCs.

2 From the Device menu, select Enable

A status report is displayed confirming change in the device(s) status.

3 Click OK to close the status report window.
 

Clock Synchronization Manager System Time
The primary function of the Clock Synchronization Manager (CSM)
boards (slots 1 and 2) is to maintain CDMA system time. The CSM in
slot 1 is the primary timing source while slot 2 provides redundancy.
The CSM2 card (CSM second generation) is required when using the
remote GPS receiver (R-GPS). R-GPS uses a GPS receiver in the
antenna head that has a digital output to the CSM2 card. CSM2 can have
a daughter card as a local GPS receiver to support an RF-GPS signal.

The CSM2 switches between the primary and redundant units (slots 1
and 2) upon failure or command. CDMA Clock Distribution Cards
(CCDs) buffer and distribute even-second reference and 19.6608 MHz
clocks. CCD 1 is married to CSM 1 and CCD 2 is married to CSM 2. A
failure on CSM 1 or CCD 1 cause the system to switch to redundant
CSM 2 and CCD 2.

Each CSM2 board features an ovenized, crystal oscillator that provides
19.6608 MHz clock, even second pulse, and 3 MHz referenced to the
selected synchronization source (see Table 3-26):

� GPS: local/RF-GPS or remote/R-GPS

� LORAN-C Frequency Receiver (LFR) or High Stability Oscillator
(HSO)

� External reference oscillator sources

Fault management has the capability of switching between the GPS
synchronization source and the LFR/HSO backup source in the event of
a GPS receiver failure on CSM 1. During normal operation, the CSM 1
board selects GPS as the primary source (see Table 3-26). The source
selection can also be overridden via the LMF or by the system software.

Synchronization between the primary and redundant CSM CCD pairs, as
well as the LFR or HSO back-up to GPS synchronization, increases
reliability.

LFR/HSO
The CSM handles the overall configuration and status monitoring
functions of the LFR/HSO. In the event of GPS failure, the LFR/HSO is
capable of maintaining synchronization initially established by the GPS
reference signal.
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The LFR requires an active external antenna to receive LORAN RF
signals.  Timing pulses are derived from this signal, which is
synchronized to Universal Time Coordinates (UTC) and GPS time. The
LFR can maintain system time indefinately after initial GPS lock.

The HSO is a high stability 10 MHz oscillator with the necessary
interface to the CSMs.  The HSO is typically installed in those
geographical areas not covered by the LORAN-C system. Since the
HSO is a free-standing oscillator, system time can only be maintained
for 24 hours after 24 hours of GPS lock.

Upgrades and Expansions: LFR2/HSO2/HSOX

LFR2/HSO2 (second generation cards) both export a timing signal to the
expansion frames. The associated expansion frames require an
HSO-expansion (HSOX) whether the starter frame has an LFR2 or an
HSO2. The HSOX accepts input from the starter frame and interfaces
with the CSM cards in the expansion frame. LFR and LFR2 use the
same source code in source selection (see Table 3-26). HSO, HSO2, and
HSOX use the same source code in source selection (see Table 3-26).

NOTE Allow the base site and test equipment to warm up for 60
minutes after any interruption in oscillator power.  CSM board
warm-up allows the oscillator oven temperature and oscillator
frequency to stabilize prior to test.  Test equipment warm-up
allows the Rubidium standard timebase to stabilize in frequency
before any measurements are made.

CSM Frequency Verification
The objective of this procedure is the initial verification of the CSM
boards before performing the RF path verification tests. Parts of this
procedure will be repeated for final verification after the overall
optimization has been completed.

Test Equipment Setup 
(GPS & LFR/HSO Verification)

Follow the steps outlined in Table 3-25 to set up test equipment.

Table 3-25: Test Equipment Setup (GPS & LFR/HSO Verification)

Step Action

1a For local GPS (RF-GPS): Verify a CSM board with a GPS receiver is installed in primary CSM slot 1
and that CSM-1 is INS.

NOTE
This is verified by checking the board ejectors for kit number SGLN1145 on the board in slot 1.

1b For Remote GPS (RGPS):Verify a CSM2 board is installed in primary slot 1 and that CSM-1 is INS.

NOTE
This is verified by checking the board ejectors for kit number SGLN4132ED or later.

2 Remove CSM-2 (if installed) and connect a serial cable from the LMF COM 1 port (via null modem
board) to the MMI port on CSM-1 (see Figure 3-7).
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Table 3-25: Test Equipment Setup (GPS & LFR/HSO Verification)

Step Action

3 Reinstall CSM-2.

4 Start an MMI communication session with CSM-1 by using the Windows desktop shortcut icon (see
Table 3-5)

NOTE
The LMF program must be running when a  Hyperterminal session is started.

5 When the terminal screen appears press the Enter key until the CSM> prompt appears.

CAUTION Connect GPS antenna to the (GPS) RF connector ONLY. Dam-
age to the GPS antenna and/or receiver can result if the GPS an-
tenna is inadvertently connected to any other RF connector.

Figure 3-7: CSM MMI Terminal Connection
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GPS Initialization/Verification
Follow the steps outlined in Table 3-26 to connect to CSM-1 installed in
the C-CCP shelf, verifying that it is functioning normally.

Table 3-26: GPS Initialization/Verification

Step Action

1 To verify that Clock alarms (0000), Dpll is locked and has a reference source, and
GPS self test passed messages are displayed within the report,  issue the following MMI
command

bstatus

- Observe the following typical response:

CSM Status INS:ACTIVE Slot A Clock MASTER.

Clock Alarms (0000):

DPLL is locked and has a reference source.
GPS receiver self test result: passed

Time since reset 0:33:11, time since power on: 0:33:11

2 Enter the following command at the CSM> prompt to display the current status of the Loran and the
GPS receivers.

sources

- Observe the following typical response for systems equipped with LFR:

N Source Name Type TO Good Status Last Phase Target Phase Valid
-------------------------------------------------------------------------
0 LocalGPS Primary 4 YES Good 0 0 Yes
1 LFR CHA Secondary 4 YES Good -2013177 -2013177 Yes
2 Not Used
Current reference source number: 0

- Observe the following typical response for systems equipped with HSO:

Num Source Name Type TO Good Status Last Phase Target Phase Valid
----------------------------------------------------------------------------
0 Local GPS Primary 4 Yes Good 3 0 Yes
1 HSO Backup 4 No N/A timed-out* Timed-out* No

*NOTE “Timed-out” should only be displayed while the HSO is warming up.  “Not-Present” or
“Faulty” should not be displayed.  If the HSO does not appear as one of the sources, then configure the
HSO as a back-up source by entering the following command at the CSM> prompt:

ss 1 12

After a maximum of 15 minutes, the Rubidium oscillator should reach operational temperature and the
LED on the HSO should now have changed from red to green.  After the HSO front panel LED has
changed to green, enter sources <cr> at the CSM> prompt.  Verify that the HSO is now a valid
source by confirming that the bold text below matches the response of the “sources” command.

The HSO should be valid within one (1) minute, assuming the DPLL is locked and the HSO rubidium
oscillator is fully warmed.

Num Source Name Type TO Good Status Last Phase Target Phase Valid
----------------------------------------------------------------------------
0 Local GPS Primary 4 Yes Good 3 0 Yes
1 HSO Backup 4 Yes N/A xxxxxxxxxx xxxxxxxxxx Yes

. . . continued on next page
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Table 3-26: GPS Initialization/Verification

Step Action

3 HSO information (underlined text above, verified from left to right) is usually the #1 reference source.
If this is not the case, have the OMCR determine the correct BTS timing source has been identified in
the database by entering the display bts csmgen command and correct as required using the edit
csm csmgen refsrc command.

* IMPORTANT
If any of the above mentioned areas fail, verify:

- If LED is RED, verify that HSO had been powered up for at least 5 minutes. After oscillator
temperature is stable, LED should go GREEN Wait for this to occur before continuing !

- If “timed out” is displayed in the Last Phase column, suspect the HSO output buffer or oscillator
is defective

- Verify the HSO is FULLY SEATED and LOCKED to prevent any possible board warpage

4 Verify the following GPS information (underlined text above):

- GPS information is usually the 0 reference source.

- At least one Primary source must indicate “Status = good” and “Valid = yes” to bring the site up.

. . . continued on next page
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Table 3-26: GPS Initialization/Verification

Step Action

5 Enter the following command at the CSM> prompt to verify that the GPS receiver is in tracking mode.

gstatus

- Observe the following typical response:

24:06:08 GPS Receiver Control Task State: tracking satellites.
24:06:08 Time since last valid fix: 0 seconds.
24:06:08 
24:06:08 Recent Change Data:
24:06:08 Antenna cable delay 0 ns.
24:06:08 Initial position: lat 117650000 msec, lon -350258000 msec, height 0 cm (GPS)
24:06:08 Initial position accuracy (0): estimated.
24:06:08 
24:06:08 GPS Receiver Status:
24:06:08 Position hold:  lat 118245548 msec, lon -350249750 msec, height 20270 cm
24:06:08 Current position: lat 118245548 msec, lon -350249750 msec, height 20270 cm
(GPS)
24:06:08 8 satellites tracked, receiving 8 satellites, 8 satellites visible.
24:06:08 Current Dilution of Precision (PDOP or HDOP): 0.
24:06:08 Date & Time: 1998:01:13:21:36:11
24:06:08 GPS Receiver Status Byte: 0x08
24:06:08 Chan:0, SVID: 16, Mode: 8, RSSI: 148, Status: 0xa8
24:06:08 Chan:1, SVID: 29, Mode: 8, RSSI: 132, Status: 0xa8
24:06:08 Chan:2, SVID: 18, Mode: 8, RSSI: 121, Status: 0xa8
24:06:08 Chan:3, SVID: 14, Mode: 8, RSSI: 110, Status: 0xa8
24:06:08 Chan:4, SVID: 25, Mode: 8, RSSI:  83, Status: 0xa8
24:06:08 Chan:5, SVID:  3, Mode: 8, RSSI:  49, Status: 0xa8
24:06:08 Chan:6, SVID: 19, Mode: 8, RSSI: 115, Status: 0xa8
24:06:08 Chan:7, SVID: 22, Mode: 8, RSSI: 122, Status: 0xa8
24:06:08 
24:06:08 GPS Receiver Identification:
24:06:08 COPYRIGHT 1991-1996 MOTOROLA INC. 
24:06:08 SFTW P/N # 98-P36830P      
24:06:08 SOFTWARE VER # 8           
24:06:08 SOFTWARE REV # 8           
24:06:08 SOFTWARE DATE  6 AUG 1996 
24:06:08 MODEL #    B3121P1115      
24:06:08 HDWR P/N # _               
24:06:08 SERIAL #   SSG0217769      
24:06:08 MANUFACTUR DATE 6B07       
24:06:08 OPTIONS LIST    IB        
24:06:08 The receiver has 8 channels and is equipped with TRAIM.

6 Verify the following GPS information (shown above in underlined text):

- At least 4 satellites are tracked, and 4 satellites are visible.

- GPS Receiver Control Task State is “tracking satellites”. Do not continue until this occurs!

- Dilution of Precision indication is not more that 30.

Record the current position base site latitude, longitude, height and height reference (height reference
to Mean Sea Level (MSL) or GPS height (GPS).  (GPS = 0   MSL = 1).

. . . continued on next page
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Table 3-26: GPS Initialization/Verification

Step Action

7 If steps 1 through 6 pass, the GPS is good.

* IMPORTANT
If any of the above mentioned areas fail, verify that:

- If Initial position accuracy is “estimated” (typical), at least 4 satellites must be tracked and
visible (1 satellite must be  tracked and visible if actual lat, log, and height data for this site has
been entered into CDF file).

- If Initial position accuracy is “surveyed,” position data currently in the CDF file is assumed to be
accurate. GPS will not automatically survey and update its position.

- The GPS antenna is not obstructed or misaligned.

- GPS antenna connector center conductor measures approximately +5 Vdc with respect to the
shield.

- There is no more than 4.5 dB of loss between the GPS antenna OSX connector and the BTS frame
GPS input.

- Any lightning protection installed between GPS antenna and BTS frame is installed correctly.

8 Enter the following commands at the CSM> prompt to verify that the CSM is warmed up and that GPS
acquisition has taken place.

debug dpllp 

Observe the following typical response if the CSM is not warmed up (15 minutes from application of
power)  (If warmed-up proceed to step 9)

CSM>DPLL Task Wait. 884 seconds left.
DPLL Task Wait. 882 seconds left.
DPLL Task Wait. 880 seconds left.   ...........etc.

NOTE
The warm command can be issued at the MMI port used to force the CSM into warm-up, but the
reference oscillator will be unstable.

9 Observe the following typical response if the CSM is warmed up.

c:17486 off: -11, 3, 6 TK SRC:0 S0: 3 S1:-2013175,-2013175
c:17486 off: -11, 3, 6 TK SRC:0 S0: 3 S1:-2013175,-2013175
c:17470 off: -11, 1, 6 TK SRC:0 S0: 1 S1:-2013175,-2013175
c:17486 off: -11, 3, 6 TK SRC:0 S0: 3 S1:-2013175,-2013175
c:17470 off: -11, 1, 6 TK SRC:0 S0: 1 S1:-2013175,-2013175
c:17470 off: -11, 1, 6 TK SRC:0 S0: 1 S1:-2013175,-2013175

10 Verify the following GPS information (underlined text above, from left to right):

- Lower limit offset from tracked source variable is not less than -60 (equates to 3 µs limit).

- Upper limit offset from tracked source variable is not more than +60 (equates to 3 µs limit).

- TK SRC: 0 is selected, where SRC 0 = GPS.

11 Enter the following commands at the CSM> prompt to exit the debug mode display.

debug  dpllp
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LORAN-C  Initialization/Verification

Table 3-27: LORAN-C Initialization/Verification

Step Action Note

1 At the CSM> prompt, enter lstatus <cr> to verify that the LFR is in tracking
mode.  A typical response is:

CSM> lstatus <cr>
LFR St ti St tLFR Station Status:
Clock coherence: 512 >
5930M 51/60 dB 0 S/N Flag:
5930X 52/64 dn -1 S/N Flag:
5990 47/55 dB -6 S/N Flag:
7980M 62/66 dB 10 S/N Fl

This must be greater
than 100 before LFR
becomes a valid source.

7980M 62/66 dB 10 S/N Flag:
7980W 65/69 dB 14 S/N Flag: . PLL Station . >
7980X 48/54 dB -4 S/N Flag:
7980Y 46/58 dB -8 S/N Flag:E
7980Z 60/67 dB 8 S/N Flag:
8290M 50/65 dB 0 S/N Flag

This shows the LFR is
locked to the selected
PLL station.

8290M 50/65 dB 0 S/N Flag:
8290W 73/79 dB 20 S/N Flag:
8290W 58/61 dB 6 S/N Flag:8290W 58/61 dB 6 S/N Flag:
8970M 89/95 dB 29 S/N Flag:
8970W 62/66 dB 10 S/N Flag:
8970X 73/79 dB 22 S/N Flag:8970X 73/79 dB 22 S/N Flag:
8970Y 73/79 dB 19 S/N Flag:
8970Z 62/65 dB 10 S/N Flag:
9610M 62/65 dB 10 S/N Fl

g
9610M 62/65 dB 10 S/N Flag:
9610V 58/61 dB 8 S/N Flag:
9610W 47/49 dB -4 S/N Flag:E9610W 47/49 dB -4 S/N Flag:E
9610X 46/57 dB -5 S/N Flag:E
9610Y 48/54 dB -5 S/N Flag:E
9610Z 65/69 dB 12 S/N Flag9610Z 65/69 dB 12 S/N Flag:
9940M 50/53 dB -1 S/N Flag:S
9940W 49/56 dB -4 S/N Flag:E9940W 49/56 dB 4 S/N Flag:E
9940Y 46/50 dB-10 S/N Flag:E
9960M 73/79 dB 22 S/N Flag:
9960W 51/60 dB 0 S/N Flag:9960W 51/60 dB 0 S/N Flag:
9960X 51/63 dB -1 S/N Flag:
9960Y 59/67 dB 8 S/N Flag:
9960Z 89/96 dB 29 S/N Fl9960Z 89/96 dB 29 S/N Flag:

LFR Task State: lfr locked to station 7980W
LFR Recent Change Data:

Search List: 5930 5990 7980 8290 8970 9940 9610 9960 >
PLL GRI: 7980W

LFR Master, reset not needed, not the reference source.
CSM>

This search list and PLL
data must match the
configuration for the
geographical location
of the cell site.

. . . continued on next page
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Table 3-27: LORAN-C Initialization/Verification

Step NoteAction

2 Verify the following LFR information (highlighted above in boldface type):

- Locate the “dot” that indicates the current phase locked station assignment (assigned by MM).

- Verify that the station call letters are as specified in site documentation as well as M X Y Z
assignment.

- Verify the S/N ratio of the phase locked station is greater than 8.

3 At the CSM> prompt, enter sources <cr> to display the current status of the the LORAN receiver.

- Observe the following typical response.

Num Source Name Type TO Good Status Last Phase Target Phase Valid
----------------------------------------------------------------------------
0 Local GPS Primary 4 Yes Good -3 0 Yes
1 LFR ch A Secondary 4 Yes Good -2013177 -2013177 Yes
2 Not used
Current reference source number: 1

4 LORAN LFR information (highlighted above in boldface type) is usually the #1 reference source
(verified from left to right).

* IMPORTANT
If any of the above mentioned areas fail, verify:

- The LFR antenna is not obstructed or misaligned.

- The antenna pre-amplifier power and calibration twisted pair connections are intact and < 91.4 m
(300 ft) in length.

- A dependable connection to suitable Earth Ground is in place.

- The search list and PLL station for cellsite location are correctly configured .

NOTE
LFR functionality should be verified using the “source” command (as shown in Step 3).  Use the
underlined responses on the LFR row to validate correct LFR operation.

5 Close the hyperterminal window.
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Calibration and Test Equipment

Connecting Test Equipment to the BTS
The following test equipment is required to perform calibration and ATP
tests:

� LMF

� Communications system analyzer model supported by the LMF

� Power meter model supported by the LMF (required when using the
HP 8921A/600 and Advantest R3465 analyzers)

� Non-radiating transmit line termination load

� Directional coupler and in-line attenuator

� RF cables and adapters

Refer to Table 3-28 and Table 3-29 for an overview of connections for
test equipment currently supported by the LMF. In addition, see the
following figures:

� Figure 3-8 and Figure 3-9 show cable calibration test setup.

� Figure 3-10, Figure 3-11 and Figure 3-13 show the test set
connections for TX calibration.

� Figure 3-13 and Figure 3-14 show test set connections for IS-95 A/B
optimization/ATP tests

� Figure 3-15 through Figure 3-18 shows test set connections for
IS-95 A/B/C optimization/ATP tests.

� Figure 3-19 and Figure 3-20 show typical TX and RX ATP setup with
a directional coupler (shown with and without RFDS).

Test Equipment GPIB Address Settings

All test equipment is controlled by the LMF through an IEEE-488/GPIB
bus. To communicate on the bus, each piece of test equipment must have
a GPIB address set which the LMF will recognize. The standard address
settings used by the LMF for the various types of test equipment items
are as follows:

� Signal generator address:  1

� Power meter address:  13

� Communications system analyzer:  18

Using the procedures included in the Setting GPIB Addresses section of
Appendix D-1, verify and, if necessary, change the GPIB address of each
piece of test equipment used to match the above.

Supported Test Sets

CAUTION To prevent damage to the test equipment, all TX test connections
must be through the directional coupler and in-line attenuator as
shown in the test setup illustrations.

3



Calibration and Test Equipment 68P09255A57-2

Aug 2002SC�4812ET Optimization/ATP Manual Software Release R16.1.x.x
PRELIMINARY

3-50

IS-95  A/B Testing
Optimization and ATP testing for IS-95A/B sites or carriers may be
performed using one of the following test equipment:

� CyberTest

� Advantest R3267 spectrum analyzer with R3562 signal generator and
HP-437B or Gigatronics Power Meter

� Agilent E4406A transmitter test set with E4432B signal generator

� Agilent 8935 series E6380A communications test set (formerly HP
8935)

� Hewlett-Packard HP 8921 (with CDMA interface for 1.9 GHz PCS
Interface) and HP-437B or Gigatronics Power Meter

� Spectrum Analyzer (HP8594E) - optional

� Rubidium Standard Timebase - optional

CDMA2000 1X Operation
Optimization and ATP testing for CDMA2000 1X sites or carriers may
be performed using the following test equipment:

� Advantest R3267 spectrum analyzer with R3562 signal generator

� Agilent E4406A transmitter test set with E4432B signal generator

� Agilent 8935 series E6380A communications test set (formerly HP
8935) with option 200 or R2K and with E4432B signal generator for
1X FER

NOTE E4432B signal generator for 1X FER needs to have the options
UN8,1E5, and 201.

Test Equipment Preparation

See Appendix F for specific steps to prepare each type of test set and
power meter to perform calibration and ATP .
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Test Equipment Connection Charts
To use the following charts to identify necessary test equipment
connections, locate the communications system analyzer being used in
the COMMUNICATIONS SYSTEM ANALYZER columns, and read down
the column. Where a dot appears in the column, connect one end of the
test cable to that connector. Follow the horizontal line to locate the end
connection(s), reading up the column to identify the appropriate
equipment and/or BTS connector.

IS-95A/B-only  Test Equipment Connections

Table 3-28 depicts the interconnection requirements for currently
available test equipment supporting IS-95A/B only which meets
Motorola standards and is supported by the LMF.

Table 3-28: IS-95A/B-only Test Equipment Interconnection
COMMUNICATIONS SYSTEM ANALYZER ADDITIONAL TEST EQUIPMENT

SIGNAL Cyber-Test
Advantest

R3465 HP 8921A
HP 8921
W/PCS

Power
Meter

GPIB
Interface LMF

Attenuator
&

Directional
Coupler BTS

EVEN SECOND
SYNCHRONIZATION

EVEN
SEC REF

EVEN SEC
SYNC IN

EVEN
SECOND
SYNC IN

EVEN
SECOND
SYNC IN

19.6608 MHZ
CLOCK

TIME
BASE IN

CDMA
TIME BASE

IN

CDMA
TIME BASE

IN

CDMA
TIME BASE

IN

CONTROL
IEEE 488 BUS

IEEE
488 GPIB GPIB

SERIAL
PORTHP-IB HP-IB

TX TEST
CABLES

RF
IN/OUT

INPUT
50� TX1-6

RF
IN/OUT

RF
IN/OUT

20 DB
ATTEN.

BTS
PORT

RX TEST
CABLES

RF
GEN OUT

RF OUT
50� RX1-6

DUPLEX
OUT

RF OUT
ONLY

SYNC
MONITOR

FREQ
MONITOR

HP-IB
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CDMA2000 1X/IS-95A/B-capable Test Equipment
Connections

Table 3-29 depicts the interconnection requirements for currently
available test equipment supporting both CDMA 2000 1X and
IS-95A/B which meets Motorola standards and is supported by the
LMF.

Table 3-29: CDMA2000 1X/IS-95A/B Test Equipment Interconnection
COMMUNICATIONS SYSTEM

ANALYZER ADDITIONAL TEST EQUIPMENT

SIGNAL

Agilent
8935

(Option
200 or
R2K)

Advantest
R3267

Agilent
E4406A

Agilent
E4432
Signal
Gen.

Advantest
R3562
Signal

Generator
Power
Meter

GPIB
Interface LMF

Attenuator
&

Directional
Coupler BTS

EVEN SECOND
SYNCHRONIZATION

EVEN
SECOND
SYNC IN

EXT TRIG
IN

19.6608 MHZ
CLOCK

EXT REF
IN

MOD TIME
BASE IN

CONTROL
IEEE 488 BUS

10 MHZ
OUT

GP-IBHP-IB GP-IB GPIB
SERIAL
PORTGPIB GPIB

TX TEST
CABLES

RF
IN/OUT

INPUT
50 � TX1-6

20 DB
ATTEN.

BTS
PORT

SYNC
MONITOR

FREQ
MONITOR

HP-IB

PATTERN
TRIG IN

EXT REF
IN

RF INPUT
50 �

RX TEST
CABLES

RF OUT
50 �

DUPLEX
OUT

RF OUTPUT
50 � RX1-6

10 MHZ
10 MHZ OUT
(SWITCHED)

SYNTHE 
REF IN

10 MHZ
IN

TRIGGER
INEXT TRIG

SIGNAL SOURCE
CONTROLLED

SERIAL I/O

SERIAL
I/O

SERIAL
I/O

10 MHZ
REF OUT

*  WHEN USED ALONE, THE AGILENT 8935 WITH OPTION 200 OR R2K SUPPORTS IS-95A/B RX TESTING BUT NOT 1X RX TESTING.

*
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Equipment Warm-up

NOTE Warm-up BTS equipment for a minimum of 60 minutes prior to
performing the BTS optimization procedure. This assures BTS
stability and contributes to optimization accuracy.

- Time spent running initial or normal power-up,
hardware/firmware audit, and BTS download counts as
warm-up time.

WARNING Before installing any test equipment directly to any BTS TX
OUT connector, verify there are no CDMA channels keyed.

- At active sites, have the OMC-R/CBSC place the antenna
(sector) assigned to the BBX under test OOS. Failure to do
so can result in serious personal injury and/or equipment
damage.

Automatic Cable Calibration Set-up
Figure 3-8 and Figure 3-9 show the cable calibration setup for the test
sets supported by the LMF. The left side of the diagram depicts the
location of the input and output connectors of each test equipment item,
and the right side details the connections for each test. Table 3-33
provides a procedure for performing automatic cable calibration.

Manual Cable Calibration

If manual cable calibration is required, refer to the procedures in
Appendix Figure 3-8.
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Figure 3-8: Cable Calibration Test Setup - CyberTest, Agilent 8935, Advantest R3465, and HP 8921A

ÏÏÏ
ÏÏÏÌ

Motorola CyberTest

Advantest Model R3465

RF OUT 50Ω

INPUT 50Ω

RF GEN OUTANT IN

SUPPORTED TEST SETS

100-W ATT  (MIN)
NON-RADIA TING

RF LOAD

TEST
SET

A. SHORT CABLE CAL

SHORT
CABLE

B. RX TEST SETUP FOR TRDC

TEST
SET

C. TX TEST SETUP AND DRDC RX TEST SETUP

20 DB IN-LINE
ATTENUATOR

CALIBRATION SET UP

N-N  FEMALE
ADAPTER

TX
CABLE

SHORT
CABLE

Note: The 30 dB directional coupler is not used
with the Cybertest test set. The TX cable is
connected directly to the Cybertest test set.

A 10dB attenuator must be used with the short test
cable for cable calibration with the CyberTest test
set. The 10dB attenuator is used only for the cable
calibration procedure, not with the test cables for
TX calibration and ATP tests.

TEST
SET

RX
CABLE

SHORT
CABLE

DIRECTIONAL
COUPLER 
(30 DB)

N-N FEMALE
ADAPTER

50 Ω
ΤERM.

ÁÁÁÁÁÁ
Á
ÁÁÁÁ
ÁÁ

Agilent 8935 Series E6380A
(formerly HP 8935)

DUPLEX
OUT

ANT
IN

Hewlett Packard Model HP 8921A

Note: For 800 MHZ only. The HP8921A cannot
be used to calibrate cables for PCS frequencies.

TX CABLE FOR
TX TEST CABLE
CALIBRATION

RX CABLE FOR
DRDC RX TEST
CABLE CALIBRATION

DUPLEX
OUT

ANT
IN
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Figure 3-9: Cable Calibration Test Setup - Agilent E4406A/E4432B and Advantest R3267/R3562

TEST
SET

A. SHORT CABLE CAL

SHORT
CABLE

B. RX TEST SETUP FOR TRDC

CALIBRATION SET UP

TEST
SET

RX
CABLE

SHORT
CABLE

N-N  FEMALE
ADAPTER

SUPPORTED TEST SETS

INPUT 50 Ω

RF OUT
50 Ω

Advantest R3267 (Top) and R3562 (Bottom)

NOTE:

SYNTHE REF IN ON REAR OF SIGNAL GENERATOR IS
CONNECTED TO 10 MHZ OUT ON REAR OF SPECTRUM
ANALYZER

Agilent E4432B (Top) and E4406A (Bottom)

NOTE:

10 MHZ IN ON REAR OF SIGNAL GENERATOR IS CONNECTED TO
10 MHZ OUT (SWITCHED) ON REAR OF TRANSMITTER TESTER
(FIGURE F-5).

RF INPUT
50 Ω

RF OUTPUT
50 Ω

100-W ATT  (MIN)
NON-RADIA TING

RF LOAD

TEST
SET

D. TX TEST SETUP AND DRDC RX TEST SETUP

20 DB IN-LINE
ATTENUATOR

N-N FEMALE
ADAPTER

TX
CABLE

SHORT
CABLE

DIRECTIONAL
COUPLER 
(30 DB)

50 Ω
ΤERM.

TX CABLE FOR
TX TEST CABLE
CALIBRATION

RX CABLE FOR
DRDC RX TEST
CABLE CALIBRATION

Set-up  for TX Calibration
Figure 3-10 and Figure 3-11 show the test set connections for TX
calibration.
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Figure 3-10: TX Calibration Test Setup - CyberTest (IS-95A/B) and 
Agilent 8935 (IS-95A/B and CDMA2000 1X)

ÁÁÁÁ
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ÁÁ
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Motorola CyberTest

Agilent 8935 Series E6380A (formerly HP 8935)

TEST SETS TRANSMIT (TX) SET UP

ÏÏÏ
ÏÏÏ
ÏÏÏÌ

FRONT PANEL
RF

IN/OUT

RF IN/OUT

HP-IB
TO GPIB
BOX

NOTE: THE 30 DB DIRECTIONAL COUPLER IS NOT USED WITH THE
CYBERTEST TEST SET. THE TX CABLE IS CONNECTED DIRECTLY
TO THE CYBERTEST TEST SET.

TO
MPC

TO LPA
TRUNKING
MODULE

RS232-GPIB
INTERFACE BOX

INTERNAL PCMCIA
ETHERNET CARD

GPIB
CABLE

UNIVERSAL TWISTED PAIR (UTP)
CABLE  (RJ45 CONNECTORS)

RS232 NULL
MODEM
CABLE

S MODE
DATA FORMAT

BAUD RATE

GPIB ADRS G MODE

ON

BTS

INTERNAL
TX
CABLE

CDMA
LMF

DIP SWITCH SETTINGS

10BASET/
10BASE2
CONVERTER

LAN
B

LAN
A

GPIB

RF IN/OUT

RX
ANTENNA

CONNECTOR

FREQ
MONITOR

SYNC
MONITOR

CSM

INTERNAL
RX

CABLE

TX
ANT
CPLD

RX
BTS
CPLD

TRDC

TX
BTS
CPLD

RX
ANT
CPLD

TX
ANTENNA

CONNECTOR

COMMUNICATIONS
TEST SET

2O DB IN-LINE
ATTENUATOR

50 Ω
TERM
.

TX TEST
CABLE

DIRECTIONAL
COUPLER
(30 DB)

100-W ATT (MIN.)
NON-RADIA TING

RF LOAD

TX TEST
CABLE

* BLACK RECTANGLES
REPRESENT THE RAISED
PART OF SWITCHES

NOTE:  IF BTS IS EQUIPPED
WITH DRDCS (DUPLEXED
RX/TX SIGNALS), CONNECT
THE TX TEST CABLE TO
THE DRDC ANTENNA
CONNECTOR.

POWER
METER

(OPTIONAL)*

POWER
SENSOR

* A POWER METER CAN BE USED IN
PLACE OF THE COMMUNICATIONS
TEST SET FOR TX CALIBRATION/
AUDIT

3



Calibration and Test Equipment68P09255A57-2

Aug 2002 SC�4812ET Optimization/ATP Manual Software Release R16.1.x.x

PRELIMINARY
3-57

Figure 3-11: TX Calibration Test Setup - Using Power Meter

TEST SETS TRANSMIT (TX) SET UP

NOTE: THE HP8921A AND ADVANTEST
R3465 CANNOT BE USED FOR TX
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ETHERNET CARD
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CONNECTOR
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CONNECTOR
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Figure 3-12: TX Calibration Test Setup - Agilent E4406A and Advantest R3567 
(IS-95A/B and CDMA2000 1X)
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Set-up  for Optimization/ATP
Figure 3-13 and Figure 3-14 show the test set connections for
optimization/ATP tests.

Figure 3-13: IS-95A/B Optimization/ATP Test Set-up, TRDC Shown - CyberTest and Advantest R3465

Motorola CyberTest
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Figure 3-14: IS-95A/B Optimization/ATP Test Setup - HP 8921A

RF OUT
ONLY

Hewlett Packard Model HP 8921A W/PCS Interface
(for  1900 MHz)

GPIB
CONNECTS
TO BACK OF

UNITS

SYNC MONITOR
EVEN SEC TICK

PULSE REFERENCE
FROM CSM BOARD

FREQ MONITOR
19.6608 MHZ CLOCK
REFERENCE FROM
CSM BOARD

TEST SETS Optimization/ATP SET UP

RF
IN/OUT

GPIB
CONNECTS
TO BACK OF

UNIT

SYNC MONITOR
EVEN SEC TICK

PULSE REFERENCE
FROM CSM BOARD

FREQ MONITOR
19.6608 MHZ CLOCK
REFERENCE FROM
CSM BOARD

Hewlett Packard Model HP 8921A
(for 800 MHz)

RF
IN/OUT

DUPLEX
OUT TO

MPC
TO LPA

TRUNKING
MODULE

RS232-GPIB
INTERFACE BOX

INTERNAL PCMCIA
ETHERNET CARD

GPIB
CABLE

UNIVERSAL TWISTED PAIR (UTP)
CABLE  (RJ45 CONNECTORS)

RS232 NULL
MODEM
CABLE

S MODE
DATA FORMAT

BAUD RATE

GPIB ADRS G MODE

ON

BTS

INTERNAL
TX
CABLE

CDMA
LMF

DIP SWITCH SETTINGS

10BASET/
10BASE2
CONVERTER

LAN
B

LAN
A

RX TEST
CABLE

GPIB

PCS INTERFACE
INPUT/OUTPUT

PORTS

RX
ANTENNA

CONNECTOR

FREQ
MONITOR

SYNC
MONITOR

CSM

INTERNAL
RX

CABLE

TX
ANT
CPLD

RX
BTS
CPLD

TRDC

TX
BTS
CPLD

RX
ANT
CPLD

TX
ANTENNA

CONNECTOR

COMMUNICATIONS
SYSTEM ANALYZER

50 Ω
TERM
.

TX TEST
CABLE

DIRECTIONAL
COUPLER
(30 DB)

100-W ATT (MIN.)
NON-RADIA TING

RF LOAD

TX TEST
CABLE

* BLACK RECTANGLES
REPRESENT THE RAISED
PART OF SWITCHES

CDMA
TIMEBASE

IN EVEN
SECOND/
SYNC IN

NOTE:  IF BTS IS EQUIPPED
WITH DRDCS (DUPLEXED
RX/TX SIGNALS), BOTH THE
TX AND RX TEST CABLES
CONNECT TO THE DRDC
ANTENNA CONNECTOR.
(SEE FIGURE 3-15.)

HP PCS
INTERFACE*

2O DB IN-LINE
ATTENUATOR

* FOR 1900 MHZ
ONLY

RF OUT ONLY

RF IN/OUT

NOTE:

FOR 800 MHZ TESTING, CONNECT CABLES TO THE
HP 8921A AS FOLLOWS:

RX TEST CABLE TO DUPLEX OUT

TX TEST CABLE TO RF IN/OUT

3



Calibration and Test Equipment68P09255A57-2

Aug 2002 SC�4812ET Optimization/ATP Manual Software Release R16.1.x.x

PRELIMINARY
3-61

Figure 3-15: IS-95A/B and CDMA2000 1X Optimization/ATP Test Setup With DRDCs - 
Agilent Test Equipment
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Figure 3-16: IS-95A/B and CDMA2000 1X Optimization/ATP Test Setup With DRDCs - 
Advantest R3267/3562 Test Equipment
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Figure 3-17: IS-95A/B and CDMA2000 1X Optimization/ATP Test Setup With TRDCs - 
Agilent Test Equipment
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Figure 3-18: IS-95A/B and CDMA2000 1X Optimization/ATP Test Setup With TRDCs - 
Advantest R3267/3562 Test Equipment
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TX ATP Setup

Figure 3-19 shows a typical TX ATP setup.

Figure 3-19: Typical TX ATP Setup with Directional Coupler (shown with and without RFDS)
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Figure 3-20: Typical RX ATP Setup with Directional Coupler (shown with or without RFDS)
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Loss/Gain Offset

Background

Proper test equipment setup ensures that the test equipment and
associated test cables do not introduce measurement errors, and that
measurements are correct.

NOTE If the test set being used to interface with the BTS has been
calibrated and maintained as a set, this procedure does not need
to be performed. (Test Set includes LMF terminal,
communications test set, additional test equipment, associated
test cables, and adapters.)

This procedure must be performed prior to beginning the optimization.
Verify all test equipment (including all associated test cables and
adapters actually used to interface all test equipment and the BTS) has
been calibrated and maintained as a set.

CAUTION If any piece of test equipment, test cable, or RF adapter, that
makes up the calibrated test equipment set, has been replaced,
re-calibration must be performed. Failure to do so can introduce
measurement errors, resulting in incorrect measurements and
degradation to system performance.

NOTE Calibration of the communications test set (or equivalent test
equipment) must be performed at the site before calibrating the
overall test set. Calibrate the test equipment  after it has been
allowed to warm-up and stabilize for a minimum of 60 minutes.

Purpose

These procedures access the CDMA LMF automated calibration routine
used to determine the path losses of the supported communications
analyzer, power meter, associated test cables, and (if used) antenna
switch that make up the overall calibrated test set. After calibration, the
gain/loss offset values are stored in a test measurement offset file on the
CDMA LMF.

GPIB Addresses

GPIB addresses can range from 1 through 30. The LMF will accept any
address in that range, but the numbers entered in the LMF Options
window GPIB address box must match the addresses of the test
equipment. Motorola recommends using 1 for a CDMA signal generator,
13 for a power meter, and 18 for a communications system analyzer. To
verify and, if necessary, change the GPIB addresses of the test
equipment, refer to the Setting GPIB Addresses section of Appendix F.

Selecting Test Equipment

Use LMF Options from the Options menu list to select test equipment
automatically (using the autodetect feature) or manually.
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Prerequisites

A Serial Connection and a Network Connection tab are provided for
test equipment selection. The Serial Connection tab is used when the
test equipment items are connected directly to the CDMA LMF
computer via a GPIB box (normal setup). The Network Connection tab
is used when the test equipment is to be connected remotely via a
network connection.

Ensure the following has been completed before selecting test
equipment:

� Test equipment is correctly connected and turned on.

� CDMA LMF computer serial port and test equipment are connected to
the GPIB box.

Manually Selecting Test Equipment in a Serial Connection Tab

Test equipment can be manually specified before, or after, the test
equipment is connected. CDMA LMF does not check to see if the test
equipment is actually detected for manual specification.

Table 3-30: Selecting Test Equipment Manually in a Serial Connection Tab

Step Action

1 From the Tools menu, select Options.

The LMF Options window appears.

2 Click on the Serial Connection tab (if not in the forefront).

3 Select the correct serial port in the COMM Port pick list (normally COM1).

4 Click on the Manual Specification button (if not enabled).

5 Click on the check box corresponding to the test item(s) to be used.

6 Type the GPIB address in the corresponding GPIB address box (refer to the Setting GPIB Addresses
section of Appendix F for directions on verifying and/or changing test equipment GPIB addresses).
Motorola-recommended addresses are:
1 = signal generator
13 = power meter
18 = communications system analyzer

* IMPORTANT
When test equipment items are manually selected by the operator, the LMF defaults to using a power
meter for RF power measurements. The LMF will use a communications system analyzer for RF
power measurements only if a power meter is not selected (power meter checkbox not checked).

7 Click on Apply. (The button will darken until the selection has been committed.)

8 Click on Dismiss to close the test equipment window.
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Automatically Selecting Test Equipment in a Serial Connection Tab
When using the auto-detection feature to select test equipment, the
CDMA LMF examines which test equipment items are actually
communicating with CDMA LMF. Follow the procedure in Table 3-31
to use the auto-detect feature.

Table 3-31: Selecting Test Equipment Using Auto-Detect

Step Action

1 From the Tools menu, select Options.

The LMF Options window appears.

2 Click on the Serial Connection tab (if not in the forefront).

3 Select the correct serial port in the COMM Port pick list (normally COM1).

4 Click on Auto-Detection (if not enabled).

5 Type in the GPIB addresses in the box labeled GPIB address to search (if not already displayed).

NOTE
Refer to the Setting GPIB addresses section of Appendix F for instructions on verifying or changing
test equipment GPIB addresses, if necessary.

When both a power meter and analyzer are selected, the first item listed in the GPIB addresses to
search box will be used for RF power measurements (i.e., TX calibration). The address for a signal
generator is normally 1, a power meter is normally 13 and the address for a CDMA analyzer is
normally 18. If 1, 13,18 are included in the GPIB addresses to search box, the power meter (13) will
be used for RF power measurements. If the test equipment items are manually selected the CDMA
analyzer is used only if a power meter is not selected.

6 Click Apply.  The button will darken until the selection has been committed. A check mark will
appear in the Manual Configuration section for detected test equipment items.

7 Click Dismiss to close the LMF Options window.

Calibrating Test Equipment

The calibrate test equipment function zeros the power measurement level
of the test equipment item that is to be used for TX calibration and audit.
If both a power meter and an analyzer are connected, only the power
meter is zeroed.

Calibrate Test Equipment from the Util menu list is used to calibrate
test equipment item before being used for testing. The test equipment
must be selected before beginning calibration. Follow the procedure in
Table 3-32 to calibrate the test equipment.

Table 3-32: Test Equipment Calibration

Step Action

1 From the Util menu, select Calibrate Test Equipment. A Directions window is displayed. Follow
the instructions provided.

2 Follow the direction provided.
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Table 3-32: Test Equipment Calibration

Step Action

3 Click on Continue to close the Directions window. A status window is displayed.

4 Click on OK to close the status report window.

Calibrating Cables

The cable calibration function is used to measure the loss (in dB) for the
TX and RX cables that are to be used for testing. A CDMA analyzer is
used to measure the loss of each cable configuration (TX cable
configuration and RX cable configuration). The cable calibration
consists of the following procedures.

� Measure the loss of a short cable. This is done to compensate for any
measurement error of the analyzer. The short cable, which is used only
for the calibration process, is used in series with both the TX and RX
cable configuration when they are measured. The measured loss of the
short cable is deducted from the measured loss of the TX and RX
cable configuration to determine the actual loss of the TX and RX
cable configurations. This deduction is done so any error in the
analyzer measurement will be adjusted out of both the TX and RX
measurements.

� Measure the short cable plus the RX cable configuration loss. The RX
cable configuration normally consists only of a coax cable with
type-N connectors that is long enough to reach from the BTS RX port
the test equipment.

� Measure the short cable plus the TX cable configuration loss is
measured. The TX cable configuration normally consists of two coax
cables with type-N connectors and a directional coupler, a load, and
an additional attenuator if required by the BTS type. The total loss of
the path loss of the TX cable configuration must be as required for the
BTS (normally 30 or 50 dB). The Motorola Cybertest analyzer is
different in that the required attenuation/load is built into the test set
so the TX cable configuration consists only of the required length
coax cable.

Calibrating Cables with a CDMA Analyzer

The Cable Calibration menu item from the Util menu list is used to
calibrate both TX and RX test cables for use with CDMA LMF.

NOTE LMF cable calibration cannot be accomplished with an
HP8921A analyzer for 1.9 MHz. A different analyzer type or the
signal generator and spectrum analyzer method must be used
(refer to Table 3-34 and Table 3-35). Cable calibration values
must be manually entered if the signal generator and spectrum
analyzer method is used. For the HP8921A, refer to Appendix F.

The test equipment must be selected before this procedure can be started.
Follow the procedure in Table 3-33 to calibrate the cables.
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Table 3-33: Cable Calibration

Step Action

1 From the Util menu, select Cable Calibration. A Cable Calibration window is displayed.

2 Enter a channel number(s) in the Channels box. Multiple channels numbers must be separated with a
comma, no space (i.e., 200,800). When two or more channels numbers are entered, the cables will be
calibrated for each channel. Interpolation will be accomplished for other channels as required for TX
calibration.

3 Select TX and RX CABLE CAL, TX CABLE CAL or RX CABLE CAL in the Cable Calibration
picklist.

4 Click OK. Follow the directions displayed for each step. A status report window will be displayed
with the results of the cable calibration.

 

Calibrating TX Cables Using a Signal Generator and Spectrum Analyzer

Follow the procedure in Table 3-34 to calibrate the TX cables using the
signal generator and spectrum analyzer. Refer to Figure 3-21 for a
diagram of the signal generator and spectrum analyzer.

Table 3-34: Calibrating TX Cables Using Signal Generator and Spectrum Analyzer

Step Action

1 Connect a short test cable between the spectrum analyzer and the signal generator.

2 Set signal generator to 0 dBm at the customer frequency of 869-894 MHz for 800 MHz CDMA and
1930-1990 MHz band for North American PCS.

3 Use spectrum analyzer to measure signal generator output (see Figure 3-21, “A”) and record the value.

4 Connect the spectrum analyzer’s short cable to point “B”, as shown in the lower portion of the
diagram, to measure cable output at customer frequency (869-894 MHz for 800 MHz CDMA and
1930-1990 MHz for North American PCS) and record the value at point “B”.

5 Calibration factor = A - B  Example: Cal = -1 dBm - (-53.5 dBm) = 52.5 dB

NOTE
The short cable is used for calibration only. It is not part of the final test setup. After calibration is
completed, do not re-arrange any cables. Use the equipment setup, as is, to ensure test procedures use
the correct calibration factor.

3



Loss/Gain Offset 68P09255A57-2

Aug 2002SC�4812ET Optimization/ATP Manual Software Release R16.1.x.x
PRELIMINARY

3-72

Figure 3-21:  Calibrating Test Equipment Setup for TX Cable Calibration
(Using Signal Generator and Spectrum Analyzer)
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Calibrating RX Cables Using a Signal Generator and Spectrum Analyzer
Follow the procedure in Table 3-35 to calibrate the RX cables using the
signal generator and spectrum analyzer. Refer to Figure 3-22, if required.

Table 3-35: Calibrating RX Cables Using a Signal Generator and Spectrum Analyzer

Step Action

1 Connect a short test cable to the spectrum analyzer and connect the other end to the Signal Generator.

2 Set signal generator to -10 dBm at the customer’s RX frequency of 824-840 MHz for 800 MHz
CDMA and 1850-1910 MHz band for North American PCS.

3 Use spectrum analyzer to measure signal generator output (see Figure 3-22, “A”) and record the value
for “A”.

4 Connect the test setup, as shown in the lower portion of the diagram, to measure the output at the
customer’s RX frequency in the 1850-1910 MHz band. Record the value at point ‘‘B”.

5 Calibration factor = A - B
Example: Cal = -12 dBm - (-14 dBm) = 2 dB

NOTE
The short test cable is used for test equipment setup calibration only. It is not be part of the final test
setup. After calibration is completed, do not re-arrange any cables. Use the equipment setup, as is, to
ensure test procedures use the correct calibration factor.

Figure 3-22:  Calibrating Test Equipment Setup for RX ATP Test
(Using Signal Generator and Spectrum Analyzer)
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Setting Cable Loss Values
Cable loss values for the TX and RX test cable configurations are
normally set by accomplishing cable calibration with use of the
applicable test equipment. The resulting values are stored in the cable
loss files. The cable loss values can also be set/changed manually.
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Prerequisites
� Logged into the BTS

Table 3-36: Setting Cable Loss Values

Step Action

1 Click on the Util menu.

2 Select Edit >Cable Loss > TX or RX. A data entry pop-up window will appear.

3 Click on the Add Row button to add a new channel number. Then click in the Channel # and Loss
(dBm) columns and enter the desired values.

4 To edit existing values click in the data box to be changed and change the value.

5 To delete a row, click on the row and then click on the Delete Row button.

6 Click on the Save button to save displayed values.

7 Click on the Dismiss button to exit the window. Values that were entered/changed after the Save
button was used will not be saved.

NOTE
� If cable loss values exist for two different channels the LMF will interpolate for all other channels.

� Entered values will be used by the LMF as soon as they are saved. You do not have to logout and
login.

Setting Coupler Loss Value
If an in-service coupler is installed the coupler loss (e.g., 30 dB) must be
manually entered so it will be included in the LMF TX calibration and
audit calculations and the RX FER test.

Prerequisites
� Logged into the BTS

Table 3-37: Setting Coupler Loss Values

Step Action

1 Click on the Util menu.

2 Select Edit >Coupler Loss>TX or RX. A data entry pop-up window will appear.

3 Click in the Loss (dBm) column for each carrier that has a coupler and enter the appropriate value.

4 To edit existing values click in the data box to be changed and change the value.

5 Click on the Save button to save displayed values.

6 Click on the Dismiss button to exit the window. Values that were entered/changed after the Save
button was used will not be saved.

NOTE
� The In-Service Calibration check box in the Tools>Options>BTS Options tab must checked

before entered coupler loss values will be used by the TX calibration and audit functions or RX Fer
test.

� Entered values will be used by the LMF as soon as they are saved. You do not have to logout and
login.
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Adjusting for loss

Introduction

Calibration compensates for normal equipment variations within the
BTS and assures maximum measurement accuracy.

RF Path Bay Level Offset Calibration

Calibration identifies the accumulated gain in every transmit path (BBX
slot) at the BTS site and stores that value in the CAL file. The BLOs are
subsequently downloaded to each BBX.

Each receive path starts at a BTS RX antenna port and terminates at a
backplane BBX slot. Each transmit path starts at a BBX backplane slot,
travels through the LPA, and terminates at a BTS TX antenna port.

Calibration identifies the accumulated gain in every transmit path (BBX
slot) at the BTS site and stores that value in the CAL file. Each transmit
path starts at a C-CCP shelf backplane BBX slot, travels through the
LPA, and ends at a BTS TX antenna port. When the TX path calibration
is performed, the RX path BLO will automatically be set to the default
value.

When to Calibrate BLOs
Calibration of BLOs is required after initial BTS installation.

The BLO data of an operational BTS site must be re-calibrated once
each year. Motorola recommends re-calibrating the BLO data for all
associated RF paths after replacing any of the following components or
associated interconnecting RF cabling:

� BBX board

� C-CCP shelf

� CIO card

� CIO to LPA backplane RF cable

� LPA backplane

� LPA

� TX filter / TX filter combiner

� TX thru-port cable to the top of frame

TX Path Calibration

The TX Path Calibration assures correct site installation, cabling, and the
first order functionality of all installed equipment. The proper function
of each RF path is verified during calibration. The external test
equipment is used to validate/calibrate the TX paths of the BTS.

WARNING Before installing any test equipment directly to any TX OUT
connector you must first verify that there are no CDMA
channels keyed. Have the OMC-R place the sector assigned to
the LPA under test OOS. Failure to do so can result in serious
personal injury and/or equipment damage.
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CAUTION Always wear a conductive, high impedance wrist strap while
handling any circuit card/module. If this is not done, there is a
high probability that the card/module could be damaged by ESD.

NOTE At new site installations, to facilitate the complete test of each
CCP shelf (if the shelf is not already fully populated with BBX
boards), move BBX boards from shelves currently not under test
and install them into the empty BBX slots of the shelf currently
being tested to insure that all BBX TX paths are tested.

- This procedure can be bypassed on operational sites that are
due for periodic optimization.

- Prior to testing, view the CDF file to verify the correct
BBX slots are equipped. Edit the file as required to include
BBX slots not currently equipped (per Systems
Engineering documentation).

BLO Calibration Data File

During the calibration process, the LMF creates a calibration (BLO) data
file. After calibration has been completed, this offset data must be
downloaded to the BBXs using the Download BLO function. An
explanation of the file is shown below.

NOTE Due to the size of the file, Motorola  recommends that you  print
out a hard copy of a bts.cal file and refer to it for the following
descriptions.

The CAL file is subdivided into sections organized on a per slot basis (a
slot Block).

Slot 1 contains the calibration data for the 12 BBX slots. Slot 20
contains the calibration data for the redundant BBX (see Table 3-39).
Each BBX slot header block contains:

� A creation Date and Time - broken down into separate parameters of
createMonth, createDay, createYear, createHour, and createMin.

� The number of calibration entries - fixed at 720 entries corresponding
to 360 calibration points of the CAL file including the slot header and
actual calibration data.

� The calibration data for a BBX is organized as a large flat array. The
array is organized by branch, BBX slot, and calibration point.

- The first breakdown of the array indicates which branch the
contained calibration points are for. The array covers transmit, main
receive and diversity receive offsets as follows:

Table 3-38: BLO BTS.cal file Array Branch Assignments

Range Assignment

C[1]-C[240] Transmit

C[241]-C[480] Receive

C[481]-C[720] Diversity Receive
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- The second breakdown of the array is per sector. Three sectors are
allowed.

Table 3-39: BTS.cal File Array (Per Sector)

BBX Sectorization TX RX RX Diversity

Slot[1] (Primary BBXs 1 through 12)

1 (Omni) 3-Sector , C[1]-C[20] C[241]-C[260] C[481]-C[500]

2
3-Sector ,

1st C[21]-C[40] C[261]-C[280] C[501]-C[520]

3 6 Sector, Carrier C[41]-C[60] C[281]-C[300] C[521]-C[540]

4
1st

Carrier 3-Sector , C[61]-C[80] C[301]-C[320] C[541]-C[560]

5
Carrier 3-Sector ,

3rd C[81]-C[100] C[321]-C[340] C[561]-C[580]

6 Carrier C[101]-C[120] C[341]-C[360] C[581]-C[600]

7 3-Sector , C[121]-C[140] C[361]-C[380] C[601]-C[620]

8
3-Sector ,

2nd C[141]-C[160] C[381]-C[400] C[621]-C[640]

9 6 Sector, Carrier C[161]-C[180] C[401]-C[420] C[641]-C[660]

10
2nd

Carrier 3-Sector , C[181]-C[200] C[421]-C[440] C[661]-C[680]

11
Carrier 3-Sector ,

4th C[201]-C[220] C[441]-C[460] C[681]-C[700]

12 Carrier C[221]-C[240] C[461]-C[480] C[701]-C[720]

Slot[20] (Redundant BBX-13)

1 (Omni) 3-Sector , C[1]-C[20] C[241]-C[260] C[481]-C[500]

2
3-Sector ,

1st C[21]-C[40] C[261]-C[280] C[501]-C[520]

3 6 Sector, Carrier C[41]-C[60] C[281]-C[300] C[521]-C[540]

4
1st

Carrier 3-Sector , C[61]-C[80] C[301]-C[320] C[541]-C[560]

5
Carrier 3-Sector ,

3rd C[81]-C[100] C[321]-C[340] C[561]-C[580]

6 Carrier C[101]-C[120] C[341]-C[360] C[581]-C[600]

7 3-Sector , C[121]-C[140] C[361]-C[380] C[601]-C[620]

8
3-Sector ,

2nd C[141]-C[160] C[381]-C[400] C[621]-C[640]

9 6 Sector, Carrier C[161]-C[180] C[401]-C[420] C[641]-C[660]

10
2nd

Carrier 3-Sector , C[181]-C[200] C[421]-C[440] C[661]-C[680]

11
Carrier 3-Sector ,

4th C[201]-C[220] C[441]-C[460] C[681]-C[700]

12 Carrier C[221]-C[240] C[461]-C[480] C[701]-C[720]

� Refer to the hard copy of the file. As you can see, 10 calibration
points per sector are supported for each branch. Two entries are
required for each calibration point.

� The first value (all odd entries) refer to the CDMA channel
(frequency) the BLO is measured at. The second value (all even
entries) is the power set level. The valid range for PwrLvlAdj is from
2500 to 27500 (2500 corresponds to -125 dBm and 27500
corresponds to +125 dBm).

� The 20 calibration entries for each slot/branch combination must be
stored in order of increasing frequency. If less than 10 points
(frequencies) are calibrated, the largest frequency that is calibrated is
repeated to fill out the 10 points.
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Example:
C[1]=384, odd cal entry

=   1 ‘‘calibration point”
C[2]=19102, even cal entry
C[3]=777,
C[4]=19086,
.
.
C[19]=777,
C[20]=19086, (since only two cal points were calibrated this 

would be repeated for the next 8 points)

� When the BBX is loaded with BLO data, the cal file data for the BBX
is downloaded to the device in the order it is stored in the CAL file.
TxCal data is sent first, C[1] - C[60]. BBX slot 1’s 10 calibration
points are sent (C[1] - C[20]), followed by BBX slot 2’s 10
calibration points (C[21] - C[40]), etc. The RxCal data is sent next,
followed by the RxDCal data.

� Temperature compensation data is also stored in the cal file for each
slot.

Test Equipment Setup: RF Path Calibration
Follow the steps in Table 3-40 to set up test equipment.

Table 3-40: Test Equipment Setup (RF Path Calibration)

Step Action

NOTE
Verify the GPIB is properly connected and turned on.

! CAUTION
To prevent damage to the test equipment, all transmit (TX) test connections must be via the 30 dB
directional coupler for 800 MHz or via a 30 dB coupler with a 20 dB in-line attenuator for 1900 MHz.

1 Connect the LMF computer terminal to the BTS LAN A connector on the BTS (if you have not
already done so). Refer to the procedure in Table 3-6.

� If required, calibrate the test equipment per the procedure in Table 3-32.

� Connect the test equipment as shown in Figure 3-16, Figure 3-17 and Figure 3-18.

Transmit (TX) Path Calibration
The assigned channel frequency and power level (as measured at the top
of the frame) for transmit calibration is derived from the site CDF file.
For each BBX, the channel frequency is specified in the ChannelList
CDF file parameter and the power is specified in the SIFPilotPwr
CDF file parameter for the sector associated with the BBX (located
under the ParentSECTOR field of the ParentCARRIER CDF file
parameter).

The calibration procedure attempts to adjust the power to within +0.5 dB
of the desired power. The calibration will pass if the error is less than
+1.5 dB.

The TX Bay Level Offset at sites WITHOUT the directional coupler
option, is approximately 42.0 dB ±3.0 dB.
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� At sites WITHOUT RFDS option, BLO is approximately 
42.0 dB ±4.0 dB. A typical example would be TX output power
measured at BTS (36.0 dBm) minus the BBX TX output level
(approximately -6.0 dBm) would equate to 42 dB BLO.

The TX Bay Level Offset at sites WITH the directional coupler option,
is approximately 41.4 dB ±3.0 dB. TX BLO = Frame Power Output
minus BBX output level.

� Example: TX output power measured at RFDS TX coupler
(39.4 dBm) minus the BBX TX output level (approximately
-2.0 dBm) and RFDS directional coupler/cable (approximately
-0.6 dBm) would equate to 41.4 dB BLO.

The LMF Tests menu list items, TX Calibration and All Cal/Audit,
perform the TX BLO Calibration test for a XCVR(s). The All Cal/Audit
menu item performs TX calibration, downloads BLO, and performs TX
audit if the TX calibration passes. All measurements are made through
the appropriate TX output connector using the calibrated TX cable setup.

Test Pattern Drop-down Pick List

Pilot is shown as the default setting in this pick list box. The full range
of available selections and their descriptions are as follows:

Standard - performs calibration or audit using pilot, paging, synch, and
six traffic channels with IS-97-specified gain. This pattern setting
should be used for all non-in-service calibrations and audits. Using this
pattern setting requires the selection of both a BBX and at least one
MCC.

Pilot (default) - performs calibration using only the pilot channel. This
pattern setting should be used for in-service calibrations, and requires
selection of only a BBX.

CDFPilot -This pattern setting is for advanced users. It performs
calibration or audit using the CDF value for pilot gain and IS-97 gain
values for all the other channels included in the Standard pattern setting
(paging, synch, and six traffic). Using this pattern setting requires the
selection of both a BBX and at least one MCC.

CDF - This pattern setting is for advanced users who need to use CDF
gain settings for all channels included in the Standard pattern setting
(pilot, paging, synch, and six traffic). Using this pattern setting requires
the selection of both a BBX and at least one MCC.

Verify BLO

In both the TX Calibration and All Cal/Audit dialog boxes, a Verify
BLO checkbox is provided and checked by default. After the actual TX
calibration is completed during either the TX Calibration or All
Cal/Audit process, the BLO derived from the calibration is compared to
a standard, acceptable BLO tolerance for the BTS. In some installations,
additional items may be installed in the transmit path. The additional
change in gain from these items could cause BLO verification failure
and, therefore, failure of the entire calibration. In these cases, either the
Verify BLO checkbox should be unchecked or the additional path losses
should be added into each applicable sector using the
Util>Edit>TX Coupler Loss function.
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Single-Sided BLO

Normally valid values are some value plus-or-minus some offset.  If
single-sided BLO” is selected, the result will only be considered a
success if it’s in the lower half of the range.  If it was normally success
from 37-47 (which is 42± 5), single-sided BLO” would make it a
success only if the result was from 37-42.

Prerequisites

Before running this test, ensure that the following have been done:

� CSM-1, GLIs, MCCs, and BBXs have correct code load and data
load.

� Primary CSM and MGLI are INS.

� All BBXs are OOS_RAM.

� Test equipment and test cables are calibrated and connected for TX
BLO calibration.

� LMF is logged into the BTS.

Connect the test equipment as shown in Figure 3-10 and Figure 3-11 and
follow the procedure in Table 3-41 to perform the TX calibration test.

WARNING Before installing any test equipment directly to any TX OUT
connector, first verify there are no CDMA BBX channels
keyed. Failure to do so can result in serious personal injury
and/or equipment damage.

NOTE Verify all BBX boards removed and repositioned have been
returned to their assigned shelves/slots. Any BBX boards moved
since they were downloaded will have to be downloaded again.

Table 3-41: BTS TX Path Calibration

� Step Action

1 Select the BBX(s) to be calibrated.

NOTE
If STANDARD, CDF or CDFPILOT is selected for TEST PATTERN, then at least one MCC
must be also selected.

2 From the Tests menu, select TX>TX Calibration.

3 Select the appropriate carrier(s) displayed in the Channels/Carrier pick list. (Press and hold the
<Shift> or <Ctrl> key to select multiple items.)

4 Type the appropriate channel number in the Carrier n Channels box.

5 Select Verify BLO (default) or Single-sided BLO.

NOTE
Single-sided BLO is only used when checking non-redundant transceivers.

6 From the Test Pattern pick list, select a test pattern.
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Table 3-41: BTS TX Path Calibration

� ActionStep

NOTE
� Selecting PILOT (default) performs tests using a pilot signal only.

� Selecting STANDARD performs tests using pilot, synch, paging and six traffic channels. This
requires an MCC to be selected.

� Selecting CDFPilot performs tests using the CDF value for pilot gain and IS-97 gain values for
all the other channels included in the Standard pattern setting (paging, synch, and six traffic).
Using this pattern setting requires the selection of both a BBX and at least one MCC.

� Selecting CDF performs tests using pilot, synch, paging and six traffic channels, however, the
gain for the channel elements is specified in the CDF file.

7 Click on OK.

8 Follow the cable connection directions as they are displayed.

A status report window displays the test results.

9 Click on Save Results or Dismiss to close the status report window.

 

Exception Handling

In the event of a failure, the calibration procedure displays a FAIL
message in the status report window and provides information in the
Description field.

Recheck the test setup and connection and re-run the test. If the tests fail
again, note specifics about the failure, and refer to Chapter 6,
Troubleshooting.

Download BLO Procedure

After a successful TX path calibration, download the BLO calibration
file data to the BBXs. BLO data is extracted from the CAL file for the
BTS and downloaded to the selected BBX devices.

NOTE If a successful All Cal/Audit was completed, this procedure
does not need to be performed, as BLO is downloaded as part of
the All Cal/Audit.

Prerequisites

Ensure the following prerequisites have been met before proceeding.

� BBXs being downloaded are OOS-RAM (yellow).

� TX calibration is successfully completed.

Follow the steps in Table 3-42 to download the BLO data to the BBXs.
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Table 3-42: Download BLO

Step Action

1 Select the BBX(s) to be downloaded.

2 From the Device menu, select Download>BLO.

A status report window displays the result of the download.

NOTE
Selected device(s) do not change color when BLO is downloaded.

3 Click OK to close the status report window.

 

Calibration Audit Introduction

The BLO calibration audit procedure confirms the successful generation
and storage of the BLO calibrations. The calibration audit procedure
measures the path gain or loss of every BBX transmit path at the site. In
this test, actual system tolerances are used to determine the success or
failure of a test. The same external test equipment set up is used.

NOTE RF path verification, BLO calibration, and BLO data download
to BBXs must have been successfully completed prior to
performing the calibration audit.

Transmit (TX) Path Audit

Perform the calibration audit of the TX paths of all equipped BBX slots,
per the steps in Table 3-43.

WARNING Before installing any test equipment directly to any TX OUT
connector, first verify there are no CDMA BBX channels
keyed. Failure to do so can result in serious personal injury
and/or equipment damage.

NOTE If a successful All Cal/Audit was completed, this procedure
does not need to be performed, as BLO is downloaded as part of
the All Cal/Audit.

TX Audit Test

The Tests menu item, TX Audit, performs the TX BLO Audit test for a
BBX(s). All measurements are made through the appropriate TX output
connector using the calibrated TX cable setup.

Prerequisites

Before running this test, the following should be done:

� CSM-1,GLI3s, BBXs have correct code load.

� Primary CSM and MGLI3 are INS.

� All BBXs are OOS_RAM.
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� Test equipment and test cables are calibrated and connected for TX
BLO calibration.

� LMF is logged into the BTS.

Follow the procedure in Table 3-43 to perform the BTS TX Path Audit
test.

Table 3-43: BTS TX Path Audit

� Step Action

1 Select the BBX(s) to be audited.

NOTE
If STANDARD or CDF is selected for Test Pattern, then at least one MCC must be also selected.

2 From the Tests menu, select TX>TX Audit.

3 Select the appropriate carrier(s) displayed in the Channels/Carrier pick list.

Press and hold the <Shift> or <Ctrl> key to select multiple items.

4 Type the appropriate channel number in the Carrier n Channels box.

5 Select Verify BLO (default) or Single-sided BLO.

NOTE
Single-sided BLO is only used when checking non-redundant transceivers.

6 From the Test Pattern pick list, select a test pattern.

NOTE
� Selecting PILOT (default) performs tests using a pilot signal only.

� Selecting STANDARD performs tests using pilot, synch, paging and six traffic channels. This
requires an MCC to be selected.

� Selecting CDFPILOT performs tests using the CDF value for pilot gain and IS-97 gain values
for all the other channels included in the Standard pattern setting (paging, synch, and six
traffic). Using this pattern setting requires the selection of both a BBX and at least one MCC.

� Selecting CDF performs tests using pilot, synch, paging and six traffic channels, however, the
gain for the channel elements is specified in the CDF file.

7 Click on OK.

8 Follow the cable connection directions as they are displayed.

A status report window displays the test results.

9 Click on Save Results or Dismiss to close the status report window.
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Exception Handling

In the event of a failure, the calibration procedure displays a FAIL
message in the status report window and provides information in the
Description field.

Recheck the test setup and connection and re-run the test. If the tests fail
again, note specifics about the failure, and refer to Chapter 6,
Troubleshooting.

All Cal/Audit Test

The Tests menu item, All Cal/Audit, performs the TX BLO Calibration
and Audit test for a XCVR(s). All measurements are made through the
appropriate TX output connector using the calibrated TX cable setup.

NOTE If the TX calibration portion of the test passed, the BLO data
will automatically be downloaded to the BBX(s) before the audit
portion of the test is run.

Prerequisites

Before running this test, the following should be done:

� CSM-1, GLI3s, BBXs have correct code and data load.

� Primary CSM and MGLI3 are INS.

� All BBXs are OOS_RAM.

� Test equipment and test cables are calibrated and connected for TX
BLO calibration.

� LMF is logged into the BTS.

Follow the procedures in Table 3-44 to perform the All Cal/Audit test.

WARNING Before installing any test equipment directly to any TX OUT
connector, first verify there are no CDMA BBX channels
keyed. Failure to do so can result in serious personal injury
and/or equipment damage.
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Table 3-44: All Cal/Audit Test

� Step Action

1 Select the BBX(s) to be tested.

NOTE
If STANDARD, CDF or CDFPILOT is selected for TEST PATTERN, then at least one MCC
must be also selected.

2 From the Tests menu, select All Cal/Audit.

3 Select the appropriate carrier(s) displayed in the Channels/Carrier pick list.

Press and hold the <Shift> or <Ctrl> key to select multiple items.

4 Type the appropriate channel number in the Carrier n Channels box.

5 Select Verify BLO or Single-sided BLO.

NOTE
Single-sided BLO is only used when checking non-redundant transceivers.

6 From the Test Pattern pick list, select a test pattern.

NOTE
� Selecting Pilot (default) performs tests using a pilot signal only.

� Selecting Standard performs tests using pilot, synch, paging and 6 traffic channels. This
requires an MCC to be selected.

� Selecting CDFPilot performs tests using the CDF value for pilot gain and IS-97 gain values for
all the other channels included in the Standard pattern setting (paging, synch, and six traffic).
Using this pattern setting requires the selection of both a BBX and at least one MCC.

� Selecting CDF performs tests using pilot, synch, paging and 6 traffic channels, however, the
gain for the channel elements is specified in the CDF file.

7 Click on OK.

8 Follow the cable connection directions as they are displayed.

A status report window displays the test results.

9 Click on Save Results or Dismiss to close the status report window.

 

Create CAL File

The Create Cal File function gets the BLO data from BBXs and
creates/updates the CAL file for the BTS. If a CAL file does not exist a
new one is created. If a CAL file already exists it is updated. After a
BTS has been fully optimized a copy of the CAL file must exist so it can
be transferred to the CBSC. If TX calibration has been successfully
performed for all BBXs and BLO data has been downloaded, a CAL file
will exist. Note the following:

� The Create Cal File function only applies to selected (highlighted)
BBXs.
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WARNING Editing the CAL file is not encouraged as this action can cause
interface problems between the BTS and the LMF. To manually
edit the CAL file you must first logout of the BTS. If you
manually edit the CAL file and then use the Create Cal File
function the edited information will be lost.

Prerequisites

Before running this test, the following should be done:

� LMF is logged in to the BTS

� BBXs are OOS_RAM with BLO downloaded

Table 3-45: Create CAL File

Step Action

1 Select the applicable BBXs. The CAL file will only be updated for the selected BBXs.

2 Click on the Device menu.

3 Click on the Create Cal File menu item.

The status report window is displays the results of the action.

4 Click OK.

 

RFDS Description
The optional RFDS is used to perform RF tests of the site from the
CBSC or from the LMF. The RFDS contains the following FRUs:

� Antenna Select Unit (ASU)

� Fixed Wireless Terminal Interface Card (FWTIC)

� Subscriber Unit Assembly (SUA)

For complete information regarding the RFDS, refer to the CDMA, and
the.LMF Help function on-line documentation.

RFDS Parameters
The bts-#.cdf  file includes RFDS parameter settings that must match the
installed RFDS equipment. The paragraphs below describe the editable
parameters and their defaults. Table 3-46 explains how to edit the
parameter settings.

� RfdsEquip - valid inputs are 0 through 2.
0 = (default) RFDS is not equipped
1 = Non-Cobra/Patzer box RFDS
2 = Cobra RFDS

� TsuEquip - valid inputs are 0 or 1
0 = (default) TSU not equipped
1 = TSU is equipped in the system

� MC1....4 - valid inputs are 0 or 1
0 = (default) Not equipped
1 = Multicouplers equipped in RFDS system 

(SC9600 internal RFDS only)
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� Asu1/2Equip - valid inputs are 0 or 1
0 = (default) Not equipped
1 = Equipped

� TestOrigDN - valid inputs are ’’’ (default) or a numerical string up to
15 characters. (This is the phone number the RFDS dials when
originating a call. A dummy number needs to be set up by the switch,
and is to be used in this field.)

NOTE Any text editor may be used to open the bts-#.cdf  file to verify,
view, or modify data. Because the bts-#.cdf  file is generated on
a Unix system, a more sophisticated editor, such as MicroSoft
WordPad, will display file content in a more easily-read format
than many simple text editors.

Checking and Setting RFDS Parameters
Follow the procedure in Table 3-46 to review and/or edit RFDS
parameters.

Table 3-46: RFDS Parameter Settings

Step Action

1 * IMPORTANT
Log out of the BTS prior to perform this procedure.

Using a text editor, verify the following fields are set correctly in the bts-#.cdf  file:

EXAMPLE:

Asu1Equip = 1
Asu2Equip = 0 (1 if system is non-duplexed)
Mc1Equip = 0
Mc2Equip = 0
Mc3Equip = 0
Mc4Equip = 0
RfdsEquip = 2
TestOrigDN = ’123456789’
TsuEquip = 1

NOTE
The above is an example of entries extracted from the bts-#.cdf  file that should have been generated
by the OMC-R and copied to the LMF. These fields will have been set by the OMC-R if the
RFDSPARM database is modified for the RFDS.

2 Save changes and/or quit the editor.

3 Log into the BTS using an LMF GUI session(refer to Table 3-14).

4 If no changes were made to the bts-#.cdf  file fields listed in step 1, proceed to Step 7. If changes were
made, continue with Step 5.

5 * IMPORTANT
To make certain the complete data download is accepted, the MGLI should be OOS_RAM (yellow)
when RFDS parameter settings are downloaded.

When changes are made to RFDS parameters in the bts-#.cdf  file, data must be downloaded to the
MGLI by performing the following:

. . . continued on next page
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Table 3-46: RFDS Parameter Settings

Step Action

5a - To be sure it does not take control when the MGLI is disabled, manually disable the redundant
GLI card by unseating it from the backplane connectors and sliding it partially out of the shelf
slot.

5b - Click on the MGLI.

5c - Click on Device in the BTS menu bar, and select Disable from the pull-down menu.
-- A status report window is displayed showing status of the operation.

5d - When the operation is complete, click OK to close the status report window.

5e - Click on the MGLI (now OOS_RAM (yellow)).

5f - Click on Device in the BTS menu bar, and select Download > Data from the pull-down menus
(selected devices do not change color when data is downloaded).
-- A status report window is displayed showing status of the download.

5g - Click OK to close the status report window.

5h - Click on the MGLI.

5i - Click on Device in the BTS menu bar, and select Enable from the pull-down menu.
-- A status report window is displayed showing status of the operation.

5j - When the operation is complete, click OK to close the status report window.

! CAUTION
When the MGLI changes to INS_ACT, data will automatically be downloaded to the RFDS. During
this process, the RFDS LED will slowly begin flashing red and green for approximately 2-3 minutes.
DO NOT attempt to perform any functions with the RFDS until the LED remains steady green.

5k - Re-seat the redundant GLI card into the backplane connectors and lock it in place with the ejector
tabs.

5l - Once the redundant GLI initializes, download data to it by selecting the card and, in the BTS
menu bar, clicking Device and selecting Download > Data from the pull-down menus.

6 Any MCCs which were INS_ACT when the MGLI was disabled must be disabled, re-enabled, and
downloaded with code as follows:

6a - Select the devices to be reset by clicking on them or using Select from the BTS menu bar and
clicking on MCCs in the pull-down menu.

6b - In the BTS menu bar, click on Device and select Disable from the pull-down menu.
-- A status window report window is displayed showing status of the operation.

6c - Click OK to close the status report window.

6d - Download data to the MCCs by following the procedure in Table 3-21.

6e - When data download is complete, enable the MCCs by following the procedure in Table 3-24.

7 Click on the RFDS tab.

8 Status the RFDS TSU by performing the following:

8a - Click on the SUA to select it.

. . . continued on next page
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Table 3-46: RFDS Parameter Settings

Step Action

8b - Click on TSU in the BTS menu bar, and select Status TSU from the pull-down menu.
-- A status report is displayed showing the software version number for the TSIC and SUA.

8c - Click OK to close the status report window.

* IMPORTANT
If the LMF displays an error message, check the following:

� Ensure AMR cable is correctly connected from the BTS to the RFDS.

� Verify RFDS has power.

� Verify RFDS status LED is green.

� Verify entries in RFDS fields of the bts-#.cdf  file are correct (refer to step 1).

� Status the MGLI and ensure it is communicating (by Ethernet) with the LMF, and is in the proper
state (INS_ACT (bright green)).

 

RFDS TSU NAM Programming

The Number Assignment Module (NAM) information needs to be
programmed into the TSU before it can receive and process test calls, or
be used for any type of RFDS test. The RFDS TSU NAM must be
programmed with the appropriate system parameters and phone number
during hardware installation. The TSU phone and TSU MSI must be
recorded for each BTS used for OMC-R RFDS software configuration.

NOTE The user will only need to program the NAM for the initial
installation of the RFDS.

Explanation of Parameters Used When Programming the TSU NAM

Table 3-47 defines the parameters used when editing the tsu.nam file.

Table 3-47: Definition of Parameters

Access Overload Code
Slot Index
System ID
Network ID

These parameters are obtained from the switch.

Primary Channel A
Primary Channel B
Secondary Channel A
Secondary Channel B

These parameters are the channels which are to be used in operation
of the system.

Lock Code
Security Code
Service Level
Station Class Mark

Do NOT change.
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Table 3-47: Definition of Parameters

IMSI MCC
IMSI 11 12

These fields are obtained at the OMC using the following command:
OMC000>disp bts-# imsi
If the fields are blank, replace the IMSI fields in the NAM file to 0,
otherwise use the values displayed by the OMC.

MIN Phone Number These fields are the phone number assigned to the mobile. The ESN
and MIN must be entered into the switch as well.

NOTE
This field is different from the TODN field in the bts-#.cdf  file. The
MIN is the phone number of the RFDS subscriber, and the TODN is
the number the subscriber calls.

Valid NAM Ranges
Table 3-48 provides the valid NAM field ranges. If any of the fields are
missing or out-of-range, the RFDS will error out.

Table 3-48: Valid NAM Field Ranges

Valid Range

NAM Field Name Minimum Maximum

Access Overload Code 0 15

Slot Index 0 7

System ID 0 32767

Network ID 0 32767

Primary Channel A 25 1175

Primary Channel B 25 1175

Secondary Channel A 25 1175

Secondary Channel B 25 1175

Lock Code 0 999

Security Code 0 999999

Service Level N/A N/A

Station Class Mark 0 255

IMSI 11 12 0 99

IMSI MCC 0 999

MIN Phone Number N/A N/A

Set Antenna Map Data
The antenna map data must be entered manually if an RFDS is installed.
Antenna map data does not need to be entered if an RFDS is not
installed. The antenna map data is only used for RFDS tests and is
required if an RFDS is installed.

Prerequisite
� LMF is logged into the BTS

Follow the procedure in Table 3-49 to set antenna map data for the
RFDS.
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Table 3-49: Set Antenna Map Data

Step Action

1 Click on Util in the BTS menu bar, and select Edit > Antenna Map... from the pull-down menus.

- A tabbed data entry pop-up window will appear.

2 In the data entry pop-up window, click on the TX Antenna Map or RX Antenna Map tab to select
the antenna map to be edited.

3 Locate the carrier and sector number for which data is to be entered or edited, and click in the column
where entry or editing is needed.

4 Enter/edit Antenna # and Antenna Label column data as needed for each carrier.

NOTE
Refer to the CDMA Help > Utility Menu > Edit-Antenna Map... section of LMF Help function
on-line documentation for antenna map examples.

5 For each tab with changes, click on the Save button to save displayed values.

6 Click on the Dismiss button to close the window.

NOTE
� Values entered or changed after the Save button was used will be lost when the window is

dismissed.

� Entered values will be used by the LMF as soon as they are saved. It is not necessary to log out and
log back into the LMF for changes to take effect.

 

Set RFDS Configuration Data
If an RFDS is installed, the RFDS configuration data must be manually
entered.

Prerequisite
� LMF is logged into the BTS

NOTE The entered antenna# index numbers must correspond to the
antenna# index numbers used in the antenna maps.

Follow the procedure in Table 3-50 to set RFDS configuration data.

Table 3-50: Set RFDS Configuration Data

Step Action

1 Click on Util in the BTS menu bar, and select Edit > RFDS Configuration... from the pull-down
menus.

- A tabbed data entry pop-up window will appear.

2 In the data entry pop-up window, click on the TX RFDS Configuration or RX RFDS Configuration
tab, as required.

3 To add a new antenna number, perform the following:

3a - Click on the Add Row button.

3b - Click in the Antenna #, Cal Antenna, Scap Antenna, or Populate [Y/N] columns, as required.

. . . continued on next page
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Table 3-50: Set RFDS Configuration Data

Step Action

3c - Enter the desired data.

4 To edit existing values click in the data box to be changed and change the value.

NOTE
Refer to the CDMA Help > Utility Menu > Edit-RFDS Configuration... section of LMF Help
function on-line documentation for RFDS configuration data examples.

5 To delete a row, click on the row and then click on the Delete Row button.

6 For each tab with changes, click on the Save button to save displayed values.

7 Click on the Dismiss button to close the window.

NOTE
� Values entered or changed after the Save button was used will be lost when the window is

dismissed.

� Entered values will be used by the LMF as soon as they are saved. It is not necessary to log out and
log back into the LMF for changes to take effect.

 

RFDS Calibration

The RFDS Calibration option is used to calibrate the RFDS TX and RX
paths.

TX Path Calibration - For a TX antenna path calibration the BTS
XCVR is keyed at a pre-determined power level and the BTS power
output level is measured by the RFDS. The power level is then measured
at the TX antenna directional coupler by the power measuring test
equipment item being used (power meter or analyzer). The difference
(offset) between the power level at the RFDS and the power level at the
TX antenna directional coupler is used as the TX RFDS calibration
offset value.

RX Path Calibration - For an RX antenna path calibration the RFDS is
keyed at a pre-determined power level and the power input level is
measured by the BTS BBX. A CDMA signal at the same power level
measured by the BTS BBX is then injected at the RX antenna directional
coupler by the communications system analyzer. The difference (offset)
between the RFDS-keyed power level and power level measured at the
BTS BBX is the RFDS RX calibration offset value.

RFDS calibration and the CAL file - The TX and RX RFDS
calibration offset values are written to the CAL file in the slot[385]
Block.

TSIC channel frequency - For each RFDS TSIC, the channel
frequency is determined at the lower third and upper third of the
appropriate band using the frequencies listed in Table 3-51.
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Table 3-51: RFDS TSIC Calibration Channel Frequencies

System Channel Calibration Points

800 MHz (A and B) 341 and 682

1.9 GHz 408 and 791

WARNING Before installing any test equipment directly to any TX OUT
connector, verify that there are no CDMA channels keyed.
Failure to do so can result in serious personal injury and/or
equipment damage.

RFDS Calibration Procedure

Prerequisites
� Test equipment has been selected.

� Test equipment and test cables have been calibrated.

� TX calibration has been performed and BLO data has been
downloaded to the BBXs.

� Test equipment and test cables are connected for TX calibration.

� Antenna map data has been entered for the site.

� BBXs are INS_TEST.

Follow the procedure in Table 3-52 to perform RFDS calibration.

3



Adjusting for loss 68P09255A57-2

Aug 2002SC�4812ET Optimization/ATP Manual Software Release R16.1.x.x
PRELIMINARY

3-94

Table 3-52: RFDS Calibration

Step Action

1 In the LMF, select the FRAME tab.

2 If it is not selected (no black dot showing), click on the B button in the BTS menu bar to select it.

3 Select the BBX(s) assigned to the carrier(s) and sector(s) which will be used in RFDS calibration
(refer to Table 1-5 for BBX carrier and sector assignments).

4 Click on RFDS in the BTS menu bar, and select RFDS Calibration... from the pull-down menu.

- An RFDS Calibration set-up window will be displayed.

5 In the Tests to Perform box, select TX Calibration or RX Calibration, as required

6 Enter the appropriate channel number(s) (refer to Table 3-51) in the Channel Field box.

� To enter more than one channel number, use the following methods:

- Separate non-sequential channel numbers with a comma and no spaces; 
for example:  247,585,742.

- Enter a range of sequential channels by typing the first and last channel numbers in the range
separated by a dash and no spaces; 
for example:  385-395.

7 If the frame is equipped with TX combiners, click in the Has Combiners checkbox.

8 Select the appropriate carrier(s) and sector(s) from the Carriers pick list (hold down the Shift or Ctrl
key while clicking on pick list items to select multiple carrier(s)-sector(s)).

9 Select the appropriate RX branch (Both, Main, or Diversity) in the drop-down list.

10 In the Rate Set box, select the appropriate transfer rate (1=9600, 2=14400) from the drop-down list.

11 Click on the OK button.

- A status report window is displayed, followed by a Directions pop-up window.

12 Follow the cable connection directions as they are displayed.

13 When the test is completed, test results are displayed in the status report window.

14 Click on the OK button to close the status report window.

15 Click on the Frame tab.

16 Select the MGLI by clicking on it.

17 Download the CAL file, now updated with the RFDS offset data, to the MGLI by clicking on Device
on the BTS menu bar, and selecting Download > Data from the pull-down menus.

NOTE
The MGLI will automatically transfer the RFDS offset data from the CAL file to the RFDS.

 

Program TSU NAM

The NAM must be programmed before it can receive and process test
calls, or be used for any type of RFDS test.

Prerequisites

� MGLI is INS_ACT (bright green).

� SUA is powered up and has a code load.

Follow the procedure in Table 3-53 to program the TSU NAM.
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Table 3-53: Program NAM Procedure

Step Action

1 In the LMF, select the RFDS tab.

2 Select the SUA by clicking on it.

3 Click on TSU in the BTS menu bar, and select Program TSU NAM from the pull-down menu.

- A NAM programming window will appear.

4 Enter the appropriate information in the boxes (see Table 3-47 and Table 3-48) .

5 Click on the OK button to display the status report.

6 Click on the OK button to close the status report window.
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Alarms
The alarms testing should be performed at a convenient point in the
optimization/ATP process, since the LMF is necessary to ensure that the
RF cabinet is receiving the appropriate alarms from the power cabinet.

The SC 4812ET is capable of concurrently monitoring 10 customer
defined input signals and four customer defined outputs, which interface
to the 50-pin punchblock. All alarms are defaulted to “Not Equipped”
during ATP testing. Testing of these inputs is achieved by triggering the
alarms and monitoring the LMF for state-transition messages from the
active MGLI3.

All customer alarms are routed through the 50 pair punchblock located
in the I/O compartment at the back of the frame. Testing is best
accomplished by using a specialized connector that interfaces to the
50-pair punchblock. This connector is wired so that customer return 1 (2
for the B side) is connected to every input, CDI 0 through CDI 17.

Alarm Reporting Display

The Alarm Monitor window can be displayed to list alarms that occur
after the window is displayed. To access the Alarm Monitor window,
select Util>Alarm Monitor.

The following buttons are included:

� The Options button allows for a severity level (Warning, Minor,
Major, Critical, and Unknown) selection. The default is all levels.
To change the level of alarms reported click on the Options button
and highlight the desired alarm level(s). To select multiple levels press
the Ctrl key (for individual selections) or Shift key (for a range of
selections) while clicking on the desired levels.

� The Pause button can be used to pause/stop the display of alarms.
When the Pause button is clicked the name of the button changes to
Continue. When the Continue button is click the display of alarms
will continue. Alarms that occur between the time the Pause button is
clicked and the Continue button is clicked will not be displayed.

� The Clear button can be used to clear the Alarm Monitor display.
New alarms that occur after the Clear button is clicked will be
displayed.

� The Dismiss button is used to dismiss/close the Alarm Monitor
display.

Heat Exchanger Alarm Test

Table 3-54 gives instructions on testing the Heat Exchanger alarm.
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Table 3-54: Heat Exchanger Alarm

Step Action

1 Turn circuit breaker “B” of the Heat Exchanger circuit breakers OFF.  This will generate a Heat
Exchanger alarm, ensure that the LMF reports the correct alarm condition in the RF Cabinet.

2 Alarm condition will be reported as BTS Relay #25 - “Heat Exchanger Alarm” makes contact.

3 Turn the circuit breaker “B” ON. Ensure that the alarm condition is now removed.

NOTE
The Heat Exchanger will go through the Start Up sequence.

Door Alarm

Table 3-55 gives instructions on testing the door alarms.

NOTE When conducting this test connect the LMF via the LAN port on
the back of the frame thru the Rear I/O Door.

Table 3-55: Door Alarm

Step Action

1 Close all doors on the power cabinet. Ensure that no alarms are reported on the LMF.

2 Individually open and then close each power supply cabinet door. Ensure that the LMF reports an
alarm when each door is opened.

3 Alarm condition will be reported as BTS Relay #27 “Door Alarm” makes contact.

AC Fail Alarm

Table 3-56 gives instructions on testing the AC Fail Alarm.

Table 3-56: AC Fail Alarm

Step Action

1 NOTE
The batteries should have a stable charge before performing this test.

Turn the Main AC breaker on the power cabinet OFF. The LMF should report an alarm on an AC Fail
(Rectifier Fail, Minor Alarm & Major Alarm) condition.

2 Alarm condition will be reported as BTS Relay #23, BTS # 21, BTS # 24 and BTS Relay # 29 “AC
Fail Alarm” makes contact  respectively.

3 Turn the Main AC breaker on the power cabinet ON. The AC Fail alarm should clear.

Minor Alarm

  Table 3-57 gives instructions on testing minor alarm.
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Table 3-57: Minor Alarm

Step Action

1 Turn the Temperature Compensation Panel (TCP) power switch OFF. This will generate a minor
alarm. Verify that the minor alarm LED (amber) is illuminated on the Meter Alarm Panel and the
LMF reports this minor alarm.

2 Alarm condition will be reported as BTS Relay #24 “Minor Alarm” makes contact.

3 Turn the TCP power switch ON. The alarm condition should clear.

Rectifier Alarms
The following series of tests are for single rectifier modules in a multiple
rectifier system. The systems include a three rectifier and a six rectifier
system.

Single Rectifier Failure (Three Rectifier System)
Table 3-58 gives instructions on testing single rectifier failure or minor
alarm in a three rectifier system.

Table 3-58: Single Rectifier Fail or Minor Alarm

Step Action

1 Remove a single rectifier module and place it into the unused rectifier shelf #2.

2 Turn the AC breaker OFF, for this 2nd shelf.

3 Verify that a rectifier fail alarm is generated. The single rectifier module will lite two RED fail LED
(DC and Power), and the Meter Alarm Panel and LMF will also indicate a minor alarm and rectifier
fail status. The RECTIFIER FAIL LED will lite.

4 Check that the LMF reports both of these alarm conditions.

NOTE
Alarm conditions reported as BTS #24 and BTS #21, contacts respectively.

5 Turn the AC breaker for the 2nd shelf ON and verify that Rectifier Fail and minor alarm conditions
clear on the Meter Alarm Panel and LMF.

 

Multiple Rectifier Failure
Table 3-59 gives instructions on testing multiple rectifier failure or major
alarm in a three rectifier system.

Table 3-59: Multiple Rectifier Failure or Major Alarm

Step Action

1 With the rectifier module still in the unused shelf position fromTable 3-58 test procedures, turn the
AC breaker for the 1st shelf OFF.

2 Verify that a rectifier alarm is generated. Each of the two rectifier modules will lite two RED fail LED
(DC and Power), and the Meter Alarm Panel and LMF  will indicate a major alarm (Rectifier Fail and
Major Alarm). The RECTIFIER FAIL LED will lite.

. . . continued on next page
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Table 3-59: Multiple Rectifier Failure or Major Alarm

Step Action

3 Verify that the LMF reports both alarm conditions. (BTS #29, BTS #21, and BTS #24)

4 Turn the AC breaker for the 1st shelf ON. Verify that all alarms have cleared.

5 Return the rectifier module to its original location. This completes the alarm test on the power cabinet.

 

Single Rectifier Failure 
(Six Rectifier System)

Table 3-60 gives instructions on testing single rectifier failure or minor
alarm in a six rectifier system.

Table 3-60: Single Rectifier Fail or Minor Alarm

Step Action

1 Remove two(2) rectifier modules from shelf #2.

2 Turn the AC breaker OFF, for shelf #2.

3 Verify that a rectifier fail alarm is generated. The single rectifier module will lite two RED fail LED
(DC and Power), and the Meter Alarm Panel and LMF will also indicate a minor alarm and rectifier
fail status. The RECTIFIER FAIL LED will lite.

4 Check that the LMF reports both of these alarm conditions. (BTS #24 and BTS #21)

5 Turn the AC breaker for this shelf ON and verify that Rectifier Fail and Minor Alarm conditions have
cleared.

 

Multiple Rectifier Failure (Six Rectifier System)

Table 3-61 gives instructions on testing multiple rectifier failure or
major alarm in a six  rectifier system.

Table 3-61: Multiple Rectifier Failure or Major Alarm

Step Action

1 Replace one rectifier module previously removed and turn the AC breaker for  this shelf, OFF.

2 Verify that a rectifier alarm is generated. Each of the two rectifier modules will lite a RED fail LED,
and the Meter Alarm Panel will indicate a major alarm (Rectifier Fail, Major and Minor Alarm).The
RECTIFIER FAIL LED will lite.

3 Verify that the LMF reports both alarm conditions. (BTS #29)

4 Turn the AC breaker for this shelf ON. Verify that all alarms have cleared.

5 Return all rectifier module to their original location. This completes the rectifier alarm tests on the
power cabinet.
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Battery Over Temperature Alarm (Optional)

CAUTION Use special care to avoid damaging insulation on cables, or
damaging battery cases when using a power heat gun.

Table 3-62 gives instructions on testing the battery over temperature
alarm system.

Table 3-62: Battery Over Temperature Alarm

Step Action

1 Use a low powered heat gun and gently heat the battery over temperature sensor (see location in
Figure 3-23). Do Not hold the hot air gun closer than 7.6 cm (3 in.) to the sensor. This will avoid
burning the cable insulation.

2 When the sensor is heated to approximately 50° C, a battery Over Temperature alarm is generated.

NOTE
An audible click will sound as K1 contact engage and K2 contacts disengage.

3 Visually inspect the K1 and K2 relays to verify state changes. The LMF should be displaying correct
alarms. (BTS #22)

4 Verify that the CHARGE DISABLE LED (amber) on the Meter Alarm Panel and the BATTERY
MAIN LED (green) are both illuminated.

5 Switch the hot air gun to cool. Cool the sensor until the K1 and K2 contact return to normal position
(K1 open and K2 closed).  Use the LMF verify that all alarms have cleared.
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Figure 3-23: Battery Over-temperature Sensor
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Rectifier Over Temperature Alarm

NOTE This is connector J8 on the rear of the Meter Alarm Panel itself,
this is not connector J8 on the connector  bulkhead at the rear of
the cabinet.

Table 3-63 gives instructions on testing the battery over temperature
alarm system.

Table 3-63: Rectifier Over Temperature Alarm

Step Action

1 Remove the J8 link on the rear of the Meter Alarm Panel (see Figure 3-24 for J8 location).

NOTE
This is the J8 on the rear of the Meter Alarm Panel itself, this is not connector J8 on the connector
bulkhead at the rear of the cabinet.

2 Verify that RECTIFIER OVERTEMP LED (red) is lite. Contacts on K1 and K2 change states (K1
now closed and K2 open).

3 Verify that the LMF has reported an alarm condition. (BTS #26)

4 Reinstall J8 connector and verify that all alarm conditions have cleared. K1 and K2 should now be in
their normal states (K1 open and K2 closed).

5 This completes the system tests of the SC 4812ET power cabinet.

 

Figure 3-24: Location of Connector J8 on the Meter Alarm Panel
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Before Leaving the site
Table 3-64 gives instructions on what to check before leaving the site.

Table 3-64: Check Before Leaving the Site

Step Action

1 Verify that ALL battery circuit breakers (for occupied shelves) are CLOSED (pushed in).

2 Verify that the Heat Exchanger is running.

3 Verify that the Meter Alarm Panel and TCP modules are switched ON.

4 Verify that the Battery Test Switch on the Meter Alarm Panel is in the OFF position.

5 Verify that no alarm conditions are being reported (with all doors closed).
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Notes
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Chapter 4

Automated Test Procedures (ATP)
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ATP Tests

Introduction

The Automated Acceptance Test Procedure (ATP) allows Motorola
Cellular Field Engineers (CFEs) to run automated acceptance tests on all
equipped BTS subsystem devices using the Local Maintenance Facility
(LMF) and supported test equipment per the current Cell Site Data File
(CDF) assignment.

The results of these tests (at the option of the operator) are written to a
file that can be printed. All tests are controlled via the LMF platform
using the GPIB interface, therefore, only recommended test equipment
supported by the LMF can be used.

This chapter describes the tests run from the GUI environment, which is
the recommended method. The GUI provides the advantages of
simplifying the LMF user interface, reducing the potential for miskeying
commmands and associated parameters, and speeding up the execution
of complex operations involving multiple command strings. If you feel
the command line interface (CLI) will provide additional insight into the
progress of ATPs and problems that could possibly be encountered, refer
to LMF CLI Commands.

NOTE Before using the LMF, use an editor to view the ”CAVEATS”
section in the ”readme.txt” file in the c:\wlmf folder for any
applicable information.

The ATP test is to be performed on out-of-service sectors only.

DO NOT substitute test equipment with other models not
supported by the LMF.

Reduced ATP

NOTE Equipment has been factory-tested for FCC compliance.  If
license-governing bodies require documentation supporting
SITE compliance with regulations, a full ATP may be necessary.
Perform the Reduced ATP only if reports for the specific BTS
site are NOT required.

After downloading the proper operational software to the BTS, the
Cellular Field Engineer (CFE) must perform these procedures (minimal
recommendation):

1 Verify the TX/RX paths by performing TX Calibration, TX Audit
and FER tests.

2 Retrieve Calibration Data required for normal site operation.

Should failures occur while performing the specified tests, refer to the
Basic Troubleshooting section of this manual for help in determining the
failure point. Once the point of failure has been identified and corrected,
refer to the BTS Optimization and ATP Test Matrix section (Table B-1)
to determine the applicable test that must be performed.
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In the unlikely event that the BTS passes these tests but has a forward
link problem during normal operation, the CFE should then perform the
additional TX tests for troubleshooting:  TX spectral mask, TX rho, and
TX code domain.

NOTE Refer to Chapter 3 for detailed information on test set
connections for calibrating equipment, cables and other test set
components, if  required.

Customer requirements determine which ATP tests are to be performed
and the field engineer selects the appropriate ATP tests to run.

The tests can be run individually or as one of the following groups:

� All TX: TX tests verify the performance of the BTS transmit line up.
These include the GLI3, MCC, BBX, and CIO cards, the LPAs and
passive components including splitters, combiners, bandpass filter,
and RF cables.

� All RX: RX tests verify the performance of the BTS receiver line up.
These includes the MPC (for starter frames), EMPC (for expansion
frames), CIO, BBX, MCC, and GLI3 cards and the passive
components including RX filter (starter frame only), and RF cables.

� All TX/RX: Executes all the TX and RX tests.

� Full Optimization: Executes the TX calibration, download BLO, and
TX audit before running all of the TX and RX tests.

ATP Test Prerequisites
Before attempting to run any ATP tests, ensure the following:

� BTS has been optimized and calibrated (see Chapter 3).

� LMF is logged into the BTS.

� CSMs, GLI3s, BBXs, MCCs and TSU (if the RFDS is installed)have
correct code load and data load

� Primary CSM and GLI3 are INS_ACT

� MCCs are INS_ACT.

� BBXs are OOS-RAM.

� BBXs are calibrated and BLOs are downloaded.

� Test cables are calibrated.

� Test equipment is selected.

� Test equipment is connected for ATP tests.

� Test equipment has been warmed up 60 minutes and calibrated.

� GPIB is on.

WARNING Before the FER is run, be sure that all LPAs are turned OFF
(circuit breakers pulled) or that all transmitter ports are properly
terminated.

All transmit ports must be properly terminated for all ATP tests.

Failure to observe these warnings may result in bodily injury or
equipment damage.
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TX/RX OUT Connections
NOTE Table:note.  Note 10pt Helvetica

Many of the acceptance test procedures require taking
measurements at the TX OUT (BTS/RFDS) connector. At sites
with RFDS, all measurements are through the RFDS directional
coupler TX OUT connector.

ATP Test Procedure
There are three different ATP testing options that can be performed to
completely test a BTS. Depending on your requirements, one of the
following ATP testing options should be run. Table 4-1 provides the
procedure to execute an ATP test. To completely test a BTS, run the ATP
tests according to one of the following ATP testing options.

ATP Testing Option 1
� All TX/RX test

ATP Testing Option 2
� All TX test

� All RX test

ATP Testing Option 3
� TX Mask test

� Rho test

� Pilot Time Offset test

� Code Domain Power test

� FER test

NOTE The Full Optimization test can be run if you want the TX path
calibrated before all the TX and RX tests are run.

NOTE If manual testing has been performed with the HP analyzer,
remove the manual control/system memory card from the card
slot and set the IO CONFIG to the Talk & Listen mode before
starting the automated testing.

CDMA 2000 Testing
Software release 2.16.x supports two new pieces of test equipment.
These are the Agilent E4406A with E4432B, as well as the Advantest
R3267 with R3562. The E4406A/E4432B pair, or the R3267/R3562
pair, should be connected together using a GPIB cable. This test
equipment is capable of performing tests in both IS95 mode as well as
cdma2000 mode if the required options are installed:

The HP 8935 with option 200 or R2k for 1X TX and with Agilent
E4432B Signal Generator for 1X FER (see note for options).

NOTE E4432B Signal Generator” for 1X FER.  The options are:
  UN8-Real Time I/Q Baseband Generator
  1E5-High Stability Timebase
  201-Real Time CDMA2000
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Individual Acceptance Tests
The following individual ATP tests can be used to verify the results of
specific tests:

Spectral Purity TX Mask

This test verifies that the transmitted CDMA carrier waveform,
generated on each sector, meets the transmit spectral mask specification
with respect to the assigned CDF file values.

Waveform Quality (rho)

This test verifies that the transmitted Pilot channel element digital
waveform quality (rho) exceeds the minimum specified value in
ANSI-J_STD-019. “Rho” represents the correlation between actual and
perfect CDMA modulation spectrum. A rho value of 1.0000 represents
100% (or perfect correlation).

Pilot Time Offset

The Pilot Time Offset is the difference between the CDMA analyzer
measurement interval (based on the BTS system time reference) and the
incoming block of transmitted data from the BTS (Pilot only, Pilot
Gain = 262, PN Offset = 0).

Code Domain Power

This test verifies code domain power levels, which have been set for all
ODD numbered Walsh channels, using the OCNS command. This is
done by verifying that the ratio of PILOT divided by OCNS is equal to
10.2 + 2 dB, and, that the noise floor of all EVEN numbered “OFF”
Walsh channels measures < -27 dB .

Frame Error Rate

The Frame Error Rate (FER) test verifies RX operation of the entire
CDMA Reverse Link using all equipped MCCs assigned to all
respective sector/antennas. The test verifies the BTS sensitivity on all
traffic channel elements currently configured on all equipped MCCs at
an RF input level of -119 dBm (or -116 dBm if using TMPC). Follow
the procedure in Table 4-1 to perform any ATP test.

NOTE The STOP button can be used to stop the testing process.
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ATP Test Procedure
Table 4-1 describes the step-by-step procedures to run any APT Test.

Table 4-1:  ATP Test Procedure

Step Action

1 Select the device(s) to be tested.

2 From the Tests menu, select the desired test.

3 Select the appropriate carrier(s) (carrier - bts# - sector# - carrier#) displayed in the Channels/Carrier
pick list.

To select multiple items, hold down the <Shift> or <Ctrl> key while making the selections.

4 Type the appropriate channel number in the Carrier n Channels box.

The default channel number displayed is determined by the CdmaChans[n] number in the cbsc-n.cdf
file for the BTS.

5 If applicable, select Verify BLO (default) or Single-sided BLO.

NOTE
Single-sided BLO is only used when checking non-redundant transceivers.

6 For RX select the appropriate RX branch (Both, Main, or Diversity) in the drop-down list.

7 In the Rate Set box, select the appropriate data rate (1=9600, 2=14400, 3=9600 1X) from the
drop-down list.

NOTE
The Rate Set selection of 3 is only available if 1X cards are selected for the test.

8 In the Test Pattern box, select the test pattern to use for the calibration from the drop-down list: Pilot
(default), CDF, CDFPilot or Standard.

9 Click OK.

The status report window and a Directions pop-up are displayed.

10 Follow the cable connection directions as they are displayed.

11 Click Save Results or Dismiss to close the status report window. 

If Dismiss is used the test results will not be saved in the test report file.
 

Background: Tx Mask Test

This test verifies the spectral purity of each BBX2 carrier keyed up at a
specific frequency, per the current CDF file assignment. All tests are
performed using the external calibrated test set, controlled by the same
command. All measurements are through the appropriate TX OUT
(BTS/RFDS) connector.

The Pilot Gain is set to 541 for each antenna and all channel elements
from the MCCs are forward-link disabled. The BBX2 is keyed up, using
both bbxlvl and bay level offsets, to generate a CDMA carrier (with pilot
channel element only). BBX2 power output is set to obtain +40 dBm as
measured at the TX OUT connector (on either the BTS or RFDS
directional coupler).

4



ATP Tests68P09255A57-2

Aug 2002 SC�4812ET Optimization/ATP Manual Software Release R16.1.x.x

PRELIMINARY
4-7

NOTE TX output power is set to +40 dBm by setting BTS power level
to +33.5 dBm to compensate for 6.5 dB increase from pilot gain
set to 541.

The calibrated communications test set measures and returns the
attenuation level of all spurious and IM products in a 30 kHz resolution
bandwidth with respect to the mean power of the CDMA channel,
measured in a 1.23 MHz bandwidth, in dB, verifying that results meet
system tolerances at the following test points:

� 1.9 GHz

- at least -45 dB @ + 885 kHz from center frequency

- at least -45 dB @ - 885 kHz from center frequency

� 800 MHz:

- at least -55 dB @ + 750 kHz from center frequency

- at least -55 dB @ - 750 kHz from center frequency

- at least -60 dB @ + 1980 kHz from center frequency

- at least -60 dB @ - 1980 kHz from center frequency

The BBX2 then de-keys, and, if selected, the MCC is re-configured to
assign the applicable redundant BBX2 to the current TX antenna path
under test. The test is then repeated.

Figure 4-1: TX Mask Verification Spectrum Analyzer Display

-  900 kHz + 900 kHz

Center Frequency
Reference

Attenuation level of all
spurious and IM products
with respect to the mean
power of the CDMA channel

.5 MHz Span/Div
Ampl 10 dB/Div

Mean CDMA Bandwidth 
Power Reference

+750 kHz

+ 1980 kHz

- 750 kHz

- 1980 kHz

FW00282

4



ATP Tests 68P09255A57-2

Aug 2002SC�4812ET Optimization/ATP Manual Software Release R16.1.x.x
PRELIMINARY

4-8

Background: Rho Test

This test verifies the transmitted Pilot channel element digital waveform
quality of each BBX2 carrier keyed up at a specific frequency per the
current CDF file assignment. All tests are performed using the external
calibrated test set controlled by the same command. All measurements
are via the appropriate TX OUT (BTS/RFDS) connector.

The Pilot Gain is set to 262 for each antenna, and all channel elements
from the MCCs will be forward link disabled. The BBX2 is keyed up
using both bbxlvl and bay level offsets, to generate a CDMA carrier
(with pilot channel element only, Walsh code 0). BBX2 power output is
set to 40 dBm as measured at the TX OUT connector (on either the BTS
or RFDS directional coupler).

The calibrated communications test set measures and returns the Pilot
channel element digital waveform quality (rho) in dB, verifying that
result meets system tolerances. Waveform quality (rho) should be

 > 0.912 (-0.4 dB).

The BBX2 then de-keys and the applicable redundant BBX2 is assigned
to the current TX antenna path under test. The test is then repeated.

The LMF Tests menu list item, Rho, performs the waveform quality test
for a XCVR(s). All measurements are made through the appropriate TX
output connector using the calibrated TX cable setup.

Background: Pilot Offset Acceptance Test

This test verifies the transmitted Pilot channel element Pilot Time Offset
of each BBX2 carrier keyed up at a specific frequency per the current
CDF file assignment. All tests are performed using the external
calibrated test set controlled by the same command. All measurements
will be via the appropriate TX OUT (BTS/RFDS) connector.

The Pilot Gain is set to 262 for each antenna and all TCH elements from
the MCCs are forward link disabled. The BBX is keyed up using both
bbxlvl and bay level offsets to generate a CDMA carrier (with pilot
channel element only, Walsh code 0). BBX power output is set to
40 dBm as measured at the TX OUT connector (on either the BTS or
RFDS directional coupler).

The calibrated communications test set measures and returns the Pilot
Time Offset in uS, verifying results meet system tolerances. Pilot Time
Offset should be within < 3 µs of the target PT Offset (0 �S).

The BBX2 then de-keys, and the applicable redundant BBX2 is assigned
to the current TX antenna path under test. The test is then repeated.
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Background: Code Domain Power Test

This test verifies the Code Domain Power/Noise of each BBX2 carrier
keyed up at a specific frequency per the current CDF file assignment.
All tests are performed using the external calibrated test set controlled by
the same command. All measurements are via the appropriate TX OUT
(BTS/RFDS) connector.

For each sector/antenna under test, the Pilot Gain is set to 262 and all
MCC channel elements under test are configured to generate Orthogonal
Channel Noise Source (OCNS) on different odd Walsh codes, and are
assigned a full-rate gain of 81. The maximum number of MCC/CEs to
be tested at any one time is 32 (32 odd Walsh codes). If more than 32
CEs exist, then multiple sets of measurements are made, so all channel
elements are verified on all sectors.

BBX2 power output is set to 40 dBm as measured at the TX OUT
connector (on either the BTS or RFDS directional coupler).

Code domain power levels, which have been set for all ODD numbered
Walsh channels, are verified using the OCNS command. This is done by
verifying that Pilot Power (dBm) minus OCNS Power (dBm) is equal to
10.2 + 2 dB and that the noise floor of all “OFF” Walsh channels
measures  < -27 dB (with respect to total CDMA channel power).

The BBX2 then de-keys and, the applicable redundant BBX2 is assigned
to the current TX antenna path under test. The test is then repeated.
Upon completion of the test, OCNS is disabled on the specified
MCC/CE.
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Figure 4-2: Code Domain Power and Noise Floor Levels
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Background: FER Test

This test verifies the BTS FER on all traffic channel elements currently
configured on all equipped MCCs (full rate at 1% FER) at an RF input
level of -119 dBm [or -116 dBm if using Tower Top Amplifier
(TMPC)]. All tests are performed using the external calibrated test set as
the signal source controlled by the same command. All measurements
will be via the LMF.

The pilot gain is set to 262 for each TX antenna and all channel elements
from the MCCs are forward-link disabled. The BBX2 is keyed up using
only bbxlvl level offsets, to generate a CDMA carrier (with pilot channel
element only). BBX2 power output is set to -20 dBm as measured at the
TX OUT connector (on either the BTS or RFDS directional coupler).
The BBX2 must be keyed in order to enable the RX receive circuitry.
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The LMF prompts the MCC/CE under test to measure all zero longcode
and provide the FER report on the selected active MCC on the reverse
link for both the main and diversity RX antenna paths, verifying the
results meet the following specification: FER returned less than 1% and
total frames measured is 1500.

All MCC/CEs selected are tested on the specified RX antenna path. The
BBX then de-keys and, the applicable redundant BBX2 is assigned to
the current RX antenna paths under test. The test is then repeated.

Background

Each time an ATP test is run, an ATP report is updated to include the
results of the most recent ATP tests if the Save Results button is used to
close the status report window. The ATP report will not be updated if the
status reports window is closed with use of the Dismiss button.

ATP Report

A separate report is created for each BTS and includes the following for
each test:

� Test name

� BBX number

� Channel number

� Carrier number

� Sector number

� Upper test limit

� Lower test limit

� Test result

� PASS or FAIL

� Description information (if applicable)

� Time stamp

� Details/Warning information (if applicable)

Follow the procedure in the Table 4-2 to view and create a printable file
for the ATP report of a BTS.

Table 4-2:  Generate an ATP  Report 

Step Action

1 Click on the Login tab if it is not in the forefront.

2 Select the desired BTS from the Available Base Stations pick list.

3 Click on the Report button.

4 Sort the report if desired by clicking on a column heading.

5 Click on the Dismiss button if you do not want to create a printable file copy.

6 To create a printable file, select the desired file type in the picklist and then click on the Save button.
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Notes
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Chapter 5

Prepare to Leave the Site
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Initializing Active Service

External Test Equipment Removal

Perform the procedure in Table 5-1 to disconnect the test equipment and
configure the BTS for active service.

Table 5-1: External Test Equipment Removal

Step Action

1 Disconnect all external test equipment from all TX and RX connectors at the rear of the frame.

2 Reconnect and visually inspect all TX and RX antenna feed lines at the rear of the frame.

CAUTION Verify all sector antenna feed lines are connected to the correct
ports on the frame. Crossed antenna cables will cause system
degradation of call processing. 

Reset All Devices

Reset all devices by cycling power before leaving the site. The CBSC
configuration data and code loads could be different from data and code
on the LMF. By resetting all devices, the CBSC can load the proper data
and code when the span is active again.

Updating BTS CAL LMF Files in the CBSC
Updated CAL file information is moved from the LMF Windows
environment back to the CBSC which resides in a Unix environment.
The procedures that follow detail how to move files from the Windows
environment to the CBSC.

Copying CAL files from LMF to a Disk

Follow the procedures in Table 5-2 to copy CAL files from a LMF
computer to a 3.5 diskette.

Table 5-2: Copy Files from LMF to a Diskette

Step Action

1 Insert a disk into your Windows A drive.

NOTE
If your disk has not been formatted, format it using Windows.  The disk must be DOS formatted
before copying any files. Consult your Windows/DOS documentation or online helps on how to
format diskettes.

2 Click on the Start button and launch the Windows Explorer program from your Programs menu list.

3 Click on your C: drive.

4 Double Click on the wlmf folder.

5 Double Click on the CDMA folder.
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Table 5-2: Copy Files from LMF to a Diskette

Step Action

6 Click on the bts-#  folder for the calibration file you want to copy.

7 Drag the BTS-#.cal  file to the 3-1/2 floppy (A:) icon on the top left of the screen and release the
mouse button.

8 Continue step 6 and 7 until you have copied each file desired and close the Windows Explorer
program by selecting Close from the File menu option.

 

Copying CAL files from diskette to the CBSC

Follow the procedure in Table 5-3 to copy CAL files from a diskette to
the CBSC.

Table 5-3: Copy CAL Files From Diskette to the CBSC

Step Action

1 Log into the CBSC workstation.

2 Place your diskette containing CAL file(s) in the CBSC workstation diskette drive.

3 Enter eject -q and press the Enter key.

4 Enter mount and press the Enter key.  Verify that  floppy/no_name is displayed.

NOTE
If the eject command has been previously entered, floppy/no_name will be appended with a number.
Use the explicit floppy/no_name reference displayed.

5 Enter cd /floppy/no_name and press the Enter key.

6 Enter ls -lia and press the Enter key.  Verify that the bts-#.cal  file is on the disk.

7 Enter cd and press the Enter key.

8 Enter pwd and press the Enter key.  Verify that you are in your  home directory (/home/<name>).

9 Enter dos2unix /floppy/no_name/bts-#.cal  bts-#.cal  and press the Enter key (where # is the BTS
number).

10 Enter ls -l *.cal and press the Enter key.  Verify that the CAL file was successfully copied.

11 Enter eject and press the Enter key.

12 Remove the floppy disk from the workstation.

 

BTS Site Span Configuration Verification

Perform the procedure in Table 5-4 to verify the current Span Framing
Format and Line Build Out (LBO) parameters. ALL MGLI3/SGLI3
boards in all C-CCP shelves that terminate a T1/E1 span should be
verified.
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Table 5-4: BTS Span Parameter Configuration

Step Action

1 Connect a serial cable from the LMF COM1 port (via null modem board) to the front panel of the
MGLI3 MMI port (see Figure 5-1).

2 Start an MMI communication session with CSM-1 by using the Windows desktop shortcut icon.

NOTE
The LMF program must not be running when a Hyperterminal session is started if COM1 is being
used for the MMI session.

3 Enter the following MMI command to display the current MGLI3/SGLI3 framing format and line
code configuration (in bold type):

span view <cr>

Observe a display similar to the options shown below:

COMMAND ACCEPTED: span view

The parameter in NVM is set to T1_2.

The frame format in flash is set to use T1_2.
Equalization:
  Span A - Default (0-131 feet for T1/J1, 120 Ohm for E1)
  Span B - Default (0-131 feet for T1/J1, 120 Ohm for E1)
  Span C - Default (0-131 feet for T1/J1, 120 Ohm for E1)

S D D f lt (0 131 f t f T1/J1 120 Oh f E1)  Span D - Default (0-131 feet for T1/J1, 120 Ohm for E1)
  Span E - Default (0-131 feet for T1/J1, 120 Ohm for E1)
  Span F - Default (0-131 feet for T1/J1, 120 Ohm for E1)

Linkspeed: Default (56K for T1 D4 AMI, 64K otherwise)
Currently, the link is running at the default rate 
The actual rate is 0

NOTE
Defaults for span equalization are 0-40 m for T1/J1 spans and 120 Ohm for E1.

Default linkspeed is 56K for T1 D4 AMI spans and 64K for all other types.

There is no need to change from defaults unless the OMC-R/CBSC span configuration requires it.

If the current MGLI3/SGLI3 framing format and line code configuration does not display the correct
choice, proceed to Table 5-5.

4 Repeat steps 1 through 3 for all remaining GLIs.

5 Exit the GLI MMI session and HyperTerminal connection by selecting File from the connection
window menu bar, and then Exit from the dropdown menu.
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Figure 5-1: MGLI3/SGLI3 MMI Port Connection

REF-  FW00344

9-PIN TO 9- PIN
RS-232 CABLE

NULL MODEM BOARD
(PART# 8484877P01)

RS-232 CABLE 
FROM LMF COM1
PORT

MMI SERIAL PORT

GLI BOARD

Set BTS Site Span Configuration

Perform the procedure in Table 5-5 to configure the Span Framing
Format and Line Build Out (LBO) parameters. ALL MGLI3/SGLI3
boards in all C-CCP shelves that terminate a T1/E1 span must be
configured.

NOTE Perform the following procedure ONLY if span configurations
loaded in the MGLI3/GLI3s do not match those in the
OMCR/CBSC data base, AND ONLY when the exact
configuration data is available. Loading incorrect span
configuration data will render the site inoperable.

Table 5-5: Set BTS Span Parameter Configuration

Step Action

1 If not already done, connect a serial cable from the LMF COM1 port (via null modem board) to the
front panel of the MGLI3 MMI port (see Figure 5-1).

2 Start an MMI communication session with CSM-1 by using the Windows desktop shortcut icon (see
Table 3-5 on page 3-17).

NOTE
The LMF program must not be running when a Hyperterminal session is started if COM1 is being
used for the MMI session.

. . . continued on next page
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Table 5-5: Set BTS Span Parameter Configuration

Step Action

3 If required only, enter the following MMI command for each span line to set the BTS span parameters
to match that of the physical spans a - f run to the site:

span_config <option#1> <option#2> <option#3> <option#4> <option#5>
option#1   =  the span to change (a - f)
option#2   =  the span type (0 - 8):

0 - E1_1 (HDB3, CCS, CRC-4)
1 - E1_2 (HDB3, CCS)
2 - E1_3 (HDB3, CAS, CRC-4, TS16)
3 - E1_4 (HDB3, CAS, TS16)
4 - T1_1 (AMI, DS1 AT&T D4, without ZCS, 3 to 1 packing, Group 0 unusable)
5 - T1_2 (B8ZS, DS1 AT&T ESF, 4 to 1 packing, 64K link)
6 - J1_1 (B8ZS, J1 AT&T ESF, Japan CRC6, 4 to 1 packing)
7 - J1_2 (B8ZS, J1 AT&T ESF, US CRC6, 4 to 1 packing)
8 - T1_3 (AMI, DS1 AT&T D4, with ZCS, 3 to 1 packing, Group 0 unusable)

option#3   =  the link speed (56 or 64) Kbps

option#4   =  the span equalization (0 - 7):
0 - T1_6 (T1,J1:long haul)
1 - T1_4 (T1,J1:393-524 feet)
2 - T1_4 (T1,J1:131-262 feet)
3 - E1_75 (E1:75 Ohm)
4 - T1_4 (T1,J1:0-131 feet)
5 - T1_4 (T1,J1:524-655 feet)
6 - T1_4 (T1,J1:262-393 feet)
7 - E1_120 (E1:120 Ohm)

option#5   =  the slot that has LAPD channel (0 - 31)

Example for setting span configuration to E1_2, 64 Kbps, E1_120-Ohm, LAPD channel 1:

span_config a 1 64 7 1
.
.

span_config f 1 64 7 1

Example for setting span configuration to T1_2, 64 Kbps, T1_4 (0-131 feet), LAPD channel 0:

span_config a 5 64 4 0
.
.

span_config f 5 64 4 0

* IMPORTANT
Make sure that spans a - f are set to the same span type and link speed. The equalization may be
different for each individual span.

After executing the span_config command, the affected MGLI3/SGLI3 board MUST be reset and
re-loaded for changes to take effect.

Although defaults are shown, always consult site specific documentation for span type and rate used at
the site.

4 Press the RESET button on the GLI3 for changes to take effect.
. . . continued on next page
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Table 5-5: Set BTS Span Parameter Configuration

Step Action

5 This completes the site specific BTS Span setup for this GLI. Move the MMI cable to the next SGLI3
and repeat steps 1 and 4 for ALL MGLI3/SGLI3 boards.

6 Terminate the Hyperterm session and disconnect the LMF from the MGLI/SGLI.
 

Re-connect  BTS T1 Spans and Integrated Frame Modem

Before leaving the site, connect any T1 span TELCO connectors which
were removed to allow the LMF to control the BTS. Refer to Table 5-6.

Table 5-6: T1/E1 Span/IFM Connections

Step Action

1 Connect the surge protectors on the 50-pin punch block for the spans.

2 Ensure that the CSU is powered ON.

3 Verify the span status.

LMF Removal

CAUTION DO NOT power down the CDMA LMF without performing the
procedure indicated below. Corrupted/lost data files may result,
and in some cases, the CDMA LMF may lock up.

Follow the procedures in Table 5-7 to terminate the LMF session and
remove the terminal.

Table 5-7: Terminate the LMF Session and Remove the LMF

Step Action

1 From the CDMA window select File>Exit.

2 From the Windows Task Bar click Start>Shutdown. Click Yes when the Shut Down Windows
message appears.

3 Disconnect the LMF terminal Ethernet connector from the BTS cabinet.

4 Disconnect the LMF serial port, the RS-232 to GPIB interface box, and the GPIB cables as required
for equipment transport.

Reestablish OMC-R Control/ Verifying T1/E1

NOTE After all activities at the site have been completed, including
disconnecting the LMF, place a phone call to the OMC-R and
request the BTS be placed under control of the OMC-R.
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Chapter 6

Troubleshooting
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Troubleshooting

Overview

The information in this chapter addresses some of the scenarios likely to
be encountered by Customer Field Engineering (CFE) team members.
This troubleshooting guide was created as an interim reference document
for use in the field. It provides basic “what to do if” basic
troubleshooting suggestions when the BTS equipment does not perform
per the procedure documented in the manual.

Comments are consolidated from inputs provided by CFEs in the field
and information gained form experience in Motorola labs and
classrooms.

Cannot Log into Cell-Site

Follow the procedure in Table 6-1 to troubleshoot any Login Failure
problem during normal operation.

Table 6-1:  Login Failure Troubleshooting Procedure

� Step Action

1 If MGLI3 LED is solid RED, it implies a hardware failure. Reset MGLI3 by re-seating it. If this
persists, install RGLI3 card in MGLI3 slot and retry. A Red LED may also indicate no Ethernet
termination at top of frame.

2 Verify that T1 is disconnected at the Channel Signaling Unit (CSU). If T1 is still connected,
verify the CBSC has disabled the BTS.

3 Try ‘ping’ing the MGLI3.

4 Verify the LMF is connected to the Primary LMF port (LAN A) in front of the BTS.

5 Verify the LMF was configured properly.

6 Verify the BTS-LMF cable is RG-58 (flexible black cable of less than 2.5 feet length).

7 Verify the Ethernet ports are terminated properly.

8 Verify a T-adapter is not used on LMF side port if connected to the BTS front LMF primary
port.

9 Try connecting to the I/O panel (back of frame). Use Tri-Ax to BNC adapter at the LMF port for
this connection.

10 Re-boot the CDMA LMF and retry.

11 Re-seat the MGLI3 and retry.

12 Verify IP addresses are configured properly.
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Cannot Communicate to Power Meter
Follow the procedure in Table 6-2 to troubleshoot a power meter
communication failure.

Table 6-2:  Troubleshooting a Power Meter Communication Failure

� Step Action

1 Verify Power Meter is connected to LMF with GPIB adapter.

2 Verify cable setup as specified in Chapter 3.

3 Verify the GP-IB address of the Power Meter is set to 13. Refer to Test Equipment setup section
of Chapter 3 for details.

4 Verify that Com1 port is not used by another application.

5 Verify that the communications analyzer is in Talk&Listen, not Control mode.

 

Cannot Communicate to Communications Analyzer
Follow the procedure in Table 6-3 to troubleshoot a communication
analyzer failure.

Table 6-3:  Troubleshooting a Communications Analyzer Communication Failure

� Step Action

1 Verify analyzer is connected to LMF with GPIB adapter.

2 Verify cable setup.

3 Verify the GPIB address is set to 18.

4 Verify the GPIB adapter DIP switch settings are correct. Refer to Test Equipment setup section
for details.

5 Verify the GPIB adapter is not locked up. Under normal conditions, only 2 green LEDs must be
‘ON’ (Power and Ready). If any other LED is continuously ‘ON’, then power-cycle the GPIB
Box and retry.

6 If a Hyperterm window is open for MMI, close it.

7 Verify the LMF GPIB address is set to 18

8 Verify the analyzer is in Talk and Listen not Control mode.

 

Code Download Failure
Follow the procedure in Table 6-4 to troubleshoot any code download
failure.

Table 6-4: Troubleshooting Code Download Failure

� Step Action

1 Verify T1 is disconnected from the BTS at CSU.

2 Verify LMF can communicate with the BTS device using the Status function.

. . . continued on next page
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Table 6-4: Troubleshooting Code Download Failure

� ActionStep

3 Communication to MGLI3 must first be established before trying to talk to any other BTS
device. MGLI3 must be INS_ACT state (green).

4 Verify the card is physically present in the cage and powered-up.

5 If card LED is solid RED, it implies hardware failure. Reset card by re-seating it. If this persists,
replace card from another slot & retry.

NOTE
The card can only be replaced by a card of the same type.

6 Re-seat card and try again.

7 If BBX reports a failure message and is OOS_RAM, the code load was OK. Status it.

8 If the download portion completes and the reset portion fails, reset the device by selecting the
device and reset.

 

Cannot Download DATA to Any Device (Card)
Follow the procedure in Table 6-5 to troubleshoot any data download
failure.

Table 6-5: Troubleshooting Data Download Failure

� Step Action

1 Re-seat card and repeat code and data load procedure.

2 Verify the ROM and RAM code loads are of the same release by statusing the card. Refer to
Chapter 3, “Download the BTS” for more information.

Cannot ENABLE Device
Before a device can be enabled (placed in-service), it must be in the
OOS_RAM state (yellow on the LMF) with data downloaded to the
device. The color of the device on the LMF changes to green, once it is
enabled.

The three states that devices can be displayed:

� Enabled (green, INS)

� Disabled (yellow, OOS_RAM)

� Reset (blue, OOS_ROM)

Follow the procedure in Table 6-6 to troubleshoot device enable failure.

Table 6-6: Troubleshooting Device Enable (INS) Failure

� Step Action

1 Re-seat card and repeat code and data load procedure.

2 If CSM cannot be enabled, verify the CDF file has correct latitude and longitude data for cell
site location and GPS sync.

. . . continued on next page
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Table 6-6: Troubleshooting Device Enable (INS) Failure

� ActionStep

3 Ensure primary CSM is in INS_ACT state.

NOTE
MCCs will not go INS without the CSM being INS.

4 Verify 19.6608 MHz CSM clock; MCCs will not go INS otherwise.

5 The BBX should not be enabled for ATP tests.

6 If MCCs give “invalid or no system time,” verify the CSM is enabled.

 

LPA Errors
Follow the procedure in Table 6-7 to troubleshoot any LPA errors.

Table 6-7: LPA Errors

� Step Action

1 If LPAs continue to give alarms, even after cycling power at the circuit breakers, then connect an
MMI cable to the LPA and set up a Hyperterminal connection. Enter ALARMS in the
Hyperterminal window. The resulting LMF display may provide an indication of the problem.
(Call Field Support for further assistance.)

Bay Level Offset Calibration Failure
Follow the procedure in Table 6-8 to troubleshoot a BLO calibration
failure.

Table 6-8: Troubleshooting BLO Calibration Failure

� Step Action

1 Verify the Power Meter is configured correctly (see the test equipment setup section) and
connection is made to the proper TX port.

2 Verify the parameters in the bts-#.cdf file are set correctly for the following bands:

For 1900 MHz:
BandClass=1; FreqBand=16

For 800 MHz:
BandClass=0; FreqBand=8

3 Verify that no LPA in the sector is in alarm state (flashing red LED). Reset the LPA by pulling
the circuit breaker, and after 5 seconds, pushing back in.

4 Re-calibrate the Power Meter and verify it is calibrated correctly with cal factors from sensor
head.

5 Verify GPIB adapter is not locked up. Under normal conditions, only 2 green LEDs must be
‘ON’ (Power and Ready). If any other LED is continuously ‘ON’, power-cycle (turn power off
and on) the GPIB Box and retry.

6 Verify sensor head is functioning properly by checking it with the 1 mW (0 dBm) Power Ref
signal.

. . . continued on next page
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Table 6-8: Troubleshooting BLO Calibration Failure

� ActionStep

7 If communication between the LMF and Power Meter is operational, the Meter display will
show “RES :’’

8 Verify the combiner frequency is the same as the test freq/chan.

 

Calibration Audit Failure

Follow the procedure in Table 6-9 to troubleshoot a calibration audit
failure.

Table 6-9: Troubleshooting Calibration Audit Failure

� Step Action

1 Verify Power Meter is configured correctly (refer to the test equipment setup section of chapter
3).

2 Re-calibrate the Power Meter and verify it is calibrated correctly with cal factors from sensor
head.

3 Verify that no LPA is in alarm state (rapidly flashing red LED). Reset the LPA by pulling the
circuit breaker, and, after 5 seconds, pushing back in.

4 Verify that no sensor head is functioning properly by checking it with the 1 mW (0 dBm) Power
Ref signal.

5 After calibration, the BLO data must be re-loaded to the BBX2s before auditing. Click on the
BBX(s) and select Device>Download BLO
Re-try the audit.

6 Verify GPIB adapter is not locked up. Under normal conditions, only 2 green LEDs must be
‘ON’ (Power and Ready). If any other LED is continuously ‘ON’, power-cycle (turn power off
and on) the GP-IB Box and retry.

 

Forward link problem

If the BTS passes the reduced ATP tests but has a forward link problem
during normal operation follow the procedure in Table 6-10 to
troubleshoot.

Table 6-10: Troubleshooting Forward Link Failure (BTS Passed Reduced ATP)

� Step Action

1 Perform these additional TX tests to troubleshoot a forward link problem:

- TX mask

- TX  rho

- TX code domain
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Cannot Perform Txmask Measurement

Follow the procedure in Table 6-11 to troubleshoot a TX Mask
Measurement failure.

Table 6-11: Troubleshooting TX Mask Measurement Failure

� Step Action

1 Verify that TX audit passes for the BBX(s).

2 If performing manual measurement, verify analyzer setup.

3 Verify that no LPA in the sector is in alarm state (flashing red LED). Re-set the LPA by pulling
the circuit breaker, and, after 5 seconds, pushing it back in.

Cannot Perform Rho or Pilot Time Offset Measurement

Follow the procedure in Table 6-12 to troubleshoot a rhoand pilot time
offset measurement failure.

Table 6-12: Troubleshooting Rho and Pilot Time Offset Measurement Failure

� Step Action

1 Verify presence of RF signal by switching to spectrum analyzer screen.

2 Verify PN offsets displayed on the analyzer is the same as the PN offset in the CDF file.

3 Re-load MGLI3 data and repeat the test.

4 If performing manual measurement, verify analyzer setup.

5 Verify that no LPA in the sector is in alarm state (flashing red LED). Reset the LPA by pulling
the circuit breaker, and, after 5 seconds, pushing back in.

6 If Rho value is unstable and varies considerably (e.g. .95,.92,.93), this may indicate that the
GPS is still phasing (i.e. trying to reach and maintain 0 freq. error). Go to the freq. bar in the
upper right corner of the Rho meter and select Hz. Press <Shift-avg> and enter 10, to obtain an
average Rho value. This is an indication the GPS has not stabilized before going INS and may
need to be re-initialized.

 

Cannot Perform Code Domain Power and Noise Floor Measurement

Follow the procedure in Table 6-13 to troubleshoot code domain and
noise floor measurement failure.

Table 6-13: Troubleshooting Code Domain Power and Noise Floor Measurement Failure

� Step Action

1 Verify presence of RF signal by switching to spectrum analyzer screen.

2 Verify PN offset displayed on analyzer is same as PN offset being used in the CDF file.

3 Disable and re-enable MCC (one or more MCCs based on extent of failure).
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Cannot Perform Carrier Measurement
Follow the procedure in Table 6-14 to troubleshoot carrier measurement
failure.

Table 6-14: Troubleshooting Carrier Measurement Failure

� Step Action

1 Perform the test manually, using the spread CDMA signal. Verify High Stability 10 MHz
Rubidium Standard is warmed up (60 minutes) and properly connected to test set-up.

Multi-FER  Test Failure
Follow the procedure in Table 6-15 to troubleshoot multi-FER failure.

Table 6-15: Troubleshooting Multi-FER Failure

� Step Action

1 Verify test equipment set up is correct for a FER test.

2 Verify test equipment is locked to 19.6608 and even second clocks. The yellow
LED (REF UNLOCK) must be OFF.

3 Verify MCCs have been loaded with data and are INS-ACT.

4 Disable and re-enable the MCC (one or more based on extent of failure).

5 Disable, re-load code and data, and re-enable MCC (one or more MCCs based on
extent of failure).

6 Verify antenna connections to frame are correct based on the directions messages.

 

Problem Description
Many of the Clock Synchronization Manager (CSM) boards may be
resolved in the field before sending the boards to the factory for repair.
This section describes known CSM problems identified in field returns,
some of which are field-repairable. Check these problems before
returning suspect CSM boards.

Intermittent 19.6608 MHz Reference Clock/GPS Receiver Operation
If having any problems with CSM board kit numbers, SGLN1145 or
SGLN4132, check the suffix with the kit number. If the kit has version
“AB,” then replace with version ‘‘BC’’ or higher, and return model AB
to the repair center.

No GPS Reference Source
Check the CSM boards for proper hardware configuration. RF-GPS
(Local GPS) - CSM kit SGLN1145, which should be installed in Slot l,
has an on-board GPS receiver; while kit SGLN4132, in Slot 2, does not
have a GPS receiver.
Remote GPS (R-GPS) - Kit SGLN4132ED or later, which should be
installed in both Slot 1 and Slot 2, does not have a GPS receiver. Any
incorrectly configured board must be returned to the repair center. Do not
attempt to change hardware configuration in the field. Also, verify the
GPS antenna is not damaged and is installed per recommended
guidelines.
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Checksum Failure
The CSM could have corrupted data in its firmware resulting in a
non-executable code. The problem is usually caused by either electrical
disturbance, or interruption of data during a download. Attempt another
download with no interruptions in the data transfer. Return CSM board
back to repair center if the attempt to reload fails.

GPS Bad RX Message Type

This is believed to be caused by a later version of CSM software (3.5 or
higher) being downloaded, via LMF, followed by an earlier version of
CSM software (3.4 or lower), being downloaded from the CBSC.
Download again with CSM software code 3.5 or higher. Return CSM
board back to repair center if attempt to reload fails.

CSM Reference Source Configuration Error
This is caused by incorrect reference source configuration performed in
the field by software download. CSM kit SGLN1145 and SGLN4132
must have proper reference sources configured (as shown below) to
function correctly.

CSM Kit No. Hardware Configuration CSM Slot No. Reference Source Configuration

SGLN1145 With GPS Receiver 1 Primary = Local GPS
Backup = Either LFR or HSO

SGLN4132ED
or later

Without GPS Receiver 2 Primary = Remote GPS
Backup = Either LFR or HSO

Takes Too Long for CSM to Come INS

This may be caused by a delay in GPS acquisition. Check the accuracy
flag status and/or current position. Refer to the GSM system time/GPS
and LFR/HSO verification section in Chapter 3. At least 1 satellite
should be visible and tracked for the “surveyed” mode and 4 satellites
should be visible and tracked for the “estimated” mode. Also, verify
correct base site position data used in “surveyed” mode.
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C-CCP  Backplane

The C-CCP backplane is a multi-layer board that interconnects all the
C-CCP modules.  The complexity of this board lends itself to possible
improper diagnoses when problems occur.

Connector Functionality

The following connector overview describes the major types of
backplane connectors along with the functionality of each. This will
allow the Cellular Field Engineer (CFE) to:

� Determine which connector(s) is associated with a specific problem
type.

� Allow the isolation of problems to a specific cable or connector.

Primary “A” and Redundant “B” ISB (Inter Shelf Bus)
connectors

The 40 pin ISB connectors provide an interface bus from the master
GLI3 to all other GLI3s in the modem frame. Its basic function is to
provide clock synchronization from the master GLI3 to all other GLI3s
in the frame.

The ISB is also provides the following functions:

� Groom span line when a single span is used for multiple cages.

� Provide MMI connection to/from the master GLI3 to cell site modem.

� Provide interface between GLI3s and the AMR (for reporting BTS
alarms).

Span Line Connector

The span line input is an 8 pin RJ-45 connector that provides a primary
and secondary (if used) span line interface to each GLI3 in the C-CCP
shelf.  The span line is used for MM/EMX switch control of the Master
GLI3 and also all the BBX traffic.

Power Input (Return A, B, and C connectors)

Provides a +27 Volt input for use by the power supply modules.

Power Supply Module Interface

Each power supply module has a series of three different connectors to
provide the needed inputs/outputs to the C-CCP backplane. These
include a VCC/Ground input connector, a Harting style multiple pin
interface, and a +15 V/Analog Ground output connector. The Transceiver
Power Module converts 27/48 Volts to a regulated +15, +6.5, +5.0 Volts
to be used by the C-CCP shelf cards.

GLI3 Connector

This connector consists of a Harting 4SU digital connector and a
6-conductor  coaxial connector for RDM distribution. The connectors
provide inputs/outputs for the GLI3s in the C-CCP backplane.
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GLI3 Ethernet “A” and “B” Connections

These BNC connectors are located on the C-CCP backplane and routed
to the GLI3 board.  This interface provides all the control and data
communications between the master GLI3 and the other GLI3, between
gateways, and for the LMF on the LAN.

BBX2 Connector

Each BBX connector consists of a Harting 2SU/1SU digital connector
and two 6-conductor coaxial connectors.  These connectors provide DC,
digital, and RF inputs/outputs for the BBXs in the C-CCP backplane.

CIO Connectors
� RX RF antenna path signal inputs are routed through RX Tri-Filters

(on the I/O plate), and via coaxial cables to the two MPC modules -
the six “A” (main) signals go to one MPC; the six “B” (diversity) to
the other.  The MPC outputs the low-noise-amplified signals via the
C-CCP backplane to the CIO where the signals are split and sent to
the appropriate BBX.

� A digital bus then routes the baseband signal through the BBX, to the
backplane, then on to the MCC slots.

� Digital TX antenna path signals originate at the MCC24s. Each
output is routed from the MCC slot via the backplane appropriate
BBX.

� TX RF path signal originates from the BBX, through the backplane to
the CIO, through the CIO, and via multi-conductor coaxial cabling to
the LPAs in the LPA shelf.

C-CCP  Backplane Troubleshooting Procedure
The following table provides a standard procedure for troubleshooting
problems that appear to be related to a defective C-CCP backplane. The
table is broken down into possible problems and steps which should be
taken in an attempt to find the root cause.

NOTE It is important to note that all steps be followed before replacing
ANY C-CCP backplane.

Digital Control Problems

No GLI3 Control via LMF (all GLI3s)

Follow the procedure in Table 6-16 for problems with GLI3 control.

Table 6-16: No GLI3 Control via LMF (all GLI3s)

Step Action

1 Check the ethernet for proper connection, damage, shorts, or opens.

2 Verify C-CCP backplane Shelf ID DIP switch is set correctly.

3 Visually check the master GLI3 connector (both board and backplane) for damage.

4 Replace the master GLI3 with a known good GLI3.
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No GLI3 Control through Span Line Connection (All
GLI3s)

Follow the procedure in Table 6-17 for problems with GLI3 control.

Table 6-17: No GLI3 Control through Span Line Connection (Both GLI3s)

Step Action

1 Verify C-CCP backplane Shelf ID DIP switch is set correctly.

2 Verify that the BTS and GLI3s are correctly configured in the OMCR/CBSC data base.

3 Visually check the master GLI3 connector (both board and backplane) for damage.

4 Replace the master GLI3 with a known good GLI3.

5 Check the span line inputs from the top of the frame to the master GLI3 for proper connection and
damage.

MGLI3 Control Good - No Control over Co-located GLI3

Follow the procedure in Table 6-18 for problems with GLI3 control.

Table 6-18: MGLI3 Control Good - No Control over Co-located GLI3

Step Action

1 Verify that the BTS and GLI3s are correctly configured in the OMCR CBSC data base.

2 Check the ethernet for proper connection, damage, shorts, or opens.

3 Visually check all GLI3 connectors (both board and backplane) for damage.

4 Replace the remaining GLI3 with a known good GLI3.

 

No AMR Control (MGLI3 good)

Follow the procedure in Table 6-19 for problems with AMR control.

Table 6-19: MGLI3 Control Good - No Control over AMR

Step Action

1 Visually check the master GLI3 connector (both board and backplane) for damage.

2 Replace the master GLI3 with a known good GLI3.

3 Replace the AMR with a known good AMR.

No BBX Control in the Shelf

Follow the procedure in Table 6-20 for problems with co-located GLI3.

Table 6-20: MGLI3 Control Good - No Control over Co-located GLI3s

Step Action

1 Visually check all GLI3 connectors (both board and backplane) for damage.

2 Replace the remaining GLI3 with a known good GLI3.

3 Visually check BBX connectors (both board and backplane) for damage.

4 Replace the BBX with a known good BBX.
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No (or Missing) Span Line Traffic

Follow the procedure in Table 6-21 for problems with span line traffic.

Table 6-21: BBX Control Good - No (or Missing) Span Line Traffic

Step Action

1 Visually check all GLI3 connectors (both board and backplane) for damage.

2 Replace the remaining GLI3 with a known good GLI3.

3 Visually check all span line distribution (both connectors and cables) for damage.

4 If the problem seems to be limited to 1 BBX, replace the BBX with a known good BBX.

No (or Missing) MCC24 Channel Elements

Follow the procedure in Table 6-22 for problems with channel elements.

Table 6-22: No MCC-1X/MCC24E/MCC8E Channel Elements

Step Action

1 Verify channel elements on a co-located MCC of the same      type (CDF MccType codes:
MCC8E = 0; MCC24E = 2; MCC-1X = 3)

2 Check MCC connectors (both module and backplane) for damage.

3  If the problem seems to be limited to one MCC, replace it with a known good MCC of the same
type.

4 If no channel elements on any MCC, verify clock reference to CIO.
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DC Power Problems

WARNING Potentially lethal voltage and current levels are routed to the
BTS equipment. This test must be carried out with a second
person present, acting in a safety role. Remove all rings, jewelry,
and wrist watches prior to beginning this test.

No DC Input Voltage to  Power Supply Module

Follow the procedure in Table 6-23 for problems with DC input voltage.

Table 6-23: No DC Input Voltage to Power Supply Module

Step Action

1 Verify DC power is applied to the BTS frame. Verify there are no breakers tripped.

* IMPORTANT
If a breaker has tripped, remove all modules from the applicable shelf supplied by the breaker and
attempt to reset it.

- If breaker trips again, there is probably a cable or breaker problem within the frame.

- If breaker does not trip, there is probably a defective module or sub-assembly within the
shelf.

2 Verify that the C-CCP shelf breaker on the BTS frame breaker panel is functional.

3 Use a voltmeter to determine if the input voltage is being routed to the C-CCP backplane by
measuring the DC voltage level on the PWR_IN cable.

- If the voltage is not present, there is probably a cable or breaker problem within the frame.

- If the voltage is present at the connector, reconnect and measure the level at the “VCC” power
feed clip on the distribution backplane.  If the voltage is correct at the power clip, inspect the
clip for damage.

4 If everything appears to be correct, visually inspect the power supply module connectors.

5 Replace the power supply module with a known good module.

6 If steps 1 through 4 fail to indicate a problem, the C-CCP backplane failure (possibly an open
trace) has occurred.

No DC Voltage (+5, +6.5, or +15 Volts) to a Specific GLI3,
BBX2, or Switchboard

Follow the procedure in Table 6-24 for problems with DC input voltage.

Table 6-24: No DC Input Voltage to any C-CCP Shelf Module

Step Action

1 Verify steps outlined in Table 6-23 have been performed.

2 Inspect the defective board/module (both board and backplane) connector for damage.

3 Replace suspect board/module with known good board/module.

SC�4812ET Optimization/ATP Manual Software Release R16.1.x.x

Follow the procedure in Table 6-25 for problems with DC input voltage.
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Table 6-25: No DC Input Voltage to any C-CCP Shelf Module

Step Action

1 Inspect all Harting Cable connectors and back-plane connectors for damage in all the affected
board slots.

2 Perform steps outlined in the RF path troubleshooting flowchart in this manual.

RFDS

The RFDS is used to perform Pre-Calibration Verification and
Post-Calibration Audits which  limit-check the RFDS-generate and
reported receive levels of every path from the RFDS through the
directional coupler coupled paths. In the event of test failure, refer to the
following tables.

All tests fail

Follow the procedure in Table 6-26 for problems with RFDS.

Table 6-26: RFDS Fault Isolation - All tests fail

Step Action

1 Check the calibration equipment for proper operation by manually setting the signal generator output
attenuator to the lowest output power setting and connecting the output port to the spectrum analyzer
rf input port.

2 Set the signal generator output attenuator to -90 dBm, and switch on the rf output. Verify that the
spectrum analyzer can receive the signal, indicate the correct signal strength, (accounting for the cable
insertion loss), and the approximate frequency.

3 Visually inspect RF cabling. Make sure each directional coupler forward and reflected port connects to
the RFDS antenna select unit on the RFDS.

4 Check the wiring against the site documentation wiring diagram or the BTS Site Installation manual.

5 Verify RGLI and TSU have been downloaded.

6 Check to see that all RFDS boards show green on the front panel indicators. Visually check  (both
board and backplane) for damage.

7 Replace any boards that do not show green with known good boards one at a time in the following
order. Re-test after each is replaced.

- RFDS ASU board.

- RFDS Transceiver board.
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All RX and TX paths fail

If every receive or transmit path fails, the problem most likely lies with
the rf converter board or the transceiver board. Refer to Table 6-27 for
fault isolation procedures.

Table 6-27: RFDS Fault Isolation - All RX and TX paths fail

Step Action

1 Visually check the master RF converter board (both board and backplane) for damage.

2 Replace the RF converter board with a known good RF converter board.

3 Visually check RXCVR TSU (both board and backplane) for damage.

4 Replace the TSU with a known good TSU.

All tests fail on a single antenna

If all path failures are on one antenna port, forward and/or reflected,
follow the procedures in Table 6-28 checks.

Table 6-28: RFDS Fault Isolation - All tests fail on single antenna path

Step Action

1 Visually inspect the site interface cabinet internal cabling to the suspect directional coupler antenna
port.

2 Verify the forward and reflected ports connect to the correct RFDS antenna select unit positions on the
RFDS backplane. Refer to the installation manual for details.

3 Visually check ASU connectors (both board and backplane) for damage.

4 Replace the ASU with a known good ASU.

5 Replace the RF cables between the affected directional coupler and RFDS.

NOTE
Externally route the cable to bypass suspect segment.

 

Module Status Indicators

Each of the non-passive plug-in modules has a bi-color (green & red)
LED status indicator located on the module front panel. The indicator is
labeled PWR/ALM. If both colors are turned on, the indicator is yellow.

Each plug-in module, except for the fan module, has its own alarm
(fault) detection circuitry that controls the state of the PWR/ALM LED.

The fan TACH signal of each fan module is monitored by the AMR.
Based on the status of this signal the AMR controls the state of the
PWR/ALM LED on the fan module.
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LED Status Combs All Modules (except GLI3, CSM, BBX2, MCC8/24E)

PWR/ALM LED

The following list describes the states of the module status indicator.

� Solid GREEN -  module operating in a normal (fault free) condition.

� Solid RED - module is operating in a fault (alarm) condition due to
electrical hardware failure.

Note that a fault (alarm) indication may or may not be due to a complete
module failure and normal service may or may not be reduced or
interrupted.

DC/DC Converter LED Status Combinations

The PWR CNVTR has its own alarm (fault) detection circuitry that
controls the state of the PWR/ALM LED.

PWR/ALM LED

The following list describes the states of the bi-color LED.

� Solid GREEN -  module operating in a normal (fault free) condition.

� Solid RED -  module is operating in a fault (alarm) condition due to
electrical hardware problem.

CSM LED Status Combinations
PWR/ALM LED

The CSMs include on-board alarm detection. Hardware and
software/firmware alarms are indicated via the front panel indicators.

After the memory tests, the CSM loads OOS-RAM code from the Flash
EPROM, if available. If not available, the OOS-ROM code is loaded
from the Flash EPROM.

� Solid GREEN - module is INS_ACT or INS_STBY no alarm.

� Solid RED - Initial power up or module is operating in a fault (alarm)
condition.

� Slowly Flashing GREEN - OOS_ROM no alarm.

� Long RED/Short GREEN - OOS_ROM alarm.

� Rapidly Flashing GREEN - OOS_RAM no alarm or 
INS_ACT in DUMB mode.

� Short RED/Short GREEN - OOS_RAM alarm.

� Long GREEN/Short RED - INS_ACT  or INS_STBY alarm.

� Off - no DC power  or on-board fuse is open.

� Solid YELLOW - After a reset, the CSMs begin to boot. During
SRAM test and Flash EPROM code check, the LED is yellow. (If
SRAM or Flash EPROM fail, the LED changes to a solid RED and
the CSM attempts to reboot.)
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Figure 6-1: CSM Front Panel Indicators & Monitor Ports

PWR/ALM
Indicator

FREQ
MONITOR

SYNC
MONITOR

FW00303

 . . . continued on next page

FREQ Monitor Connector

A test port provided at the CSM front panel via a BNC receptacle allows
monitoring of the 19.6608 MHz clock generated by the CSM. When
both CSM 1 and CSM 2 are in an in-service (INS) condition, the CSM 2
clock signal frequency is the same as that output by CSM 1.

The clock is a sine wave signal with a minimum amplitude of +2 dBm
(800 mVpp) into a 50 Ω load connected to this port.

SYNC Monitor Connector

A test port provided at the CSM front panel via a BNC receptacle allows
monitoring of the “Even Second Tick” reference signal generated by the
CSMs.

At this port, the reference signal is a TTL active high signal with a pulse
width of 153 nanoseconds.

MMI Connector - Only accessible behind front panel. The
RS-232 MMI port connector is intended to be used primarily in
the development or factory environment, but may be used in the
field for debug/maintenance purposes.
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GLI3 LED Status Combinations

The GLI3 module has indicators, controls and connectors as described
below and shown in Figure 6-2.

The indicators and controls consist of:

� Four LEDs

� One pushbutton

ACTIVE LED
Solid GREEN - GLI3 is active. This means that the GLI3 has shelf
control and is providing control of the digital interfaces.

Off - GLI3 is not active (i.e., Standby). The mate GLI3 should be
active.

MASTER LED
� Solid GREEN - GLI3 is Master (sometimes referred to as MGLI3).

� Off - GLI3 is non-master (i.e., Slave).

ALARM LED
� Solid RED -  GLI3 is in a fault condition or in reset.

� While in reset transition,  STATUS LED is OFF while GLI3 is
performing ROM boot (about 12 seconds for normal boot).

� While in reset transition,  STATUS LED is ON while GLI3 is
performing RAM boot (about 4 seconds for normal boot).

� Off - No Alarm.

STATUS LED
� Flashing GREEN-  GLI3 is in service (INS), in a stable operating

condition.

� On - GLI3 is in OOS RAM state operating downloaded code.

� Off - GLI3 is in OOS ROM state operating boot code.

SPANS LED
� Solid GREEN - Span line is connected and operating.

� Solid RED - Span line is disconnected or a fault condition exists.
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GLI3 Pushbuttons and Connectors
RESET Pushbutton - Depressing the RESET pushbutton
causes a partial reset of the CPU and a reset of all board devices.
GLI3 will be placed in the OOS_ROM state

MMI Connector - The RS-232MMI port connector is intended
to be used primarily in the development or factory environment
but may be used in the field for debug/maintenance purposes.

Figure 6-2: GLI3 Front Panel Operating Indicators

STATUS OFF − operating normally
ON − briefly during power−up when the Alarm LED turns OFF
SLOW GREEN − when the GLI3 is INS (in−service)

RESET

ALARM OFF − operating normally
ON − briefly during power−up when the Alarm LED turns OFF
SLOW GREEN − when the GLI3 is INS (in−service)

BPR A

Span

MMI

ACTIVE

LED OPERATING STATUS

Pressing and releasing the switch resets all functions on the GLI3.

Shows the operating status of the redundant cards. The redundant
card toggles automatically if the active card is removed or fails

ON − active card operating normally
OFF − standby card operating normally

Connects to either a BPR or expansion cage and is wired as an
ethernet hub.

An RS−232, serial, asynchronous communications link for use as
an MMI port. This port supports 300 baud, up to a maximum of
115,200 baud communications.

BPR B

GLI

AUX

Supports the cross−coupled ethernet circuits to the mate GLI using a
standard ethernet straight cable.

Wired as an ethernet hub for direct connection to a personal comput−
er with a standard ethernet cable. It allows connection of ethernet
7sniffer" when the ethernet switch is properly configured for port mon−
itoring.

Connects to either a BPR or expansion cage and is wired as an
ethernet hub.

MMI Port

Reset Switch

Dual 100BASE-T
in a single RJ45
to Redundant
(Mate) GLI3

100BASE-T
Auxiliary Monitor
Port

B
P

R
 B

A
U

X
R

E
S

E
T

S
P

A
N

A
LA

R
M

M
M

I

A
C

T

S
TA

100BASE-T to
BTS Packet Router
or Expansion cage

Span (LED)

Alarm (LED)

Active (LED)

Status (LED)

G
LI

B
P

R
 A

ti-CDMA-WP-00064-v01-ildoc-ftw

OFF − card is powered down, in initialization, or in standby
GREEN − operating normally
YELLOW − one or more of the equipped initialized spans is receiving
a remote alarm indication signal from the far end
RED − one or more of the equipped initialized spans is in an alarm
state
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BBX LED Status Combinations

PWR/ALM LED

The BBX module has its own alarm (fault) detection circuitry that
controls the state of the PWR/ALM LED.

The following list describes the states of the bi-color LED:

� Solid GREEN - INS_ACT no alarm

� Solid RED Red - initializing or power-up alarm

� Slowly Flashing GREEN - OOS_ROM no alarm

� Long RED/Short GREEN - OOS_ROM alarm

� Rapidly Flashing GREEN - OOS_RAM no alarm

� Short RED/Short GREEN - OOS_RAM alarm

� Long GREEN/Short RED - INS_ACT  alarm

MCC LED Status Combinations

The MCC module has LED indicators and connectors as described
below. See Figure 6-3. Note that the figure does not show the connectors
as they are concealed by the removable lens.

The LED indicators and their states are as follows:

PWR/ALM LED
� RED - fault on module

ACTIVE LED
� Off - module is inactive, off-line, or not processing traffic.

� Slowly Flashing GREEN - OOS_ROM no alarm.

� Rapidly Flashing Green - OOS_RAM no alarm.

� Solid GREEN - module is INS_ACT, on-line, processing traffic.

PWR/ALM and ACTIVE LEDs
� Solid RED - module is powered but is in reset or the BCP is inactive.

MMI Connectors
� The RS-232 MMI port connector (four-pin) is intended to be used

primarily in the development or factory environment but may be used
in the field for debugging purposes.

� The RJ-11 ethernet port connector (eight-pin) is intended to be used
primarily in the development environment but may be used in the field
for high data rate debugging purposes.
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Figure 6-3: MCC24/8E Front Panel LEDs and LED Indicators

PWR/ALM LED

LENS
(REMOVABLE)

ACTIVE LED

P
W

R
/A

LM
A

C
T

IV
E

PWR/ALM OFF − operating normally
ON − briefly during power−up and during failure
=conditions

ACTIVE

LED OPERATING STATUS

RAPIDLY BLINKING − Card is code−loaded but
=not enabled
SLOW BLINKING − Card is not code−loaded
ON − card is code−loaded and enabled
=(INS_ACTIVE)

COLOR

GREEN

RED

RED ON − fault condition
SLOW FLASHING (alternating with green) − CHI
=bus inactive on power−up

An alarm is generated in the event of a failure

FW00224

LPA Shelf LED Status Combinations

LPA Module LED

Each LPA module contains a bi-color LED just above the MMI
connector on the ETIB module. Interpret this LED as follows:

� GREEN — LPA module is active and is reporting no alarms (Normal
condition).

� Flashing GREEN/RED — LPA module is active but is reporting an
low input power condition. If no BBX is keyed, this is normal and
does not constitute a failure.

� Flashing RED — LPA is in alarm.

Span Problems
(No Control Link)

Follow the procedure in Table 6-29 when troubleshooting a control link
failure.
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Table 6-29: Troubleshooting Control Link Failure

� Step Action

1 Verify the span settings using the span view command on the active master GLI3 MMI
port. If these are set correctly, verify the edlc parameters using the show command. Any
alarms conditions indicate that the span is not operating correctly.

- Try looping back the span line from the DSX panel back to the mobility manager
(MM) and verify that the looped signal is good.

- Listen for control tone on appropriate timeslot from base site and MM.
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Notes
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Appendix A

System Data
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Site Operation Verification

Verification of Test Equipment Used

Table A-1: Verification of Test Equipment Used

Manufacturer Model Serial Number

Comments:________________________________________________________

__________________________________________________________________
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Site Checklist

Table A-2: Site Checklist

OK Parameter Specification Comments

� Deliveries Per established procedures

� Floor Plan Verified

�

�

�

Inter Frame Cables:

Ethernet

Frame Ground

Power

Per procedure

Per procedure

Per procedure

�

�

�

Factory Data:

BBX

Test Panel

RFDS

Per procedure

Per procedure

Per procedure

� Site Temperature

� Dress Covers/Brackets
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Preliminary Operations

Table A-3: Preliminary Operations

OK Parameter Specification Comments

� Shelf ID Dip Switches Per site equipage

� Ethernet LAN verification Verified per procedure

Comments:_________________________________________________________
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Pre-Power  and Initial Power  Tests

Table A3a: Pre-power Checklist

OK Parameter Specification Comments

� Pre-power-up tests Verify power supply
output voltage at the top
of each BTS frame is
within specifications

�

�

�

�

�

�

�

�

Internal Cables:

ISB (all cages)

CSM (all cages)

Power (all cages)

Ethernet Connectors

LAN A ohms

LAN B ohms

LAN A shield

LAN B shield

Ethernet Boots

verified

verified

verified

verified

verified

isolated

isolated

installed

� Air Impedance Cage (single cage) installed

� Initial power-up tests Verify power supply
output voltage at the top
of each BTS frame is
within specifications:

Comments:_________________________________________________________

A



Site Operation Verification 68P09255A57-2

Aug 2002SC�4812ET Optimization/ATP Manual Software Release R16.1.x.x
PRELIMINARY

A-6

General Optimization Checklist

Table A3b: Pre-power Checklist

OK Parameter Specification Comments

�

�

LEDs

Frame fans

illuminated

operational

�

�

�

�

LMF to BTS Connection

Preparing the LMF

Log into the LMF PC

Create site specific BTS directory

Download device loads

per procedure

per procedure

per procedure

per procedure

�

�

Ping LAN A

Ping LAN B

per procedure

per procedure

�

�

�

�

�

�

�

�

�

Download/Enable MGLI3s

Download/Enable GLI3s

Set Site Span Configuration

Download CSMs

Enable CSMs

Enable CSMs

Download/Enable MCCs*

Download BBXs*

Download TSU  (in RFDS)

Program TSU NAM

per procedure

per procedure

per procedure

per procedure

per procedure

per procedure

per procedure

per procedure

per procedure

� Test Set Calibration per procedure

*MCCs may be MCC8Es, MCC24s or MCC-1Xs. BBXs may be BBXs or BBX-1Xs

Comments:_________________________________________________________
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GPS Receiver Operation

Table A-4: GPS Receiver Operation

OK Parameter Specification Comments

� GPS Receiver Control Task State:

tracking satellites

Verify parameter

� Initial Position Accuracy: Verify Estimated
or Surveyed

� Current Position:
lat
lon
height

RECORD in
msec and cm also
convert to deg
min sec

� Current Position: satellites tracked

Estimated:

(>4) satellites tracked,(>4) satellites visible

Surveyed:

(>1) satellite tracked,(>4) satellites visible

Verify parameter
as appropriate:

� GPS Receiver Status:Current Dilution of
Precision 
(PDOP or HDOP): (<30)

Verify parameter

� Current reference source:
Number: 0; Status: Good; Valid: Yes

Verify parameter

Comments:_________________________________________________________
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LFR Receiver Operation

Table A-5: LFR Receiver Operation

OK Parameter Specification Comments

� Station call letters M X Y Z
assignment.

as specified in site
documentation

� SN ratio is > 8 dB

� LFR Task State: 1fr

locked to station xxxx

Verify parameter

� Current reference source:

Number: 1; Status: Good; Valid: Yes

Verify parameter

Comments:_________________________________________________________
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LPA IM Reduction 

Table A-6: LPA IM Reduction

Parameter Comments

CARRIER
OK LPA

# 4:1 & 2:1
3-Sector

2:1
6-Sector

Dual BP
3-Sector

Dual BP
6-Sector

Specification

� 1A C1 C1 C1 C1 No Alarms

� 1B C1 C1 C1 C1 No Alarms

� 1C C1 C1 C1 C1 No Alarms

� 1D C1 C1 C1 C1 No Alarms

� 2A C2 C2 C2 No Alarms

� 2B C2 C2 C2 No Alarms

� 2C C2 C2 C2 No Alarms

� 2D C2 C2 C2 No Alarms

� 3A C3 C1 C1 No Alarms

� 3B C3 C1 C1 No Alarms

� 3C C3 C1 C1 No Alarms

� 3D C3 C1 C1 No Alarms

� 4A C4 C2 No Alarms

� 4B C4 C2 No Alarms

� 4C C4 C2 No Alarms

� 4D C4 C2 No Alarms

Comments:_________________________________________________________
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TX Bay Level Offset / Power Output Verification for 3-Sector Configurations 
1-Carrier
2-Carrier  Non-adjacent Channels
4-Carrier Non-adjacent Channels

Table A-7: TX BLO Calibration (3-Sector: 1-Carrier,  2-Carrier and 4-Carrier Non-adjacent Channels)

OK Parameter Specification Comments

�
BBX-1, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibrate
carrier 1

TX Bay Level Offset = 37 dB (+4 dB)
prior to calibration

BBX-2, ANT-2 = dB

BBX-r , ANT-2 = dB

�
BBX-3, ANT-3 = dB

BBX-r , ANT-3 = dB

�
BBX-7, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibrate
carrier 2

TX Bay Level Offset = 37 dB (+4 dB)
prior to calibration

BBX-8, ANT-2 = dB

BBX-r , ANT-2 = dB

�
BBX-9, ANT-3 = dB

BBX-r , ANT-3 = dB

�
BBX-4, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibrate
carrier 3

TX Bay Level Offset = 37 dB (+4 dB)
prior to calibration

BBX-5, ANT-2 = dB

BBX-r , ANT-2 = dB

�
BBX-6, ANT-3 = dB

BBX-r , ANT-3 = dB

�
BBX-10, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibrate
carrier 4

TX Bay Level Offset = 37 dB (+4 dB)
prior to calibration

BBX-1 1, ANT-2 = dB

BBX-r , ANT-2 = dB

�
BBX-12, ANT-3 = dB

BBX-r , ANT-3 = dB

�
BBX-1, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibration

Audit
carrier 1

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX-2, ANT-2 = dB

BBX-r , ANT-2 = dB

�

carrier 1
BBX-3, ANT-3 = dB

BBX-r , ANT-3 = dB

. . . continued on next page
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Table A-7: TX BLO Calibration (3-Sector: 1-Carrier,  2-Carrier and 4-Carrier Non-adjacent Channels)

OK CommentsSpecificationParameter

�
BBX-7, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibration

Audit
carrier 2

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX-8, ANT-2 = dB

BBX-r , ANT-2 = dB

�

carrier 2
BBX-9, ANT-3 = dB

BBX-r , ANT-3 = dB

�
BBX-4, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibration

Audit
carrier 3

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX-5, ANT-2 = dB

BBX-r , ANT-2 = dB

�

carrier 3
BBX-6, ANT-3 = dB

BBX-r , ANT-3 = dB

�
BBX-10, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibration

Audit
carrier 4

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX-1 1, ANT-2 = dB

BBX-r , ANT-2 = dB

�

carrier 4
BBX-12, ANT-3 = dB

BBX-r , ANT-3 = dB

 

Comments:________________________________________________________

__________________________________________________________________

2-Carrier  Adjacent Channel

Table A-8: TX Bay Level Offset Calibration (3-Sector: 2-Carrier Adjacent Channels)

OK Parameter Specification Comments

�
BBX-1, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibrate
carrier 1

TX Bay Level Offset = 42 dB (typical),
38 dB (minimum) prior to calibration

BBX-2, ANT-2 = dB

BBX-r , ANT-2 = dB

�
BBX-3, ANT-3 = dB

BBX-r , ANT-3 = dB

. . . continued on next page
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Table A-8: TX Bay Level Offset Calibration (3-Sector: 2-Carrier Adjacent Channels)

OK CommentsSpecificationParameter

�
BBX-7, ANT-4 = dB

BBX-r , ANT-4 = dB

�
Calibrate
carrier 2

TX Bay Level Offset = 42 dB (typical),
38 dB (minimum) prior to calibration

BBX-8, ANT-5 = dB

BBX-r , ANT-5 = dB

�
BBX-9, ANT-6 = dB

BBX-r , ANT-6 = dB

�
BBX-1, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibration

Audit
carrier 1

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX-2, ANT-2 = dB

BBX-r , ANT-2 = dB

�

carrier 1
BBX-3, ANT-3 = dB

BBX-r , ANT-3 = dB

�
BBX-7, ANT-4 = dB

BBX-r , ANT-4 = dB

�
Calibration

Audit
carrier 2

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX-8, ANT-5 = dB

BBX-r , ANT-5 = dB

�

carrier 2
BBX-9, ANT-6 = dB

BBX-r , ANT-6 = dB

 

Comments:________________________________________________________

__________________________________________________________________

3-Carrier  Adjacent Channels
4-Carrier Adjacent Channels

Table A-9: TX Bay Level Offset Calibration (3-Sector: 3 or 4-Carrier Adjacent Channels)

OK Parameter Specification Comments

�
BBX-1, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibrate
carrier 1

TX Bay Level Offset = 37 dB before
calibration

BBX-2, ANT-2 = dB

BBX-r , ANT-2 = dB

�
BBX-3, ANT-3 = dB

BBX-r , ANT-3 = dB

. . . continued on next page
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Table A-9: TX Bay Level Offset Calibration (3-Sector: 3 or 4-Carrier Adjacent Channels)

OK CommentsSpecificationParameter

�
BBX-7, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibrate
carrier 2

TX Bay Level Offset =37 dB before
calibration

BBX-8, ANT-2 = dB

BBX-r , ANT-2 = dB

�
BBX-9, ANT-3 = dB

BBX-r , ANT-3 = dB

�
BBX-4, ANT-4 = dB

BBX-r , ANT-4 = dB

�
Calibrate
carrier 3

TX Bay Level Offset = 37 dB before
calibration

BBX-5, ANT-5 = dB

BBX-r , ANT-5 = dB

�
BBX-6, ANT-6 = dB

BBX-r , ANT-6 = dB

�
BBX-10, ANT-4 = dB

BBX-3, ANT-4 = dB

�
Calibrate
carrier 4

TX Bay Level Offset = 37 dB before
calibration

BBX-1 1, ANT-5 = dB

BBX-r , ANT-5 = dB

�
BBX-12, ANT-6 = dB

BBX-r , ANT-6 = dB

�
BBX-1, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibration

Audit
carrier 1

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX-2, ANT-2 = dB

BBX-r , ANT-2 = dB

�

carrier 1
BBX-3, ANT-3 = dB

BBX-r , ANT-3 = dB

�
BBX-7, ANT-1 = dB

BBX-r , ANT-1 = dB

�
Calibration

Audit
carrier 2

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX-8, ANT-2 = dB

BBX-r , ANT-2 = dB

�

carrier 2
BBX-9, ANT-3 = dB

BBX-r , ANT-3 = dB

. . . continued on next page
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Table A-9: TX Bay Level Offset Calibration (3-Sector: 3 or 4-Carrier Adjacent Channels)

OK CommentsSpecificationParameter

�
BBX-4, ANT-4 = dB

BBX-r , ANT-4 = dB

�
Calibration

Audit
carrier 3

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX-5, ANT-5 = dB

BBX-r , ANT-5 = dB

�

carrier 3
BBX-6, ANT-6 = dB

BBX-r , ANT-6 = dB

�
BBX-10, ANT-4 = dB

BBX-r , ANT-4 = dB

�
Calibration

Audit
carrier 4

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX-1 1, ANT-5 = dB

BBX-r , ANT-5 = dB

�

carrier 4
BBX-12, ANT-6 = dB

BBX-r , ANT-6 = dB

 

Comments:________________________________________________________

__________________________________________________________________
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TX Bay Level Offset / Power Output Verification for 6-Sector Configurations 
1-Carrier
2-Carrier  Non-adjacent Channels

Table A-10: TX BLO Calibration (6-Sector: 1-Carrier, 2-Carrier Non-adjacent Channels)

OK Parameter Specification Comments

�
BBX-1, ANT-1 = dB

BBX-r , ANT-1 = dB

�
BBX-2, ANT-2 = dB

BBX-r , ANT-2 = dB

�
Calibrate TX Bay Level Offset = 42 dB (typical),

BBX-3, ANT-3 = dB

BBX-r , ANT-3 = dB

�

carrier 1 38 dB (minimum) prior to calibration BBX-4, ANT-4 = dB

BBX-r , ANT-4 = dB

�
BBX-5, ANT-5 = dB

BBX-r , ANT-5 = dB

�
BBX-6, ANT-6 = dB

BBX-r , ANT-6 = dB

�
BBX-7, ANT-1 = dB

BBX-r , ANT-1 = dB

�
BBX-8, ANT-2 = dB

BBX-r , ANT-2 = dB

�
Calibrate TX Bay Level Offset = 42 dB (typical),

BBX-9, ANT-3 = dB

BBX-r , ANT-3 = dB

�

carrier 2 38 dB (minimum) prior to calibration BBX-10, ANT-4 = dB

BBX-3, ANT-4 = dB

�
BBX-1 1, ANT-5 = dB

BBX-r , ANT-5 = dB

�
BBX-12, ANT-6 = dB

BBX-r , ANT-5 = dB

. . . continued on next page
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Table A-10: TX BLO Calibration (6-Sector: 1-Carrier, 2-Carrier Non-adjacent Channels)

OK CommentsSpecificationParameter

�
BBX-1, ANT-1 = dB

BBX-r , ANT-1 = dB

�
BBX-2, ANT-2 = dB

BBX-r , ANT-2 = dB

� Calibration 0 dB (+0.5 dB) for gain set resolution

BBX-3, ANT-3 = dB

BBX-r , ANT-3 = dB

�

Audit
carrier 1

post calibration BBX-4, ANT-4 = dB

BBX-r , ANT-4 = dB

�
BBX-5, ANT-5 = dB

BBX-r , ANT-5 = dB

�
BBX-6, ANT-6 = dB

BBX-r , ANT-6 = dB

�
BBX-7, ANT-1 = dB

BBX-r , ANT-1 = dB

�
BBX-8, ANT-2 = dB

BBX-r , ANT-2 = dB

� Calibration 0 dB (+0.5 dB) for gain set resolution

BBX-9, ANT-3 = dB

BBX-r , ANT-3 = dB

�

Audit
carrier 2

post calibration BBX-10, ANT-4 = dB

BBX-r , ANT-4 = dB

�
BBX-1 1, ANT-5 = dB

BBX-r , ANT-5 = dB

�
BBX-12, ANT-6 = dB

BBX-r , ANT-6 = dB

 

Comments:________________________________________________________

__________________________________________________________________
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TX Antenna VSWR

Table A-11: TX Antenna VSWR

OK Parameter Specification Data

�
VSWR - 
Antenna 1

   < (1.5 : 1)

�
VSWR -
Antenna 2

   < (1.5 : 1)

�
VSWR -
Antenna 3

   < (1.5 : 1)

�
VSWR -
Antenna 4

   < (1.5 : 1)

�
VSWR -
Antenna 5

   < (1.5 : 1)

�
VSWR -
Antenna 6

   < (1.5 : 1)

Comments:________________________________________________________

__________________________________________________________________

RX Antenna VSWR

Table A-12: RX Antenna VSWR

OK Parameter Specification Data

�
VSWR - 
Antenna 1

   < (1.5 : 1)

�
VSWR -
Antenna 2

   < (1.5 : 1)

�
VSWR -
Antenna 3

   < (1.5 : 1)

�
VSWR -
Antenna 4

   < (1.5 : 1)

�
VSWR -
Antenna 5

   < (1.5 : 1)

�
VSWR -
Antenna 6

   < (1.5 : 1)

Comments:_________________________________________________________
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Alarm Verification

Table A-13: CDI Alarm Input Verification

OK Parameter Specification Data

�

Verify CDI alarm input
operation per Table 3-1.

BTS Relay #XX -
Contact Alarm
Sets/Clears

Comments:_________________________________________________________
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C-CCP  Shelf

Site I/O A & B
C-CCP Shelf
CSM-1
CSM-2
HSO
CCD-1
CCD-2
AMR-1
AMR-2
MPC-1
MPC-2
Fans 1-3 
GLI3-1
GLI3-2
BBX-1
BBX-2
BBX-3
BBX-4
BBX-5
BBX-6
BBX-7
BBX-8
BBX-9
BBX-10
BBX-1 1
BBX-12
BBX-r
MCC-1
MCC-2
MCC-3
MCC-4
MCC-5
MCC-6
MCC-7
MCC-8
MCC-9
MCC-10

CIO
SWITCH
PS-1
PS-2
PS-3

A
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LPAs

LPA 1A
LPA 1B
LPA 1C
LPA 1D
LPA 2A
LPA 2B
LPA 2C
LPA 2D
LPA 3A
LPA 3B
LPA 3C
LPA 3D
LPA 4A
LPA 4B
LPA 4C
LPA 4D
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Appendix B

ATP Matrix Table
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Re-optimization

Usage & Background

Periodic maintenance of a site may also mandate re-optimization of
specific portions of the site. An outline of some basic guidelines is
included in the following tables.

NOTE Re-optimization steps listed for any assembly detailed in the
tables below must be performed anytime an RF cable associated
with it is replaced.

Detailed Optimization/ATP Test Matrix

Table B-1 outlines in more detail the tests that would need to be
performed if one of the BTS components were to fail and be replaced. It
is also assumes that all modules are placed OOS-ROM via the LMF
until full redundancy of all applicable modules is implemented.

The following guidelines should also be noted when using this table.

NOTE Not every procedure required to bring the site back in service is
indicated in Table B-1. It is meant to be used as a guideline
ONLY. The table assumes that the user is familiar enough with
the BTS Optimization/ATP procedure to understand which test
equipment set ups, calibrations, and BTS site preparation will be
required before performing the Table # procedures referenced.

Various passive BTS components (such as the DRDCs, filter; etc.) only
require a TX calibration audit to be performed in lieu of a full path
calibration. If the TX path calibration audit fails, the entire RF path
calibration will need to be repeated. If the RF path calibration fails,
further troubleshooting is warranted.

Whenever any C-CCP BACKPLANE is replaced, it is assumed that
only power to the C-CCP shelf being replaced is turned off via the
breaker supplying that shelf.

NOTE If any significant change in signal level results from any
component being replaced in the RX or TX signal flow paths, it
would be identified by re-running the RX and TX calibration
audit command.

When the CIO is replaced, the C-CCP shelf remains powered up. The
BBX boards may need to be removed, then re-installed into their
original slots, and re-downloaded (code and BLO data). RX and TX
calibration audits should then be performed.
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Table B-1: SC 4812ET BTS Optimization and ATP Test Matrix
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Table 3-20/
Table 3-21/

Download Code/Data � � � � � �

Table 3-23 Enable CSMs � � � � �

Table 3-26 GPS &HSO Initialization  /
Verification � � � � � � � �

Table 3-27 LFR   Initialization  /
Verification � � �

Table 3-41 TX Path Calibration 4 4 1 1 4 * 3 3 4 7

Table 3-42 Download Offsets to BBX 4 1
4

*

Table 3-43 TX Path Audit 4 4 1 1 4 * 3 4 7

Table 3-52 RFDS Path Calibration and
Offset Data Download

6 5 4 5 1 1 6 * 3 4 6 6

Table 4-1 Spectral Purity TX Mask 4 1 4 * * * *

Table 4-1 Waveform Quality (rho) 4 * 1 4 * * * 1 * *

Table 4-1 Pilot Time Offset 4 * 1 4 * * * * *

Table 4-1 Code Domain Power /
Noise Floor

4 1 4 8 8 8 8 * * *

Table 4-1 FER Test 5 5 5 2 2 5 8 8 8 8 * 7

Table 3-54/
Table 3-63

Alarm Tests �

. . . continued on next page
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Table B-1: SC 4812ET BTS Optimization and ATP Test Matrix
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Description

OPTIMIZATION AND TEST LEGEND:

�  Required
*  Perform if determined necessary for addtional fault isolation, repair assurance, or required for site
certification.
**  Replace power supply modules one at a time so that power to the C-CCP shelf is not interrupted. If power
to the shelf is lost, all cards in the shelf must be downloaded again.
1. Perform on all carrier and sector TX paths to the C-CCP cage.

2. Perform on all carrier and sector RX paths to the C-CCP cage.

3. Perform on all primary and redundant TX paths of the affected carrier.

4. Perform on the affected carrier and sector TX path(s) (BBXR replacement affects all carrier 
and sector TX paths)

5. Perform on the affected carrier and sector RX path(s) (BBXR replacement affects all carrier 
RX paths)

6. Perform on all RF paths of the affected carrier and sector  (RFDS replacement affects all 
carriers)

7. Perform with redundant BBX for at least one sector on one carrier.

8. Verify performance by performing on one sector of one carrier only.
9 Perform only if RGD/RGPS, LFR antenna, or HSO or LFR expansion was installed

10 Verify performance by performing testing on one sector of each carrier.
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BBX Gain
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BBX Gain Set Point

Usage & Background
Table C-1 outlines the relationship between the total of all code domain
channel element gain settings (digital root sum of the squares) and the
BBX Gain Set Point  between 33.0 dBm and 44.0 dBm. The resultant
RF output (as measured at the top of the BTS in dBm) is shown in the
table.  The table assumes that the BBX Bay Level Offset (BLO) values
have been calculated.

As an illustration, consider a  BBX keyed up to produce a CDMA carrier
with only the Pilot channel (no MCCs forward link enabled). Pilot gain
is set to 262. In this case, the BBX Gain Set Point is shown to correlate
exactly to the actual RF output anywhere in the 33 to 44 dBm output
range.  (This is the level used to calibrate the BTS).

Table C-1: BBX Gain Set Point vs. Actual BTS Output (in dBm)

dBm	

Gain

44 43 42 41 40 39 38 37 36 35 34 33

541 - - - - - - - 43.3 42.3 41.3 40.3 39.3

533 - - - - - - - 43.2 42.2 41.2 40.2 39.2

525 - - - - - - - 43 42 41 40 39

517 - - - - - - - 42.9 41.9 40.9 39.9 38.9

509 - - - - - - - 42.8 41.8 40.8 39.8 38.8

501 - - - - - - - 42.6 41.6 40.6 39.6 38.6

493 - - - - - - 43.5 42.5 41.5 40.5 39.5 38.5

485 - - - - - - 43.4 42.4 41.4 40.4 39.4 38.4

477 - - - - - - 43.2 42.2 41.2 40.2 39.2 38.2

469 - - - - - - 43.1 42.1 41.1 40.1 39.1 38.1

461 - - - - - - 42.9 41.9 40.9 39.9 38.9 37.9

453 - - - - - - 42.8 41.8 40.8 39.8 38.8 37.8

445 - - - - - 43.6 42.6 41.6 40.6 39.6 38.6 37.6

437 - - - - - 43.4 42.4 41.4 40.4 39.4 38.4 37.4

429 - - - - - 43.3 42.3 41.3 40.3 39.3 38.3 37.3

421 - - - - - 43.1 42.1 41.1 40.1 39.1 38.1 37.1

413 - - - - - 43 42 41 40 39 38 37

405 - - - - - 42.8 41.8 40.8 39.8 38.8 37.8 36.8

397 - - - - 43.6 42.6 41.6 40.6 39.6 38.6 37.6 36.6

389 - - - - 43.4 42.4 41.4 40.4 39.4 38.4 37.4 36.4

 . . . continued on next page
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Table C-1: BBX Gain Set Point vs. Actual BTS Output (in dBm)

dBm	

Gain

333435363738394041424344

381 - - - - 43.3 42.3 41.3 40.3 39.3 38.3 37.3 36.3

374 - - - - 43.1 42.1 41.1 40.1 39.1 38.1 37.1 36.1

366 - - - - 42.9 41.9 40.9 39.9 38.9 37.9 36.9 35.9

358 - - - - 42.7 41.7 40.7 39.7 38.7 37.7 36.7 35.7

350 - - - 43.5 42.5 41.5 40.5 39.5 38.5 37.5 36.5 35.5

342 - - - 43.3 42.3 41.3 40.3 39.3 38.3 37.3 36.3 35.3

334 - - - 43.1 42.1 41.1 40.1 39.1 38.1 37.1 36.1 35.1

326 - - - 42.9 41.9 40.9 39.9 38.9 37.9 36.9 35.9 34.9

318 - - - 42.7 41.7 40.7 39.7 38.7 37.7 36.7 35.7 34.7

310 - - 43.5 42.5 41.5 40.5 39.5 38.5 37.5 36.5 35.5 34.5

302 - - 43.2 42.2 41.2 40.2 39.2 38.2 37.2 36.2 35.2 34.2

294 - - 43 42 41 40 39 38 37 36 35 34

286 - - 42.8 41.8 40.8 39.8 38.8 37.8 36.8 35.8 34.8 33.8

278 - 43.5 42.5 41.5 40.5 39.5 38.5 37.5 36.5 35.5 34.5 33.5

270 - 43.3 42.3 41.3 40.3 39.3 38.3 37.3 36.3 35.3 34.3 33.3

262 - 43 42 41 40 39 38 37 36 35 34 33

254 - 42.7 41.7 40.7 39.7 38.7 37.7 36.7 35.7 34.7 33.7 32.7

246 43.4 42.4 41.4 40.4 39.4 38.4 37.4 36.4 35.4 34.4 33.4 32.4

238 43.2 42.2 41.2 40.2 39.2 38.2 37.2 36.2 35.2 34.2 33.2 32.2

230 42.9 41.9 40.9 39.9 38.9 37.9 36.9 35.9 34.9 33.9 32.9 31.9

222 42.6 41.6 40.6 39.6 38.6 37.6 36.6 35.6 34.6 33.6 32.6 31.6

214 42.2 41.2 40.2 39.2 38.2 37.2 36.2 35.2 34.2 33.2 32.2 31.2
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Channel Frequencies

Introduction

Programming of each of the BTS BBX synthesizers is performed by the
BTS GLIs via the CHI bus. This programming data determines the
transmit and receive transceiver operating frequencies (channels) for
each BBX2.

1900 MHz PCS Channels

Figure D-1 shows the valid channels for the North American PCS
1900 MHz frequency spectrum. There are 10 CDMA wireline or
non-wireline band channels used in a CDMA system (unique per
customer operating system).

Figure D-1: North America PCS Frequency Spectrum (CDMA Allocation)
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Calculating 1900 MHz Center Frequencies
Table D-1 shows selected 1900 MHz CDMA candidate operating
channels, listed in both decimal and hexadecimal, and the corresponding
transmit, and receive frequencies. Center frequencies (in MHz) for
channels not shown in the table may be calculated as follows:

� TX = 1930 + 0.05 * Channel#
Example: Channel 262
TX = 1930 + 0.05*262 = 1943.10 MHz

� RX = TX - 80
Example: Channel 262
RX = 1943.10 - 50 = 1863.10 MHz

Actual frequencies used depend on customer CDMA system frequency
plan.

Each CDMA channel requires a 1.77 MHz frequency segment. The
actual CDMA carrier is 1.23 MHz wide, with a 0.27 MHz guard band on
both sides of the carrier.

Minimum frequency separation required between any CDMA carrier and
the nearest NAMPS/AMPS carrier is 900 kHz (center-to-center).

Table D-1: 1900 MHz TX and RX Frequency vs. Channel
Channel Number
Decimal       Hex

Transmit Frequency (MHz)
Center Frequency

Receive Frequency (MHz)
Center Frequency

25 0019 1931.25 1851.25
50 0032 1932.50 1852.50
75 004B 1933.75 1853.75
100 0064 1935.00 1855.00
125 007D 1936.25 1856.25
150 0096 1937.50 1857.50
175 00AF 1938.75 1858.75
200 00C8 1940.00 1860.00
225 00E1 1941.25 1861.25
250 00FA 1942.50 1862.50
275 0113 1943.75 1863.75
300 012C 1945.00 1865.00
325 0145 1946.25 1866.25
350 015E 1947.50 1867.50
375 0177 1948.75 1868.75
400 0190 1950.00 1870.00
425 01A9 1951.25 1871.25
450 01C2 1952.50 1872.50
475 01DB 1953.75 1873.75
500 01F4 1955.00 1875.00
525 020D 1956.25 1876.25
550 0226 1957.50 1877.50
575 023F 1958.75 1878.75
600 0258 1960.00 1880.00
625 0271 1961.25 1881.25
650 028A 1962.50 1882.50

. . . continued on next page
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Table D-1: 1900 MHz TX and RX Frequency vs. Channel
Channel Number
Decimal       Hex

Receive Frequency (MHz)
Center Frequency

Transmit Frequency (MHz)
Center Frequency

675 02A3 1963.75 1883.75
700 02BC 1965.00 1885.00
725 02D5 1966.25 1886.25
750 02EE 1967.50 1887.50
775 0307 1968.75 1888.75
800 0320 1970.00 1890.00
825 0339 1971.25 1891.25
850 0352 1972.50 1892.50
875 036B 1973.75 1893.75
900 0384 1975.00 1895.00
925 039D 1976.25 1896.25
950 03B6 1977.50 1897.50
975 03CF 1978.75 1898.75

1000 03E8 1980.00 1900.00
1025 0401 1981.25 1901.25
1050 041A 1982.50 1902.50
1075 0433 1983.75 1903.75
1100 044C 1985.00 1905.00
1125 0465 1986.25 1906.25
1150 047E 1987.50 1807.50
1175 0497 1988.75 1908.75

 

800 MHz CDMA Channels

Figure D-2 shows the valid channels for the North American cellular
telephone frequency spectrum. There are 10 CDMA wireline or
non-wireline band channels used in a CDMA system (unique per
customer operating system).

Figure D-2: North American Cellular Telephone System Frequency Spectrum (CDMA Allocation).
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Calculating 800 MHz Center Frequencies
Table D-2 shows selected 800 MHz CDMA candidate operating
channels, listed in both decimal and hexadecimal, and the corresponding
transmit, and receive frequencies. Center frequencies (in MHz) for
channels not shown in the table may be calculated as follows:

� Channels 1-777
TX = 870 + 0.03 * Channel#
Example: Channel 262
TX = 870 + 0.03*262 = 877.86 MHz

� Channels 1013-1023
TX = 870 + 0.03 * (Channel# - 1023)
Example: Channel 1015
TX = 870 +0.03 *(1015 - 1023) = 869.76 MHz

� RX = TX - 45 MHz
Example: Channel 262
RX = 877.86 -45 = 832.86 MHz

Table D-2: 800 MHz TX and RX Frequency vs. Channel

Channel Number
Decimal   Hex

Transmit Frequency (MHz)
Center Frequency

Receive Frequency (MHz)
Center Frequency

1 0001 870.0300 825.0300

25 0019 870.7500 825.7500

50 0032 871.5000 826.5000

75 004B 872.2500 827.2500

100 0064 873.0000 828.0000

125 007D 873.7500 828.7500

150 0096 874.5000 829.5000

175 00AF 875.2500 830.2500

200 00C8 876.0000 831.0000

225 00E1 876.7500 831.7500

250 00FA 877.5000 832.5000

275 0113 878.2500 833.2500

300 012C 879.0000 834.0000

325 0145 879.7500 834.7500

350 015E 880.5000 835.5000

375 0177 881.2500 836.2500

400 0190 882.0000 837.0000

425 01A9 882.7500 837.7500

450 01C2 883.5000 838.5000

475 01DB 884.2500 839.2500

500 01F4 885.0000 840.0000

525 020D 885.7500 840.7500

550 0226 886.5000 841.5000
. . . continued on next page
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Table D-2: 800 MHz TX and RX Frequency vs. Channel

Channel Number
Decimal   Hex

Receive Frequency (MHz)
Center Frequency

Transmit Frequency (MHz)
Center Frequency

575 023F 887.2500 842.2500

600 0258 888.0000 843.0000

625 0271 888.7500 843.7500

650 028A 889.5000 844.5000

675 02A3 890.2500 845.2500

700 02BC 891.0000 846.0000

725 02D5 891.7500 846.7500

750 02EE 892.5000 847.5000

775 0307 893.2500 848.2500

NOTE
Channel numbers 778 through 1012 are not used.

1013 03F5 869.7000 824.7000

1023 03FF 870.0000 825.0000
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PN Offset

Background
All channel elements transmitted from a BTS in a particular 1.25 MHz
CDMA channel are orthonogonally spread by 1 of 64 possible Walsh
code functions; additionally, they are also spread by a quadrature pair of
PN sequences unique to each sector.

Overall, the mobile uses this to differentiate multiple signals transmitted
from the same BTS (and surrounding BTS) sectors, and to synchronize
to the next strongest sector.

The PN offset per sector is stored on the BBXs, where the
corresponding I & Q registers reside.

The PN offset values are determined on a per BTS/per sector(antenna)
basis as determined by the appropriate cdf file content. A breakdown of
this information is found in Table E-1.

Usage 
There are three basic RF chip delays currently in use. It is important to
determine what RF chip delay is valid to be able to test the BTS
functionality.  This can be done by ascertaining  if the CDF file 
FineTxAdj  value was set to “on” when the MCC was downloaded with
“image data”. The FineTxAdj value is used to compensate for the
processing delay (approximately 20 �S) in the BTS using any type of
mobile meeting IS-97 specifications.

Observe the following guidelines:

� If the FineTxAdj value in the cdf file is 101 (65 HEX), the
FineTxAdj has not been set. The I and Q values from the 0 table
MUST be used.

If the FineTxAdj value in the cdf file is 213 (D5 HEX), FineTxAdj has
been set for the 14 chip table.

� If the FineTxAdj value in the cdf file is 197 (C5 HEX), FineTxAdj
has been set for the 13 chip table.

NOTE CDF file I and Q values can be represented in DECIMAL or
HEX. If using HEX, add 0x before the HEX value. If necessary,
convert HEX values in Table E-1 to decimal before comparing
them to cdf file I & Q value assignments.

- If you are using a Qualcomm mobile, use the I and Q values from
the 13 chip delay table.

- If you are using a mobile that does not have the 1 chip offset
problem, (any mobile meeting the IS-97 specification), use the 14
chip delay table.

NOTE If the wrong  I and Q values are used with the wrong
FineTxAdj parameter, system timing problems will occur. This
will cause the energy transmitted to be “smeared” over several
Walsh codes (instead of the single Walsh code that it was
assigned to), causing erratic operation. Evidence of smearing is
usually identified by Walsh channels not at correct levels or
present when not selected in the Code Domain Power Test.
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Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14-Chip Delay 13-Chip Delay 0-Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

0 17523 23459 4473 5BA3 29673 25581 73E9 63ED 4096 4096 1000 1000

1 32292 32589 7E24 7F4D 16146 29082 3F12 719A 9167 1571 23CF 0623
2 4700 17398 125C 43F6 2350 8699 092E 21FB 22417 7484 5791 1D3C

3 14406 26333 3846 66DD 7203 32082 1C23 7D52 966 6319 03C6 18AF
4 14899 4011 3A33 0FAB 19657 18921 4CC9 49E9 14189 2447 376D 098F

5 17025 2256 4281 08D0 28816 1128 7090 0468 29150 24441 71DE 5F79
6 14745 18651 3999 48DB 19740 27217 4D1C 6A51 18245 27351 4745 6AD7

7 2783 1094 0ADF 0446 21695 547 54BF 0223 1716 23613 06B4 5C3D
8 5832 21202 16C8 52D2 2916 10601 0B64 2969 11915 29008 2E8B 7150

9 12407 13841 3077 3611 18923 21812 49EB 5534 20981 5643 51F5 160B
10 31295 31767 7A3F 7C17 27855 28727 6CCF 7037 24694 28085 6076 6DB5

11 7581 18890 1D9D 49CA 24350 9445 5F1E 24E5 11865 18200 2E59 4718
12 18523 30999 485B 7917 30205 29367 75FD 72B7 6385 21138 18F1 5292

13 29920 22420 74E0 5794 14960 11210 3A70 2BCA 27896 21937 6CF8 55B1
14 25184 20168 6260 4EC8 12592 10084 3130 2764 25240 25222 6298 6286

15 26282 12354 66AA 3042 13141 6177 3355 1821 30877 109 789D 006D
16 30623 11187 779F 2BB3 27167 23525 6A1F 5BE5 30618 6028 779A 178C

17 15540 11834 3CB4 2E3A 7770 5917 1E5A 171D 26373 22034 6705 5612
18 23026 10395 59F2 289B 11513 23153 2CF9 5A71 314 15069 013A 3ADD

19 20019 28035 4E33 6D83 30409 30973 76C9 78FD 17518 4671 446E 123F
20 4050 27399 0FD2 6B07 2025 31679 07E9 7BBF 21927 30434 55A7 76E2

21 1557 22087 0615 5647 21210 25887 52DA 651F 2245 11615 08C5 2D5F
22 30262 2077 7636 081D 15131 18994 3B1B 4A32 18105 19838 46B9 4D7E

23 18000 13758 4650 35BE 9000 6879 2328 1ADF 8792 14713 2258 3979
24 20056 11778 4E58 2E02 10028 5889 272C 1701 21440 241 53C0 00F1

25 12143 3543 2F6F 0DD7 18023 18647 4667 48D7 15493 24083 3C85 5E13
26 17437 7184 441D 1C10 29662 3592 73DE 0E08 26677 7621 6835 1DC5

27 17438 2362 441E 093A 8719 1181 220F 049D 11299 19144 2C23 4AC8
28 5102 25840 13EE 64F0 2551 12920 09F7 3278 12081 1047 2F31 0417

29 9302 12177 2456 2F91 4651 23028 122B 59F4 23833 26152 5D19 6628
30 17154 10402 4302 28A2 8577 5201 2181 1451 20281 22402 4F39 5782

31 5198 1917 144E 077D 2599 19842 0A27 4D82 10676 21255 29B4 5307
32 4606 17708 11FE 452C 2303 8854 08FF 2296 16981 30179 4255 75E3

33 24804 10630 60E4 2986 12402 5315 3072 14C3 31964 7408 7CDC 1CF0
34 17180 6812 431C 1A9C 8590 3406 218E 0D4E 26913 115 6921 0073

35 10507 14350 290B 380E 17749 7175 4555 1C07 14080 1591 3700 0637
36 10157 10999 27AD 2AF7 16902 23367 4206 5B47 23842 1006 5D22 03EE

37 23850 25003 5D2A 61AB 11925 32489 2E95 7EE9 27197 32263 6A3D 7E07
38 31425 2652 7AC1 0A5C 27824 1326 6CB0 052E 22933 1332 5995 0534

39 4075 19898 0FEB 4DBA 22053 9949 5625 26DD 30220 12636 760C 315C
40 10030 2010 272E 07DA 5015 1005 1397 03ED 12443 4099 309B 1003

41 16984 25936 4258 6550 8492 12968 212C 32A8 19854 386 4D8E 0182
42 14225 28531 3791 6F73 18968 31109 4A18 7985 14842 29231 39FA 722F

43 26519 11952 6797 2EB0 25115 5976 621B 1758 15006 25711 3A9E 646F
44 27775 31947 6C7F 7CCB 26607 28761 67EF 7059 702 10913 02BE 2AA1

45 30100 25589 7594 63F5 15050 32710 3ACA 7FC6 21373 8132 537D 1FC4
46 7922 11345 1EF2 2C51 3961 22548 0F79 5814 23874 20844 5D42 516C

47 14199 28198 3777 6E26 19051 14099 4A6B 3713 3468 13150 0D8C 335E
48 17637 13947 44E5 367B 29602 21761 73A2 5501 31323 18184 7A5B 4708

49 23081 8462 5A29 210E 31940 4231 7CC4 1087 29266 19066 7252 4A7A
50 5099 9595 13EB 257B 22565 23681 5825 5C81 16554 29963 40AA 750B

. . . continued on next page
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Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14-Chip Delay 13-Chip Delay 0-Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

51 32743 4670 7FE7 123E 28195 2335 6E23 091F 22575 6605 582F 19CD

52 7114 14672 1BCA 3950 3557 7336 0DE5 1CA8 31456 29417 7AE0 72E9
53 7699 29415 1E13 72E7 24281 30543 5ED9 774F 8148 22993 1FD4 59D1

54 19339 20610 4B8B 5082 29717 10305 7415 2841 19043 27657 4A63 6C09
55 28212 6479 6E34 194F 14106 17051 371A 429B 25438 5468 635E 155C

56 29587 10957 7393 2ACD 26649 23386 6819 5B5A 10938 8821 2ABA 2275
57 19715 18426 4D03 47FA 30545 9213 7751 23FD 2311 20773 0907 5125

58 14901 22726 3A35 58C6 19658 11363 4CCA 2C63 7392 4920 1CE0 1338
59 20160 5247 4EC0 147F 10080 17411 2760 4403 30714 5756 77FA 167C

60 22249 29953 56E9 7501 31396 29884 7AA4 74BC 180 28088 00B4 6DB8
61 26582 5796 67D6 16A4 13291 2898 33EB 0B52 8948 740 22F4 02E4

62 7153 16829 1BF1 41BD 23592 28386 5C28 6EE2 16432 23397 4030 5B65
63 15127 4528 3B17 11B0 19547 2264 4C5B 08D8 9622 19492 2596 4C24

64 15274 5415 3BAA 1527 7637 17583 1DD5 44AF 7524 26451 1D64 6753
65 23149 10294 5A6D 2836 31974 5147 7CE6 141B 1443 30666 05A3 77CA

66 16340 17046 3FD4 4296 8170 8523 1FEA 214B 1810 15088 0712 3AF0
67 27052 7846 69AC 1EA6 13526 3923 34D6 0F53 6941 26131 1B1D 6613

68 13519 10762 34CF 2A0A 19383 5381 4BB7 1505 3238 15969 0CA6 3E61
69 10620 13814 297C 35F6 5310 6907 14BE 1AFB 8141 24101 1FCD 5E25

70 15978 16854 3E6A 41D6 7989 8427 1F35 20EB 10408 12762 28A8 31DA
71 27966 795 6D3E 031B 13983 20401 369F 4FB1 18826 19997 498A 4E1D

72 12479 9774 30BF 262E 18831 4887 498F 1317 22705 22971 58B1 59BB
73 1536 24291 0600 5EE3 768 24909 0300 614D 3879 12560 0F27 3110

74 3199 3172 0C7F 0C64 22511 1586 57EF 0632 21359 31213 536F 79ED
75 4549 2229 11C5 08B5 22834 19046 5932 4A66 30853 18780 7885 495C

76 17888 21283 45E0 5323 8944 26541 22F0 67AD 18078 16353 469E 3FE1
77 13117 16905 333D 4209 18510 28472 484E 6F38 15910 12055 3E26 2F17

78 7506 7062 1D52 1B96 3753 3531 0EA9 0DCB 20989 30396 51FD 76BC
79 27626 7532 6BEA 1D6C 13813 3766 35F5 0EB6 28810 24388 708A 5F44

80 31109 25575 7985 63E7 27922 32719 6D12 7FCF 30759 1555 7827 0613
81 29755 14244 743B 37A4 27597 7122 6BCD 1BD2 18899 13316 49D3 3404

82 26711 28053 6857 6D95 26107 30966 65FB 78F6 7739 31073 1E3B 7961
83 20397 30408 4FAD 76C8 30214 15204 7606 3B64 6279 6187 1887 182B

84 18608 5094 48B0 13E6 9304 2547 2458 09F3 9968 21644 26F0 548C
85 7391 16222 1CDF 3F5E 24511 8111 5FBF 1FAF 8571 9289 217B 2449

86 23168 7159 5A80 1BF7 11584 17351 2D40 43C7 4143 4624 102F 1210
87 23466 174 5BAA 00AE 11733 87 2DD5 0057 19637 467 4CB5 01D3

88 15932 25530 3E3C 63BA 7966 12765 1F1E 31DD 11867 18133 2E5B 46D5
89 25798 2320 64C6 0910 12899 1160 3263 0488 7374 1532 1CCE 05FC

90 28134 23113 6DE6 5A49 14067 25368 36F3 6318 10423 1457 28B7 05B1
91 28024 23985 6D78 5DB1 14012 24804 36BC 60E4 9984 9197 2700 23ED

92 6335 2604 18BF 0A2C 23951 1302 5D8F 0516 7445 13451 1D15 348B
93 21508 1826 5404 0722 10754 913 2A02 0391 4133 25785 1025 64B9

94 26338 30853 66E2 7885 13169 29310 3371 727E 22646 4087 5876 0FF7
95 17186 15699 4322 3D53 8593 20629 2191 5095 15466 31190 3C6A 79D6

96 22462 2589 57BE 0A1D 11231 19250 2BDF 4B32 2164 8383 0874 20BF
97 3908 25000 0F44 61A8 1954 12500 07A2 30D4 16380 12995 3FFC 32C3

98 25390 18163 632E 46F3 12695 27973 3197 6D45 15008 27438 3AA0 6B2E
99 27891 12555 6CF3 310B 26537 22201 67A9 56B9 31755 9297 7C0B 2451

100 9620 8670 2594 21DE 4810 4335 12CA 10EF 31636 1676 7B94 068C
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Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14-Chip Delay 13-Chip Delay 0-Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

101 6491 1290 195B 050A 23933 645 5D7D 0285 25414 12596 6346 3134

102 16876 4407 41EC 1137 8438 18087 20F6 46A7 7102 19975 1BBE 4E07
103 17034 1163 428A 048B 8517 19577 2145 4C79 20516 20026 5024 4E3A

104 32405 12215 7E95 2FB7 28314 23015 6E9A 59E7 19495 8958 4C27 22FE
105 27417 7253 6B19 1C55 25692 16406 645C 4016 17182 19143 431E 4AC7

106 8382 8978 20BE 2312 4191 4489 105F 1189 11572 17142 2D34 42F6
107 5624 25547 15F8 63CB 2812 32729 0AFC 7FD9 25570 19670 63E2 4CD6

108 1424 3130 0590 0C3A 712 1565 02C8 061D 6322 30191 18B2 75EF
109 13034 31406 32EA 7AAE 6517 15703 1975 3D57 8009 5822 1F49 16BE

110 15682 6222 3D42 184E 7841 3111 1EA1 0C27 26708 22076 6854 563C
111 27101 20340 69DD 4F74 25918 10170 653E 27BA 6237 606 185D 025E

112 8521 25094 2149 6206 16756 12547 4174 3103 32520 9741 7F08 260D
113 30232 23380 7618 5B54 15116 11690 3B0C 2DAA 31627 9116 7B8B 239C

114 6429 10926 191D 2AAE 23902 5463 5D5E 1557 3532 12705 0DCC 31A1
115 27116 22821 69EC 5925 13558 25262 34F6 62AE 24090 17502 5E1A 445E

116 4238 31634 108E 7B92 2119 15817 0847 3DC9 20262 18952 4F26 4A08
117 5128 4403 1408 1133 2564 18085 0A04 46A5 18238 15502 473E 3C8E

118 14846 689 39FE 02B1 7423 20324 1CFF 4F64 2033 17819 07F1 459B
119 13024 27045 32E0 69A5 6512 31470 1970 7AEE 25566 4370 63DE 1112

120 10625 27557 2981 6BA5 17680 31726 4510 7BEE 25144 31955 6238 7CD3
121 31724 16307 7BEC 3FB3 15862 20965 3DF6 51E5 29679 30569 73EF 7769

122 13811 22338 35F3 5742 19241 11169 4B29 2BA1 5064 7350 13C8 1CB6
123 24915 27550 6153 6B9E 24953 13775 6179 35CF 27623 26356 6BE7 66F4

124 1213 22096 04BD 5650 21390 11048 538E 2B28 13000 32189 32C8 7DBD
125 2290 23136 08F2 5A60 1145 11568 0479 2D30 31373 1601 7A8D 0641

126 31551 12199 7B3F 2FA7 27727 23023 6C4F 59EF 13096 19537 3328 4C51
127 12088 1213 2F38 04BD 6044 19554 179C 4C62 26395 25667 671B 6443

128 7722 936 1E2A 03A8 3861 468 0F15 01D4 15487 4415 3C7F 113F
129 27312 6272 6AB0 1880 13656 3136 3558 0C40 29245 2303 723D 08FF

130 23130 32446 5A5A 7EBE 11565 16223 2D2D 3F5F 26729 16362 6869 3FEA
131 594 13555 0252 34F3 297 21573 0129 5445 12568 28620 3118 6FCC

132 25804 8789 64CC 2255 12902 24342 3266 5F16 24665 6736 6059 1A50
133 31013 24821 7925 60F5 27970 32326 6D42 7E46 8923 2777 22DB 0AD9

134 32585 21068 7F49 524C 28276 10534 6E74 2926 19634 24331 4CB2 5F0B
135 3077 31891 0C05 7C93 22482 28789 57D2 7075 29141 9042 71D5 2352

136 17231 5321 434F 14C9 28791 17496 7077 4458 73 107 0049 006B
137 31554 551 7B42 0227 15777 20271 3DA1 4F2F 26482 4779 6772 12AB

138 8764 12115 223C 2F53 4382 22933 111E 5995 6397 13065 18FD 3309
139 15375 4902 3C0F 1326 20439 2451 4FD7 0993 29818 30421 747A 76D5

140 13428 1991 3474 07C7 6714 19935 1A3A 4DDF 8153 20210 1FD9 4EF2
141 17658 14404 44FA 3844 8829 7202 227D 1C22 302 5651 012E 1613

142 13475 17982 34A3 463E 19329 8991 4B81 231F 28136 31017 6DE8 7929
143 22095 19566 564F 4C6E 31479 9783 7AF7 2637 29125 30719 71C5 77FF

144 24805 2970 60E5 0B9A 24994 1485 61A2 05CD 8625 23104 21B1 5A40
145 4307 23055 10D3 5A0F 22969 25403 59B9 633B 26671 7799 682F 1E77

146 23292 15158 5AFC 3B36 11646 7579 2D7E 1D9B 6424 17865 1918 45C9
147 1377 29094 0561 71A6 21344 14547 5360 38D3 12893 26951 325D 6947

148 28654 653 6FEE 028D 14327 20346 37F7 4F7A 18502 25073 4846 61F1
149 6350 19155 18CE 4AD3 3175 27477 0C67 6B55 7765 32381 1E55 7E7D

150 16770 23588 4182 5C24 8385 11794 20C1 2E12 25483 16581 638B 40C5

. . . continued on next page

E



PN Offset 68P09255A57-2

Aug 2002SC�4812ET Optimization/ATP Manual Software Release R16.1.x.x
PRELIMINARY

E-6

Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14-Chip Delay 13-Chip Delay 0-Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

151 14726 10878 3986 2A7E 7363 5439 1CC3 153F 15408 32087 3C30 7D57

152 25685 31060 6455 7954 25594 15530 63FA 3CAA 6414 97 190E 0061
153 21356 30875 536C 789B 10678 29297 29B6 7271 8164 7618 1FE4 1DC2

154 12149 11496 2F75 2CE8 18026 5748 466A 1674 10347 93 286B 005D
155 28966 24545 7126 5FE1 14483 25036 3893 61CC 29369 16052 72B9 3EB4

156 22898 9586 5972 2572 11449 4793 2CB9 12B9 10389 14300 2895 37DC
157 1713 20984 06B1 51F8 21128 10492 5288 28FC 24783 11129 60CF 2B79

158 30010 30389 753A 76B5 15005 30054 3A9D 7566 18400 6602 47E0 19CA
159 2365 7298 093D 1C82 21838 3649 554E 0E41 22135 14460 5677 387C

160 27179 18934 6A2B 49F6 25797 9467 64C5 24FB 4625 25458 1211 6372
161 29740 23137 742C 5A61 14870 25356 3A16 630C 22346 15869 574A 3DFD

162 5665 24597 1621 6015 23232 32310 5AC0 7E36 2545 27047 09F1 69A7
163 23671 23301 5C77 5B05 32747 25534 7FEB 63BE 7786 26808 1E6A 68B8

164 1680 7764 0690 1E54 840 3882 0348 0F2A 20209 7354 4EF1 1CBA
165 25861 14518 6505 38B6 25426 7259 6352 1C5B 26414 27834 672E 6CBA

166 25712 21634 6470 5482 12856 10817 3238 2A41 1478 11250 05C6 2BF2
167 19245 11546 4B2D 2D1A 29766 5773 7446 168D 15122 552 3B12 0228

168 26887 26454 6907 6756 25939 13227 6553 33AB 24603 27058 601B 69B2
169 30897 15938 78B1 3E42 28040 7969 6D88 1F21 677 14808 02A5 39D8

170 11496 9050 2CE8 235A 5748 4525 1674 11AD 13705 9642 3589 25AA
171 1278 3103 04FE 0C1F 639 18483 027F 4833 13273 32253 33D9 7DFD

172 31555 758 7B43 02F6 27761 379 6C71 017B 14879 26081 3A1F 65E1
173 29171 16528 71F3 4090 26921 8264 6929 2048 6643 21184 19F3 52C0

174 20472 20375 4FF8 4F97 10236 27127 27FC 69F7 23138 11748 5A62 2DE4
175 5816 10208 16B8 27E0 2908 5104 0B5C 13F0 28838 32676 70A6 7FA4

176 30270 17698 763E 4522 15135 8849 3B1F 2291 9045 2425 2355 0979
177 22188 8405 56AC 20D5 11094 24150 2B56 5E56 10792 19455 2A28 4BFF

178 6182 28634 1826 6FDA 3091 14317 0C13 37ED 25666 19889 6442 4DB1
179 32333 1951 7E4D 079F 28406 19955 6EF6 4DF3 11546 18177 2D1A 4701

180 14046 20344 36DE 4F78 7023 10172 1B6F 27BC 15535 2492 3CAF 09BC
181 15873 26696 3E01 6848 20176 13348 4ED0 3424 16134 15086 3F06 3AEE

182 19843 3355 4D83 0D1B 30481 18609 7711 48B1 8360 30632 20A8 77A8
183 29367 11975 72B7 2EC7 26763 22879 688B 595F 14401 27549 3841 6B9D

184 13352 31942 3428 7CC6 6676 15971 1A14 3E63 26045 6911 65BD 1AFF
185 22977 9737 59C1 2609 32048 23864 7D30 5D38 24070 9937 5E06 26D1

186 31691 9638 7BCB 25A6 27701 4819 6C35 12D3 30300 2467 765C 09A3
187 10637 30643 298D 77B3 17686 30181 4516 75E5 13602 25831 3522 64E7

188 25454 13230 636E 33AE 12727 6615 31B7 19D7 32679 32236 7FA7 7DEC
189 18610 22185 48B2 56A9 9305 25960 2459 6568 16267 12987 3F8B 32BB

190 6368 2055 18E0 0807 3184 19007 0C70 4A3F 9063 11714 2367 2DC2
191 7887 8767 1ECF 223F 24247 24355 5EB7 5F23 19487 19283 4C1F 4B53

192 7730 15852 1E32 3DEC 3865 7926 0F19 1EF6 12778 11542 31EA 2D16
193 23476 16125 5BB4 3EFD 11738 20802 2DDA 5142 27309 27928 6AAD 6D18

194 889 6074 0379 17BA 20588 3037 506C 0BDD 12527 26637 30EF 680D
195 21141 31245 5295 7A0D 30874 29498 789A 733A 953 10035 03B9 2733

196 20520 15880 5028 3E08 10260 7940 2814 1F04 15958 10748 3E56 29FC
197 21669 20371 54A5 4F93 31618 27125 7B82 69F5 6068 24429 17B4 5F6D

198 15967 8666 3E5F 21DA 20223 4333 4EFF 10ED 23577 29701 5C19 7405
199 21639 816 5487 0330 31635 408 7B93 0198 32156 14997 7D9C 3A95

200 31120 22309 7990 5725 15560 26030 3CC8 65AE 32709 32235 7FC5 7DEB
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Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14-Chip Delay 13-Chip Delay 0-Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

201 3698 29563 0E72 737B 1849 30593 0739 7781 23557 30766 5C05 782E

202 16322 13078 3FC2 3316 8161 6539 1FE1 198B 17638 5985 44E6 1761
203 17429 10460 4415 28DC 29658 5230 73DA 146E 3545 6823 0DD9 1AA7

204 21730 17590 54E2 44B6 10865 8795 2A71 225B 9299 20973 2453 51ED
205 17808 20277 4590 4F35 8904 27046 22C8 69A6 6323 10197 18B3 27D5

206 30068 19988 7574 4E14 15034 9994 3ABA 270A 19590 9618 4C86 2592
207 12737 6781 31C1 1A7D 18736 17154 4930 4302 7075 22705 1BA3 58B1

208 28241 32501 6E51 7EF5 26360 28998 66F8 7146 14993 5234 3A91 1472
209 20371 6024 4F93 1788 30233 3012 7619 0BC4 19916 12541 4DCC 30FD

210 13829 20520 3605 5028 19154 10260 4AD2 2814 6532 8019 1984 1F53
211 13366 31951 3436 7CCF 6683 28763 1A1B 705B 17317 22568 43A5 5828

212 25732 26063 6484 65CF 12866 31963 3242 7CDB 16562 5221 40B2 1465
213 19864 27203 4D98 6A43 9932 31517 26CC 7B1D 26923 25216 692B 6280

214 5187 6614 1443 19D6 23537 3307 5BF1 0CEB 9155 1354 23C3 054A
215 23219 10970 5AB3 2ADA 31881 5485 7C89 156D 20243 29335 4F13 7297

216 28242 5511 6E52 1587 14121 17663 3729 44FF 32391 6682 7E87 1A1A
217 6243 17119 1863 42DF 24033 28499 5DE1 6F53 20190 26128 4EDE 6610

218 445 16064 01BD 3EC0 20750 8032 510E 1F60 27564 29390 6BAC 72CE
219 21346 31614 5362 7B7E 10673 15807 29B1 3DBF 20869 8852 5185 2294

220 13256 4660 33C8 1234 6628 2330 19E4 091A 9791 6110 263F 17DE
221 18472 13881 4828 3639 9236 21792 2414 5520 714 11847 02CA 2E47

222 25945 16819 6559 41B3 25468 28389 637C 6EE5 7498 10239 1D4A 27FF
223 31051 6371 794B 18E3 28021 16973 6D75 424D 23278 6955 5AEE 1B2B

224 1093 24673 0445 6061 21490 32268 53F2 7E0C 8358 10897 20A6 2A91
225 5829 6055 16C5 17A7 23218 17903 5AB2 45EF 9468 14076 24FC 36FC

226 31546 10009 7B3A 2719 15773 23984 3D9D 5DB0 23731 12450 5CB3 30A2
227 29833 5957 7489 1745 27540 17822 6B94 459E 25133 8954 622D 22FA

228 18146 11597 46E2 2D4D 9073 22682 2371 589A 2470 19709 09A6 4CFD
229 24813 22155 60ED 568B 24998 25977 61A6 6579 17501 1252 445D 04E4

230 47 15050 002F 3ACA 20935 7525 51C7 1D65 24671 15142 605F 3B26
231 3202 16450 0C82 4042 1601 8225 0641 2021 11930 26958 2E9A 694E

232 21571 27899 5443 6CFB 31729 30785 7BF1 7841 9154 8759 23C2 2237
233 7469 2016 1D2D 07E0 24390 1008 5F46 03F0 7388 12696 1CDC 3198

234 25297 17153 62D1 4301 24760 28604 60B8 6FBC 3440 11936 0D70 2EA0
235 8175 15849 1FEF 3DE9 24103 20680 5E27 50C8 27666 25635 6C12 6423

236 28519 30581 6F67 7775 26211 30086 6663 7586 22888 17231 5968 434F
237 4991 3600 137F 0E10 22639 1800 586F 0708 13194 22298 338A 571A

238 7907 4097 1EE3 1001 24225 17980 5EA1 463C 26710 7330 6856 1CA2
239 17728 671 4540 029F 8864 20339 22A0 4F73 7266 30758 1C62 7826

240 14415 20774 384F 5126 19959 10387 4DF7 2893 15175 6933 3B47 1B15
241 30976 24471 7900 5F97 15488 25079 3C80 61F7 15891 2810 3E13 0AFA

242 26376 27341 6708 6ACD 13188 31578 3384 7B5A 26692 8820 6844 2274
243 19063 19388 4A77 4BBC 29931 9694 74EB 25DE 14757 7831 39A5 1E97

244 19160 25278 4AD8 62BE 9580 12639 256C 315F 28757 19584 7055 4C80
245 3800 9505 0ED8 2521 1900 23724 076C 5CAC 31342 2944 7A6E 0B80

246 8307 26143 2073 661F 16873 32051 41E9 7D33 19435 19854 4BEB 4D8E
247 12918 13359 3276 342F 6459 21547 193B 542B 2437 10456 0985 28D8

248 19642 2154 4CBA 086A 9821 1077 265D 0435 20573 17036 505D 428C
249 24873 13747 6129 35B3 24900 21733 6144 54E5 18781 2343 495D 0927

250 22071 27646 5637 6BFE 31435 13823 7ACB 35FF 18948 14820 4A04 39E4
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Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14-Chip Delay 13-Chip Delay 0-Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

251 13904 1056 3650 0420 6952 528 1B28 0210 23393 1756 5B61 06DC

252 27198 1413 6A3E 0585 13599 19710 351F 4CFE 5619 19068 15F3 4A7C
253 3685 3311 0E65 0CEF 22242 18507 56E2 484B 17052 28716 429C 702C

254 16820 4951 41B4 1357 8410 18327 20DA 4797 21292 31958 532C 7CD6
255 22479 749 57CF 02ED 31287 20298 7A37 4F4A 2868 16097 0B34 3EE1

256 6850 6307 1AC2 18A3 3425 17005 0D61 426D 19538 1308 4C52 051C
257 15434 961 3C4A 03C1 7717 20444 1E25 4FDC 24294 3320 5EE6 0CF8

258 19332 2358 4B84 0936 9666 1179 25C2 049B 22895 16682 596F 412A
259 8518 28350 2146 6EBE 4259 14175 10A3 375F 27652 6388 6C04 18F4

260 14698 31198 396A 79DE 7349 15599 1CB5 3CEF 29905 12828 74D1 321C
261 21476 11467 53E4 2CCB 10738 22617 29F2 5859 21415 3518 53A7 0DBE

262 30475 8862 770B 229E 27221 4431 6A55 114F 1210 3494 04BA 0DA6
263 23984 6327 5DB0 18B7 11992 16999 2ED8 4267 22396 6458 577C 193A

264 1912 7443 0778 1D13 956 16565 03BC 40B5 26552 10717 67B8 29DD
265 26735 28574 686F 6F9E 26087 14287 65E7 37CF 24829 8463 60FD 210F

266 15705 25093 3D59 6205 20348 32574 4F7C 7F3E 8663 27337 21D7 6AC9
267 3881 6139 0F29 17FB 22084 17857 5644 45C1 991 19846 03DF 4D86

268 20434 22047 4FD2 561F 10217 25907 27E9 6533 21926 9388 55A6 24AC
269 16779 32545 418B 7F21 28949 29100 7115 71AC 23306 21201 5B0A 52D1

270 31413 7112 7AB5 1BC8 27786 3556 6C8A 0DE4 13646 31422 354E 7ABE
271 16860 28535 41DC 6F77 8430 31111 20EE 7987 148 166 0094 00A6

272 8322 10378 2082 288A 4161 5189 1041 1445 24836 28622 6104 6FCE
273 28530 15065 6F72 3AD9 14265 21328 37B9 5350 24202 6477 5E8A 194D

274 26934 5125 6936 1405 13467 17470 349B 443E 9820 10704 265C 29D0
275 18806 12528 4976 30F0 9403 6264 24BB 1878 12939 25843 328B 64F3

276 20216 23215 4EF8 5AAF 10108 25451 277C 636B 2364 25406 093C 633E
277 9245 20959 241D 51DF 17374 26323 43DE 66D3 14820 21523 39E4 5413

278 8271 3568 204F 0DF0 16887 1784 41F7 06F8 2011 8569 07DB 2179
279 18684 26453 48FC 6755 9342 32150 247E 7D96 13549 9590 34ED 2576

280 8220 29421 201C 72ED 4110 30538 100E 774A 28339 22466 6EB3 57C2
281 6837 24555 1AB5 5FEB 23690 25033 5C8A 61C9 25759 12455 649F 30A7

282 9613 10779 258D 2A1B 17174 23345 4316 5B31 11116 27506 2B6C 6B72
283 31632 25260 7B90 62AC 15816 12630 3DC8 3156 31448 21847 7AD8 5557

284 27448 16084 6B38 3ED4 13724 8042 359C 1F6A 27936 28392 6D20 6EE8
285 12417 26028 3081 65AC 18832 13014 4990 32D6 3578 1969 0DFA 07B1

286 30901 29852 78B5 749C 28042 14926 6D8A 3A4E 12371 30715 3053 77FB
287 9366 14978 2496 3A82 4683 7489 124B 1D41 12721 23674 31B1 5C7A

288 12225 12182 2FC1 2F96 17968 6091 4630 17CB 10264 22629 2818 5865
289 21458 25143 53D2 6237 10729 32551 29E9 7F27 25344 12857 6300 3239

290 6466 15838 1942 3DDE 3233 7919 0CA1 1EEF 13246 30182 33BE 75E6
291 8999 5336 2327 14D8 16451 2668 4043 0A6C 544 21880 0220 5578

292 26718 21885 685E 557D 13359 25730 342F 6482 9914 6617 26BA 19D9
293 3230 20561 0C9E 5051 1615 26132 064F 6614 4601 27707 11F9 6C3B

294 27961 30097 6D39 7591 26444 29940 674C 74F4 16234 16249 3F6A 3F79
295 28465 21877 6F31 5575 26184 25734 6648 6486 24475 24754 5F9B 60B2

296 6791 23589 1A87 5C25 23699 24622 5C93 602E 26318 31609 66CE 7B79
297 17338 26060 43BA 65CC 8669 13030 21DD 32E6 6224 22689 1850 58A1

298 11832 9964 2E38 26EC 5916 4982 171C 1376 13381 3226 3445 0C9A
299 11407 25959 2C8F 6567 18327 31887 4797 7C8F 30013 4167 753D 1047

300 15553 3294 3CC1 0CDE 20400 1647 4FB0 066F 22195 25624 56B3 6418
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301 17418 30173 440A 75DD 8709 29906 2205 74D2 30380 10924 76AC 2AAC

302 14952 15515 3A68 3C9B 7476 20593 1D34 5071 15337 23096 3BE9 5A38
303 52 5371 0034 14FB 26 17473 001A 4441 10716 22683 29DC 589B

304 27254 10242 6A76 2802 13627 5121 353B 1401 13592 10955 3518 2ACB
305 15064 28052 3AD8 6D94 7532 14026 1D6C 36CA 2412 17117 096C 42DD

306 10942 14714 2ABE 397A 5471 7357 155F 1CBD 15453 15837 3C5D 3DDD
307 377 19550 0179 4C5E 20844 9775 516C 262F 13810 22647 35F2 5877

308 14303 8866 37DF 22A2 19007 4433 4A3F 1151 12956 10700 329C 29CC
309 24427 15297 5F6B 3BC1 32357 21468 7E65 53DC 30538 30293 774A 7655

310 26629 10898 6805 2A92 26066 5449 65D2 1549 10814 5579 2A3E 15CB
311 20011 31315 4E2B 7A53 30405 29461 76C5 7315 18939 11057 49FB 2B31

312 16086 19475 3ED6 4C13 8043 26677 1F6B 6835 19767 30238 4D37 761E
313 24374 1278 5F36 04FE 12187 639 2F9B 027F 20547 14000 5043 36B0

314 9969 11431 26F1 2CA7 17064 22639 42A8 586F 29720 22860 7418 594C
315 29364 31392 72B4 7AA0 14682 15696 395A 3D50 31831 27172 7C57 6A24

316 25560 4381 63D8 111D 12780 18098 31EC 46B2 26287 307 66AF 0133
317 28281 14898 6E79 3A32 26348 7449 66EC 1D19 11310 20380 2C2E 4F9C

318 7327 23959 1C9F 5D97 24479 24823 5F9F 60F7 25724 26427 647C 673B
319 32449 16091 7EC1 3EDB 28336 20817 6EB0 5151 21423 10702 53AF 29CE

320 26334 9037 66DE 234D 13167 24474 336F 5F9A 5190 30024 1446 7548
321 14760 24162 39A8 5E62 7380 12081 1CD4 2F31 258 14018 0102 36C2

322 15128 6383 3B18 18EF 7564 16971 1D8C 424B 13978 4297 369A 10C9
323 29912 27183 74D8 6A2F 14956 31531 3A6C 7B2B 4670 13938 123E 3672

324 4244 16872 1094 41E8 2122 8436 084A 20F4 23496 25288 5BC8 62C8
325 8499 9072 2133 2370 16713 4536 4149 11B8 23986 27294 5DB2 6A9E

326 9362 12966 2492 32A6 4681 6483 1249 1953 839 31835 0347 7C5B
327 10175 28886 27BF 70D6 16911 14443 420F 386B 11296 8228 2C20 2024

328 30957 25118 78ED 621E 28070 12559 6DA6 310F 30913 12745 78C1 31C9
329 12755 20424 31D3 4FC8 18745 10212 4939 27E4 27297 6746 6AA1 1A5A

330 19350 6729 4B96 1A49 9675 17176 25CB 4318 10349 1456 286D 05B0
331 1153 20983 0481 51F7 21392 26311 5390 66C7 32504 27743 7EF8 6C5F

332 29304 12372 7278 3054 14652 6186 393C 182A 18405 27443 47E5 6B33
333 6041 13948 1799 367C 23068 6974 5A1C 1B3E 3526 31045 0DC6 7945

334 21668 27547 54A4 6B9B 10834 31729 2A52 7BF1 19161 12225 4AD9 2FC1
335 28048 8152 6D90 1FD8 14024 4076 36C8 0FEC 23831 21482 5D17 53EA

336 10096 17354 2770 43CA 5048 8677 13B8 21E5 21380 14678 5384 3956
337 23388 17835 5B5C 45AB 11694 27881 2DAE 6CE9 4282 30656 10BA 77C0

338 15542 14378 3CB6 382A 7771 7189 1E5B 1C15 32382 13721 7E7E 3599
339 24013 7453 5DCD 1D1D 32566 16562 7F36 40B2 806 21831 0326 5547

340 2684 26317 0A7C 66CD 1342 32090 053E 7D5A 6238 30208 185E 7600
341 19018 5955 4A4A 1743 9509 17821 2525 459D 10488 9995 28F8 270B

342 25501 10346 639D 286A 24606 5173 601E 1435 19507 3248 4C33 0CB0
343 4489 13200 1189 3390 22804 6600 5914 19C8 27288 12030 6A98 2EFE

344 31011 30402 7923 76C2 27969 15201 6D41 3B61 2390 5688 0956 1638
345 29448 7311 7308 1C8F 14724 16507 3984 407B 19094 2082 4A96 0822

346 25461 3082 6375 0C0A 24682 1541 606A 0605 13860 23143 3624 5A67
347 11846 21398 2E46 5396 5923 10699 1723 29CB 9225 25906 2409 6532

348 30331 31104 767B 7980 27373 15552 6AED 3CC0 2505 15902 09C9 3E1E
349 10588 24272 295C 5ED0 5294 12136 14AE 2F68 27806 21084 6C9E 525C

350 32154 27123 7D9A 69F3 16077 31429 3ECD 7AC5 2408 25723 0968 647B

. . . continued on next page
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Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14-Chip Delay 13-Chip Delay 0-Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

351 29572 5578 7384 15CA 14786 2789 39C2 0AE5 13347 13427 3423 3473

352 13173 25731 3375 6483 18538 31869 486A 7C7D 7885 31084 1ECD 796C
353 10735 10662 29EF 29A6 17703 5331 4527 14D3 6669 24023 1A0D 5DD7

354 224 11084 00E0 2B4C 112 5542 0070 15A6 8187 23931 1FFB 5D7B
355 12083 31098 2F33 797A 17993 15549 4649 3CBD 18145 15836 46E1 3DDC

356 22822 16408 5926 4018 11411 8204 2C93 200C 14109 6085 371D 17C5
357 2934 6362 0B76 18DA 1467 3181 05BB 0C6D 14231 30324 3797 7674

358 27692 2719 6C2C 0A9F 13846 19315 3616 4B73 27606 27561 6BD6 6BA9
359 10205 14732 27DD 398C 16958 7366 423E 1CC6 783 13821 030F 35FD

360 7011 22744 1B63 58D8 23649 11372 5C61 2C6C 6301 269 189D 010D
361 22098 1476 5652 05C4 11049 738 2B29 02E2 5067 28663 13CB 6FF7

362 2640 8445 0A50 20FD 1320 24130 0528 5E42 15383 29619 3C17 73B3
363 4408 21118 1138 527E 2204 10559 089C 293F 1392 2043 0570 07FB

364 102 22198 0066 56B6 51 11099 0033 2B5B 7641 6962 1DD9 1B32
365 27632 22030 6BF0 560E 13816 11015 35F8 2B07 25700 29119 6464 71BF

366 19646 10363 4CBE 287B 9823 23041 265F 5A01 25259 22947 62AB 59A3
367 26967 25802 6957 64CA 25979 12901 657B 3265 19813 9612 4D65 258C

368 32008 2496 7D08 09C0 16004 1248 3E84 04E0 20933 18698 51C5 490A
369 7873 31288 1EC1 7A38 24240 15644 5EB0 3D1C 638 16782 027E 418E

370 655 24248 028F 5EB8 20631 12124 5097 2F5C 16318 29735 3FBE 7427
371 25274 14327 62BA 37F7 12637 21959 315D 55C7 6878 2136 1ADE 0858

372 16210 23154 3F52 5A72 8105 11577 1FA9 2D39 1328 8086 0530 1F96
373 11631 13394 2D6F 3452 18279 6697 4767 1A29 14744 10553 3998 2939

374 8535 1806 2157 070E 16763 903 417B 0387 22800 11900 5910 2E7C
375 19293 17179 4B5D 431B 29822 28593 747E 6FB1 25919 19996 653F 4E1C

376 12110 10856 2F4E 2A68 6055 5428 17A7 1534 4795 5641 12BB 1609
377 21538 25755 5422 649B 10769 31857 2A11 7C71 18683 28328 48FB 6EA8

378 10579 15674 2953 3D3A 17785 7837 4579 1E9D 32658 25617 7F92 6411
379 13032 7083 32E8 1BAB 6516 17385 1974 43E9 1586 26986 0632 696A

380 14717 29096 397D 71A8 19822 14548 4D6E 38D4 27208 5597 6A48 15DD
381 11666 3038 2D92 0BDE 5833 1519 16C9 05EF 17517 14078 446D 36FE

382 25809 16277 64D1 3F95 25528 20982 63B8 51F6 599 13247 0257 33BF
383 5008 25525 1390 63B5 2504 32742 09C8 7FE6 16253 499 3F7D 01F3

384 32418 20465 7EA2 4FF1 16209 27076 3F51 69C4 8685 30469 21ED 7705
385 22175 28855 569F 70B7 31391 30311 7A9F 7667 29972 17544 7514 4488

386 11742 32732 2DDE 7FDC 5871 16366 16EF 3FEE 22128 28510 5670 6F5E
387 22546 20373 5812 4F95 11273 27126 2C09 69F6 19871 23196 4D9F 5A9C

388 21413 9469 53A5 24FD 30722 23618 7802 5C42 19405 13384 4BCD 3448
389 133 26155 0085 662B 20882 32041 5192 7D29 17972 4239 4634 108F

390 4915 6957 1333 1B2D 22601 17322 5849 43AA 8599 20725 2197 50F5
391 8736 12214 2220 2FB6 4368 6107 1110 17DB 10142 6466 279E 1942

392 1397 21479 0575 53E7 21354 26575 536A 67CF 26834 28465 68D2 6F31
393 18024 31914 4668 7CAA 9012 15957 2334 3E55 23710 19981 5C9E 4E0D

394 15532 32311 3CAC 7E37 7766 28967 1E56 7127 27280 16723 6A90 4153
395 26870 11276 68F6 2C0C 13435 5638 347B 1606 6570 4522 19AA 11AA

396 5904 20626 1710 5092 2952 10313 0B88 2849 7400 678 1CE8 02A6
397 24341 423 5F15 01A7 32346 20207 7E5A 4EEF 26374 15320 6706 3BD8

398 13041 2679 32F1 0A77 18600 19207 48A8 4B07 22218 29116 56CA 71BC
399 23478 15537 5BB6 3CB1 11739 20580 2DDB 5064 29654 5388 73D6 150C

400 1862 10818 0746 2A42 931 5409 03A3 1521 13043 22845 32F3 593D

. . . continued on next page

E



PN Offset68P09255A57-2

Aug 2002 SC�4812ET Optimization/ATP Manual Software Release R16.1.x.x

PRELIMINARY
E-11

Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14-Chip Delay 13-Chip Delay 0-Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

401 5850 23074 16DA 5A22 2925 11537 0B6D 2D11 24457 28430 5F89 6F0E

402 5552 20250 15B0 4F1A 2776 10125 0AD8 278D 17161 8660 4309 21D4
403 12589 14629 312D 3925 18758 21166 4946 52AE 21314 2659 5342 0A63

404 23008 29175 59E0 71F7 11504 30407 2CF0 76C7 28728 8803 7038 2263
405 27636 13943 6BF4 3677 13818 21767 35FA 5507 22162 19690 5692 4CEA

406 17600 11072 44C0 2B40 8800 5536 2260 15A0 26259 22169 6693 5699
407 17000 29492 4268 7334 8500 14746 2134 399A 22180 8511 56A4 213F

408 21913 5719 5599 1657 31516 17687 7B1C 4517 2266 17393 08DA 43F1
409 30320 7347 7670 1CB3 15160 16485 3B38 4065 10291 11336 2833 2C48

410 28240 12156 6E50 2F7C 14120 6078 3728 17BE 26620 13576 67FC 3508
411 7260 25623 1C5C 6417 3630 31799 0E2E 7C37 19650 22820 4CC2 5924

412 17906 27725 45F2 6C4D 8953 30746 22F9 781A 14236 13344 379C 3420
413 5882 28870 16FA 70C6 2941 14435 0B7D 3863 11482 20107 2CDA 4E8B

414 22080 31478 5640 7AF6 11040 15739 2B20 3D7B 25289 8013 62C9 1F4D
415 12183 28530 2F97 6F72 17947 14265 461B 37B9 12011 18835 2EEB 4993

416 23082 24834 5A2A 6102 11541 12417 2D15 3081 13892 16793 3644 4199
417 17435 9075 441B 2373 29661 24453 73DD 5F85 17336 9818 43B8 265A

418 18527 32265 485F 7E09 30207 28984 75FF 7138 10759 4673 2A07 1241
419 31902 3175 7C9E 0C67 15951 18447 3E4F 480F 26816 13609 68C0 3529

420 18783 17434 495F 441A 30079 8717 757F 220D 31065 10054 7959 2746
421 20027 12178 4E3B 2F92 30413 6089 76CD 17C9 8578 10988 2182 2AEC

422 7982 25613 1F2E 640D 3991 31802 0F97 7C3A 24023 14744 5DD7 3998
423 20587 31692 506B 7BCC 31205 15846 79E5 3DE6 16199 17930 3F47 460A

424 10004 25384 2714 6328 5002 12692 138A 3194 22310 25452 5726 636C
425 13459 18908 3493 49DC 19353 9454 4B99 24EE 30402 11334 76C2 2C46

426 13383 25816 3447 64D8 19443 12908 4BF3 326C 16613 15451 40E5 3C5B
427 28930 4661 7102 1235 14465 18214 3881 4726 13084 11362 331C 2C62

428 4860 31115 12FC 798B 2430 29433 097E 72F9 3437 2993 0D6D 0BB1
429 13108 7691 3334 1E0B 6554 16697 199A 4139 1703 11012 06A7 2B04

430 24161 1311 5E61 051F 32480 19635 7EE0 4CB3 22659 5806 5883 16AE
431 20067 16471 4E63 4057 30433 28183 76E1 6E17 26896 20180 6910 4ED4

432 2667 15771 0A6B 3D9B 21733 20721 54E5 50F1 1735 8932 06C7 22E4
433 13372 16112 343C 3EF0 6686 8056 1A1E 1F78 16178 23878 3F32 5D46

434 28743 21062 7047 5246 27123 10531 69F3 2923 19166 20760 4ADE 5118
435 24489 29690 5FA9 73FA 32260 14845 7E04 39FD 665 32764 0299 7FFC

436 249 10141 00F9 279D 20908 24050 51AC 5DF2 20227 32325 4F03 7E45
437 19960 19014 4DF8 4A46 9980 9507 26FC 2523 24447 25993 5F7F 6589

438 29682 22141 73F2 567D 14841 25858 39F9 6502 16771 3268 4183 0CC4
439 31101 11852 797D 2E4C 28014 5926 6D6E 1726 27209 25180 6A49 625C

440 27148 26404 6A0C 6724 13574 13202 3506 3392 6050 12149 17A2 2F75
441 26706 30663 6852 77C7 13353 30175 3429 75DF 29088 10193 71A0 27D1

442 5148 32524 141C 7F0C 2574 16262 0A0E 3F86 7601 9128 1DB1 23A8
443 4216 28644 1078 6FE4 2108 14322 083C 37F2 4905 7843 1329 1EA3

444 5762 10228 1682 27F4 2881 5114 0B41 13FA 5915 25474 171B 6382
445 245 23536 00F5 5BF0 20906 11768 51AA 2DF8 6169 11356 1819 2C5C

446 21882 18045 557A 467D 10941 27906 2ABD 6D02 21303 11226 5337 2BDA
447 3763 25441 0EB3 6361 22153 32652 5689 7F8C 28096 16268 6DC0 3F8C

448 206 27066 00CE 69BA 103 13533 0067 34DD 8905 14491 22C9 389B
449 28798 13740 707E 35AC 14399 6870 383F 1AD6 26997 8366 6975 20AE

450 32402 13815 7E92 35F7 16201 21703 3F49 54C7 15047 26009 3AC7 6599

. . . continued on next page
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Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14-Chip Delay 13-Chip Delay 0-Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

451 13463 3684 3497 0E64 19355 1842 4B9B 0732 17460 5164 4434 142C

452 15417 23715 3C39 5CA3 20428 24685 4FCC 606D 17629 17126 44DD 42E6
453 23101 15314 5A3D 3BD2 31950 7657 7CCE 1DE9 10461 21566 28DD 543E

454 14957 32469 3A6D 7ED5 19686 29014 4CE6 7156 21618 21845 5472 5555
455 23429 9816 5B85 2658 31762 4908 7C12 132C 11498 28149 2CEA 6DF5

456 12990 4444 32BE 115C 6495 2222 195F 08AE 193 9400 00C1 24B8
457 12421 5664 3085 1620 18834 2832 4992 0B10 16140 19459 3F0C 4C03

458 28875 7358 70CB 1CBE 27061 3679 69B5 0E5F 13419 7190 346B 1C16
459 4009 27264 0FA9 6A80 22020 13632 5604 3540 10864 3101 2A70 0C1D

460 1872 28128 0750 6DE0 936 14064 03A8 36F0 28935 491 7107 01EB
461 15203 30168 3B63 75D8 19553 15084 4C61 3AEC 18765 25497 494D 6399

462 30109 29971 759D 7513 27422 29877 6B1E 74B5 27644 29807 6BFC 746F
463 24001 3409 5DC1 0D51 32560 18580 7F30 4894 21564 26508 543C 678C

464 4862 16910 12FE 420E 2431 8455 097F 2107 5142 4442 1416 115A
465 14091 20739 370B 5103 19029 26301 4A55 66BD 1211 4871 04BB 1307

466 6702 10191 1A2E 27CF 3351 24027 0D17 5DDB 1203 31141 04B3 79A5
467 3067 12819 0BFB 3213 21549 22325 542D 5735 5199 9864 144F 2688

468 28643 19295 6FE3 4B5F 26145 27539 6621 6B93 16945 12589 4231 312D
469 21379 10072 5383 2758 30737 5036 7811 13AC 4883 5417 1313 1529

470 20276 15191 4F34 3B57 10138 21399 279A 5397 25040 8549 61D0 2165
471 25337 27748 62F9 6C64 24748 13874 60AC 3632 7119 14288 1BCF 37D0

472 19683 720 4CE3 02D0 30625 360 77A1 0168 17826 8503 45A2 2137
473 10147 29799 27A3 7467 16897 29711 4201 740F 4931 20357 1343 4F85

474 16791 27640 4197 6BF8 28955 13820 711B 35FC 25705 15381 6469 3C15
475 17359 263 43CF 0107 28727 20159 7037 4EBF 10726 18065 29E6 4691

476 13248 24734 33C0 609E 6624 12367 19E0 304F 17363 24678 43D3 6066
477 22740 16615 58D4 40E7 11370 28239 2C6A 6E4F 2746 23858 0ABA 5D32

478 13095 20378 3327 4F9A 18499 10189 4843 27CD 10952 7610 2AC8 1DBA
479 10345 25116 2869 621C 17892 12558 45E4 310E 19313 18097 4B71 46B1

480 30342 19669 7686 4CD5 15171 26710 3B43 6856 29756 20918 743C 51B6
481 27866 14656 6CDA 3940 13933 7328 366D 1CA0 14297 7238 37D9 1C46

482 9559 27151 2557 6A0F 17275 31547 437B 7B3B 21290 30549 532A 7755
483 8808 28728 2268 7038 4404 14364 1134 381C 1909 16320 0775 3FC0

484 12744 25092 31C8 6204 6372 12546 18E4 3102 8994 20853 2322 5175
485 11618 22601 2D62 5849 5809 25112 16B1 6218 13295 26736 33EF 6870

486 27162 2471 6A1A 09A7 13581 19183 350D 4AEF 21590 10327 5456 2857
487 17899 25309 45EB 62DD 29477 32594 7325 7F52 26468 24404 6764 5F54

488 29745 15358 7431 3BFE 27592 7679 6BC8 1DFF 13636 7931 3544 1EFB
489 31892 17739 7C94 454B 15946 27801 3E4A 6C99 5207 5310 1457 14BE

490 23964 12643 5D9C 3163 11982 22157 2ECE 568D 29493 554 7335 022A
491 23562 32730 5C0A 7FDA 11781 16365 2E05 3FED 18992 27311 4A30 6AAF

492 2964 19122 0B94 4AB2 1482 9561 05CA 2559 12567 6865 3117 1AD1
493 18208 16870 4720 41E6 9104 8435 2390 20F3 12075 7762 2F2B 1E52

494 15028 10787 3AB4 2A23 7514 23341 1D5A 5B2D 26658 15761 6822 3D91
495 21901 18400 558D 47E0 31510 9200 7B16 23F0 21077 12697 5255 3199

496 24566 20295 5FF6 4F47 12283 27039 2FFB 699F 15595 24850 3CEB 6112
497 18994 1937 4A32 0791 9497 19956 2519 4DF4 4921 15259 1339 3B9B

498 13608 17963 3528 462B 6804 27945 1A94 6D29 14051 24243 36E3 5EB3
499 27492 7438 6B64 1D0E 13746 3719 35B2 0E87 5956 30508 1744 772C

500 11706 12938 2DBA 328A 5853 6469 16DD 1945 21202 13982 52D2 369E

. . . continued on next page
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Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14-Chip Delay 13-Chip Delay 0-Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

501 14301 19272 37DD 4B48 19006 9636 4A3E 25A4 11239 25039 2BE7 61CF

502 23380 29989 5B54 7525 11690 29870 2DAA 74AE 30038 24086 7556 5E16
503 11338 8526 2C4A 214E 5669 4263 1625 10A7 30222 21581 760E 544D

504 2995 18139 0BB3 46DB 21513 27985 5409 6D51 13476 21346 34A4 5362
505 23390 3247 5B5E 0CAF 11695 18539 2DAF 486B 2497 28187 09C1 6E1B

506 14473 28919 3889 70F7 19860 30279 4D94 7647 31842 23231 7C62 5ABF
507 6530 7292 1982 1C7C 3265 3646 0CC1 0E3E 24342 18743 5F16 4937

508 20452 20740 4FE4 5104 10226 10370 27F2 2882 25857 11594 6501 2D4A
509 12226 27994 2FC2 6D5A 6113 13997 17E1 36AD 27662 7198 6C0E 1C1E

510 1058 2224 0422 08B0 529 1112 0211 0458 24594 105 6012 0069
511 12026 6827 2EFA 1AAB 6013 17257 177D 4369 16790 4534 4196 11B6
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Test Equipment Setup

Purpose

This appendix provides information on setting up the HP8921 with PCS
interface, the HP8935 and the Advantest R3465. The Cybertest test set
doesn’t require any setup.

HP8921A Test Equipment Connections

Table F-1 depicts the rear panels of the HP 8921A test equipment as
configured to perform automatic tests. All test equipment is  controlled
by the LMF via an IEEE-488/GPIB bus. The LMF expects  each piece
of test equipment to have a factory-set GPIB address (refer to Table F-4).
If there is  a communications problem between the LMF and any piece
of test equipment, you should verify that the GPIB addresses have been
set correctly and that the GPIB cables are firmly connected to the test
equipment.

Figure F-1 shows the connections when not using an external 10 MHz
Rubidium reference.

Table F-1: HP8921A/600 Communications Test Set Rear Panel Connections Without Rubidium

From Test Set: To Interface:

8921A 83203B CDMA 83236A PCS
Connector Type

CW RF OUT CW RF IN SMC-female - SMC-female

114.3 MHZ IF OUT 114.3 MHZ IF IN SMC-female - SMC-female

IQ RF IN IQ RF OUT SMC-female - SMC-female

DET OUT AUX DSP IN SMC-female - SMC-female

CONTROL I/O CONTROL I/O 45-pin custom BUS

10 MHZ OUT SYNTH REF IN BNC-male - BNC-male

HPIB INTERFACE HPIB INTERFACE HPIB cable

10 MHZ OUT REF IN BNC-male - BNC-male
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Figure F-1: HP8921A/600 Cables Connection for 10 MHz Signal and GPIB without Rubidium
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Figure F-2  shows the connections when using an external 10 MHz
Rubidium reference.

Table F-2: HP8921A/600 Communications Test Set Rear Panel Connections With Rubidium

From Test Set: To Interface:

8921A 83203B CDMA 83236A PCS
Connector Type

CW RF OUT CW RF IN SMC-female - SMC-female

114.3 MHZ IF OUT 114.3 MHZ IF IN SMC-female - SMC-female

IQ RF IN IQ RF OUT SMC-female - SMC-female

DET OUT AUX DSP IN SMC-female - SMC-female

CONTROL I/O CONTROL I/O 45-pin custom BUS

10 MHZ OUT REF IN BNC-male - BNC-male

HPIB INTERFACE HPIB INTERFACE HPIB cable

10 MHZ INPUT 10 MHZ OUT BNC-male - BNC-male
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Figure F-2: HP8921A Cables Connection for 10 MHz Signal and GPIB with Rubidium
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HP8921A System Connectivity Test

Follow the steps in Table F-3 to verify that the connections between the
PCS Interface and the HP8921A are correct and cables are intact.  The
software also performs basic functionality checks of each instrument.

NOTE Disconnect other GPIB devices, especially system controllers,
from the system before running the connectivity software.

Table F-3: System Connectivity

Step Action

* IMPORTANT
- Perform this procedure after test equipment has been allowed to warm-up and stabilize for a

minimum of 60 minutes.

1 Insert HP 83236A Manual Control/System card into memory card slot.

2 Press the [PRESET] pushbutton.

3 Press the Screen Control [TESTS] pushbutton to display the “Tests” Main Menu screen.

4 Position the cursor at Select Procedure Location and select it by pressing the cursor control knob. In
the Choices selection box, select Card.

5 Position the cursor at Select Procedure Filename and select it by pressing the cursor control knob. In
the Choices selection box, select SYS_CONN.

6 Position the cursor at RUN TEST and select it.  The software will prompt you through the
connectivity setup.

7 Do the following when the test is complete,

� position cursor on STOP TEST and select it

� OR press the [K5] pushbutton.

8 To return to the main menu, press the [K5] pushbutton.

9 Press the [PRESET] pushbutton.

Setting HP8921A and HP83236A/B GPIB Address

Follow the steps in Table F-4 to set the HP8921A GPIB address.

Table F-4: Setting HP8921A GPIB Address

Step Action

1 If you have not already done so, turn the HP8921A power on.

2 Verify that the GPIB addresses are set correctly.

� HP8921A HP-IB Adrs = 18, accessed by pushing LOCAL and selecting More and I/O Configure
on the HP8921A/600. (Consult test equipment OEM documentation for additional info as required).

� HP83236A (or B) PCS Interface GPIB address=19. Set dip switches as follows:

- A1=1, A2=1, A3=0, A4=0, A5=1, HP-IB/Ser = 1
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Pretest Setup for HP8921A

Before the HP8921A CDMA analyzer is used for LMF controlled testing
it must be set up correctly for automatic testing.

Table F-5: Pretest Setup for HP8921A

Step Action

1 Unplug the memory card if it is plugged in.

2 Press the CURSOR CONTROL knob.

3 Position the cursor at IO CONFIG (under To Screen and More) and select it.

4 Select Mode and set for Talk&Lstn.

Pretest Setup for HP8935

Before the HP8935 CDMA analyzer is used for LMF controlled testing
it must be set up correctly for automatic testing.

Table F-6: Pretest Setup for HP8935

Step Action

1 Unplug the memory card if it is plugged in.

2 Press the Shift button and then press the I/O Config button.

3 Press the Push to Select knob.

4 Position the cursor at IO CONFIG and select it.

5 Select Mode and set for Talk&Lstn.

Advantest R3465 Connection

The following diagram depicts the rear panels of the Advantest test
equipment as configured to perform automatic tests. All test equipment
is  controlled by the LMF via an IEEE-488/GPIB bus. The LMF expects
each piece of test equipment to have a factory-set GPIB address (refer to
Table F-7). If there is  a communications problem between the LMF and
any piece of test equipment, you should verify that the GPIB addresses
have been set correctly and that the GPIB cables are firmly connected to
the test equipment.

Figure F-3 shows the connections when not using an external 10 MHz
Rubidium reference.
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Figure F-3: Cable Connections for Test Set without 10 MHz Rubidium Standard
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Figure F-4 shows the connections when using an external 10 MHz
Rubidium reference.

Figure F-4: Cable Connections for Test Set with 10 MHz Rubidium Standard
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R3465 GPIB Address & Clock setup

Follow the steps in Table F-7 to set the GPIB address and clock for the
Advantest R3465 equipment.

Table F-7: Advantest R3465 GPIB Address and Clock Setup

Step Action

1 Communications test set GPIB address=18 (perform the following to view/set as required)

Perform the following to set the standard parameters on the test set:

� Push the SHIFT then PRESET pushbutton (just below the CRT display).

� Push the LCL pushbutton (CW in Measurement just below the CRT display)
- Push the GPIB and Others CRT menu key to view the current address.

- If required, change GPIB address to 18 (rotate the vernier knob to set, push the vernier knob to
enter)

2 Verify the current Date and Time in upper/right of the CRT display (perform the following to set if
required)

Communications test set GPIB address=18 (perform the following to view/set as required)

� Push the Date/Time CRT menu key

� If required, change to correct Date/Time (rotate the vernier knob to select and set, push the vernier
knob to enter)

�  Push the SHIFT then PRESET pushbutton (just below the CRT display).

 

Pretest Setup for Advantest R3465

Before the Advantest R3465 analyzer is used for LMF controlled testing
it must be set up correctly for automatic testing.

Table F-8: Pretest Setup for Advantest R3465

Step Action

1 Press the SHIFT button so the LED next to it is illuminated.

2 Press the RESET button.
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Agilent E4406A/E4432B Test Equipment Interconnection

To provide proper operation during testing when both units are required,
the 10 MHz reference signal from the E4406A transmitter test set must
be provided to the E4432B signal generator. Connect a BNC (M)-BNC
(M) cable from the E4406A 10 MHz OUT (SWITCHED) connector to
the E4432B 10MHz IN connector as shown in Figure F-5.

Figure F-5: Agilent 10 MHz Reference Connections
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Calibrating Test Cable Setup
using HP PCS Interface (HP83236)

Table F-9 covers the procedure to calibrate the test equipment using 
the HP8921 Cellular Communications Analyzer equipped with the
HP83236 PCS Interface.

NOTE Table:note.  Note 10pt Helvetica
This calibration method must be executed with great care. Some
losses are measured close to the minimum limit of the power
meter sensor (-30 dBm).

Prerequisites

Ensure the following prerequisites have been met before proceeding:

� Test equipment to be calibrated has been connected correctly for cable
calibration.

� Test equipment has been selected and calibrated.

Table F-9: Calibrating Test Cable Setup (using the HP PCS Interface)

Step Action

NOTE
Verify that GPIB controller is turned off.

1 Insert HP83236 Manual Control System card into memory card slot.

2 Press the Preset pushbutton.

3 Under Screen Controls, press the TESTS pushbutton to display the TESTS (Main Menu) screen.

4 Position the cursor at Select Procedure Location and select it. In the Choices selection box, select
CARD.

5 Position the cursor at Select Procedure Filename and select it. In the Choices selection box, select
MANUAL.

6 Position the cursor at RUN TEST and select it. HP must be in Control Mode Select YES.

7 If using HP 83236A:
Set channel number=<chan#>:

- Position cursor at Channel
Number and select it.

- Enter the chan# using the numeric
keypad; press [Enter] and the
screen will go blank.

- When the screen reappears, the
chan# will be displayed on the
channel number line.

If using HP 83236B:
Set channel frequency:

- Position cursor at Frequency Band and press Enter.

- Select User Defined Frequency.

- Go Back to Previous Menu.

- Position the cursor to 83236 generator frequency and
enter actual RX frequency.

- Position the cursor to 83236 analyzer frequency and
enter actual TX frequency.

8 Set RF Generator level:

- Position the cursor at RF Generator Level and select it.

- Enter -10  using the numeric keypad; press [Enter] and the screen will go blank.

- When the screen reappears, the value -10 dBm will be displayed on the RF Generator Level line.

. . . continued on next page
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Table F-9: Calibrating Test Cable Setup (using the HP PCS Interface)

Step Action

9 Set the user fixed Attenuation Setting to 0 dBm:

- Position cursor at Analyzer Attenuation and select it
- Position cursor at User Fixed Atten Settings and select it.

- Enter 0 (zero) using the numeric keypad and press [Enter].

10 Select Back to Previous Menu.

11 Record the HP83236 Generator Frequency Level:

Record the HP83236B Generator Frequency Level:

- Position cursor at Show Frequency and Level Details and select it.
- Under HP83236 Frequencies and Levels, record the Generator Level.
- Under HP83236B Frequencies and Levels, record the Generator Frequency Level (1850 - 1910

MHz).

- Position cursor at Prev Menu and select it.

12 Click on Pause for Manual Measurement.

13 Connect the power sensor directly to the RF OUT ONLY port of the PCS Interface.

14 On the HP8921A, under To Screen, select CDMA GEN.

15 Move the cursor to the Amplitude field and click on the Amplitude value.

16 Increase the Amplitude value until the power meter reads 0 dBm ±0.2 dB.

NOTE
The Amplitude value can be increased coarsely until 0 dBM is reached; then fine tune the amplitude
by adjusting the Increment Set to 0.1 dBm and targeting in on 0 dBm.

17 Disconnect the power sensor from the RF OUT ONLY port of the PCS Interface.

* IMPORTANT
The Power Meter sensor’s lower limit is -30 dBm. Thus, only components having losses ≤30 dB
should be measured using this method. For further accuracy, always re-zero the power meter
before connecting the power sensor to the component being calibrated. After connecting the
power sensor to the component, record the calibrated loss immediately.

18 Disconnect all components in the test setup and calibrate each one separately by connecting each
component, one-at-a-time, between the RF OUT ONLY PORT and the power sensor. Record the
calibrated loss value displayed on the power meter.

� Example: (A) Test Cable(s) = -1.4 dB
(B) 20 dB Attenuator = -20.1 dB
(B) Directional Coupler = -29.8 dB

19 After all components are calibrated, reassemble all components together and calculate the total test
setup loss by adding up all the individual losses:
� Example: Total test setup loss = -1.4 -29.8 -20.1 = -51.3 dB.

This calculated value will be used in the next series of tests.

20 Under Screen Controls press the TESTS button to display the TESTS (Main Menu) screen.

21 Select Continue (K2).

22 Select RF Generator Level and set to -119 dBm.

. . . continued on next page
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Table F-9: Calibrating Test Cable Setup (using the HP PCS Interface)

Step Action

23 Click on Pause for Manual Measurement.

24 Verify the HP8921A Communication Analyzer/83203A CDMA interface setup is as follows (fields
not indicated remain at default):

� Verify the GPIB (HP-IB) address:

- under To Screen, select More

- select IO CONFIG

- Set HP-IB Adrs to 18

- set Mode to Talk&Lstn

� Verify the HP8921A is displaying frequency (instead of RF channel)

- Press the blue [SHIFT] button, then press the Screen Control [DUPLEX] button; this switches to
the CONFIG (CONFIGURE) screen.

- Use the cursor control to set RF Display to Freq

25 Refer toChapter 3 for assistance in setting the cable loss values into the LMF.
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Figure F-6: Cable CalibrationUsing HP8921 with PCS Interface

(A)

(C)

POWER
SENSOR(A)

POWER
SENSOR

(C)

30 dB
DIRECTIONAL

COUPLER

150 W
NON-RADIA TING

RF LOAD

POWER
SENSOR

(B)

POWER
SENSOR

(B)

MEMORY
CARD
SLOT

20 dB / 20 WATT
ATTENUATOR

FW00292

F



Test Equipment Setup 68P09255A57-2

Aug 2002SC�4812ET Optimization/ATP Manual Software Release R16.1.x.x
PRELIMINARY

F-16

Calibrating Test Cable Setup using Advantest R3465

NOTE Be sure the GPIB Interface is OFF for this procedure.

Advantest R3465 Manual Test setup and calibration must be performed
at both the TX and RX frequencies.

Table F-10: Procedure for Calibrating Test Cable Setup Using Advantest R3465

Step Action

* IMPORTANT
- This procedure can only be performed after test equipment has been allowed to warm-up and

stabilize for a minimum of 60 minutes.

1 Press the SHIFT and the PRESET keys located below the display

2 Press the ADVANCE key in the MEASUREMENT area of the control panel.

3 Select the CDMA Sig CRT menu key

4 Select the Setup CRT menu key

5 Using the vernier knob and the cursor keys set the following parameters

NOTE
Fields not listed remain at default

Generator Mode: SIGNAL

Link: FORWARD

Level Unit: dBm

CalCorrection: ON

Level Offset: OFF

6 Select the return CRT menu key

7 Press FREQ key in the ENTRY area

8 Set the frequency to the desired value using the keypad entry keys

9 Verify that the Mod CRT menu key is highlighting OFF; if not, press the Mod key to toggle it OFF.

10 Verify that the Output CRT menu key is highlighting OFF; if not, press the Output key to toggle it
OFF.

11 Press the LEVEL key in the ENTRY area.

12 Set the LEVEL to 0 dBm using the key pad entry keys.

13 Zero power meter. Next connect the power sensor directly to the “RF OUT” port on the R3561L
CDMA Test Source Unit.

14 Press the Output CRT menu key to toggle Output to ON.

15 Record the power meter reading  ________________________

. . . continued on next page
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Table F-10: Procedure for Calibrating Test Cable Setup Using Advantest R3465

Step Action

16 Disconnect the power meter sensor from the R3561L RF OUT jack.

* IMPORTANT
The Power Meter sensor’s lower limit is -30 dBm.  Thus, only components having losses < 30 dB
should be measured using this method. For best accuracy, always re-zero the power meter before
connecting the power sensor to the component being calibrated.  Then, after connecting the
power sensor to the component, record the calibrated loss immediately.

17 Disconnect all components in the the test setup and calibrate each one separately.  Connect each
component one-at-a-time between the “RF OUT” port and the power sensor (see Figure F-7, “Setups
A, B, and C”).  Record the calibrated loss value displayed on the power meter for each connection.

Example: (A) 1st Test Cable =  -0.5 dB
(B) 2nd Test Cable =  -1.4 dB
(C) 20 dB Attenuator =  -20.1 dB
(D) 30 dB Directional Coupler =  -29.8 dB

18 Press the Output CRT menu key to toggle Output OFF.

19 Calculate the total test setup loss by adding up all the individual losses:

Example: Total test setup loss  =  0.5 + 1.4 + 20.1 + 29.8  =  51.8 dB

This calculated value will be used in the next series of tests.

20 Press the FREQ key in the ENTRY area

21 Using the keypad entry keys, set the test frequency to the RX frequency

22 Repeat steps 9 through 19 for the RX frequency.

23 Refer to Chapter 3 for assistance in setting the cable loss values into the LMF.
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Figure F-7: Cable Calibration using Advantest R3465
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Calibrating HP 437 Power Meter

Precise transmit output power calibration measurements are made using
a bolometer-type broadband power meter with a sensitive power sensor.
Follow the steps outlined in Table F-11 to enter information unique to
the power sensor before calibrating the test setup. Refer to Figure F-8 as
required.

NOTE Table:note.  Note 10pt Helvetica
This procedure must be done in conjunction with the automated
calibration to enter power sensor specific calibration values.

Figure F-8: Power Meter Detail
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Table F-11: Power Meter Calibration Procedure

Step Action

! CAUTION
Do not connect/disconnect the power meter sensor cable with ac power applied to the meter.
Disconnection could result in destruction of the sensing element or mis-calibration.

1 - Make sure the power meter AC LINE pushbutton is OFF.

- Connect the power sensor cable to the SENSOR input.

2 Set the AC LINE pushbutton to ON.

NOTE
The calibration should be performed only after the power meter and sensor have been allowed to
warm-up and stabilize for a minimum of 60 minutes.

3 Perform the following to set or verify the GPIB address:

- To enter the SPECIAL data entry function, press [SHIFT] then [PRESET].

- Use the [�] or [
] button to select HP-IB ADRS; then press [ENTER].

- Use the [�] or [
] button to select HP-IB ADRS 13; then press [ENTER].

- To EXIT the SPECIAL data entry function press [SHIFT] then [ENTER].

. . . continued on next page
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Table F-11: Power Meter Calibration Procedure

Step Action

4 Perform the following to set or verify the correct power sensor model:

- Press [SHIFT]  then [�] to select SENSOR.

- Identify the power sensor model number from the sensor label.  Use the [�] or [
] button to
select the appropriate model; then press [ENTER].

NOTE
Be sure the PWR REF (power reference) output is OFF (observe that the triangular indicator is NOT
displayed as shown in Step 7). If on, press [SHIFT] then [	] to turn it off.

5 Press [ZERO].  Display will show “Zeroing ******.”  Wait for process to complete.

6 Connect the power sensor to the POWER REF output.

7 To turn on the PWR REF, perform the following:

- Press [SHIFT] then [	].

- Verify that the triangular indicator (below) appears in the display above “PWR REF”.

8 Perform the following to set the REF CF %:

- Press ([SHIFT] then [ZERO]) for CAL.

- Enter the sensor’s REF CF % from the sensor’s decal using the arrow keys and press [ENTER].
(The power meter will display ”CAL *****” for a few seconds.)

NOTE
If the REF CAL FACTOR (REF CF) is not shown on the power sensor, assume it to be 100%.

9 Perform the following to set the CAL FAC %:

- Press [SHIFT] then [FREQ] for CAL FAC.

- On the sensor’s decal, locate an approximate calibration percentage factor (CF%) at 2 GHz.  Enter
the sensor’s calibration % (CF%) using the arrow keys and press [ENTER].

When complete, the power meter will typically display 0.05 dBm. (Any reading between 0.00 and
0.10 is normal.)

10 To turn off the PWR REF, perform the following:

- Press [SHIFT] then [	].

- Disconnect the power sensor from the POWER REF output.
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Calibrating Gigatronics 8541C power meter

Precise transmit output power calibration measurements are made using
a bolometer-type broadband power meter with a sensitive power sensor.
Follow the steps in Table F-12 to enter information unique to the power
sensor.

Table F-12: Calibrate Gigatronics 8541C Power Meter

Step Action

! CAUTION
Do not connect/disconnect the power meter sensor cable with AC power applied to the meter.
Disconnection could result in destruction of the sensing element or miscalibration.

NOTE
Allow the power meter and sensor to warm up and stabilize for a minimum of 60 minutes before
performing the calibration procedure.

1 � Make sure the power meter POWER pushbutton is OFF.

� Connect the power sensor cable to the SENSOR input.

� Set the POWER pushbutton to ON.

2 Verify the Power GPIB mode and address:

� Press MENU. Use the 
 arrow key to select CONFIG MENU, and press ENTER.

� Use the 
 arrow key to select GPIB, and press ENTER.

� Use the 
� arrow keys to set MODE to 8541C.

� Press 	 and use the 
� arrow keys as required to set ADDRESS to 13.

� Press ENTER.

3 � Connect the power sensor to the CALIBRATOR output connector.

� Press ZERO.

� Wait for the process to complete. Sensor factory calibration data is read to power meter during this
process.

� Disconnect the power sensor from the CALIBRATOR output.

Figure F-9: Gigatronics 8541C Power Meter Detail

CONNECT POWER SENSOR
WITH POWER METER
TURNED OFF

CONNECT POWER SENSOR TO
CALIBRATOR POWER REFERENCE
WHEN CALIBRATING/ZEROING UNIT

FRONT View REAR View

GPIB CONNECTIONAC POWER

FW00564

F



Calibrating Gigatronics 8541C power meter 68P09255A57-2

Aug 2002SC�4812ET Optimization/ATP Manual Software Release R16.1.x.x
PRELIMINARY

F-22

Notes
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Appendix G

Power Calibration
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Calibrating Output Power

Power Calibration

This procedure is a guide to expanding your system with multiple
carriers while the system remains in service. This procedure also allows
you to perform on site maintenance (replace defective boards and
recalibrate) while the remainder of the site stays in service.

Motorola recommends that you perform this procedure during a
maintenance window.

This procedure cannot be performed on BTSs with 4-to-1 combiners.
The procedure can only be performed on one side of the BTS at one
time. That is, LPAs 1, 2 ,3, 7, 8, 9 (feed antennas 1, 2, 3) can be
calibrated while LPAs 6, 7, 8, 10, 11, 12 (feed antennas 4, 5, 6) remain
in service and vice versa.

Equipment Warm up

NOTE Calibration of the communications test set (or equivalent test
equipment) must be performed at the site before calibrating the
overall test set. Calibrate the test equipment  after it has been
allowed to warm-up and stabilize for a minimum of 60 minutes.

CAUTION If any piece of test equipment (i.e., test cable, RF adapter) has
been replaced, re-calibration must be performed. Failure to do so
could introduce measurement errors, causing incorrect
measurements and degradation to system performance.

Power Delta Calibration Introduction

The In-service calibration procedure has several differences from a
normal calibration procedure. One of these is the use of a spectrum
analyzer instead of a power meter to measure power. Power meters are
broadband measurement devices and cannot be used to measure power
during In-service Calibration since other carriers are operating. A
spectrum analyzer can be used because it measures power at a given
frequency. However, measuring power using a spectrum analyzer is less
accurate than using a power meter. Therefore, you must compensate for
the difference (delta) between the power meter and the spectrum
analyzer.
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HP8921A Power Delta Calibration
Use the HP8921A Spectrum Analyzer to measure power during
In-Service Calibration for 800 MHz systems. After the offset value has
been calculated, add it to the TX cable loss value.

Follow the procedure in Table G-1 to perform the HP8921A Power Delta
Calibration procedure.

NOTE This procedure requires two HP8921As.

Table G-1: HP8921A Power Delta Calibration Procedure

Step Action

* IMPORTANT
Perform this procedure after test equipment has been allowed to warm-up and stabilize for a minimum
of 60 minutes.

1 Connect a short RF cable between the HP8921A Duplex Out port and the HP437B power sensor (see
Figure G-1).

2 Set the HP8921A signal source as follows:

- Measure mode to CDMA Generator
- Frequency to the CDMA Calibration target frequency

- CW RF Path to IQ

- Output Port to Dupl

- Data Source to Random

- Amplitude to 0 dBm

3 Measure and record the power value reading on the HP437B Power Meter.

4 Record the Power Meter reading as result A ________________________.

5 Turn off the source HP8921A signal output, and disconnect the HP437B.

NOTE
Leave the settings on the source HP8921A for convenience in the following steps.

6 Connect the short RF cable between the source HP8921A Duplex Out port and the measuring
HP8921A RF-IN  port (see Figure G-2).

7 Ensure that the source HP8921A settings are the same as in Step 2.

8 Set the measuring HP8921A as follows:

- Measure mode to CDMA Anl
- Frequency to the CDMA calibration target frequency

- Input Attenuation to 0 dB

- Input port to RF-IN

- Gain to Auto

- Analyzer Direction to Fwd

9 Turn on the source HP8921A signal output.

10 Measure and record the channel power reading on the measuring HP8921A as result
B ________________________.

11 Turn off the source HP8921A signal output and disconnect the equipment.

. . . continued on next page
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Table G-1: HP8921A Power Delta Calibration Procedure

Step Action

12 Compute the delta between HP437B and HP8921A using the following formula:

Delta = A - B
Example: Delta = -0.70 dBm - (-1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm - 0.55 dBm = -0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In-Service Calibration.

 

Figure G-1: Delta Calibration Setup - HP8921A to HP437B
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Figure G-2: Delta Calibration Setup - HP8921A to HP8921A
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Advantest R3465 Power Delta Calibration

Follow the procedure in Table G-2 to perform the Advantest 3465 Power
Delta Calibration procedure.
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Table G-2: Advantest Power Delta Calibration Procedure

Step Action

* IMPORTANT
Perform this procedure after test equipment has been allowed to warm-up and stabilize for a minimum
of 60 minutes.

On the Advantest R3465:

1 Press the SHIFT and the PRESET keys located below the CRT display.

2 Press the ADVANCE key in the Measurement area of the control panel.

3 Press the CDMA Sig CRT menu key.

4 Press the FREQ key in the Entry area of the control panel.

5 Set the frequency to the desired value using the keypad entry keys.

6 Press the LEVEL key in the Entry area of the control panel.

7 Set the LEVEL to 0 dBm using the keypad entry keys.

8 Verify the Mod CRT menu key is highlighting OFF, if not press the Mod key to toggle it OFF.

9 Verify the Output CRT menu key is highlighting OFF, if not press the Output key to toggle it OFF.

On the HP 437 Power Meter:

10 Zero the Power Meter prior to connecting the power sensor to the RF cable from the signal generator.

* IMPORTANT
For best accuracy, always re-zero the power meter before connecting the power sensor to the
component being calibrated.

11 Connect the RF cable from the R3561L CDMA Test Source Unit RF OUT port to the power sensor,
refer to Figure G-3.

12 Press the Output CRT menu key to toggle the Output to ON.

13 Record the Power Meter reading as result A ________________________.

14 Press the Output CRT menu key to toggle the Output to OFF.

15 Connect the RF cable from the R3561L CDMA Test Source Unit RF OUT port to the Spectrum
Analyzer INPUT Port, refer to Figure G-4.

16 Press the Output CRT menu key to change the Output to ON.

17 Press the CW key in the Measurement area of the control panel.

18 Press the LEVEL key in the Entry area of the control panel.

19 Set the REF LEVEL to 10 dBm using the keypad entry keys.

20 Press the dB/div CRT menu key.

21 Press the 10 dB/div CRT menu key.

22 Press the FREQ key in Entry area of the control panel.

23 Set the frequency to the desired value using the keypad entry keys.

24 Press the more 1/2 CRT menu key.

. . . continued on next page
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Table G-2: Advantest Power Delta Calibration Procedure

Step Action

25 Press the Preselector CRT menu key to highlight 3.0G.

26 Press the FORMAT key in the Display Control area of the control panel.

27 Press the TRACE CRT menu key.

28 Press the AVG A CRT menu key.

29 Set AVG to 20 using keypad entry keys.

30 Press the return CRT menu key.

31 Press the SPAN key in the Entry area of the control panel.

32 Press the Zero Span CRT menu key.

33 Press the BW key in the Entry area of the control panel.

34 Press the RBW CRT menu key to highlight MNL. using keypad entry keys enter 30 kHz.

35 Set RBW to 30 kHz using keypad entry keys.

36 Press the VBW CRT menu key to highlight MNL.

37 Set VBW to 1 MHz using keypad entry keys.

38 Press the Marker ON key in the Display Control area of the control panel.

39 Record the Marker Level reading as result B ________________________.

40 Calculate the Power Calibration Delta value. The delta value is the power meter measurement minus
the Advantest measurement.

Delta = A - B

Example: Delta = -0.70 dBm - (-1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm - 0.55 dBm = -0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In-Service Calibration.

 

Figure G-3: Delta Calibration Setup - R3561L to HP437B
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Figure G-4: Delta Calibration Setup - R3561L to R3465
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HP8935 Power Delta Calibration
Follow the procedure in Table G-3 to perform the HP8935 Power Delta
Calibration procedure.

Table G-3: HP8935 Power Delta Calibration Procedure

Step Action

* IMPORTANT
Perform this procedure after test equipment has been allowed to warm-up and stabilize for a minimum
of 60 minutes.

1 Connect a short RF cable between the HP8935 Duplex Out port and the HP437B power sensor (see
Figure G-5).

2 Set the HP8935 signal source as follows:

- Measure mode to CDMA Gen
- Frequency to the CDMA Calibration target frequency

- CW RF Path to IQ

- Output Port to Dupl

- Data Source to Random

- Amplitude to 0 dBm

3 Measure and record the power value reading on the HP437B Power Meter.

4 Record the Power Meter reading as result A ________________________.

5 Turn off the source HP8935 signal output, and disconnect the HP437B.

NOTE
Leave the settings on the source HP8935 for convenience in the following steps.

6 Connect the short RF cable between the source HP8935 Duplex Out port and the RF-IN/OUT  port
(see Figure G-6).

7 Ensure that the source HP8935 settings are the same as in Step 2.

8 Set the measuring HP8935 as follows:

- Measure mode to CDMA Anl
- Frequency to the CDMA calibration target frequency

- Input Attenuation to 0 dB

- Input port to RF-IN

- Gain to Auto

- Anl Dir to Fwd

. . . continued on next page
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Table G-3: HP8935 Power Delta Calibration Procedure

Step Action

9 Turn on the source HP8935 signal output.

10 Set the Chn Pwr Cal to Calibrate and select to calibrate.

11 Measure and record the channel power reading on the measuring HP8935 as result
B ________________________.

12 Turn off the source HP8935 signal output and disconnect the equipment.

13 Calculate the Power Calibration Delta value. The delta value is the power meter measurement minus
the Advantest measurement.

Delta = A - B

Example: Delta = -0.70 dBm - (-1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm - 0.55 dBm = -0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In-Service Calibration.

 

Figure G-5: Delta Calibration Setup - HP8935 to HP437B
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Figure G-6: Delta Calibration Setup - HP8935 to HP8935
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Agilent E4406A Power Delta Calibration

The Agilent E4406A transmitter tester and E4432B signal generator test
equipment combination can be used for CDMA 2000 as well as
IS-95A/B operation modes. The power delta calibration is performed on
the E4406A, but the E4432B is required to generate the reference signal
used to calculate the power delta offset. After the offset value has been
calculated, add it to the TX cable loss value in the LMF.

Follow the procedure in Table G-4 to perform the Agilent E4406A
Power Delta Calibration procedure.

Table G-4: Agilent E4406A Power Delta Calibration Procedure

Step Action

* IMPORTANT
Perform this procedure after test equipment has been allowed to warm-up and stabilize for a minimum
of 60 minutes. After it is warmed up and stabilized, calibrate the test equipment as described in the
“Test Set Calibration” section of the Optimization/Calibration chapter in the SC 4812ET
Optimization/ATP manual.

1 Zero the Power Meter prior to connecting the power sensor to the RF cable from the signal generator.

* IMPORTANT
For best accuracy, always re-zero the power meter before connecting the power sensor to the
component being calibrated.

2 Connect a short RF cable from the E4432B RF OUTPUT connector the HP437 power meter power
sensor (see Figure G-7).

3 Set the E4432B signal generator as follows:

- Press  Preset  to exit any modes for which the signal generator is configured.

- Press  Frequency  and enter the frequency of the channel to be calibrated on the numeric keypad.

- Using the soft keys to the right of the screen, select the frequency range to be measured; for
example  MHz.

- Press  Amplitude  and, using the numeric keypad, set signal amplitude to  0 (zero).

- Using the soft keys, set the measurement type to  dBm.

4 On the E4432B, press RF On/Off to toggle the RF output to  RF ON.

- Note that the RF On/Off status in the screen display changes.

5 Measure and record the value reading on the HP437 power meter as result A____________________.

6 On the E4432B, press RF On/Off to toggle the RF output to  RF OFF.

- Note that the RF On/Off status in the screen display changes.

7 Disconnect the short RF cable from the HP437 power meter power sensor, and connect it to the RF
INPUT connector on the E4406A transmitter tester (see Figure G-8).

. . . continued on next page
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Table G-4: Agilent E4406A Power Delta Calibration Procedure

Step Action

8 * IMPORTANT
Do not change the frequency and amplitude settings on the E4432B when performing the following
steps.

Set the E4406A as follows:

- Press  Preset  to exit any modes for which the transmitter tester is configured

- Press  MODE  and, using the soft keys to the right of the screen, select  cdmaOne

- Press  MEASURE  and, using the soft keys, select  spectrum

- Press  Frequency  and, using the soft keys, select  Center Frequency

- Enter the frequency of the channel to be calibrated using the numeric keypad

- Using the soft keys, select the frequency range to be measured; for example,  MHz

- Press Input/Output and, using the soft keys, select  Input Atten

- Using the numeric keypad, set Input Atten  to  0 (zero) and, using the soft keys, select  dB

- Using the soft keys, select  External Atten  and then select Mobile
- Using the numeric keypad, set Mobile to  0 (zero) and, using the soft keys, select  dB

- Using the soft keys, select  Base

- Using the numeric keypad, set Base to  0 (zero) and, using the soft keys, select  dB

- Press  MEASURE  and, using the soft keys, select  Channel Power

9 On the E4432B signal generator, press RF On/Off to toggle the RF output to  RF ON.

- Note that the RF On/Off status in the screen display changes.

10 Read the measured Channel Power from the E4406A screen display and record it as 
result B____________________.

11 On the E4432B, press RF On/Off to toggle the RF output to  RF OFF.

- Note that the RF On/Off status in the screen display changes.

12 Calculate the Power Calibration Delta value. The delta value is the power meter measurement minus
the Agilent measurement.

Delta = A - B

Example: Delta = -0.70 dBm - (-1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm - 0.55 dBm = -0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In-Service Calibration.
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Figure G-7: Delta Calibration Setup - Agilent E4432B to HP437
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Figure G-8: Delta Calibration Setup - Agilent E4432B to Agilent E4406A
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In-Service  Calibration

NOTE This feature does NOT have fault tolerance at this time. The
system has no safe-guards to stop you from doing something
that will take the BTS out of service. If possible, perform this
procedure during a maintenance window.

Follow the procedures in this section precisely, otherwise the
entire BTS will most likely go OUT OF SERVICE.

At the CBSC, only perform operations on expansion hardware
when it is in the OOS_MANUAL state.

The operator must be trained in the LMF operation prior to
performing this procedure.

Prerequisites

� Expansion hardware has been added in the CBSC database, and the
CDF file has been generated.

� The expansion devices have been inserted into the C-CCP cage and
are in the OOS_MANUAL state at the CBSC.

� The site specific cdf (with the expansion hardware) and cal files have
been loaded onto the LMF.

� The LMF has the same code and dds files as the CBSC to download.
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NOTE Do not download code or data to any cards other than those you
are working on. Downloading code or data to other cards will
take the site OUT OF SERVICE.

The code file version numbers must match the version numbers
on the other cards in the frame. If the numbers do not match, the
site may go OUT OF SERVICE.

The BTS-#.cdf, CBSC-#.cdf, and CAL files for this BTS must
have come from the CBSC.

� Test equipment has been configured per Figure G-9 or Figure G-10.

� An RFDS (or at a minimum a directional coupler), whose loss is
already known, must be in line to perform the in-service calibration.

� Test equipment has been calibrated after 1 hour warm up.

� A short RF cable and two BNC-N adapters are available to perform
Cable Calibration.

� The Power Delta Calibration has been performed (see Table G-1,
Table G-2, or Table G-3).
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Figure G-9: Optimization/ATP Test Setup Using RFDS
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Figure G-10: IS-95 A/B/C Optimization/ATP Test Setup Using RFDS
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Follow the procedure in Table G-5 to perform the In-Service
Calibration.

Table G-5: In-Service Calibration

Step Action

* IMPORTANT
Perform this procedure after test equipment has been allowed to warm-up and stabilize for a minimum
of 60 minutes.

1 Set up the LMF for In-Service Calibration:

- Start the LMF by double-clicking the LMF icon on the Windows desktop.

- Click Tools>Options from the menu bar at the login screen.

- Check the applicable spectrum analyzer check box and the signal generator check box on the Test
Equipment tab.
Ensure that the GPIB address is 18 for the CDMA analyzer and 1 for the signal generator.

- Uncheck any other other equipment that is selected.

- Click the Apply button.

- Select the BTS Options tab in the LMF Option window.

- Check the In-Service Calibration check box.

- Click the Apply button.

- Click the Dismiss button to close the LMF Option window.

2 Login to the target BTS:

- Select the target BTS icon.

- Click the Login button at the login screen.

3 Measure the Cable Loss using the Cable Calibration function:

- Click Util>Cable Calibration from the menu bar at the main window.

- Set the desired channel(s) and select TX and RX CABLE CAL at the cable calibration pop up
window.

- Click the OK button to perform cable calibration.

- Follow the on-screen instructions to complete the cable loss measurement.

NOTE
- The measured value is input automatically to the cable loss file.

- To view the cable loss file, click Util>Examine>Cable Loss>TX or RX.

4 Add the spectrum analyzer power delta to the Cable Loss.

- To view the cable loss file, click Util>Examine>Cable Loss>TX or RX.

- Add the value computed in Table G-1, Table G-2, or Table G-3 to the TX Cable Loss.

NOTE
Be sure to include the sign of the value. The following examples are included to show the mathematics
and do not represent actual readings:

- Example: 5.65 dBm + 0.55 dBm = 6.20 dBm

- Example: 5.65 dBm + (-0.29 dBm) = 5.36 dBm

- Example: -5.65 dBm + 0.55 dBm = -5.10 dBm

- Example: -5.65 dBm + (-0.29 dBm) = -5.94 dBm

. . . continued on next page
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Table G-5: In-Service Calibration

Step Action

5 Input the Coupler Loss for the TX and RX tests:

- Click Util>Edit>Coupler Loss>TX or RX from the menu bar at the main window.

- Input the appropriate coupler loss for the target carrier(s) by referring to the information taken at
the time of BTS installation.

- Click the Save button.

- Click the Dismiss button to close the window.

- To view the coupler loss file, click Util>Examine>Coupler Loss>TX or RX.

6 Have the CBSC operator put the redundant BBX OOS_MANUAL.

! CAUTION
Be sure to download OOS devices only. Loading in-service devices takes them OUT OF SERVICE
and can result in dropped calls.

The code file version numbers must match the version numbers on the other cards in the frame. If the
numbers do not match, the site may go OUT OF SERVICE.

NOTE
Be sure to include the redundant BBX in steps 9, 10, and 11.

7 Download code and data to the target devices:

- Click Tools>Update NextLoad>CDMA to set the code version that will be downloaded.

- Select the BTS(s) you need, check the appropriate code version in the pop up window, and click
the Save button to close.

- Select the target BBX(s) on the C-CCP cage picture.

- Click Device>Download>Code/Data to start downloading code.

- Select the target BBX(s) on the C-CCP cage picture.

- Click Device>Download>Data to start downloading data.

. . . continued on next page
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Table G-5: In-Service Calibration

Step Action

! CAUTION
Perform the In-service Calibration procedure on OOS devices only.

8 Select the desired test:

- Select the target BBX(s) on the C-CCP cage picture.

- Click Tests>[desired test] from the menu bar at the main window.

- Select the target carrier and confirm the channel number in the pop up window.

- Leave the Verify BLO check box checked.

- From the Test Pattern pick list, select a test pattern.

- Click the OK button to start calibration.

- Follow the on-screen instructions, except, do not connect to the BTS antenna port, connect to the
directional coupler (fwd) port associated with the on screen prompt antenna port.

NOTE
� Selecting Pilot (default) performs tests using a pilot signal only.

� Selecting Standard performs tests using pilot, synch, paging and six traffic channels. This requires
an MCC to be selected.

� Selecting CDFPilot performs tests using the CDF value for pilot gain and IS-97 gain values for all
the other channels included in the Standard pattern setting (paging, synch, and six traffic). Using
this pattern setting requires the selection of both a BBX and at least one MCC.

� Selecting CDF performs tests using pilot, synch, paging and six traffic channels, however, the gain
for the channel elements is specified in the CDF file.

9 Save the result and download the BLO data to the target BBX(s):

- Click the Save Result button on the result screen.
The window closes automatically.

10 Logout from the BTS and close the LMF session:

- Click BTS>Logout to close the BTS connection.

- Close the LMF window.

11 Restore the new “bts-*.cal” file to the CBSC.

12 Enable the target device(s) from the CBSC.
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Notes
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Cable Interconnection
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Intra-Cabinet  Cabling 

SC 4812ET Intra-Cabinet Cabling 

This appendix provides the identification and location of the cables
connecting the components which make up the SC 4812ET RF cabinet.
The number of cables and components incorporated in the RF cabinet
will vary depending on the the manner in which the cabinet is equipped.
For example, a 3 sector, 2 carrier system will require less components
and less cables than a 6 sector 2 carrier system.

Refer to Table H-1 and Figure H-1 through Figure H-19 for the cable
you wish to research.

NOTE In some cases cables with the same number are used to connect
two different signalling paths. These cables are designated A &
B and the point they connect to and from is also designated A &
B. Ensure the correct cable (A or B) is connected to the correct
designation (A or B) connector or plug.

Table H-1: SC4812ET RF CABINET INTER-CONNECT CABLES

DRDC, Combiner, Trunking Backplane Cables

CABLE # FROM NOTE’s TO

3064795A05 TX CIO Figure H-6 Trunking BP

3064735A10 TX Trunking BP Figure H-5 Combiner Connector Pnl

3064735A07 TX Combiner
See Figure H-1, Figure H-11,

Figure H-12, Figure H-13, and
Figure H-14

DRDC

3064735A11 TX Combiner (See Above) DRDC

3064735A12 TX Combiner (See Above) DRDC

3064795A07 TX CIO Figure H-11 Trunking BP

3086435H01 TX Combiner QDS PkZ Adptr

3086435H02 TX Combiner QDS PkZ Adptr

3086435H03 TX Combiner QDS PkZ Adptr

3086168H01 Power LPA PDA Figure H-5 Trunk BP

C-CCP Cables

CABLE # FROM NOTE’s TO

3064809A01 Power CCCP/PDA See Figure H-1 & Figure H-5 C-CCP Backplane

3064899A04 LAN I/O A in See Figure H-1 & Figure H-5 C-CCP LAN I/O A In

C-CCP Cables (cont)

CABLE # FROM NOTEs TO

3064899A04 LAN I/O B in See Figure H-1 & Figure H-5 C-CCP LAN I/O B In

3086033H03 GPS Surge Arrestor See Figure H-1 & Figure H-5 C-CCPBackplane

3064899A04 LAN I/O B in See Figure H-1 & Figure H-5 C-CCP LAN I/O B In

. . . continued on next page
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Table H-1: SC4812ET RF CABINET INTER-CONNECT CABLES

3064899A03 C-CCP LAN I/O A Out See Figure H-1 & Figure H-5 LAN I/O A Out

3064899A03 C-CCP LAN I/O B Out See Figure H-1 & Figure H-5 LAN I/O B Out

3064899A07 Sync CSM See Figure H-1 I/O

3086000H02 Site I/O C-CCP See Figure H-9 J2 on ETIB

3086001H02 A SPAN I/O BlkHd See Figure H-1 & Figure H-5 C-CCP/A SPAN I/O

3086001H02 B SPAN I/O BlkHd See Figure H-1 & Figure H-5 C-CCP/B SPAN I/O

3086086H02 Alarm C-CCP See Figure H-1 & Figure H-9 J1 on ETIB

3086366H02 HSO/LFR See Figure H-1 & Figure H-5 C-CCP HSO/LFR

4886044H01 LBD See Figure H-1 & Figure H-5 C-CCP Backplane

Span I/O Board Cables

CABLE # FROM NOTEs TO

3086601H01 SPAN I/O Pblock See Figure H-1 & Figure H-10 CSU

3086601H02 SPAN CSU See Figure H-1 & Figure H-10 A & B SPAN I/O BRD

3086001H02 SPAN CSU See Figure H-1 & Figure H-10
A & B SPAN Connector on
C-CCP Backplane

RFDS Cables

CABLE # FROM NOTE’s TO

3064238A17 RFDS/ASU-1 Figure H-16 & Figure H-17 DRDC

3064238A18 RFDS/ASU-2 Figure H-16 & Figure H-17 DRDC

3064238A19 RFDS/ASU-1 Figure H-16 & Figure H-17 DRDC

3064238A20 RFDS/ASU-2 Figure H-16 & Figure H-17 DRDC

ETIB/LPAC Cables

CABLE # FROM NOTE’s TO

3064794A03 LPAC See Figure H-8 C-CCP Bkpln

3064794A05 ETIB See Figure H-1 & Figure H-9 RFDS

3086433H04 RGPS I/O See Figure H-1 & Figure H-9 ETIB (15 position)

3086169H01
Power, Heat Exchanger,
PDA

See Figure H-1 & Figure H-9 ETIB, OPT, HX, EBA

3086500H01 Alm/Ctrl ETIB See Figure H-1 & Figure H-9 HX/LPA

3086505H01 DC Cable (DC Power Dist) See Figure H-1 & Figure H-19 EBA Blower Assembly

3086566H01 LPAC See Figure H-1 &  Figure H-8 1 Cable to each LPA Bk Pln

3086569H01 Door Intrusion Alarm See Figure H-5 & Figure H-19 Door  Switch

3086655H02 LPAC
See Figure H-8, Figure H-5 &
Figure H-19

ETIB
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Figure H-1: 4812ET RF Cabinet Internal FRU Locations

LPA’s

LPA Trunking
Backplane

RFDS

DC
Power
Dist.

Punch
Block
(back)

EBA

OPTIONAL AREA

Span I/OAlarm to
ETIB

ETIB
LPAC

SPAN I/O

A

B

INOUT
LAN

19 MHz

2 Sec

CSU

(See  Figure H-8,
Figure H-9), and

Figure H-10)

(See Figure H-4,
Figure H-5, Figure H-6

and Figure H-8)

DRDC

FW00698
SYS
Sync LPA Trunking

Backplane

RFDS

DC
Power
Dist.

Punch
Block
(back)

EBA

C-CCP Shelf

Combiner
Cage

OPTIONAL AREA

Span I/O
to C-CCP

Alarm to
ETIB

ETIB
LPAC

SPAN I/O

A

B

INOUT
LAN

LAN I/O

19 MHz

2 Sec

CSU

(See Figure H-2
and  Figure H-5)

(See Figure H-11,
Figure H-12,

Figure H-13, and
Figure H-14)

(See Figure H-11)

(See Figure H-10)

DRDC

FW00698
SYS
Sync

(See Figure H-5
and  Figure H-10)

Modem

To
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C-CCP  Cables and Cable Connectors
The C-CCP Shelf assembly consists of the C-CCP Shelf and the attached
backplane with cables and connectors (see Figure H-2 and Figure H-3).

The C-CCP shelf contains all of the CDMA unique functions within the
SC 4812ET RF frame. The C-CCP shelf contains the following
components:

� Broadband Transceiver (BBX) cards

� Multi-Channel CDMA (MCC) cards

� Combiner Input/Output (CIO) card

� Power Supply cards

� Group Line Interface (GLI3) cards

� Alarm Monitor Reporting (AMR) cards

� Clock Synchronization Modules (CSM)

� High Stability Oscillator/Low frequency Receiver (HSO/LFR)

� Multicoupler Preselector Cards (MPC)

� CDMA Clock Distribution (CCD) card

� Integrated Frame Modem (IFM) card

� Switch card

� C-CCP Fan Modules

H
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Figure H-2: C-CCP Shelf Cable Numbers and Connectors

P
S

-3

A
M

R
-1

H
S

O
/L

F
R

C
S

M
-1

C
S

M
-2

F
IL

LE
R

A
M

R
-2

G
LI

3-
1

G
LI

3-
2

M
C

C
24

-6

B
B

X
2-

1

B
B

X
2-

2

B
B

X
2-

3

B
B

X
2-

4

B
B

X
2-

5

B
B

X
2-

6

B
B

X
2-

13
S

w
itc

h 
C

ar
d

M
P

C
/E

M
P

C
-1

M
P

C
/E

M
P

C
-2

C
IO

B
B

X
2-

7

B
B

X
2-

8

B
B

X
2-

9

B
B

X
2-

10

B
B

X
2-

1
1

B
B

X
2-

12

M
C

C
24

-5

M
C

C
24

-4

M
C

C
24

-3

M
C

C
24

-2

M
C

C
24

-1

M
C

C
24

-1
2

M
C

C
24

-1
1

M
C

C
24

-1
0

M
C

C
24

-9

M
C

C
24

-8

M
C

C
24

-7

P
S

-2

P
S

-1

C
C

D
-2

C
C

D
-1

19
 m

m
 F

ilt
er

 P
an

el

C-CCP Shelf

SPAN A SPAN B

Cable #
3064794A03

Cable #
3086366H02

Cable #
3064899A04

Cable #
3064899A04

LPAC

ALARMS SITE I/O

HSO/LFR

LAN I/O A

LAN I/O B

Cable #
3086001H02

Cable #
3086000H02

Cable #
3086001H02

Cable #
3086086H02

To LAN I/O
connectors on
the Bulkhead

(To J1
connector on

the ETIB)

(To SPAN A I/O
connector on
the Bulkhead)

(To SPAN B I/O
connector on the

Bulkhead)

(To J2
connector on

the ETIB)

(To the C-CCP
connector on the
LPAC Module)

FW00699
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Figure H-3: C-CCP Backplane

SYSTEM
LED

LAN OUT BGPS

FW00700

Cable #
3064794A03

Cable #
3086366H02

Cable #
3064899A04

Cable #
3064899A04

LPAC

HSO/LFR

LAN IN A

LAN IN B

Cable #
3086001H02

Cable #
3086000H02

Cable #
3086001H02

Cable #
3086086H02

To LAN I/O
connectors on
the Bulkhead

(To J1
connector on

the ETIB)

(To SPAN A I/O
connector on
the Bulkhead)

(To SPAN B I/O
connector on the

Bulkhead)

(To J2
connector on

the ETIB)

(To the C-CCP
connector on the
LPAC Module)

CCCP Power
3064809A01

LAN OUT A
Cable #
3064899A03
Cable #
3064899A03Cable #

3086033H03

Cable #
4886044H01
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RF Cabinet LPA Cables 

There can be a maximum of 16 LPAs in an RF cabinet. The connections
shown are for one LPA backplane which controls four LPAs. The
remaining LPAs are connected in the same manner. Refer to Figure H-4,
through Figure H-8 for the cables connected to the LPAs in the 4812ET
RF cabinet.

Figure H-4: LPAs for the SC 4812ET

5 RU RACK
SPACE

RFDS

EBAETIB

Unpopulated
LPA Shelf Cover

LPA Module
(4-Each Cage)

External Blower
Assembly (EBA)

Note:
LPA Component door
not shown for clarity

SC 4812ET BTS RF Cabinet

FW00173
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Figure H-5: BTS Combiner to LPA Backplane Cables

5 RU RACK SPACE

RFDS

EBA

ETIB

SC 4812ET BTS
RF Cabinet

FW00708-REF
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C4

S1
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LPA-1

LPA-2

LPA-3

LPA-4

TX
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TX
OUT2

TX
OUT3

TX
IN 3

TX
IN2

TX
IN 1

Cable
3064735A10

(3 each)

LPA
Backplane

4A4B

5A5B

6A6B

1A1B

2A2B

3A3B

S1

S2
S3

S1

S2
S3

S1

S2
S3

BACK

LPA-1

LPA-2

LPA-3

LPA-4
FROM APPROPRIATE
LPA

LPA 1, LPA 2,
LPA 3, LPA 4
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Figure H-6: Combiner to LPA Backplane/LPA Backplane To CIO Board Cables

TO J15 on CIO Board
(See Figure H-7)

5 RU RACK SPACE
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EBA

ETIB

SC 4812ET BTS
RF Cabinet

FW00711

C1
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S1
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LPA-1
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IN 3
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Figure H-7: Components Located on CIO Card

RX EXP A

RX EXP B

TX BTS 1-6

J12

J13

J14

J15

BTS 7-12
M/F 1-6TX

SC 4812ET RF Cabinet

FW00237

5 RU RACK
SPACE

RFDS

EBAETIB
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LPAC Cabling 

The LPAC module provides the communication interface from the ETIB
and C-CCP to the LPA through the trunking backplane. The LPAC
interface board is contained in a protective housing which is mounted on
the RF cabinet frame behind the ETIB module. See Figure H-3,
Figure H-8 and Figure H-9 for connecting cables and connector
locations.

The LPAC is located internally to the frame as shown in Figure H-1.

Figure H-8: LPAC Interface Board Connectors and Attaching Cable Numbers

NOTE: The LPAC is Located
Behind the ETIB Module

LPAC INTERFACE
BOARD

LPA 1A, 1B 1C, 1D
RIBBON CABLE
3086566H01

LPA 2A, 2B 2C, 2D
RIBBON CABLE
3086566H01

LPA 3A, 3B 3C, 3D
RIBBON CABLE
3086566H01

LPA 4A, 4B 4C, 4D
RIBBON CABLE
3086566H01

LPA-1

LPA-2

LPA-3

LPA-4

FRONT

TX
OUT1

TX
OUT2

TX
OUT3

TX IN 3

TX
IN2

TX IN
1

LPA BACKPLANE
1, 2, 3, & 4

Cable # 3086566H01
(4 Connections each Side)

ALARM RIBBON
CABLE TO ETIB
3086655H02

RIBBON CABLE TO
C-CCP BACKPLANE
3064794A03

FW00702
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ETIB Cables and Cable Connectors 

The ETIB module (see Figure H-9) provides the interface for the LPA’s
through the LPAC, punchblock, heat exchanger and alarms to the
C-CCP backplane. The ETIB interface board is contained in a protective
housing which is mounted on the RF cabinet frame.

The ETIB is located internally to the frame as shown in Figure H-1.

Figure H-9: ETIB I/O Connectors and Attaching Cable Numbers

SITE I/O (C-CCP Backplane)

FW00701

P7
RFDS

J6
DC POWER

(Reserved) J1 To ALARMS OUT
(C-CCP Backplane)

P2
LPAC

P9 ALARMS IN
(From Bulkhead )

RGD/RGPS

P8 OPTIONS
RECEPTACLE

Cable #
3064794A05

Cable #
3086655H02

Cable #
3064534A08

Cable #
3086086H02

Cable #
3086000H02

Cable #
3086433H04

Cable #
3086366H02

J2

J5LFR/HSO

J3

J4

HEAT EXCH

(See Figure H-16)

See Figure 2-5
and Figure H-3

See Figure 2-5
and Figure H-3

See Figure 2-5
and  Figure H-3

Cable #
3086500h01

(See Figure H-8)

(See Figure H-1)

(See Figure H-1)

Cable #
3086168H01

Cable #
3086569h01

DOOR INTRUSION ALARM
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SPAN I/O Cable Connection Diagram 

The SPAN I/O card provides the frame interface and secondary surge
protection for the T1 lines. There are two span cards in an RF cabinet.
SPAN I/O A supports spans A, C, and E. SPAN I/O B supports span B,
D, and F. See Figure H-10 for SPAN cables and cable connections.

The SPAN I/O is located internally to the frame as shown in Figure H-1.
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Figure H-10: SPAN I/O Cables and Connectors
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Bulkhead
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3086601H01 CSU 3086601H02

SPAN I/O BSPAN I/O A

3086001H02

SPAN I/O WIRING DIAGRAM
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the LPAC Module,
See Figure H-1)
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3086001H02
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FW00703
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DRDC/TRDC Cables and Cable Connections 

The DRDC is a Duplexer, RX Filter, and Directional Coupler which
provides the RF interface at the rear of the cabinet. The connections are
the antenna connection (outside rear), transmit into the DRDC TX filter.
Receive out of DRDC (RX filter), and Directional coupler.

The TRDC is a TX filter/RX filter/Directional Coupler that is the same
as the DRDC except the TRDC has two antenna outputs (TX only and
RX only) The TRDC is not available in the 1.9 GHz band.

See Figure H-11, Figure H-12, Figure H-13, and Figure H-14 for the
cable diagram that fits the configuration of your BTS site.
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Figure H-11: 3 Sector, 2 Carrier BTS Combiner DRDC/TRDC Cable Connection

COMBINER CAGE

FW00704

1A1B

2A2B

3A3B

1A2A3A1B2B3B

3 Sector, 2 Carrier Maximum

1-1B 3064735A11 3 SEC
2-2B 3064735A07 3 SEC
3-3B 3064735A07 3 SEC

1-1A 3064735A11 3 SEC
2-2A 3064735A07 3 SEC
3-3A 3064735A07 3 SEC

Add the following
cables for 2nd Carrier

DRDCs

Dual Bandpass Filters
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Figure H-12: BTS 2 to 1, 3 or 6 Sector Combiner DRDC/TRDC Cable Connection

* FOR 3 SECTOR-4 CARRIER
Connect Combiner 4 to 1B
Combiner 5 to 2B
Combiner 6 to 3B

COMBINER CAGE

FW00705

14

25

36

1A2A3A1B2B3B

2 to 1 Combiners
2 Carrier - 6 Sector

4-4A 3064735A12 6 SEC
5-5A 3064735A11 6 SEC
6-6A 3064735A07 6 SEC

1-1A 3064735A11 3/6 SEC
2-2A 3064735A07 3/6 SEC
3-3A 3064735A07 3/6 SEC

DRDCs

4A5A6A4B5B6B
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Figure H-13: BTS Combiner DRDC/TRDC Cable Connection

FW00706

1A

2A

3A

1A2A3A1B2B3B

4 to 1 Combiners
3 Sector

1-1A 3064735A11 3 SEC
2-2A 3064735A07 3 SEC
3-3A 3064735A07 3 SEC

COMBINER CAGE

DRDCs

4A5A6A4B5B6B
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Figure H-14: SC 4812ET BTS Combiner DRDC/TRDC Cable Connection

4A4B

5A5B

6A6B

FW00707

1A1B

2A2B

3A3B

1A2A3A1B2B3B

Dual Bandpass Filter
6 Sector - 1 or 2 Carrier

1-1B 3064735A11 6 Sec
2-2B 3064735A07 6 Sec
3-3B 3064735A07 6 Sec

1-1A 3064735A11 6 Sec
2-2A 3064735A07 6 Sec
3-3A 3064735A07 6 Sec

COMBINER CAGE

DRDCs

4A5A6A4B5B6B

4-4A 3064735A12 6 Sec
5-5A 3064735A11 6 Sec
6-6A 3064735A07 6 Sec

4-4B 3064735A12 6 Sec
5-5B 3064735A11 6 Sec
6-6B 3064735A07 6 Sec
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MPC Functional Description 
The MPC card provides (see Figure H-15) low-noise amplification for
all RX path signals. The low noise, high gain design improves frame RX
sensitivity and overcomes the splitting loss in the receive path. DC
voltages are monitored on the RF devices and regulators and are used to
generate hard and soft alarms. The MPC is not redundant at the
card-level, but includes dual-path amplifiers which provide soft-fail
redundancy for all sectors.

MPC to DRDC Cabling

The cables connecting the MPC cards to the DRDCs for a three sector
RF cabinet are shown in Figure H-15. A six sector RF cabinet would
have six more DRDC’s and they would be connected to the front of the
MPC cards.
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Figure H-15: DRDC To C-CCP Cage MPC Boards Cable Connections

5 RU RACK
SPACE

RFDS

EBAETIB

SC 4812ET
RF Cabinet

FW00710

1A2A3A1B2B3B1A - 3A: CABLE # 3086659H01
1B - 3B: CABLE # 3086659H01

DRDC CAGE

CABLES CONNECT
1A, 2A, 3A TO TOP

MPC BOARD
#  3086659H01

MPC BOARDS

CABLES CONNECT
1B, 2B, 3B TO

BOTTOM MPC BOARD
#  3086659H01

* Use Cable 3086659H02
For Sectors 4 - 6
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RFDS Cabling Details
Figure H-16 shows the components of the RFDS. Table H-2 depicts the
cabling for a 3-Sector Duplexed configuration and Table H-3 depicts the
cabling for a 6-Sector Duplexed configuration. Figure H-17 shows the
connection of the RFDS to the BTS combiners.

Figure H-16: RFDS Component Identification

ASU1

REFL/ANT PORTS 1
THROUGH 6

SUBSCRIBER
UNIT ASSEMBLY

AMR BUS/POWER
CONNECTOR (LR485)

FWTIC

FWD/BTS PORTS
1 THROUGH 6

HANDLE

ASU2

P2

P3

MCX
CONNECTOR
TO ASU

SMA CONNECTORS
TO DRDC BTS OR
ANT PORTS

Å

MCX CABLE DETAIL

KNURLED
LOCK
SCREWS

ÇÇ
ÇÇ

CONNECTS to P2 AND
P3 OF ASU1 AND ASU2

FW00217-REF

Cable #
3064794A05

(See Figure H-9)

(See Figure H-17)

(See Figure H-17)

(See Figure H-17)

Table H-2: SC 4812ET Series 3-Sector Duplexed Directional Coupler to RFDS Cabling Table

DRDC Label Directional Coupler Port Cobra RFDS Port

ASU 1 - FWD (six pack MCX)
1A BTS Sector 1 Main BTS ASU1-FWD BTS-1

1B BTS Sector 1 Diversity BTS ASU1-FWD BTS-2

2A BTS Sector 2 Main BTS ASU1-FWD BTS-3

2B BTS Sector 2 Diversity BTS ASU1-FWD BTS-4

3A BTS Sector 3 Main BTS ASU1-FWD BTS-5

3B BTS Sector 3 Diversity BTS ASU1-FWD BTS-6

ASU 1 - REF (six pack MCX)
1A ANT Sector 1 Main ANT ASU1-REF ANT-1

1B ANT Sector 1 Diversity ANT ASU1-REF ANT-2

2A ANT Sector 2 Main ANT ASU1-REF ANT-3

2B ANT Sector 2 Diversity ANT ASU1-REF ANT-4

3A ANT Sector 3 Main ANT ASU1-REF ANT-5

3B ANT Sector 3 Diversity ANT ASU1-REF ANT-6
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Table H-3: SC 4812ET Series 6-Sector Duplexed Directional Coupler to RFDS Cabling Table

DRDC Label Directional Coupler Port Cobra RFDS Port

ASU 1 - FWD (six pack MCX)

1A BTS Sector 1 Main BTS ASU1-FWD BTS-1

1B BTS Sector 1 Diversity BTS ASU1-FWD BTS-2

2A BTS Sector 2 Main BTS ASU1-FWD BTS-3

2B BTS Sector 2 Diversity BTS ASU1-FWD BTS-4

3A BTS Sector 3 Main BTS ASU1-FWD BTS-5

3B BTS Sector 3 Diversity BTS ASU1-FWD BTS-6

ASU 2 - FWD (six pack MCX)

4A BTS Sector 4 Main BTS ASU2-FWD BTS-1

4B BTS Sector 4 Diversity BTS ASU2-FWD BTS-2

5A BTS Sector 5 Main BTS ASU2-FWD BTS-3

5B BTS Sector 5 Diversity BTS ASU2-FWD BTS-4

6A BTS Sector 6 Main BTS ASU2-FWD BTS-5

6B BTS Sector 6 Diversity BTS ASU2-FWD BTS-6

ASU 1 - REF (six pack MCX)

1A ANT Sector 1 Main ANT ASU1-REF ANT-1

1B ANT Sector 1 Diversity ANT ASU1-REF ANT-2

2A ANT Sector 2 Main ANT ASU1-REF ANT-3

2B ANT Sector 2 Diversity ANT ASU1-REF ANT-4

3A ANT Sector 3 Main ANT ASU1-REF ANT-5

3B ANT Sector 3 Diversity ANT ASU1-REF ANT-6

ASU 2 - REF (six pack MCX)

4A ANT Sector 4 Main ANT ASU2-REF ANT-1

4B ANT Sector 4 Diversity ANT ASU2-REF ANT-2

5A ANT Sector 5 Main ANT ASU2-REF ANT-3

5B ANT Sector 5 Diversity ANT ASU2-REF ANT-4

6A ANT Sector 6 Main ANT ASU2-REF ANT-5

6B ANT Sector 6 Diversity ANT ASU2-REF ANT-6
H
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Figure H-17: SC 4812ET BTS Combiner DRDC/TRDC RFDS Cable Connection

1A2A3A1B2B3B

4A5A6A4B5B6B

FW00709

ANT COUPLED
TO RFDS ASU 1

ANT COUPLED
TO RFDS ASU 2

(See Figure H-16)

(See Figure H-16)

DRDC CAGE

BTS COUPLED
TO RFDS ASU 2
(See Figure H-16)

BTS COUPLED
TO RFDS ASU 1
(See Figure H-16)

TO RFDS
ASU1 & ASU2

50 Pair Punchblock 

The 50 pair punchblock is the main interface point for RGPS, span lines,
customer I/O, Power Cabinet alarm lines, and the modem. The
punchblock provides primary protection for all lines. Refer to
Figure H-18 and Table H-4 for punchblock pin-out.

CAUTION SC4812ET Span Line Labeling for Span B and Span C is
swapped

- On the SC4812ET’s, the span cabel internal to the base station
that connects the 50 pin header on the I/O plate to the CSU has
Span B and Span C (RJ-45) connectors mis-labeled.

- CFE will punch down the span on the 50 pair bunchblock as
per Motorola documentation and punchdown chart. When con-
ecting the span input to the CSU re-label “Span B” cable
to”Span C” cable to “Span B”. Connect to CSU as per docu-
mentation

- Note: The labeling issue on the cable from the I/O plate to the
CSU Part Number 3086601H01 Rev C shall be corrected on
revision “D” to address this issue. The cut over date to Rev. D
will be approximately January 30, 2001.
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CAUTION A wiring discrepancy exists between the manuals and the frame
for remote GPS.

- The TX and RX are reversed in the ETIB, leading to inoper-
ability of the RGPS. The RGPS will not work in either a single
standalone or multiple frame configuration.

- Swap the White and White/Bk wires to punch pins 44T and
44R. The Green and Green/Bk go to 45T and 45R. This will
correct non-expansion configurations.

- Single frame and expansion BTSs without RGPS can use this
workaround as a permanent solution.

- For expansion with RGPS required a new cable (P/N
3086433H10 ) will correct the problem.
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Figure H-18: 50 Pair Punchblock

TOP VIEW OF
PUNCH BLOCK

STRAIN RELIEVE
INCOMING CABLE TO
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          ”                ”

RF Cabinet I/O Area

50R
50T

49R
49T

1T

FW00162-REF

TO SPAN
CONNECTOR

TO ALARMS
CONNECTOR

TO MODEM
CONNECTOR

TO RGD/RGPS
CONNECTOR

SeeTable H-4
for Pin-Out.
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Alarm and Span Line Cable Pin/Signal Information

Table H-4 lists the complete pin/signal identification for the 50-pin
punch block.

Table H-4: Pin-Out for 50-Pair Punchblock

Punchblock
Cable

Connector
Function

Signal Name Punch Pin Ext. Cable Wire
Color

Power Cab Control - NC 1T Blue

Power Cab Control - NO 1R Blk/Blue

Power Cab Control-Com 2T Yellow

Reserved 2R N/C

Rectifier Fail 3T Blk/Yellow

AC Fail 3R Green

Power Cabinet Power Cab Exchanger Fail 4T Blk/Grn

Power Cab Door Alarm 4R White

Power Cab Major Alarm 5T Blk/White

Battery Over Temp 5R Red

Power Cab Minor Alarm 6T Blk/Red

Reticifier Over Temp 6R Brown

Power Cab Alarm Rtn 7T Blk/Brn
ALARM

LFR_HSO_GND 7R
HSO/LFR EXT_1PPS_POS 8T
Extension

EXT_1PPS_NEG 8R

CAL_+ 9T

CAB_- 9R
LFR Antenna

LORAN_+ 10T

LORAN_- 10R

Pilot Beacon Alarm - Minor 11T

Pilot Beacon Alarm - Rtn 11R

Pilot Beacon Alarm - Major 12T
Pilot Beacon

Pilot Beacon Control-NO 12R

Pilot Beacon Control - COM 13T

Pilot Beacon Control - NC 13R

. . . continued on next page
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Table H-4: Pin-Out for 50-Pair Punchblock

Punchblock
Cable

Connector

Ext. Cable Wire
Color

Punch PinSignal Name
Function

Customer Outputs 1 - NO 14T

Customer Outputs 1 - COM 14R

Customer Outputs 1 - NO 14T

Customer Outputs 1 - COM 14R

Customer Outputs 1 - NC 15T

Customer Outputs 2 - NO 15R

Customer Outputs 2 - COM 16T
ALARM Customer Outputs

Customer Outputs 2 - NC 16R

Customer Outputs 3 - NO 17T

Customer Outputs 3 - COM 17R

Customer Outputs 3 - NC 18T

Customer Outputs 4 - NO 18R

Customer Outputs 4-COM 19T

Customer Outputs 4 - NC 19R

Customer Inputs 1 20T

Cust_Rtn_A_1 20R

Customer Inputs 2 21T

Cust_Rtn_A_2 21R

Customer Inputs 3 22T

Cust_Rtn_A_3 22R

Customer Inputs 4 23T

Cust_Rtn_A_4 23R

Customer Inputs 5 24T

Cust_Rtn_A_5 24R
ALARM Customer Inputs

Customer Inputs 6 25T

Cust_Rtn_A_6 25R

Customer Inputs 7 26T

Cust_Rtn_A_7 26R

Customer Inputs 8 27T

Cust_Rtn_A_8 27R

Customer Inputs 9 28T

Cust_Rtn_A_9 28R

Customer Inputs 10 29T

Cust_Rtn_A_10 29R

. . . continued on next page
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Table H-4: Pin-Out for 50-Pair Punchblock

Punchblock
Cable

Connector

Ext. Cable Wire
Color

Punch PinSignal Name
Function

RCV_TIP_A 30T

RCV_RING_A 30R
Span 1

XMIT_TIP_A 31T

XMIT_RING_A 31R

RCV_TIP_B 32T

RCV_RING_B 32R
Span 2

XMIT_TIP_B 33T

XMIT_RING_B 33R

RCV_TIP_C (Note) 34T

RCV_RING_C (Note) 34R
Span 3

XMIT_TIP_C (Note) 35T

XMIT_RING_C(Note) 35R

RCV_TIP_D (Note) 36T
SPAN I/O

RCV_RING_D (Note) 36R
Span 4

XMIT_TIP_D (Note) 37T

XMIT_RING_D(Note) 37R

RCV_TIP_E (Note) 38T

RCV_RING_E (Note) 38R
Span 5

XMIT_TIP_E (Note) 39T

XMIT_RING_E(Note) 39R

RCV_TIP_F (Note) 40T

RCV_RING_F (Note) 40R
Span 6

XMIT_TIP_F (Note) 41T

XMIT_RING_F(Note) 41R

NOTE
Span 3 through 6 are spares for expansion purposes

. . . continued on next page
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Table H-4: Pin-Out for 50-Pair Punchblock

Punchblock
Cable

Connector

Ext. Cable Wire
Color

Punch PinSignal Name
Function

GPS_Power_A 42T Yellow

For frame GPS_Power_A_Return 42R Yellow/Black
without RGD GPS_Power_B 43T Blue
Expansion
Punchblock GPS_Power_B_Return 43R Blue/Black

Single Frame GPS_TXD+ 44T White
RGD/RGPS BTS;RGPS Head GPS_TXD- 44R White/Black

Connection
GPS_RXD+ 45T Green

OR

Multiple Frame GPS_RXD- 45R Green/BlackMultiple Frame
BTS; RGD Signal Ground (TDR+) 46T Red
Connection at Signal Ground (TDR-) 46R Red/Black
RGPS Secondary
Frame GPS_1PPS+ 47T Brown

GPS_1PPS- 47R Brown/Black

GPS_Power_A 42T Yellow

GPS_Power_A_Return 42R Yellow/Black

GPS_Power_B 43T Blue

For frame with GPS_Power_B_Return 43R Blue/Black
RGD Expansion
Punchblock GPS_TXD+ 44T White

OR GPS_TXD- 44R White/Black
RGD/RGPS Multiple Frame

BTS; RGPS Head
GPS_RXD+ 45T Green

BTS; RGPS Head
Connection at GPS_RXD- 45R Green/Black
RGPS Primary
Frame Signal Ground (TDR+) 46T Red

Master Frame (TDR-) 46R Red/Black

GPS_1PPS+ 47T Brown

GPS_1PPS- 47R Brown/Black

Reserved 48T

MODEM Reserved 48R

RGD/RGPS Chassis Ground 49T N/A

None No Connection 49R None

Reserved 50T None

ALARM Reserved 50R None
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RF Cabinet Parts Locator

Figure H-19 illustrates the location of door switch interlocks, DC Power
distribution and the EBA blower assembly.

Figure H-19: SC 4812ET RF Cabinet Parts Locator

FW00440-REF

2

3
4

1

INDEX:
1. Door Switch

2. Door Switch (Main)
3. DC Power Distribution
4. EBA Blower Assembly
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Appendix I

GPIB Addressing
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GPIB

GPIB Introduction

Use the procedures in this appendix to verify and/or change the GPIB
addresses of the applicable test equipment.

HP437 Power Meter GPIB Address

Follow the steps in Table I-1 to verify and, if necessary, change the
HP437 GPIB address.

NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table I-1: Verify and/or Change HP437 Power Meter GPIB Address

Step Action

1 Press Shift and PRESET (see Figure I-1).

2 Use the � arrow  key to navigate to HP-IB ADRS and press ENTER.

The HP-IB address is displayed.

NOTE
HP-IB is the same as GPIB.

3 If the current GPIB address is not set to 13, perform the following to change it:

- Use the � 
 arrow keys to change the HP-IB ADRS to 13.

- Press ENTER to set the address.

4 Press Shift and ENTER to return to a standard configuration.

 

Figure I-1: HP437 Power Meter

ENTER

PRESETSHIFT (BLUE) PUSHBUTTON -
ACCESSES FUNCTION AND

DATA ENTRY KEYS IDENTIFIED
WITH LIGHT BLUE TEXT ON
THE FRONT PANEL ABOVE

THE BUTTONS

FW00308REF
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Gigatronics 8541C Power Meter GPIB Address

Follow the steps in Table I-2 to verify and, if necessary, change the
Gigatronics 8541C power meter GPIB address.

NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table I-2: Verify and/or Change Gigatronics 8541C Power Meter GPIB Address

Step Action

! CAUTION
Do not connect/disconnect the power meter sensor cable with AC power applied to the meter.
Disconnection could result in destruction of the sensing element or miscalibration.

1 Press MENU (see Figure I-2).

2 Use the 
 arrow key to select CONFIG MENU and press ENTER.

3 Use the 
 arrow key to select GPIB and press ENTER.

The current Mode and GPIB Address are displayed.

4 If the Mode is not set to 8541C, perform the following to change it:

Use the � 	 arrow keys as required to select MODE.

Use the 
� arrow keys as required to set MODE to 8541C.

5 If the GPIB address is not set to 13, perform the following to change it:

Use the 	 arrow key to select ADDRESS.

Use the 
� arrow keys as required to set the GPIB address to 13.

6 Press ENTER to return to normal operation.

Figure I-2: Gigatronics 8541C Power Meter Detail

MENU ENTER ARROW
KEYS

REF FW00564

1
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Motorola CyberTest GPIB Address

Follow the steps in Table I-3 to verify and, if necessary, change the
GPIB address on the Motorola CyberTest. Changing the GPIB address
requires the following items:

� Motorola CyberTest communications analyzer

� Computer running Windows 3.1/Windows 95

� Motorola CyberTAME software program “TAME”

� Parallel printer port cable (shipped with CyberTest)

NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table I-3: Verify and/or Change Motorola CyberTest GPIB Address

Step Action

1 On the LMF desktop, locate the CyberTAME icon. Double click on the icon to run the CyberTAME
application.

2 In the CyberTAME window taskbar, under Special, select IEEE.488.2.

3 CyberTAME software will query the CyberTest Analyzer for its current GPIB address. It then will
open the IEEE 488.2 dialog box. If the current GPIB address is not 18, perform the following
procedure to change it:

- Use the up or down increment arrows, or double-click in the field and type the number.

- Click on the OK button.
The new address will be written to the CyberTest via the parallel port and saved.

NOTE
Verify that the address has been set by repeating steps 2 and 3. The new address should now appear in
the IEEE 488.2 dialog box Address field.

HP8935 Test Set GPIB Address

Follow the procedure in Table I-4 to verify and, if necessary, change the
HP8935 GPIB address.

NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table I-4: Verify and/or Change HP8935 GPIB Address

Step Action

* IMPORTANT
The HP I/O configuration MUST be set to Talk & Listen, or NO device on the GPIB bus will be
accessible. (Consult test equipment OEM documentation for additional information as required.)

1 To verify that the GPIB addresses are set correctly, press Shift and LOCAL on the HP8935 (see
Figure I-3). The current HP-IB address is displayed at the top of the screen.

NOTE
HP-IB is the same as GPIB.
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Table I-4: Verify and/or Change HP8935 GPIB Address

Step Action

2 If the current GPIB address is not set to 18, perform the following to change it:

- Press Shift and Inst Config.

- Turn the Cursor Control knob to move the cursor to the HP-IB Adrs field.

- Press the Cursor Control knob to select the field.

- Turn the Cursor Control knob as required to change the address to 18.

- Press the Cursor Control knob to set the address.

3 � Press Preset to return to normal operation.

Figure I-3: HP8935 Test Set

FW00885

Preset

Cursor ControlShift

Inst Config

Local
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Setting HP8921A and HP83236A/B GPIB Address

Follow the procedure in Table I-5 to verify and, if necessary, change the
HP8921A HP83236A GPIB addresses.

NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table I-5: Verify and/or Change HP8921A and HP83236A GPIB Addresses

Step Action

1 To verify that the GPIB addresses are set correctly, press Shift and LOCAL on the HP8921A (see
Figure I-4). The current HP-IB address is displayed at the top of the screen.

NOTE
HP-IB is the same as GPIB.

2 If the current HP-IB address is not set to 18, perform the following to change it:

- Turn the Cursor Control knob to move the cursor to More and press the knob to select the field.

- Turn the Cursor Control knob to move the cursor to I/O Config and press the knob to select the
field.

- Turn the Cursor Control knob to move the cursor to Adrs and press the knob to select the field.

- Turn the Cursor Control knob to change the HP-IB address to 18 and press the knob to set the
address.

- Press Shift and Preset to return to normal operation.

3 To set the HP83236A (or B) PCS Interface GPIB address=19, set the dip switches as follows:

- A1=1, A2=1, A3=0, A4=0, A5=1, HP-IB/Ser = 1
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Figure I-4: HP8921A and HP83236A/B

Preset

Cursor ControlShift

Local

Advantest R3465 GPIB Address

Table I-6 describes the steps to verify and, if necessary, change the GPIB
address for the Advantest R3465.

NOTE This procedure assumes that the test equipment is set up and
ready for testing.

Table I-6: Verify and/or Change Advantest R3465 GPIB Address

Step Action

1 To verify that the GPIB address is set correctly, perform the following procedure:

- Press SHIFT then PRESET (see Figure I-5).

- Press LCL.

- Press the GPIB and Others CRT menu key to view the current address.

2 If the current GPIB address is not set to 18, perform the following to change it:

- Turn the vernier knob as required to select 18.

- Press the vernier knob to set the address.

3 To return to normal operation, press Shift and Preset.
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Figure I-5: R3465 Communications Test Set

BNC
“T”

REF UNLOCK EVEN
SEC/SYNC IN

CDMA
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POWER

OFF ON

REF FW00337LCL Shift Preset

GPIB and others

Vernier
Knob

RS232 GPIB Interface Box

Ensure that the RS232 GPIB interface box dip switches are set as shown
in Figure I-6.

Figure I-6: RS232 GPIB Interface Box

RS232-GPIB
INTERFACE BOX

S MODE

DATA FORMAT

BAUD RATE

GPIB ADRS

ON

DIP SWITCH SETTINGS

G MODE

Advantest R3267 Spectrum Analyzer GPIB Address

Perform the procedure in Table I-7 and refer to Figure I-7 to verify and,
if necessary, change the Advantest R3267 spectrum analyzer GPIB
address.
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Table I-7: Verify and Change Advantest R3267 GPIB Address

Step Action

1 If the REMOTE LED is lighted, press the LCL key.

- The LED turns off.

2 Press the CONFIG key.

- The CONFIG softkey labels will appear in the softkey label display area of the instrument
display.

- The current GPIB address will be displayed below the GPIB Address softkey label.

3

3a

If the current GPIB address is not set to 18, perform the following to change it:

- Press the GPIB Address softkey.
-- A GPIB Address entry window will open in the instrument display showing the current

GPIB address.

3b
- Enter 18 on the keypad in the ENTRY section of the instrument front panel.

-- Characters typed on the keypad will replace the address displayed in the GPIB Address
entry window.

NOTE
To correct an entry, press the BS (backspace) key at the lower right of the keypad to delete one
character at a time.

3c - Press the ENTR key to the lower right of the keypad to enter the address.
-- The GPIB Address entry window closes.
-- The new address is diplayed in the bottom portion of the GPIB Address softkey label.

 

Figure I-7: Setting Advantest R3267 GPIB Address

�� REMOTE
LED

LCL Key

CONFIG
Key

Softkey Lable
Display Area

Softkey
Buttons

Keypad BS
Key

ENTR
Key

Advantest R3562 Signal Generator GPIB Address
Set the GP-IB ADDRESS switch on the rear of the Advantest R3562
signal generator to address 1 as shown in Figure I-8.
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Figure I-8: Advantest R3562 GPIB Address Switch Setting

1 2 3 4 5 6 7 8

5 4 3 2 1

GP-IP  ADDRESS

1

0

GPIB Address set to “1”
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Agilent E4406A Transmitter Tester GPIB Address

 Follow the procedure in Table I-8 and refer to Figure I-9 to verify and, if
necessary, change the Agilent E4406A GPIB address.

Table I-8: Verify and Change Agilent E4406A GPIB Address

Step Action

1 In the SYSTEM section of the instrument front panel, press the System key.

- The softkey labels displayed on the right side of the instrument screen will change.

2 Press the Config I/O softkey button to the right of the instrument screen.

- The softkey labels will change.

- The current instrument GPIB address will be displayed below the GPIB Address softkey label.

3 If the current GPIB address is not set to 18, perform the following to change it:

3a - Press the GPIB Address softkey button.
-- In the on-screen Active Function Area, GPIB Address will be displayed followed by the

current GPIB address.

3b - On the front panel Data Entry keypad, enter the communications system analyzer GPIB address of
18.

-- The GPIB Address label will change to Enter.
-- Digits entered with the keypad will replace the current GPIB address in the display.

NOTE
To correct an entry, press the Bk Sp key at the upper right of the keypad to delete one character at a
time.

3c - Press the Enter softkey button or the keypad Enter key to set the new GPIB address.
-- The Config I/O softkey labels will reappear.
-- The new GPIB address will be displayed under the GPIB Address softkey label.
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Figure I-9: Setting Agilent E4406A GPIB Address
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Agilent E4432B Signal Generator GPIB Address

Follow the procedure in Table I-9 and refer to Figure I-10 to verify and,
if necessary, change the Agilent E4432B GPIB address.

Table I-9: Verify and Change Agilent E4432B GPIB Address

Step Action

1 In the MENUS section of the instrument front panel, press the Utility key.

- The softkey labels displayed on the right side of the instrument screen will change.

2 Press the GPIB/RS232 softkey button to the right of the instrument screen.

- The softkey labels will change.

- The current instrument GPIB address will be displayed below the GPIB Address softkey label.

3 If the current GPIB address is not set to 1, perform the following to change it:

3a - Press the GPIB Address softkey button.
-- The GPIB Address label and current GPIB address will change to boldface.
-- In the on-screen Active Entry Area, Address: will be displayed followed by the current

GPIB address.
. . . continued on next page
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Table I-9: Verify and Change Agilent E4432B GPIB Address

Step Action

3b - On the front panel Numeric keypad, enter the signal generator GPIB address of 1.
-- The GPIB Address label will change to Enter.
-- Digits entered with the keypad will replace the current GPIB address in the Active Entry

display.

NOTE
To correct an entry, press the backspace key at the lower right of the keypad to delete one character at
a time.

3c - Press the Enter softkey button to set the new GPIB address.
-- The new GPIB address will be displayed under the GPIB Address softkey label.

 

Figure I-10: Setting Agilent E4432B GPIB Address
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Notes
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Appendix J

Downloading ROM
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Downloading ROM Code

Exception Procedure - Downloading ROM Code

This procedure is not part of a normal optimization.

Perform this procedure only on an exception basis when no alternative
exists to load a BTS device with the correct version of ROM code.

NOTE One GLI must be INS_ACT (bright green) before ROM code
can be downloaded to non-GLI devices.

CAUTION The correct ROM and RAM codes for the software release used
on the BSS must be loaded into BTS devices. To identify the
correct device ROM and RAM code loads for the software
release being used on the BSS, refer to the Version Matrix
section of the SC� CDMA Release Notes (supplied on the tape
or CD-ROM containing the BSS software).

All devices in a BTS must be loaded with the ROM and RAM
code specified for the software release used on the BSS before
any optimization or ATP procedures can be performed.

If a replacement device is loaded with ROM code which is not
compatible with the BSS software release being used, the device
ROM code can be changed using the LMF before performing the
BTS optimization and ATPs. A device loaded with later release
ROM code can not be converted back to a previous release ROM
code in the field without Motorola assistance

If it is necessary to download ROM code to a device from the LMF, the
procedure in Table J-1 includes steps for both ROM and RAM code
download using LMF.

Prerequisites

Prior to performing this procedure, ensure the correct ROM and RAM
code files exist in the LMF computer’s applicable lmf home directory
code folder for each of the devices to be loaded.

CAUTION The Release level of the ROM code to be downloaded must be
the one specified for the software release installed in the BSS.
The release level of the ROM code resident in the other devices
in the BTS must also be correct for the BSS software release
being used. ROM code must not be downloaded to a frame
loaded with code for a BSS software release with which it is not
compatible.

This procedure should only be used to upgrade replacement
devices for a BTS. It should NOT be used to upgrade all devices
in a BTS. If a BTS is to be upgraded from R15.x to R16.0, the
upgrade should be done by the OMC-R using the DownLoad
Manager.
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Table J-1: Download ROM and RAM Code to Devices

Step Action

1 Click on the device to be loaded.

NOTE
More than one device of the same type can be selected for download by either clicking on each one to
be downloaded or from the BTS menu bar Select pull-down menu, select the device item that applies.

Where:  device  =  the type of device to be loaded (BBX, CSM, MCC)

2 From the BTS menu bar Device pull-down menu, select Status.

- A status report window will appear.

3 Make a note of the number in the HW Bin Type column.

NOTE
“HW Bin Type” is the Hardware Binary Type for the device. This code is used as the last four digits in
the filename of a device’s binary ROM code file. Using this part of the filename, the ROM code file
can be matched to the device in which it is to be loaded.

4 Click OK to close the status window.

5 Click on the device to be loaded.

6 * IMPORTANT
The LMF will not automatically select ROM code files for download. ROM code files must be
selected manually.

From the BTS menu bar Device pull-down menus, select Download > Code Manual.

- A file selection window will appear.

7 Double-click on the version folder with the desired version number for the ROM code file (for
example 2.16.0.x).

8 Double-click the Code folder.

- A list of ROM and RAM code files will be displayed.

! CAUTION
A ROM code file with the correct HW Bin Type must be chosen. Using a file with the wrong HW Bin
Type can result in unpredictable operation and damage to the device.

9 Click on the ROM code file with the filename which matches the device type and HW Bin Type
number noted in step 3 (for example, file bbx_rom.bin.0604 is the ROM code file for a BBX with a
HW Bin Type of 0604).

- The file should be highlighted.

10 Click on the Load button.

- A status report window is displayed showing the result of the download.

NOTE
If the ROM load failed for some devices, load them individually by clicking on one device, perform
steps 6 through 10 for it, and repeat the process for each remaining device.

11 Click OK to close the status window.

12 From the LMF window menu bar Tools pull-down menus, select Update NextLoad > CDMA.

13 In the left-hand pane of the window which opens, click on the BTS number for the frame being loaded
(for example, BTS-14 ).

. . . continued on next page
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Table J-1: Download ROM and RAM Code to Devices

Step Action

14 On the list of versions displayed in the right-hand pane, click the button next to the version number of
the folder that was used for the ROM code download (for example, 2.16.0.x) and click Save.

- A pop-up message will appear showing the CDF has been updated.

15 Click on the OK button to dismiss the pop-up message.

16 Click on the device that was loaded with ROM code.

NOTE
RAM code is automatically selected for download.

17 From the BTS menu bar Device pull-down menus, select Download > Code/Data to download RAM
code and dds file data.

- A status report is displayed showing the result of the download.

18 Click OK to close the status window.

19 Observe the downloaded non-GLI device to ensure it is OOS_RAM (yellow).

20 Click on the device which was loaded with code.

21 From the BTS menu bar Device pull-down menu, select Status.

Verify that the correct ROM and RAM version numbers are displayed in the status report window.

22 Click OK to close the status window.
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Optimizing the Companion Frame

Optimizing the TX section

The optimization/ATP procedure for the transmit side of the Companion
Frame is identical to that of the SC4812ET BTS.

Table K-1: Optimizing the TX section of the Companion Frame

� Step Action

1 Please refer to the TX Optimization/ATP - Chapter 3 of this manual for step-by-step TX
Optimization/ATP instructions for the standalone frame

2 Run the TX tests.
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Optimizing the RX section

RX (Main) Optimization/ATP

To test the RX Main antenna system follow the instructions in Table K-2
and refer to illustration Figure K-1(3-sector configuration).

Table K-2: Optimizing the RX (Main) section of the Companion Frame

� Step Action

1 Connect the RX test cables to the antenna ports 1A-3A (for 3-sector optimization) or
antenna ports 1A-6A (for 6-sector optimization).

2 Login the LMF and select MPC (see Figure K-2 for display screen and field location).

3 Run the RX tests.

RX (Diversity) Optimization/ATP (Single Frame)

To test the RX Diversity antenna system follow the instructions in
Table K-3.

Table K-3: Optimizing the RX (Diversity) on a Single Frame

� Step Action

1 Connect the RX test cables to the expansion ports on the I/O plates labeled 1B-3B (for
3-sector optimization) or expansion ports 1B-6B (for 6-sector optimization).

2 Login the LMF under EMPC (see Figure K-2 for display screen and field location).

3 Run the RX tests.

RX (Diversity) Optimization/ATP (Two Frame)

To test the RX Diversity antenna configuration on a two frame
Companion BTS system follow the instructions in Table K-4.

Table K-4: Optimizing the RX (Diversity) on a Two Frame Companion Site

� Step Action

1 Connect RX expansion cables from the expansion ports on the other Companion frame
labeled 1A-3A (for 3-sector optimization) or expansion ports 1A-6A (for 6-sector
optimization) to the 1B-3B (for 3-sector optimization) or expansion ports 1B-6B (for
6-sector optimization) see Figure K-1 for an illustration of the configuration.

NOTE
Connect the cables from the 2nd frame A ports to the B ports of the 1st frame.

2 Login using the LMF select MPC (see Figure K-2 for field location on LMF display screen)

NOTE
- Although the test will be done to one frame, the RX cable will be connected to the

other frame’s corresponding antenna ports.

- The other frame has to be powered up and include all the RX Path Components.
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Figure K-2: WinLMF Display Screen
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Numbers
10BaseT/10Base2 Converter, 1-12

2-way Splitter, 1-15

3-Sector Duplexed Directional Coupler to RFDS
Cabling Table, H-23

4812ET RF Cabinet Internal FRU Locations, H-4

6-Sector Duplexed Directional Coupler to RFDS
Cabling Table, H-24

A
Acceptance Test Procedures ATP , 1-3

Acronyms, 1-16

ACTIVE LED
GLI, 6-41
MCC, 6-44

Advantest R3465, 3-64
GPIB, I-9

Alarm and Span Line Cable Pin/Signal Information,
3-8

ALARM LED, GLI, 6-41

Alarm Monitor window, 3-130

Alarm Reporting Display, 3-130

All Cal/Audit Test, 3-113

All inclusive, TX ATP test outline - CCP shelf 1,
primary, 4-18

All tests fail on a single antenna, Troubleshooting,
RFDS, 6-35

AMR, 1-21

Applying AC Power, 2-6

ATP
generate failure report, 4-17
generate report, 4-17
test matrix/detailed optimization, B-3

ATP - Reduced, 4-3

ATP Report, 4-18

ATP Test Procedure, 4-9

B
Basic Troubleshooting Overview, 6-2

Battery Charge Test (Connected Batteries), 2-12

Battery Discharge Test, 2-12

Bay Level offset calibration failure, 6-10

BBX, gain set point vs SIF output considerations, C-2

BBX2, 1-21

BBX2 Connector, 6-25

BBX2 LED Status Combinations, 6-43

Broad Band Receiver. See BBX

BTS
download, 3-42
Ethernet LAN interconnect diagram, 3-25
LMF connection, 3-12, 3-24
system software download, 3-3

BTS Cabinet, 1-28

BTS directory, create, 3-28

Create CAL File, 3-114

C
C-CCP Backplane, H-7

C-CCP Backplane Troubleshooting, Procedure, 6-26

C-CCP shelf, 1-21

cable calibration, automatic, test set-up, 3-72
Advantest R3267/R3562, 3-72
Advantest R3465, 3-71
Agilent 8935, 3-71
Agilent E4406A/E4432B, 3-72
CyberTest, 3-71
HP 8921A, 3-71

Cables Connection for 10 MHz Signal and GPIB ,
F-4, F-6

Calibrate BLO, 3-98

Calibrating Cables, 3-90

Calibrating Test Cable Setup, PCS Interface
HP83236B, F-16

Calibrating Test Equipment, 3-89

Calibration
data file calibration, BLO, 3-100
In-Service, G-18
power meter, Gigatronics 8542B, F-25

Calibration Audit failure, 6-11

calibration data file, description of, BLO, 3-100

Cannot communicate to Communications Analyzer,
6-5

Cannot communicate to Power Meter, 6-4

Cannot Download DATA to any device card, 6-6, 6-7

Cannot ENABLE device, 6-8

Cannot Log into cell-site, 6-3
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Cannot perform carrier measurement, 6-16

Cannot perform Code Domain Noise Power
measurement, 6-15

Cannot perform Rho or pilot time offset
measurement, 6-14

Cannot perform Txmask measurement, 6-13

CCD, 1-21

CCP, shelf 1 - all inclusive TX ATP test outline,
primary, 4-18

CDF
site configuration, 3-3
site equipage verification, 3-4
site type and equipage data information, 2-2

CDF file
create, 3-31
update device load version, 3-32, 3-33

CDMA
allocation diagram for the North American, cellular

telephone frequency spectrum, D-6
optimization/ATP test matrix, B-2

cdpower test, 4-14

Cell Site
equipage verification, 2-2
types configuration, 3-3

Cell Site Data File. See CDF

Cell Site Field Engineer CFE, 1-3

Channel Service Unit, 3-6

CIO, 1-21

CIO Connectors, 6-25

CLI, 1-4

Clock Sync Module. See CSM

Code Domain Power and Noise Floor Levels, 4-15

Code Domain Power/Noise, 4-14

Communication test set, rear panel, F-4, F-6

Communications System Analyzer, 1-13

Communications system analyzer , 1-13

Components Located on CIO Card, H-11

Connecting test equipment to the BTS, 3-62

Connector Functionality
Backplane, Troubleshooting, 6-24
Troubleshooting, Backplane, 6-24

Copy CAL Files From Diskette to the CBSC, 5-4

Copy CDF Files from CBSC, 3-19

Copy Files from LMF to Diskette, 5-4

Copying CAL files from CDMA LMF to the CBSC,
5-4

Copying CAL files to the CBSC, 5-4

create
BTS directory, 3-28
CDF file, 3-31
master-bts-cdma, 3-28

CSM, 1-21
and LFR primary functions, 3-52

CSM frequency verification, 3-54

CSM LED Status Combinations, 6-39

Customer I/O, 1-21

CyberTest, 3-64

CyberTest Communication Analyzer, 1-13

D
DC Power Pre-test (BTS Frame), 2-8

DC Power Problems, C-CCP Backplane
Troubleshooting, 6-30

DC/DC Converter LED Status Combinations, 6-38

Detailed, optimization/ATP test matrix, B-3

Devices, download. See Download

Digital Control Problems, 6-27
C-CCP Backplane Troubleshooting, 6-27

Digital Multimeter, 1-14

Directional Coupler, 1-14

Download
See also Devices
BTS, 3-42
BTS system software, 3-3

Download BLO Procedure, 3-106

download ROM and RAM code. See ROM code

Download/Enable MCCs, 3-51

Download/Enable MGLIs, 3-45

Duplexer/Directional Coupler DDC, 1-20, 1-21, 1-22,
1-30

E
Enable CSMs & BDCs, 3-49

Equipment Overview, 1-18

Equipment warm-up, 3-68

Ethernet LAN
interconnect diagram, 3-25
transceiver, 1-12

ETIB I/O Connectors, H-13



Index 68P09255A57-2

SC�4812ET Optimization/ATP Manual Software Release R16.1.x.x

PRELIMINARY
Aug 2002Index-4

Every test fails, Troubleshooting, RFDS, 6-33

F
fer test, 4-16

Files, calibration data file, BLO, 3-100

Folder Structure Overview, 3-21, 3-23

Foreword, xx

FREQ Monitor Connector, CSM, 6-40

Frequency counter, optional test equipment, 1-15

G
Gain set point, C-2

General Safety, xxii

General optimization checklist, test data sheets, A-6

Gigatronics 8542B power meter, illustration, F-25,
I-4

Gigatronics Power Meter, 3-64

GLI. See Master (MGLI2) and Slave (SGLI2) Group
Line Interface

GLI Connector, 6-25

GLI Ethernet A and B Connections, 6-25

GLI LED Status Combinations, 6-41

GLI Pushbuttons and Connectors, 6-42

GLI2, 1-21

GLI2 Front Panel Operating Indicators, 6-42

GPIB, F-3, F-7, F-11
Advantest R3465, I-9
HP83236A/B, I-7
HP8921A, I-7
HP8935, I-6
power meter

Gigatronics 8542B, I-4
HP437B, I-3

set address, Motorola CyberTest, I-5

GPIB Cables, 1-13

GPS, receiver operation, test data sheets, A-7

GPS Initialization/Verification
estimated position accuracy, 3-55
surveyed position accuracy, 3-55

GPS satellite system, 3-49

Graphical User Interface Overview , 3-34, 3-35

Group Line Interface. See GLI

H
Hardware Requirements, 1-9

High Stability 10 MHz Rubidium Standard, 1-15

High-impedance Conductive Wrist Strap, 1-14

HP 437B, 3-64

HP 83236A, F-7

HP 8921, 3-64

HP83236A/B, GPIB, I-7

HP8921A, F-7
GPIB, I-7

HP8935, GPIB, I-6

HP8935 Analyzer, 1-13

HSO, 1-21

HSO Initialization/Verification, 3-53

I
I and Q values, E-3

In-Service Calibration, G-18

Initial HP8921A setup, F-16

Initial Installation of Boards/Modules, preliminary
operations, 2-2

Initial power tests, test data sheets, A-5

Installation and Update Procedures, 3-16

Intercabinet I/O, 1-22

Internal FRU, 1-29

Internal FRUs, 1-20

IS-97 specification, E-3

ISB Inter Shelf Bus connectors, 6-24

L
LAN, BTS frame interconnect, illustration, 3-25
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LED Status Combinations for all Modules except
GLI2 CSM BBX2 MCC24 MCC8E, 6-37

LFR, 1-21
receiver operation, test data sheets, A-8

Line Build Out parameters
configure, 5-8
verify, 5-6

LMF, F-3, F-11
to BTS connection, 3-12, 3-24
view CDF information, 3-4

LMF Removal, 5-12

Load Center Wiring, 2-5

Local Area Network (LAN) Tester, 1-15

Log into the BTS, 3-27

Log into the LMF, 3-27

Logging In to a BTS, 3-36

Logging Out, 3-39

LORAN-C Initialization/Verification, 3-60

LPA errors, 6-9

LPA Module LED, 6-45

LPA Shelf LED Status Combinations, 6-45

LPAC Interface Board, H-12

M
major components, 1-19

Manual, layout, 1-2

Master Group Line Interface. See MGLI

MASTER LED, GLI, 6-41

master-bts-cdma directory, create, 3-28

MCC LED Status Combinations, 6-44

MCC/CE, 4-14

MGLI2, board detail, MMI port connections, 5-7

MMI common connections, 3-41

MMI Connection, 3-41

MMI Connector
CSM, 6-40
GLI, 6-42

MMI Connectors, MCC, 6-44

MMI equipment setup, 3-41

Model SLN2006A MMI Interface Kit, 1-13

Module status indicators, 6-36

Motorola, SC9600 Base Transceiver Subsystem, 1-2

MPC, 1-21

Multi Channel Card. See MCC

Multi-FER test Failure, 6-17

N
New Installations, 1-6

No AMR control, 6-28

No BBX2 control in the shelf, 6-28

No DC input voltage to  Power Supply Module, 6-30

No DC voltage +5 +65 or +15 Volts to a specific
GLI2 BBX2 or Switch board, 6-31

No GLI2 Control through span line connection, 6-27

No GLI2 Control via LMF, 6-27

No or missing MCC24 channel elements, 6-29

No or missing span line traffic, 6-28

North American, cellular telephone system frequency
spectrum, CDMA allocation, D-6

Null modem cable detail, 1-12

O
Online Help, 1-4

Optimization, 1-3

optimization/ATP, test set-up, 3-76
Advantest R3267/R3562

DRDCs, 3-79
TRDCs, 3-81

Advantest R3465, 3-76
Agilent 8935

DRDCs, 3-78
TRDCs, 3-80

Agilent E4406A/E4432B
DRDCs, 3-78
TRDCs, 3-80

CyberTest, 3-76
HP 8921A, 800 MHz, 3-77
HP 8921A, 1.9 GHz, 3-77

Optimization/ATP Test Matrix, 1-6

Optional Test Equipment, 1-15

Optional test equipment, frequency counter, 1-15

Oscilloscope, 1-15

P
Pilot Time Offset. See PN

Ping, 3-25
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PN
offset programming information, E-2
offset usage, E-3

PN offset per sector, E-3

PN Offset Usage , E-3

Power Delta Calibration
Advantest, G-7
HP8921A, G-4
HP8935, G-10

Power Input, 6-24

Power Meter, 1-13
illustration, F-23, I-3
Pre-calibration, F-23

Power meter
calibration, Gigatronics 8542B, F-25
GPIB

Gigatronics 8542B, I-4
HP437B, I-3

illustration, Gigatronics 8542B, F-25, I-4

Power Supply Module Interface, 6-24

Pre-calibration, Power Meter, F-23

Pre-power tests, test data sheets, A-5

Preliminary operations
cell Site types, 2-2
test data sheets, A-4

Prepare to Leave the Site
External test equipment removal, 5-2
LMF Removal, 5-12
Reestablish OMC-R control, 5-13
Verify T1/E1, 5-13

Prepare to leave the site
re-connect BTS IFM connector, 5-11
re-connect BTS T1 spans, 5-11

Procedures to Copy CAL Files From Diskette to the
CBSC, 6-3, 6-4, 6-5, 6-6, 6-7

Product Description, 1-4

Pseudorandom Noise. See PN

ptoff test, 4-13

Punch Block, 3-8

PWR/ALM and ACTIVE LEDs, MCC, 6-44

PWR/ALM LED
BBX2, 6-43
CSM, 6-39
DC/DC Converter, 6-38
generic, 6-37
MCC, 6-44
MPC and EMPC Card, H-21

R
RAM code, described, 3-42

Re-connect BTS IFM connector, 5-11

Re-connect BTS T1 Spans, 5-11

Receive Distribution Card RXDC, 1-30

Reduced ATP, 4-3

Reduced ATP passes but forward link problem
prevails, 6-12

Reestablish OMC-R control, 5-13

Removing and Installing LPAs for the SC 4812ET,
H-8

Required documents, 1-7, 1-29

Required Test Equipment
Ethernet LAN transceiver, 1-12
substitute equipment, 1-8

RESET Pushbutton, GLI, 6-42

Resetting BTS modules, 5-3

Revision History, xxiv

RF Adapters, 1-14

RF Attenuators, 1-14

50 Pair Punchblock, H-27

RF Path Bay Level Offset Calibration, 3-97

RF Test Cable, 1-15

RFDS Cabling Details, H-23

RFDS calibration
description, 3-125
procedure, 3-126

RFDS FRU, H-15

RFDS Location, SC 4812ET, 1-24

RFDS parameters, 3-116
checking, 3-117
setting, 3-117

RFDS Test Subscriber Unit, 3-43

RFDS TSU Calibration Channel Frequencies, 3-125

rho test, 4-12

ROM code
described, 3-42
downloading, J-2, K-2, K-3

procedure, J-3
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RS-232 to GPIB Interface, 1-12

Rubidium Standard Timebase, 3-64

RX, antenna VSWR, test data sheets, A-18

RX and TX paths fail, Troubleshooting, RFDS, 6-34

S
SC 4812 BTS Optimization/ATP Test Matrix, B-4

SC 4812ET BTS Combiner, H-9, H-10, H-17, H-18,
H-19, H-20, H-22, H-23, H-25

SCLPA, convergence test data sheets, A-9

Selecting Test Equipment, 3-85

Set Antenna Map Data, 3-123

Set RFDS Configuration Data, 3-124

Set Span Parameter Configuration, procedure, 5-8

Setting Cable Loss Values, 3-94

Setting Control Port, 3-6

Setting Coupler Loss Value, 3-95

SGLI2, board detail, MMI port connections, 5-7

SIF, output considerations vs BBX gain set point, C-2

Site, equipage verification, 3-4

Site checklist, verification data sheets, A-3

site equippage, CDF file, 3-3

Site Specific BTS Files, 3-28

Span Framing Format
configure, 5-8
verify, 5-6

SPAN I/O Functional Description, Introduction, H-14

Span Line (T1/E1) Verification Equipment, 1-15

Span Line connector , 6-24

Span Parameter Configuration
set, procedure, 5-8
verification, procedure, 5-6

Span Problems no control link, Troubleshooting, 6-46

SPANS LED, 6-41

Spectrum Analyzer, 1-15

Spectrum Analyzer , HP8594E, 3-64

STATUS LED, GLI, 6-41

SYNC Monitor Connector, CSM, 6-40

System Connectivity Test, F-7

T
T1, isolate BTS from the T1 spans, 3-5, 3-14

Telco Interface Board TIB, 1-30

Test data sheets
Alarm verification, A-19
general optimization checklist, A-6
GPS receiver operation, A-7
initial power tests, A-5
LFR receiver operation, A-8
pre-power tests, A-5
preliminary operations, A-4
RX antenna VSWR, A-18
SCLPA convergence, A-9
site checklist, A-3
TX antenna VSWR, A-16
TX BLO, A-10, A-15
verification of test equipment used, A-2

Test equipment, verification data sheets, A-2

Test equipment connections , F-3
preliminary Agilent E4406A/E4432B set-up, F-15

Test Equipment Policy, 1-8

Test Equipment Setup Calibration for TX Bay Level
Offset, 3-93, F-20

Test Equipment Setup Chart, 3-66

Test equipment setup RF path  calibration, 3-103

Timing Reference Cables, 1-13

Transmit TX path audit, 3-109

Transmit TX path calibration, 3-104

Transmit/Receive Module TRX, 1-29

Troubleshooting
DC Power Problems, 6-30
Span Problems no control link, 6-46

Troubleshooting Forward Link Failure (BTS Passed
Reduced ATP), 6-12

TSU NAM, programming
description, 3-120
parameter ranges, 3-122
parameters, 3-121
procedure, 3-128

TX
antenna VSWR, test data sheets, A-16, A-19
BLO test data sheets, A-10, A-15

TX and RX Frequency vs Channel , D-4

TX Audit Test, 3-110

TX Bay Level Offset and TX ATP test equipment
setup calibration, 3-92
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TX calibration, set-up, 3-73
Advantest R3267, 3-75
Advantest R3465, 3-74
Agilent 8935, 3-73
Agilent E4406A, 3-75
CyberTest, 3-73
HP 8921A, 3-74

tx fine adjust, E-3

TX Mask Verification, spectrum analyzer display,
illustration, 4-11

TX Output Acceptance Tests - Introduction
Code domain power, 4-8
Pilot time offset, 4-8
Spectral purity TX mask, 4-8
Waveform Quality (rho), 4-8

TX Path Calibration, 3-99

TX/RX OUT Connections, 4-5

txmask test, 4-10

U
Updating CDMA LMF Files, 5-4

V
Verify, test equipment used, test data sheets, A-2

Verify GLI ROM code load, 3-44

Verify Span Parameter Configuration, procedure, 5-6

W
Walsh channels, 4-14

X
XCVR Backplane Troubleshooting, 6-24

Xircom Model PE3-10B2, LMF to BTS connection,
3-24


